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About this information product

...............................................................................................................................................................................................................................................................

Purpose This Provisioning Guide provides operations, administration and
maintenance information about the WaveStar® TDM 10G (STM-64).

Reason for reissue The present release (Issue a) is the first version of this manual.

Safety labels The present manual contains basic safety instructions which have to
be strictly observed when handling the equipment and systems
described.

Strictly observe the warnings and safety instructions before carrying
out work of any kind on the equipment and systems described.

All safety instructions include a signal word that classifies the danger
and a text block that contains descriptions of the type and cause of the
danger, the consequences of ignoring the safety instruction and the
measures that can be taken to minimize the danger. In some safety
instructions, a warning symbol is placed underneath the signal word.

Example:

....................................................................................................................................................................................................................................
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DANGER
Arcing on removing or inserting a live power supply plug.

Arcing can cause burns to the hands and damage to the
eyes. Ensure that the line circuit-breaker on the fuse
panel is in the ″OFF″ position before removing or
inserting the power supply plug.

Classification of hazards

There are three classes of hazards. They are designated using the head
words “Danger”, “Warning” and “Caution”. Their meaning is as
follows:

• Danger
is used to mark safety warnings which, if not followed, will
certainly or with a very high degree of probability result in death
or extremely serious injury.

• Warning
is used to mark safety warnings which, if not followed, can lead
to serious injury or permanent damage to the health of an
individual or to property.

• Caution
is used to mark safety warnings which, if not followed, can lead
to injury or property damage - including financial losses due to
extensive operational impairment.

Warning symbols

The examples below show the warning symbols used.

DANGER
Example of a general warning about a danger.

DANGER
Example of a warning about laser radiation.

Provisioning Guide for WaveStar® TDM
10G (STM-64)

About this information product
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DANGER
Warning about devices sensitive to electrostatic discharge
(ESD)

The safety instructions for the classes “Danger”, “Warning” and
“Caution” always have a warning symbol, the “Important” and
“Notice” safety instructions can, but do not always have a warning
symbol.

Conventions used These conventions are used in this document:

Numbering

The chapters of this document are numbered consecutively. The page
numbering restarts at “1” in each chapter. To facilitate identifying
pages in different chapters, the page numbers are prefixed with the
chapter number. For example, page 2-3 is the third page in chapter 2.

Cross-references

Cross-reference conventions are identical with those used for
numbering, i.e. the first number in a reference to a particular page
refers to the corresponding chapter.

Keyword blocks

This document contains so-called keyword blocks to facilitate the
location of specific text passages. The keyword blocks are placed to
the left of the main text and indicate the contents of a paragraph or
group of paragraphs.

Typographical conventions

Special typographical conventions apply to elements of the graphical
user interface (GUI), file names and system path information,
keyboard entries, alarm messages etc.

• Elements of the graphical user interface (GUI)
These are examples of text that appears on a graphical user
interface (GUI), such as menu options, window titles or
push-button:

- Provision…, Delete, Apply, Close, OK (push-button)

- Provision Timing/Sync (window title)

- View Equipment Details… (menu option)

- Administration → Security → User Provisioning… (path
for invoking a window)

• File names and system path information

Provisioning Guide for WaveStar® TDM
10G (STM-64)
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These are examples of file names and system path information:

- setup.exe

- C:\Program Files\Lucent Technologies

• Keyboard entries
These are examples of keyboard entries:

- F1, Esc X, Alt-F, Ctrl-D, Ctrl-Alt-Del (simple keyboard entries)
A hyphen between two keys means that both keys have to
be pressed simultaneously. Otherwise, a single key has to be
pressed, or several keys have to be pressed in sequence.

- copy abc xyz (command)
A complete command has to be entered.

• Alarms and error messages
These are examples of alarms and error messages:

- Loss of Signal

- Circuit Pack Failure

- HP-UNEQ, MS-AIS, LOS, LOF

- Not enough disk space available

Abbreviations

Abbreviations used in this document can be found in the “Glossary”
unless it can be assumed that the reader is familiar with the
abbreviation.

Related documentation This section briefly describes the documents that are included in the
WaveStar® TDM 10G documentation set.

• Installation Manual
The WaveStar® TDM 10G (STM-64) Installation Manual is a
step-by-step guide to system installation and setup. It also
includes information needed for pre-installation site planning and
post-installation acceptance testing.

• Applications, Planning, and Ordering Guide
The WaveStar® TDM 10G (STM-64) Applications, Planning, and
Ordering Guide (APOG) is for use by network planners, analysts
and managers. It is also for use by the Lucent Account Team. It
presents a detailed overview of the system, describes its
applications, gives planning requirements, engineering rules,
ordering information, and technical specifications.

• User Operations Guide
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The WaveStar® TDM 10G (STM-64) User Operations Guide
provides step-by-step information for use in daily system
operations. The manual demonstrates how to perform system
provisioning, operations, and administrative tasks by use of
WaveStar® CIT.

• Alarm Messages and Trouble Clearing Guide
The WaveStar® TDM 10G (STM-64) Alarm Messages and
Trouble Clearing Guide gives detailed information on each
possible alarm message. Furthermore, it provides procedures for
routine maintenance, troubleshooting, diagnostics, and component
replacement.

• TL1 Reference Manual
The WaveStar® TDM 10G (STM-64) TL1 Reference Manual
serves as a reference for all TL1 commands which can be used to
operate the network element. The manual also gives an
introduction to the concept of the TL1 commands and instructs
how to use them.

• WaveStar® SNMS Provisioning Guide for WaveStar® TDM 10G
(STM-64))
The WaveStar® SNMS Provisioning Guide for WaveStar® TDM
10G (STM-64)) gives instructions on how to perform system
provisioning, operations, and administrative tasks by use of
WaveStar® SNMS.

The following table lists the documents included in the WaveStar®
TDM 10G documentation set.

Document Number Title

109149773
(365-371-521)

WaveStar® TDM 10G (STM-64)
Applications, Planning, and Ordering Guide

109149781
(365-371-522)

WaveStar® TDM 10G (STM-64) User
Operations Guide

109149799
(365-371-523)

WaveStar® TDM 10G (STM-64) Alarm
Messages and Trouble Clearing Guide

109149823
(365-371-525)

WaveStar® TDM 10G (STM-64) Installation
Manual

109149831(365-371-
526)

WaveStar® TDM 10G (STM-64) TL1
Reference Manual

109149807
(365-371-524)

WaveStar® SNMS Provisioning Guide for
WaveStar® TDM 10G (STM-64))

109149856 CD-ROM Documentation WaveStar® TDM
10G (STM-64) (all manuals on one
CD-ROM)

Provisioning Guide for WaveStar® TDM
10G (STM-64)
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How to comment Because customer satisfaction is extremely important to Lucent
Technologies, every attempt is made to encourage feedback from
customers about our information products.

Customer Comment Form

A customer comment form is located immediately after the title page
of this document. Please fill out the form and fax it to the number
provided on the form.

How to order If the customer comment form is missing, send or fax comments
about this document to

Lucent Technologies Network Systems GmbH

Customer Training and Information Products (CTIP-SDH)

Thurn- und-Taxis-Str. 10

90327 Nürnberg, Germany

Fax: +49 911 526 3545

Provisioning Guide for WaveStar® TDM
10G (STM-64)

About this information product

....................................................................................................................................................................................................................................

x v i i i Lucent Technologies 365-371-524
Issue a, October 2001

,



1 Management communication
setup

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes how network elements are added to the
management of SNMS and how they are modified or deleted.

Contents
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Add a Network Element—TCP/IP Communications 1-5

Modify a Network Element 1-9

Delete a Network Element 1-10

Configuring the basic DCN parameters for an NE 1-11

Supporting information for “Configuring the basic
DCN parameters for an NE”

1-13

Provision DCC Configuration 1-15

Configuring data communication channels for
multiplex section (DCC-M)

1-21

Supporting information for ”Configuring data
communication channels for multiplex section
(DCC-M)”

1-23

Configuring data communication channels for
regenerator section (DCC-R)

1-24

Supporting information for “Configuring data
communication channels for regenerator section
(DCC-R)”

1-26

Configuring the TARP parameters for an NE 1-27

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 - 1

1-27

1-26

1-24

1-23

1-21

1-15

1-13

1-11

1-10

1-9

1-5

1-3



Supporting information for ”Configuring the TARP
parameters for an NE”

1-29

Assigning TARP manual adjacencies 1-30

View DCC terminations 1-32

Provision an IP Gateway Network Element (for IP
Tunneling)

1-34

Supporting information for “Provision an IP
Gateway Network Element (for IP Tunneling)”

1-37

Provision IP Tunnel Parameters 1-38

Supporting information for “Provision IP Tunnel
Parameters”

1-41

Overview Management communication setup

....................................................................................................................................................................................................................................

1 - 2 Lucent Technologies 365-371-524
Issue a, October 2001

1-41

1-38

1-37

1-34

1-32

1-30

1-29



Add a Network Element—OSI Communications
....................................................................................................................................................................................................................................

When to use Use this procedure to add an NE to WaveStar SNMS host.

All other NEs in your network which are connected to this NE are
automatically added to the SNMS.

Related information For related information, see Chapter 8, “Management communication
setup concepts”.

Instructions Complete the following steps to add an OSI-connected NE.
............................................................................................................................................................

1 Select Administration → Network → Network Elements from the
main menu bar on the Map window.

Result:

The Manage NEs window is displayed, showing the current list
of NEs in your Target Group.

............................................................................................................................................................

2 Click on the Add button. The Add an NE - General Information
panel is displayed.

............................................................................................................................................................

3 Enter the NE’s Target Identifier (TID). A TID can be 1-20
alphanumeric characters. Hyphens, slashes (“/”), and periods are
allowed. This field is required.

............................................................................................................................................................

4 Enter the NE’s Alias. An alias can be 1-20 alphanumeric characters.
Uppercase and lowercase letters are allowed. Spaces are allowed. This
field is optional.

............................................................................................................................................................

5 Select TDM 10G STM-64 as the NE Type.

............................................................................................................................................................

6 Select the NE’s time zone by clicking the appropriate radio button,
e.g. for Germany select Other and enter 1.00. If Other is selected,
enter the time difference, in hours and minutes, between the NE time
and Greenwich Mean Time (GMT). Specify the time difference, “+”
(plus) or “-” (minus), up to five characters. Valid values are -11.0 to
13.00 (the plus “+” is implied). Default value: Same as Host.

............................................................................................................................................................

7 Under Communicate via click the OSI radio button.

Management communication setup
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............................................................................................................................................................

8 Click on the NE Communications Details (OSI) tab. And enter the
NEs Controller #1 NSAP.

............................................................................................................................................................

9 Click on the NE Communications Details (OSI)#2 tab. Keep the
default values.

............................................................................................................................................................

10 Click on the NE Security tab. The NE Security panel is displayed.

............................................................................................................................................................

11 Enter the primary NE login and password for the NE being added.
The login and password can be 1-10 characters.

............................................................................................................................................................

12 Re-enter the primary NE password, in the Re-enter Password field,
for checking.

............................................................................................................................................................

13 Enter the backup login and password for the NE. The backup login
and password can be 1-10 characters.

............................................................................................................................................................

14 Click the Apply button to activate your choices, or click the OK
button to activate your choices and close the NE Security panel of the
Add/Modify NE window.

Result:

A message in the status bar is displayed, indicating that the NE
is being added to WaveStar SNMS.

Please note that an OSI-connected NE can be added via
DSA (Directory Services Agent) if it is available.

Add a Network Element—OSI
Communications
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Add a Network Element—TCP/IP Communications
....................................................................................................................................................................................................................................

When to use Use this procedure to add an NE with a direct TCP/IP interface to
WaveStar SNMS host. NEs with a “pure” direct TCP/IP interface can
be set up to communicate directly via TCP/IP with the WaveStar
SNMS host or through a TCP/IP-connected NE serving as a Gateway
Network Element (GNE) for the other NEs in a ring. To provide
support in the event of a communications failure, a backup GNE can
be assigned to a subnetwork to allow switchover to another GNE.

All other NEs in your network which are connected to this NE are
automatically added to the SNMS.

Related information For related information, see Chapter 8, “Management communication
setup concepts”.

Before you begin Before you begin this task, if you are adding a TCP/IP-connected NE
as a GNE, the following must be established:

• The GNE’s Target Identifier (TID)

• A valid NE login/password, and a valid backup NE
login/password

• The GNE’s IP address

• The number of associations for exchanging messages between the
GNE and the other NEs in a ring

Before adding a TCP/IP GNE, you must first create a compatible
subnetwork to which it can be assigned.

Instructions Complete the following steps to add a TCP/IP-connected NE.
............................................................................................................................................................

1 Select Administration → Network → Network Elements from the
main menu bar on the Map window.

Result:

The Manage NEs window is displayed, showing the current list
of NEs in your Target Group.

............................................................................................................................................................

2 Click on the Add button. The Add an NE - General Information
panel is displayed.

............................................................................................................................................................

3 Enter the NE’s Target Identifier (TID). A TID can be 1-20
alphanumeric characters. Hyphens, slashes (“/”), and periods are
allowed. This field is required.

Management communication setup
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............................................................................................................................................................

4 Enter the NE’s Alias. An alias can be 1-40 alphanumeric characters.
Uppercase and lowercase letters are allowed. Spaces are allowed. This
field is optional.

............................................................................................................................................................

5 Select TDM 10G STM-64 as the NE Type.

............................................................................................................................................................

6 Select the NE’s time zone by clicking the appropriate radio button,
e.g. for Germany select Other and enter 1.00. If Other is selected,
enter the time difference, in hours and minutes, between the NE time
and Greenwich Mean Time (GMT). Specify the time difference, “+”
(plus) or “-” (minus), up to five characters. Valid values are -11.0 to
13.00 (the plus “+” is implied). Default value: Same as Host.

..........................................................................................................................................................

7 In the Communicate Via field:

IF ... CLICK ...

The NE is communicating
with the WaveStar SNMS
host via a GNE

the GNE radio button. Go to Step 8.

The NE is communicating
directly with the WaveStar
SNMS host via TCP/IP

the TCP/IP radio button. Go to Step 9.

............................................................................................................................................................

8 If you selected the Communicate Via GNE option in Step 7, click on
the NE Communications Detail (GNE) panel. Select a GNE from the
list on the panel. Skip to Step 15.

............................................................................................................................................................

9 If you selected the Communicate Via TCP/IP option in Step 7, click
on the NE Communications Details (TCP/IP) tab. The NE
Communications Details (TCP/IP) panel is displayed. This panel is
used to enter information about the interface between this GNE, the
WaveStar SNMS host and the other NEs in the subnetwork.

............................................................................................................................................................

10 The Communication Type defaults to TL1 Only. The other options are
currently not available.

............................................................................................................................................................

11 Click on the down arrow to the right of the Choose a Subnetwork
field to display a list of subnetworks, and select a compatible
subnetwork. This field is required.

Add a Network Element—TCP/IP
Communications
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............................................................................................................................................................

12 Enter the NE’s IP address. The IP address field is divided into four
3-character fields separated by periods.

............................................................................................................................................................

13 Choose the number of associations for the NE type. This field is
required.

............................................................................................................................................................

14 Click on the FTP/FTAM Gateway Settings tab. The FTP/FTAM
Gateway Settings panel is displayed.

..........................................................................................................................................................

15 IF ... THEN ...

you want to use the
FTAM/FTP Gateway for
Backup/Restore and S/W
Download

click on the the FTAM/FTP Gateway for
Backup/Restore and S/W Download
radio button.

you do not want to use the
FTAM/FTP Gateway for
Backup/Restore and S/W
Download

click on the the None radio button.

............................................................................................................................................................

16 Click on the NE Security tab. The NE Security panel is displayed.

............................................................................................................................................................

17 Enter the primary NE login and password for the NE being added.
The login and password can be 1-10 characters.

............................................................................................................................................................

18 Re-enter the primary NE password, in the Re-enter Password field,
for checking.

............................................................................................................................................................

19 Enter the backup login and password for the NE. The backup login
and password can be 1-10 characters.

............................................................................................................................................................

20 Click the Apply button to activate your choices, or click the OK
button to activate your choices and close the NE Security panel of the
Add/Modify NE window.

Result:

A message in the status bar is displayed, indicating that the NE
is being added to WaveStar SNMS.

Add a Network Element—TCP/IP
Communications
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..........................................................................................................................................................

21 IF ... THEN ...

You are adding a GNE and
the system prompts
whether DNO should be
run at this time to update
the WaveStar SNMS
database with complete
information about the
newly added NE.

Choose Yes to run DNO or No to not
perform DNO at this time.Importan-t!
If you are adding more GNEs to the
same subnetwork, choose No to not
perform DNO at this time. A DNO
should not be performed until all
GNEs in the same subnetwork have
been added. So new RNEs discovered
automatically by WaveStar SNMS via
a newly added GNE can be reassigned
to another GNE in the same
subnetwork, if necessary.

You are not adding a GNE No DNO prompt is displayed.

Result:

A message in the status bar is
displayed, indicating that the NE is
being added to WaveStar SNMS.

Add a Network Element—TCP/IP
Communications
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Modify a Network Element
....................................................................................................................................................................................................................................

When to use Use this procedure to modify an NE.

Related information For related information, see Chapter 8, “Management communication
setup concepts”.

Before you begin Before you begin this task, be aware that the TID and Communicate
Via fields cannot be modified. To perform this task, access the Map
window.

Instructions Complete the following steps to modify an NE.
............................................................................................................................................................

1 Select Administration → Network → Network Elements from the
main menu bar on the Map window.

Result:

The Network Element Manager window is displayed, showing
the current list of NEs in your Target Group.

............................................................................................................................................................

2 Choose the NE to be modified and click the Modify button.

Result:

The Add/Modify a Network Element - General Information
panel is displayed.

............................................................................................................................................................

3 Click on the tab of the appropriate panel, and change the NE field(s),
as needed.

............................................................................................................................................................

4 Click the Apply button to activate your choices, or click the OK
button to activate your choices and close the Add/Modify a Network
Element window.

Result:

A message in the status bar is displayed, indicating that the NE
is being modified.

Management communication setup
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Delete a Network Element
....................................................................................................................................................................................................................................

When to use Use this procedure to delete an NE.

Before you begin Before you begin this task, make sure that if the NE is assigned to an
aggregate, that you remove it from the aggregate before deleting it.
When an NE is deleted, all information related to that NE is
immediately removed from the WaveStar SNMS database. Associated
trails may also be deleted. Any trail that is deleted as a result of
deleting an NE is also removed from any open window that shows the
deleted trail (like the Map window pane and the Trail Manager).

To perform this task, access the Map window.

Instructions Complete the following steps to delete an NE.
............................................................................................................................................................

1 Select Administration → Network → Network Elements from the
main menu bar on the Map window.

Result:

The Network Element Manager window is displayed, showing
the current list of NEs in your Target Group.

............................................................................................................................................................

2 Choose the NE to be deleted and click the Delete button.

............................................................................................................................................................

3 Click the OK button.

Result:

A pop-up window is displayed, asking if you really want to
delete the chosen NE.

............................................................................................................................................................

4 Choose Yes.

Result:

A message in the status bar is displayed, indicating that the NE
is being deleted.
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Configuring the basic DCN parameters for an NE
....................................................................................................................................................................................................................................

When to use Use this procedure to configure the basic DCN parameters for a
network element. Configuring the basic DCN parameters includes:

• Enabling/Disabling the Intraoffice LAN (IAO-LAN),

• Modifying a node’s area address (the area address is the
configurable part of the NSAP address),

• Specifying the node’s intermediate system (IS) characteristics,

• Setting the CLNP PDU lifetime.

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to configure the basic DCN
parameters for an NE.
............................................................................................................................................................

1 Select the desired NE in the Map pane and then select
Administration → Network → DCC from the main menu.

Result:

The DCC Provisioning window opens.

............................................................................................................................................................

2 Select in the Network Element Explorer part of the window the DCC
controller (ADJCTL/DCCEI circuit pack) of the shelf for which you
want to configure the basic DCN parameters and press Configure.

Result:

By default the LAN Mgmt is displayed in the window.

............................................................................................................................................................

3 If desired, change the value for the LAN Router Priority next to LAN
Router Priority. The possible values range from 1 to 127.

This is the priority of the router connected to the LAN. A higher
number has priority over a lower one. From all routers connected to
the LAN, the router with the highest priority is selected as the
Designated router. The designated Router takes care of routing of
packets in the Q-LAN.

............................................................................................................................................................

4 You may now enable or disable the LAN access to the external LAN
(IAO-LAN for the high speed part) and/or the internal LAN of the
main shelf via External LAN Channel and Internal LAN Channel.

Management communication setup
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Important! The attempt to disable the LAN access to the IAO-LAN
for the low-speed part of the main shelf is rejected by the NE because
the current association between the WaveStar® SNMS and the NE
would be lost in that case, and only remote associations via DCC
would be possible.

............................................................................................................................................................

5 If desired, change the value for the Internal Max Link Metric
parameter. The possible values range from 1 to 63.

............................................................................................................................................................

6 If desired, change the value for the External Max Link Metric
parameter. The possible values range from 1 to 63.

............................................................................................................................................................

7 If you have made any changes in the LAN Mgmt tab click Apply to
confirm your changes.

............................................................................................................................................................

8 Select the Network Layer tab.

............................................................................................................................................................

9 Check the actual setting of the area address in the NSAP segment and
change it if desired.

............................................................................................................................................................

10 If desired, change the value for the CLNP PDU Lifetime. The possible
values range from 2 to 255 hops.

............................................................................................................................................................

11 Specify the node’s IS routing capability by means of the Routing
Capability check boxes in the Intermediate System group box
depending on whether the node shall act as a Level 1 or Level 1&2
router.

............................................................................................................................................................

12 If desired, change the value for the node’s ISCT next to Intermediate
System Config Timer. The possible values range from 10 to 1000
seconds in one-second intervals.

............................................................................................................................................................

13 If you have made any changes in the Network Layer tab click Apply.

Configuring the basic DCN parameters for
an NE
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Supporting information for “Configuring the basic DCN
parameters for an NE”
....................................................................................................................................................................................................................................

Network elements and
nodes

A distinction has to be made between network elements and nodes.
Network elements can be identified by their target identifier (TID), i.e.
their NE name (“NE name” and “TID” are used synonymously
throughout this WaveStar® SNMS Provisioning Guide), whereas a
node is identified by its Network Service Access Point (NSAP)
address. Each NSAP address within a network constitutes a node
which can individually be addressed.

The DCC Provisioning
window

The LAN Management, the Transport Layer and the Network Layer
tabs of the Data Communications window are relevant to perform
this task.

The LAN Management tab The LAN Management tab of the Data Communications window
makes it possible to enable or disable the LAN access to the internal
LAN, the so-called Operations Network (ON), and to the external
LAN (Intraoffice LAN (IAO-LAN)) for a selected DCC controller
(ADJCTL/DCCEI circuit pack). The LAN access is enabled in the
basic configuration. The LAN Management tab also offers the
opportunity to modify the LAN Router Priority and the Max Link
Metric parameters for both LAN types.

Elements of the LAN
Managment tab

The elements of the Lan Managment tab and their meaning are listed
in the following table. If applicable, the permitted value range as well
as the default settings of the parameters are given.

Window
element

Meaning Value
range

Default
setting

LAN Router
Priority (127)

Indicates the priority of
the router connected to
the LAN. A higher
number has priority over
a lower one.

From all routers
connected to the LAN,
the router with the highest
priority is selected as the
Designated router.

The designated Router
takes care of routing of
packets in the Q-LAN.

0- 127 64
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Window
element

Meaning Value
range

Default
setting

Internal Max
Link Metric

1 to 63 14

External Max
Link Metric

1 to 63 14

The Network Layer tab The Network Layer tab of the DCC Provisioning window provides
information on the actual network layer configuration and offers the
opportunity to modify the NE’s area address and to specify the NE’s
IS characteristics and the CLNP PDU lifetime.

Elements of the Network
Layer tab

The elements of the Network Layer tab and their meaning are listed
in the following table. If applicable, the permitted value range as well
as the default settings of the parameters are given.

Window
element

Meaning Value range Default setting

NSAP The complete
area address in
hexadecimal
representation

dependent on
the actual
setting of the
configurable
NSAP address
fields

read-only;

Modify... Click this button to invoke a configuration window
for the Primary Area Address.

Intermediate
System
Routing
Capability

The node’s IS
routing
capability

Level 1

Level 1&2

Level 1&2
w/Partition
repair

Level 1

Notes on the table:

• Intermediate systems periodically generate IS Hellos (ISHs). The
interval between two ISHs is determined by the Intermediate
System Configuration Timer (ISCT).

• The CLNP PDU lifetime specifies the maximum number of hops
permitted for a PDU. If this PDU lifetime control parameter is
exceeded, the PDU will not be forwarded further. A direct
transmission link between two nodes is referred to as a hop.

Supporting information for “Configuring the
basic DCN parameters for an NE”
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Provision DCC Configuration
....................................................................................................................................................................................................................................

When to use Use this procedure to provision the internal and external LAN port
settings and protocol properties for the different management layers of
the OSI stack for DCC channels on the selected NE’s DCC circuit
pack(s). The DCC channels are designated overhead bits on
SONET/SDH optical ports. These overhead bits can be used by the
customer (or NE) as low bandwidth communication channels to the
remote NE that terminates the optical fiber. The DCC circuit pack in a
shelf controls all DCC channels for fibers terminated by that shelf.

The various areas of the DCC configuration that can be provisioned
are:

• LAN Management—The LAN interface provides a higher
bandwidth communications path to the element management
system. The LAN capability is contained within the Data Link
layer of the OSI model. Functions that can be provisioned
include enabling/disabling of the internal and external LAN
interfaces of the DCC circuit pack in an I/O shelf.

• Network Layer—The Network Layer provides the means to
transmit data across a network regardless of network type,
topology, or services offered by the underlying network. The
Connectionless Network Service (CLNS) and its corresponding
Connectionless Network Protocol (CLNP) provides the following
services and functions at the Network Layer: Network Addresses,
Quality of Service (QoS) parameters, Error Notification,
Segmentation of messages, routing, and relaying of messages
through intermediate systems. The Network Service Access Point
(NSAP) Address is the access point where the Network Layer
services are available to network service users.

• Transport Layer—The Transport Layer provides the means to
transmit data reliably between end NEs across a communications
facility. The Transport Layer provides transparent transfer of data
between the session entities.

• TCP/IP—The network layer provided for TCP/IP network is
strictly a connectionless service. The IP only transfers datagrams
on a best effort basis. The Internet Protocol (IP) provides the
functions necessary for delivering datagrams from a source to a
destinatio over an interconnected system of networks.

• TARP—The TID Resolution Protocol (TARP) is used where
there is a need to translate the TID of TL1 messages to the
CLNP address (NSAP) of the NE. TARP allows NEs to translate
between the TID and NSAP by automatically exchanging
mapping information with other NEs.

Management communication setup
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Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Before you begin Before you begin this task, if you are performing a LAN reset using
this procedure, the LAN interface on the DCC circuit pack must be
enabled. Enabling and disabling of internal and external LAN
interfaces can only be done on a DCC circuit pack on the I/O shelf,
not the Main shelf or System Controller shelf.

Instructions Complete the following steps to provision LAN port parameters
and protocol properties of the DCC channels.
............................................................................................................................................................

1 Select the desired NE on the Map window.

............................................................................................................................................................

2 From the main menu bar on the Map Window select Administration
→ Network → DCC.

Result:

The DCC Provisioning window for the selected NE is displayed.

............................................................................................................................................................

3 In the Network Element explorer portion of the window, expand the
equipment hierarchy by clicking on the plus (+) sign next to each
component level until the desired DCC Controller (ADJCTL) circuit
pack is displayed.

............................................................................................................................................................

4 Select the DCC Controller circuit pack.

Result:

The Configure button at the bottom of the Network Element
explorer portion of the window is enabled.

............................................................................................................................................................

5 Click the Configure button.

Result:

The provisioning panels of the DCC Provisioning window are
displayed:

• LAN Mgmt

• Network Layer

• Transport Layer

• TCP/IP

Provision DCC Configuration Management communication setup
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• TARP Provisioning

• TARP Maj (Manual Adjacency)

............................................................................................................................................................

6 Click on the LAN Mgmt panel tab.

Result:

The LAN Mgmt provisioning window panel is displayed.

..........................................................................................................................................................

7 TO ... DO THIS ...

Reset the LAN interface
controller card

Click the RESET button next to the
Reset LAN field. A pop-up warning
dialog window is displayed, warning
that resetting the LAN may cause loss
of communication between the EMS or
between the NE(s) and asks if you
want to do it anyway. Choose Yes to
reset the LAN or No to cancel the
operation.

Provision other LAN
properties

Skip this step. Go to Step 9.

..........................................................................................................................................................

8 TO ... DO THIS ...

Enable the external LAN Click the down arrow next to the
EXTERNAL LAN CHANNEL field to
display a drop-down list and select
Enabled.

Disable the external LAN Click the down arrow next to the
EXTERNAL LAN CHANNEL field to
display a drop-down list and select
Disabled.

..........................................................................................................................................................

9 TO ... DO THIS ...

Enable the internal LAN Click the down arrow next to the
INTERNAL LAN CHANNEL field to
display a drop-down list and select
Enabled.

Provision DCC Configuration Management communication setup
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TO ... DO THIS ...

Disable the internal LAN

CAUTION
If the internal LAN is
disabled, all external
management communications
with the NE may be lost.

Click the down arrow next to the
INTERNAL LAN CHANNEL field to
display a drop-down list and select
Disabled.

............................................................................................................................................................

10 Provision the other LAN parameters.

............................................................................................................................................................

11 Click the Network Layer panel tab.

Result:

The Network Layer panel is displayed. This panel shows the
current NSAP and the other Network Layer parameters:

• CLNP PDU LIFETIME HOPS (2-255)

• Intermediate System Configuration Timer

............................................................................................................................................................

12 Provision the Network Layer parameters, as needed.

............................................................................................................................................................

13 Click the Transport Layer panel tab.

Result:

The Transport Layer panel is displayed. The Transport Layer
parameters are:

• Window Timer—the maximum time to wait before
transmitting window information

• Transport Credit - PDUs—the maximum number of
outstanding/unacknowledged transport of PDUs allowed

............................................................................................................................................................

14 Provision the Transport Layer parameters, as needed.

............................................................................................................................................................

15 Click the TCP/IP panel tab.

Provision DCC Configuration Management communication setup
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Result:

The TCP/IP panel is displayed. The TCP/IP parameters are:

• IP Address

• Default Router Address

• IP Subnet Mask

............................................................................................................................................................

16 Provision the TCP/IP parameters, as needed.

............................................................................................................................................................

17 Click the TARP Provisioning panel tab.

Result:

The TARP Provisioning panel is displayed.

............................................................................................................................................................

18 Provision the TARP parameters, as needed.

............................................................................................................................................................

19 Click the TARP MAJ (Manual Adjacency) panel tab.

Result:

The TARP MAJ (Manual Adjacency) panel is displayed.

..........................................................................................................................................................

20 TO ... DO THIS ...

Modify the current adjacent
NE

Select thecurrent existing manual
adjacency radio button and click the
down arrow to the right of this field to
display a drop-down list. Select the
NSAP address of the current adjacent
NE. Click the Modify Adjacency
button. Enter the NSAP address of the
new adjacent NE in the Enter New
Value for selected adjacency field.

Delete the current adjacent
NE

Select thecurrent existing manual
adjacency radio button and click the
down arrow to the right of this field to
display a drop-down list. Select the
NSAP address of the current adjacent
NE. Click the Delete Adjacency button.
Click the Apply button.Do not click
Apply if you have not provisioned all
DCC parameters for this window..

Provision DCC Configuration Management communication setup
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............................................................................................................................................................

21 If you have provisioned all the DCC channel parameters, click the
Apply button.

Result:

A pop-up dialog window is displayed, informing you that this
action may cause loss of communication with the NE(s) and
asks if you want to continue. Choose Yes to process the request
or No to cancel the change.

............................................................................................................................................................

22 Choose Yes to process the changes for the NE.

............................................................................................................................................................

23 Click the Close button to close the window.
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Configuring data communication channels for multiplex section
(DCC-M)
....................................................................................................................................................................................................................................

When to use Use this procedure to modify existing DCC terminations for the
multiplex section.

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to modify an existing DCC
termination.
............................................................................................................................................................

1 Select the desired NE in the Map pane and then select
Administration → Network → DCC Terminations from the main
menu.

Result:

The DCC Terminations window opens.

............................................................................................................................................................

2 Select in the Network Element Explorer part of the window the DCC
controller (ADJCTL/DCCEI circuit pack) of the shelf for which you
want to configure the DCC Terminations and press Configure.

Result:

The Multiplex Section (Mulitplextab is displayed in the
window.

............................................................................................................................................................

3 Select the Port AID for which you want to modify the DCC
terminations.

Result:

The values for this Port AID are displayed in the window.

............................................................................................................................................................

4 Enable or disable the DCC Termination.

Important! Disabling a previously enabled DCC at an NE needs to be
coordinated with disabling the same DCC at the opposite end of the
DCC link (remote NE) to avoid persistent alarms from the remote NE.

............................................................................................................................................................

5 Next to LAPD Role choose USER-SIDE or NETWORK-SIDE.

Management communication setup
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Important! The LAPD Role setting must be different at both ends of
a DCC link. Otherwise, an alarm (either “User-Network Side RSect
Failure” or “User-Network Side MSect Failure”) will be generated.

............................................................................................................................................................

6 Press Apply to make your changes take effect.

Configuring data communication channels
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Supporting information for” Configuring data communication
channels for multiplex section (DCC-M)”
....................................................................................................................................................................................................................................

Preconditions for enabling
a DCC

You are permitted to enable a DCC if all of the following
preconditions are fulfilled:

• The corresponding optical interface port is provisioned
(configured) or at least pre-provisioned.

• The type of DCC (either DCC-R or DCC-M) is supported on the
corresponding optical interface.

• The DCC is not yet enabled.

• There are LAPD channels available. Please refer to “Max.
number of active DCC links” (1-23) below.

Max. number of active
DCC links

The maximum number of simultaneously supported LAPD channels
per DCC controller is 32. Each DCC controller thus can support up to
32 active DCC links. Upon circuit pack insertion, DCCs will
automatically be enabled and a LAPD channel assigned as long as
LAPD channels are available.

Preconditions for
disabling a DCC

You should disable a DCC only if all of the following preconditions
are fulfilled:

• The DCC is currently enabled.

• The DCC is currently not needed for MS-SPRing management.

• The DCC is not the only management connection to remote NEs.
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Configuring data communication channels for regenerator
section (DCC-R)
....................................................................................................................................................................................................................................

When to use Use this procedure to modify existing DCC terminations for the
regenerator section.

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to modify an existing DCC
termination.
............................................................................................................................................................

1 Select the desired NE in the Map pane and then select
Administration → Network → DCC Terminations from the main
menu.

Result:

The DCC Terminations window opens.

............................................................................................................................................................

2 Select in the Network Element Explorer part of the window the DCC
controller (ADJCTL/DCCEI circuit pack) of the shelf for which you
want to configure the DCC Terminations and press Configure.

Result:

By default the Multiplex Section tab is displayed in the
window.

............................................................................................................................................................

3 Click on the Regenerator Section tab and select the Port AID for
which you want to modify the DCC terminations.

Result:

The values for this Port AID are displayed in the window.

............................................................................................................................................................

4 Enable or disable the DCC Termination.

Important! Disabling a previously enabled DCC at an NE needs to be
coordinated with disabling the same DCC at the opposite end of the
DCC link (remote NE) to avoid persistent alarms from the remote NE.

............................................................................................................................................................

5 Next to LAPD Role choose the USER-SIDE or NETWORK-SIDE.
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Important! The LAPD Role setting must be different at both ends of
a DCC link. Otherwise, an alarm (either “User-Network Side RSect
Failure” or “User-Network Side MSect Failure”) will be generated.

............................................................................................................................................................

6 Press Apply to make your changes take effect.

Configuring data communication channels
for regenerator section (DCC-R)
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Supporting information for “Configuring data communication
channels for regenerator section (DCC-R)”
....................................................................................................................................................................................................................................

Preconditions for enabling
a DCC

You are permitted to enable a DCC if all of the following
preconditions are fulfilled:

• The corresponding optical interface port is provisioned
(configured) or at least pre-provisioned.

• The type of DCC (either DCC-R or DCC-M) is supported on the
corresponding optical interface.

• The DCC is not yet enabled.

• There are LAPD channels available. Please refer to “Max.
number of active DCC links” (1-23) below.

Preconditions for
disabling a DCC

You should disable a DCC only if all of the following preconditions
are fulfilled:

• The DCC is currently enabled.

• The DCC is currently not needed for MS-SPRing management.

• The DCC is not the only management connection to remote NEs.
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Configuring the TARP parameters for an NE
....................................................................................................................................................................................................................................

When to use Use this procedure to

• enable or disable the TARP propagation functionality,

• enable or disable the TARP responder functionality, or to

• set the TARP loop detection buffer (LDB) entry timer and flush
timer

for a selected node.

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to configure the TARP parameters
for an NE:
............................................................................................................................................................

1 Select the desired NE in the Map pane and then select
Administration → Network → DCC from the main menu.

Result:

The DCC Provisioning window opens.

............................................................................................................................................................

2 Select in the Network Element Explorer part of the window the DCC
controller (ADJCTL/DCCEI circuit pack) of the shelf for which you
want to configure the basic DCN parameters and press Configure.

Result:

The LAN Mgmt tab is displayed in the window.

............................................................................................................................................................

3 Select the TARP Provisioning tab.

............................................................................................................................................................

4 Enable or disable the TARP responder functionality according to your
needs by selecting the corresponding value next to TARP Responder
Function. The TARP responder functionality is enabled by default.

Important! It is recommended to have the TARP responder
functionality enabled for the low-speed part of the main shelf.
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............................................................................................................................................................

5 Enable or disable the TARP clipping functionality according to your
needs by selecting the corresponding value next to TARP Clipping
Function

............................................................................................................................................................

6 Set the TARP Clipping Limit to the desired value. The possible values
are from 10 to 2550.

............................................................................................................................................................

7 Set the TARP Clipping Interval. The possible values are from 1 to
255.

............................................................................................................................................................

8 Enable or disable the TARP propagation functionality according to
your needs by selecting the corresponding value next to TARP
Propagation Function. The TARP propagation functionality is
enabled by default.

Important! It is recommended to have the TARP propagation
functionality enabled for the low-speed part of the main shelf.

............................................................................................................................................................

9 Set the Loop Detect Entry Time. The possible values are from 1 to
10minutes.

............................................................................................................................................................

10 Set the Loop Detect Buffer Flush Time. The possible values are
from 1 to 1440 minutes.

............................................................................................................................................................

11 Enable or disable the TARP Originator Function by selecting the
corresponding value next to the TARP Originator Function.

............................................................................................................................................................

12 Press Apply to make your changes take effect.

Configuring the TARP parameters for an NE Management communication setup

....................................................................................................................................................................................................................................

1 - 2 8 Lucent Technologies 365-371-524
Issue a, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Supporting information for” Configuring the TARP parameters
for an NE”
....................................................................................................................................................................................................................................

TARP functionality The WaveStar® SNMS supports the TARP originator functionality
which cannot be disabled. The related timers (T1, T2, T3 and T4) are
permanently preset according to the Telcordia Technologies (formerly
Bellcore) GR-253 standard.

LDB entry timer The LDB entry timer determines the time interval in minutes during
which a previously processed and again received TARP PDU will be
discarded. Possible values are 1 to 10 minutes, the default value is 5
minutes.

LDB flush timer The LDB flush timer serves to periodically re-initialize the loop
detection buffer. Possible values are 1 to 1440 minutes (24 hours), the
default value is 5 minutes.
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Assigning TARP manual adjacencies
....................................................................................................................................................................................................................................

When to use Use this procedure to manually assign adjacent nodes that support
TARP (“TARP manual adjacencies”) by entering their Network Entity
Title (NET).

Two TARP manual adjacencies can be created for one DCC.

The area address together with the system identifier (SYSTEM field)
of the NSAP address is also called the Network Entity Title (NET).

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to assign TARP manual adjacencies:
............................................................................................................................................................

1 Select the desired NE in the Map pane and then select
Administration → Network → DCC from the main menu.

Result:

The DCC Provisioning window opens.

............................................................................................................................................................

2 Select in the Network Element Explorer part of the window the DCC
controller (ADJCTL/DCCEI circuit pack) of the shelf for which you
want to configure the basic DCN parameters and press Configure.

Result:

The LAN Mgmt tab is displayed in the window.

............................................................................................................................................................

3 Select the TARP MAJ tab.

..........................................................................................................................................................

4 Depending on whether you want to assign a new, modify or delete an
existing TARP manual adjacency:

If you want to ... then ...

add a manual adjacency,
there must be an empty
Current Adjacency1 and 2.

click on Enter new manual adjacency
and enter the new NET in this field.

modify an existing manual
adjacency,

select the adjacency you want to
modify via the option menu Select an
existing manual adjacency and press
Modify Adjacency.
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If you want to ... then ...

delete an existing manual
adjacency,

select the adjacency you want to delete
via the option menu Select an existing
manual adjecency and press Delete
Adjacency.

............................................................................................................................................................

5 Press Apply to make your changes take effect.
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View DCC terminations
....................................................................................................................................................................................................................................

When to use Use this procedure to view details about the optical ports provisioned
as DCC termination points. The result of this procedure is a window
panel showing, for each DCC port:

• The port AID

• The port type—working or protection

• The DCC channel type—Multiplex section or regnerator section

• The protection type

• The operational status of the DCC channel

• The LAPD role—Network side or User side

Related information For related information, please refer to Chapter 8, “Management
communication setup concepts”.

Instructions Complete the following steps to view details about the optical
ports provisioned as DCC termination points.
............................................................................................................................................................

1 Select Administration →Network →DCC Terminations from the
main menu bar on the Map window.

Result:

The DCC Terminations window for the selected NE is
displayed.

............................................................................................................................................................

2 In the Network Element explorer portion of the window, expand the
equipment hierarchy by clicking on the plus (+) sign next to each
component level until the desired DCC Controller (ADJCTL) circuit
pack is displayed.

............................................................................................................................................................

3 Select the DCC Controller circuit pack.

Result:

The Configure button at the bottom of the Network Element
explorer portion of the window is enabled.

............................................................................................................................................................

4 Click the View button.
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Result:

The View DCC Terminations window panel is displayed. This
panel shows in table row format, for each optical port
provisioned as a DCC termination point:

• The port AID

• The port type—working or protection

• The DCC channel type—Multiplex section or regnerator
section

• The protection type

• The operational status of the DCC channel

• The LAPD role—Network side or User side
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Provision an IP Gateway Network Element (for IP Tunneling)
....................................................................................................................................................................................................................................

When to use Use this procedure to provision an IP Gateway for IP tunneling. The
IP Gateway NE:

• creates and hold entries in the TCP/IP subnetwork application
context map. This map lists the IP addresses or host names of
operations systems (OSs) and maps them to an OS application
service/context (such as TL1 MAINTENANCE, TL1 MEMORY
ADMINISTRATION) and allows these OS application services to
be forwarded over a TCP/IP LAN connection through the IP
Gateway NE to the OSI network of NEs to IP-connected
managed devices in an IP subnetwork.

• To support the above function, the IP Gateway NE function is
enabled on the selected IP Gateway NE, to allow pure TCP/IP to
OSI conversion.

The IP Gateway NE has an IP router entity with an additional port
configured on the IP router entity (set up on the DCC controller
circuit pack) to add the tunneling capability. In effect, the OSI
subnetwork is provisioned with IP routing tables and set up to
function as an IP subnetwork.

Before you begin Before you begin this task, make sure that the selected NE has a Dual
Stack configuration (can handle OSI and TCP/IP traffic) and has the
IP Tunneling capability enabled.

This function can only be accessed by the WaveStar® SNMS
administrator.

Instructions Complete the following steps to select and provision the IP
Gateway NE.
............................................................................................................................................................

1 Select Administration → Communications → IP
Gateway/Tunneling from the main menu bar on the Map window.

Result:

The IP Gateway/Tunneling window for the selected NE is
displayed.

............................................................................................................................................................

2 In the Network Element explorer portion of the window, expand the
equipment hierarchy by clicking on the plus (+) sign next to each
component level until the desired DCC Controller (ADJCTL) circuit
pack is displayed.
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............................................................................................................................................................

3 Select the DCC Controller circuit pack.

Result:

The Provision button at the bottom of the Network Element
explorer portion of the window is enabled.

............................................................................................................................................................

4 Click the Provision button.

Result:

The two provisioning panels of the IP Tunneling window are
displayed:

• IP Gateway

• IP Tunnel

............................................................................................................................................................

5 Click on the IP Gateway panel tab.

Result:

The IP Gateway provisioning window panel is displayed.

The IP Gateway provisioning window panel is divided into two
provisioning sections:

• IP Parameters—this consists of a display area showing the
current OS IP host addresses and Application Context IDs in the
OS Application Context Map, with two functional buttons which
allow you to add and delete entries in the Application Context
Map. There are also two radio buttons for enabling or disabling
the IP Gateway functionality on the selected NE.

• Tap Properties—this is the area for entering the TT-TD port
numbers for allowing IP tunneling of encapsulated IP packets to
IP-connected managed devices via the OSI network. You can
enter a separate port number to access by each coding method:
Length Value Encoding, Raw Encoding, Telnet Encoding.

..........................................................................................................................................................

6

Provision an IP Gateway Network Element
(for IP Tunneling)
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TO... DO THIS...

Add an entry to the TCP/IP
subnetwork Application
Context Map

Click the Add button next to the
Application Context Map display. A
secondary Add an IP window is
displayed. Enter the OS host’s IP
address and Application Context ID
(examples are TL1 MAINTENANCE
and TL1 MEMORY ADMINISTRA-
TION). Click the Apply button to
apply your entries and leave the
window open or click the OK button to
apply your entries and close the
window.

Delete an entry in the
TCP/IP subnetwork
Application Context Map

Select a line entry in the display area
showing current IP entries/Application
Context IDs and click the Delete
button to the right of the display area.
The selected entry is deleted.

..........................................................................................................................................................

7 TO... CICK...

Enable the TCP/IP Gateway
function for the selected
NE

The Enabled radio button to the right
of the TCP/IP Gateway label.

Disable the IP Gateway
function for the selected
NE

The Disabled radio button to the right
of the TCP/IP Gateway label.

..........................................................................................................................................................

8 TO... DO THIS...

Enter the T-TD LENGTH
VALUE PORT

Enter the port number in the T-TD
Length Value Port field.

Enter the T-TD RAW
PORT

Enter the port number in the T-TD Raw
Port field.

Enter the T-TD Telnet Port Enter the port number in the T-TD
Telnet Port field. Important! Click the
Retrieve button to retrieve previously
stored values for each field.

............................................................................................................................................................

9 Click the Apply button to apply your selections.

Result:

The IP Gateway NE is provisioned for IP tunneling.

Provision an IP Gateway Network Element
(for IP Tunneling)
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Supporting information for “Provision an IP Gateway Network
Element (for IP Tunneling)”
....................................................................................................................................................................................................................................

Elements of the TCP/IP
Gateway tab

The elements of the TCP/IP Gateway tab and their meaning are listed
in the following table. If applicable, the permitted value range as well
as the default settings of the parameters are given.

Window element Meaning Value range

TCP/IP Gateway Control This parameter enables or disables
TCP/IP to OSI conversion for the
selected NE.

Enable, Disable

Default: Disable

TCP/IP Gateway Host List

Host Name IP address of the host. 1 to 24 alphanumeric characters.

Optional.

Host Type Application Context Identifier. Possible values

• Maintenance OS
(TL1MAINTENANCE)

• Memory Administration OS
(TL1MEMORYADMIN)

• Test OS (TL1TEST)

• Other OS (TL1OTHER1)

• Peer Communications OS
(TL1PEERCOM)
(Default)

Encoding Mode Port Numbers

T-TD Length Value Port Sets the Port Number over which the
T-TD function is accessible using the
length value Encoding method.

0..65535.

(Default: 3081)

T-TD Raw Port Sets the Port Number over which the
T-TD function is accessible using the
raw-mode encoding.

0..65535.

(Default: 3082)

T-TD Telnet Port Sets the Port Number over which the
T-TD function is accessible using the
Telnet encoding mode.

0..65535.

(Default: 3083)
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Provision IP Tunnel Parameters
....................................................................................................................................................................................................................................

When to use Use this procedure to set the tunnel-related parameters for each NE
associated with the IP tunnel. This function allows you to enable or
disable whether the selected NE has the IP tunneling feature enabled
and selection of Tunnel Automated Provisioning (TAP) properties for
the participating NEs.

Before you begin Before you begin this task, make sure that the selected NE has a Dual
Stack configuration (can handle OSI and TCP/IP traffic) and has the
IP Tunneling capability enabled.

This function can only be accessed by the WaveStar® SNMS
administrator.

Instructions Complete the following steps to select and provision the IP
Gateway NE.
............................................................................................................................................................

1 Select Administration → Communications → IP
Gateway/Tunneling from the main menu bar on the Map window.

Result:

The IP Gateway/Tunneling window for the selected NE is
displayed.

............................................................................................................................................................

2 In the Network Element explorer portion of the window, expand the
equipment hierarchy by clicking on the plus (+) sign next to each
component level until the desired DCC Controller (ADJCTL) circuit
pack is displayed.

............................................................................................................................................................

3 Select the DCC Controller circuit pack.

Result:

The Provision button at the bottom of the Network Element
explorer portion of the window is enabled.

............................................................................................................................................................

4 Click the Provision button.

Result:

The two provisioning panels of the IP Tunneling window are
displayed:

• IP Gateway

• IP Tunnel
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............................................................................................................................................................

5 Click on the IP Tunnel panel tab.

Result:

The IP Tunneling provisioning window panel is displayed.

............................................................................................................................................................

6 Click the Edit button in the IP Parameters portion of the window
panel.

Result:

A secondary IP Tunnel Provisioning parameters window is
displayed.

This window is divided into two main parts:

• IP Parameters

• Tap Properties

..........................................................................................................................................................

7 TO... CICK...

Enable the IP Tunneling
function for the selected
NE

The Enabled radio button to the right
of the IP Tunnel Status label.

Disable the IP Tunneling
function for the selected
NE

The Disabled radio button to the right
of the IP Tunnel Status label.

..........................................................................................................................................................

8 TO... DO THIS...

Advertise the IP routing
table information to other
Dual Stack with Tunneling
(DSwT) NEs to insert into
their own IP route tables

Click the Enabled radio button to the
right of the Tap Advertise label.

Disallow advertising of the
IP routing table
information

Click the Disabled radio button to the
right of the Tap Advertise label.

..........................................................................................................................................................

9 TO... DO THIS...

Enable learning of the IP
routing table information
by the selected NE

Click the Enabled radio button to the
right of the Tap Learn label.

Provision IP Tunnel Parameters Management communication setup
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TO... DO THIS...

Disable learning of the IP
routing table information
by the selected NE

Click the Disabled radio button to the
right of the Tap Learn label.

..........................................................................................................................................................

10 TO... DO THIS...

Enter the TAP Group to
which the NE belongs

Enter the TAP Group informationin the
Tap Group field.

............................................................................................................................................................

11 Click the Apply button to apply your selections and leave the window
open or click the OK button to apply your selections and close the
window.

Result:

The IP tunnel parameters for the selected NE are provisioned.

Provision IP Tunnel Parameters Management communication setup
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Supporting information for “Provision IP Tunnel Parameters”
....................................................................................................................................................................................................................................

Elements of the IP Tunnel
tab

The elements of the IP tunnel tab and their meaning are listed in the
following table. If applicable, the permitted value range as well as the
default settings of the parameters are given.

Window element Meaning Value range

IP Tunneling

IP Tunnel Status This parameter enables or disables IP
tunneling.

Enable Disable

Default: Disable

Local Owner route list (only the fields TAP Advertise and TAP Cost can be edited)

Dest. IP Destination IP address. 4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

Dest. Mask Destination mask. 4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

Next Hop Port For each route Id: type of next hop
port.

LAN

CLNP Tunnel

Next Hop Address For each route Id: address of the next
hop.

Values :

• IP Address,

• NSAP Address,

TAP Advertise Indicates whether the route should be
advertised (individual advertising).

Yes

No

TAP Cost Cost of the route. 0…65535.

Manual Owner route list ( all fields can be edited, entries can be added and deleted).

Dest. IP Destination IP address. 4 dot-separated decimal numbers
ranging from 0 to 255.

Dest. Mask Destination mask. 4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

Next Hop Port For each route Id: type of next hop
port.

LAN

CLNP Tunnel

Next Hop Address For each route Id: address of the next
hop.

Values :

• IP Address,

• NSAP Address,

TAP Advertise Indicates whether the route should be
advertised (individual advertising).

Yes

No

Management communication setup

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 - 4 1



Window element Meaning Value range

TAP Cost Cost of the route. 0…65535.

IP Default Router
Address

This is the 32 bit IPv4 router address.
The format is a dotted decimal
notation. This parameter must be
provisioned prior to the enabling the
TCP/IP Bridge function.

4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

TAP Owner route list (read only)

Dest. IP Destination IP address. 4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

Dest. Mask Destination mask. 4 dot-separated decimal numbers
ranging from 0 to 255.

No default.

Next Hop Port For each route Id: type of next hop
port.

LAN

CLNP Tunnel

Next Hop Address For each route Id: address of the next
hop.

Values :

• IP Address,

• NSAP Address,

TAP Advertise Indicates whether the route should be
advertised (individual advertising).

Yes

No

TAP Cost Cost of the route. 0…65535.

TAP Properties

TAP Advertise This parameter allows the user to
globally enable or disable the
advertising of the routes marked to be
advertised (the parameter overrules all
the individual TAP Advertise as
displayed in the Route List).

Enable

Disable

TAP Learn This parameter controls the learning
status for the auto provisioning
protocol.

Enable

Disable

TAP Group Defines the TAP Group to which the
system belongs.

0...65535

Supporting information for “Provision IP
Tunnel Parameters”
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2 Equipment provisioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains procedures for provisioning the equipment.

Contents
Establish WaveStar Equipment 2-2

Remove WaveStar Equipment 2-5

View NE Equipment 2-6

View NE Equipment Details 2-8

View NE Equipment Lists 2-9

Perform Cut-Through Commands 2-10

Build TL1 Commands 2-11

Broadcast TL1 Commands 2-13

Set NE Date/Time Synchronization 2-15

Enable/Disable Fall Back and Spring Forward 2-17
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Establish WaveStar Equipment
....................................................................................................................................................................................................................................

When to use Use this procedure to establish WaveStar® TDM 10G
(STM-64)equipment. In the WaveStar® TDM 10G (STM-64), bays,
shelves, and circuit packs can be added and removed.

Related information For related information, see Chapter 9, “Equipment provisioning
concepts”.

Instructions Complete the following steps to establish WaveStar equipment.
............................................................................................................................................................

1 From the main menu bar on the Map window, select Configuration
→ Establish.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Select an NE from the list by double-clicking on it.

............................................................................................................................................................

3 Click on OK button.

Result:

The Create/Provision Equipment window for the selected NE
is displayed.

Equipment provisioning
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............................................................................................................................................................

4 Select one of the three radio buttons near the top left of the window
establish equipment for a Bay, Shelf, or Circuit Pack.

• Bay–When you select this radio button, the Explorer section (just
below the radio buttons) contains the AID of all bays that have
not yet been established. You can choose a bay to establish.

• Shelf –When you select this radio button, the Explorer section
(just below the radio buttons) contains the AID of all bays that
have not yet been established and the corresponding shelf AIDS
for those bays. It also contains the AID of each bay that does not
have all shelves established in it, and the AID of the shelf or
shelves that are not established. You can choose a shelf to
establish.

• Circuit Pack–When you select this radio button, the Explorer
section (just below the radio buttons) contains the AID of
existing bays and existing shelves. Under the shelves are
displayed only those slots for which no circuit pack has been
established. Within the slot is displayed the type of circuit packs
that are legal types for that slot AID. You can choose a circuit
pack type within the slot.

............................................................................................................................................................

5 Once you have selected a radio button, use the mouse to select an
AID to establish from the displayed information in the Explorer
section. Selecting the AID or circuit pack enables the Get Parameters
button.

............................................................................................................................................................

6 Click on the Get Parameters button.

Result:

The right hand portion of the panel is populated with the current
values for provisionable parameters. Additional parameter
information may have to be entered before the equipment is
established. The correct parameter labels are displayed and are
populated with their default values, which are updatable.

............................................................................................................................................................

7 Click the Apply button.

Result:

The equipment is established. If there is a problem with the
request to establish equipment, a pop-up error message is
displayed, indicating the nature of the problem.

Establish WaveStar Equipment Equipment provisioning
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SWIF circuit pack

When the type of circuit pack being provisioned on a Universal I/O
shelf is a SWIF circuit pack, the BSW Port Identifier must be
provisioned in such a manner that no two SWIF circuit pack pairs
both have the same identifier. SWIF circuit packs are paired based on
their slot AIDs. Each pair of circuit packs share a single BSW Port
ID, so if there is already circuit pack in one slot of the slot pair, then
the other circuit pack should have the same BSW Port ID defaulted in
the provisioning window.

First circuit pack

When the circuit pack being provisioned is the first one in the current
slot pair, the list of possible values for the BSW Port Identifier
parameter includes only those values that are not already assigned to a
slot pair. When the circuit pack being provisioned is the second one in
the current slot pair, the list of possible values includes only the value
already chosen for the first circuit pack provisioned in the slot pair.

I/O shelves

When provisioning I/O shelves, the list of possible values for the ON
Cable Pair parameter is a list of only those values that are not
currently assigned to another shelf in this BWM.

Establish WaveStar Equipment Equipment provisioning
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Remove WaveStar Equipment
....................................................................................................................................................................................................................................

When to use Use this procedure to remove WaveStar NE equipment. In the
WaveStar® TDM 10G (STM-64), bays, shelves, and circuit packs can
be added and removed.

Related information For related information, see Chapter 9, “Equipment provisioning
concepts”.

Instructions Complete the following steps to remove WaveStar equipment.
............................................................................................................................................................

1 From the main menu bar on the Map window, select Configuration
→ Remove.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE in the list to select it and click the OK button.

Result:

The Remove Equipment window is displayed. This window
allows you to choose existing equipment from the explorer tree
and to remove that equipment provisioning from the network
element.

............................................................................................................................................................

3 To remove the undesired equipment, first select it with the mouse.

• select a circuit pack, or

• select an empty bay or shelf.

............................................................................................................................................................

4 After selecting the undesired equipment with the mouse, click the
Remove button.

Result:

If the removal is allowed, the system displays a confirmation
window to which you should reply Yes.

If you try to remove a bay/shelf that is not empty, the system
displays a message window explaining that the bay/shelf is not
empty and cannot be removed. You must first empty the
bay/shelf before removing it.

Equipment provisioning
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View NE Equipment
....................................................................................................................................................................................................................................

When to use Use this procedure to display and view NE equipment on the
Equipment Configuration window.

Related information For related information, see Chapter 9, “Equipment provisioning
concepts”.

Instructions Complete the following steps to display and view various NE
equipment components on the Equipment View window.
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Equipment from the main menu bar on the
Map window.

Result:

This displays the Equipment View window, containing
equipment information for the selected NE.

............................................................................................................................................................

3 The Equipment View window allows you to view and/or “drill down”
through a network element to view its various constituent parts via the
graphical representation (the network element view panel), or to select
a component (shelf, bay, slot) for viewing via the hierarchical
representation (the network explorer panel). In addition, you can
access certain features via a pop-up menu that is available in both
panels.

Equipment provisioning
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Navigational conventions

View Panel

• Single Left Click – selects the component both here and in the
explorer.

• Double Left Click– shows the contents of the component in the
view panel, and indicates that it is selected. Shows the
component as selected in the explorer and its subtending
components (if there are any).

• Single Right Click – indicates that the component is selected,
and shows the pop-up menu.

Explorer List Item

• Single Left Click – selects the explorer component and the view
component. If the component selected has contents, it shows the
content in the view panel. Does not show/hide subtending
explorer components.

• Double Left Click – same as single left click on explorer list
item, but does show/hide subtending components in the explorer.

• Single Right Click – indicates that the component is selected,
and shows the pop-up menu.

Explorer plus or minus sign

• Single Left Click – shows/hides subtending components.

View NE Equipment Equipment provisioning
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View NE Equipment Details
....................................................................................................................................................................................................................................

When to use Use this procedure to view details of a single component inside a
network element.

Related information For related information, see Chapter 9, “Equipment provisioning
concepts”.

Instructions Complete the following steps to display NE equipment details.
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Equipment from the main menu bar on the
Map window.

Result:

This displays the Equipment View window, containing
equipment information for the selected NE.

............................................................................................................................................................

3 In the NE Explorer part of the Equipment View window, right click
on the component for which you want to display equipment details.

............................................................................................................................................................

4 On the sub-menu displayed when you right clicked, select Equipment
Details.

Result:

This displays the Equipment Details window, containing the
requested information.

Right clicking on the desired component in the Equipment View
window also displays a sub-menu from which Equipment
Details can be selected. If the component selected for details is a
populated slot (with a circuit pack installed) then details for both
the slot and circuit pack are displayed in Equipment Details.

Equipment provisioning
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View NE Equipment Lists
....................................................................................................................................................................................................................................

When to use Use this procedure to access the list of a given component’s
subtending equipment. When you request an equipment item from
either the drop-down or pop-up menu, WaveStar SNMS provides a list
of equipment for the selected item and its subtending equipment. The
lists can be saved and printed.

Related information For related information, see Chapter 9, “Equipment provisioning
concepts”.

Instructions Complete the following steps to view NE equipment lists.
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Equipment from the main menu bar on the
Map window.

Result:

This displays the Equipment View window, containing
equipment information for the selected NE.

............................................................................................................................................................

3 Select View → Equipment List from the menu bar.

Result:

This displays the equipment list for the selected component. The
list contains information about the NE equipment, at the level
you requested. The information is textual and listed in
name/value pairs.

Right clicking on the desired component in the Equipment View
window also displays a sub-menu from which Equipment List
can be selected. If the component selected for listing is a
populated slot (with a circuit pack installed) then information for
both the slot and circuit pack are displayed in the Equipment
List.

Equipment provisioning
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Perform Cut-Through Commands
....................................................................................................................................................................................................................................

When to use Use this procedure to initiate a TL1 cut-through session from the Map
window and perform enhanced cut-through commands via the
Cut-Through window.

Related information For related information, see “Cut-Through commands” (9-28).

Before you begin Before you begin this task, you must have already displayed the Map
window and determined the NE for which you want to initiate a
cut-through session.

Instructions Complete the following steps to initiate and perform cut-through.
............................................................................................................................................................

1 Position the mouse pointer over the NE to which a cut-through is
required, press the menu mouse button and select Cut-Through from
the pop-up menu or select Configuration → Cut-Through in the
main menu of the Map window.

Result:

The Cut-Through window and the Cut-Through Output
window are displayed. (If the NE is unavailable for any reason,
a message identifying the cause of the error is displayed in a
pop-up window.)

............................................................................................................................................................

2 At the Cut-Through window, type the appropriate TL1 command into
the Cut-Through Command field. If desired, select the displayed
Command by double-clicking on the command and the desired AID
from the list by single-clicking on it to save typing time. See your NE
documentation for detailed command information. (You can select the
Clear Command Area button any time to clear the Cut-Through
Command field and start over.)

The AID list for an NE displayed in the AID scroll list may not be
complete. You may have to select a similar AID from the list to
populate the Cut-Through Command field and then manually edit the
AID to make it the correct one.

............................................................................................................................................................

3 After completing your entry in the Cut-Through Command field,
select the Send Command Now button.

Result:

The command is echoed to the Cut-Through Output window
and the command output appears there.

Equipment provisioning
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Build TL1 Commands
....................................................................................................................................................................................................................................

When to use Use this procedure to create a TL1 command file to assist in
performing maintenance and provisioning activities on one or more
NEs (such as download of standard configuration), without having to
manually enter a set of TL1 command strings. This feature both
reduces the amount of manual entry needed to create TL1 command
strings and allows for the reuse, at a later time, of the commands built
on the same NE or other NEs of the same type.

Related information For related information, see “Building TL1 commands” (9-28).

Before you begin Before you begin this task, you must have already determined the TL1
commands you wish to build.

Instructions Complete the following steps to build TL1 commands.
............................................................................................................................................................

1 On the Map window, select File→ TL1 Macro Scripts → TL1 Macro
Builder from the main menu bar.

Result:

This displays the Macro Builder/Broadcaster window.

............................................................................................................................................................

2 Select the Macro Builder tab if it is not already selected. TL1
command files can only be built for one NE type at a time, so first
specify the NE type by clicking the down arrow adjacent to the NE
Type field (directly below the Manage TL1 Macro Files heading) and
select an NE.

............................................................................................................................................................

3 Next type the appropriate TL1 command(s) into the Macro File
Commands area at the lower left of the window. Press the Return key
between commands, typing each new command on the next available
line in the Macro File Commands area. If desired, select from the
displayed Command List by double-clicking on the command and
from the AID List by single-clicking on the AID to save typing time.
To enter multiple commands from the Command List, click on the
end of a command string and press the Return key before entering the
next command. This will access the next available command line. See
your NE documentation for detailed TL1 command information.

............................................................................................................................................................

4 When you have completed your macro file commands, select
Save/Save As.

Equipment provisioning
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Result:

This displays the Save As window.

............................................................................................................................................................

5 In the Save As window, save the contents of the Macro File
Command lines as a new macro file (by typing the new macro file
name into the Save As field) or to an existing macro file name,
overwriting the contents of the file (by selecting one from the
displayed list). Don’t forget to use the radio buttons to indicate
whether the file should be Accessible by all or Accessible by
owner only.

............................................................................................................................................................

6 The following list shows how to use remaining items on the TL1
Macro Builder window:

• Clear Command(s) – click this button to clear the current entries
in the Macro File Command area.

• Owner – displays the macro file owner’s login ID.

• File Properties – indicates whether the displayed macro file is
Accessible By Allor Accessible by Owner Only. This value can
be changed (by owners) via the Save Asscreen, which is
displayed by clicking the Save/Save Asbutton.

• Put Into Command Area – select this button to put the contents
of the selected macro file into the command line text area.

• View Macro – use this button to view the contents of the selected
macro file.

• Delete Macro – click this button to delete the selected macro file
(for owners only).

Build TL1 Commands Equipment provisioning
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Broadcast TL1 Commands
....................................................................................................................................................................................................................................

When to use The broadcast TL1 commands feature allows you to perform
maintenance and provisioning activities (such as download of standard
configuration) on one or more NEs, utilizing the TL1 command files
created by the TL1 macro builder feature, and broadcasting those files
to multiple NEs of the same type. This feature saves you time by
performing similar tasks on multiple NEs in one step, and by reducing
the manual entry required in the creation of TL1 command strings.

Related information For related information, see “Broadcasting TL1 commands to NEs”
(9-28).

Before you begin Before you begin this task, you must have already determined the TL1
commands you wish to broadcast, or know the name of the TL1
macro file you are going to use.

Instructions Complete the following steps to broadcast TL1 commands.
............................................................................................................................................................

1 On the Map window, select File → TL1 Macro Scripts → TL1 Macro
Broadcaster from the main menu bar.

Result:

This displays the Macro Builder/Broadcaster window.

............................................................................................................................................................

2 Specify the NE type for the broadcast; select All NEs, NEs by Type,
or NEs by TID from the Where to Broadcast block at the top middle
of the Broadcaster window. Specify the parameters of the broadcast
further by highlighting NEs in the Available Network Elements list
(on the left side of the window) and clicking the single right arrow
(>) to move them to the Chosen Network Elements list (on the right
side). The NEs placed in the Chosen Network Elements list on the
right will be the ones to receive the broadcast. You can use the double
arrows (>>, <<) to move all current choices between the two lists.)

............................................................................................................................................................

3 Next type the name of the macro file (to be broadcast to the NEs
selected in the Chosen Network Element list) into the field in the
Macro File to Broadcast block (or simply select a macro file from
the displayed list by double clicking on it).
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............................................................................................................................................................

4 Select the Broadcast Macro button to ask the system to perform the
broadcast. The following list shows how to use the remaining buttons
on the Broadcaster window:

• View Macro- use this button to view the macro file, which you
may want to do before executing it.

• Abort Broadcast- use this button to stop the execution of the
TL1 commands at any time while the broadcast window is
active. When this button is chosen, the system stops sending out
the next command in the macro file to the NE(s) currently being
broadcast to. Once the abort is completed, the system displays a
message.

• Close- click this button any time before clicking the Broadcast
Macro button to remove the Broadcast window from your screen.

Broadcast TL1 Commands Equipment provisioning
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Set NE Date/Time Synchronization
....................................................................................................................................................................................................................................

When to use Use this procedure to manually initiate date/time synchronization for a
single NE, a group of NEs, an aggregate, or all NEs under WaveStar
SNMS control.

Related information For related information, see “Ways to perform date/time
synchronization” (9-33).

Before you begin Before you begin this task, you must take into account whether the
NE(s) being set with the date/time synchronization feature are located
in the same or a different time zone as the WaveStar SNMS host. You
can also select to have WaveStar SNMS automatically make
adjustments for Daylight Savings Time (Spring Forward) and standard
time (Fall Back) before doing date/time synchronization for the
selected NE(s).

Instructions Complete the following steps to manually perform date/time
synchronization.
............................................................................................................................................................

1 Select Configuration → Date/Time Synchronization → Manual from
the main menu bar on the Map window.

Result:

The Choose an NE/Aggregate window is displayed.

............................................................................................................................................................

2 Click the NEs radio button to display a list of NEs or click the
Aggregates radio button to display a list of aggregates.

Result:

A list of NEs or aggregates is displayed.

............................................................................................................................................................

3 Double-click on the NE or aggregate to select it for date/time
synchronization. To perform date/time synchronization on all NEs,
scroll to the top of the Choose an NE/ Aggregate window and
double-click on the word ALL in the list. Click the OK button.

Result:

The Date and Time Synchronization window is displayed.

............................................................................................................................................................

4 Click the OK button to initiate date/time synchronization for the NE(s)
or aggregate.
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Result:

Date/Time synchronization is initiated. A pop-up window is
displayed, showing the status of the date/time synchronization.

The status is as follows:

• Completed – date/time synchronization is completed for
the selected NE(s) or aggregate.

• Incompleted – The command to perform date/time
synchronization may be completed but the time difference
between the host and NE is greater than the drift threshold
set.

Set NE Date/Time Synchronization Equipment provisioning
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Enable/Disable Fall Back and Spring Forward
....................................................................................................................................................................................................................................

When to use Use this procedure to enable or disable the Spring Forward (Daylight
Savings Time) and Fall Back (standard time) feature to make
automatic time adjustments in date/time synchronization for the
selected NE(s)/aggregate(s).

Related information For related information, see “Standard time and daylight savings time”
(9-33).

Instructions Complete the following steps to enable or disable the Spring
Forward/Fall Back time adjustment feature.
............................................................................................................................................................

1 Select one or more NEs/aggregates from the Map window or select no
NEs/aggregates to use this feature for all NEs in your Target group.

............................................................................................................................................................

2 Select Configuration → Date/Time Synchronization → Spring/Fall
Change from the main menu bar on the Map window. If you have not
yet selected the NE(s)/aggregate(s), the Choose an NE/Aggregate
window is displayed. Select the NE(s)/aggregate(s) on which to use
the Spring Forward/ Fall Back feature and click the OK button.

Result:

The Fall Back and Spring Forward Active Status of NEs
window is displayed.

............................................................................................................................................................

3 If you want to enable the Spring Forward/Fall Back feature for the
selected NE(s) click the Enable FB/SF for above NEs button. If you
want to disable the Spring Forward/Fall Back feature for the selected
NE(s) click the Disable FB/SF for above NEs button.

............................................................................................................................................................

4 Click the OK button to activate your choices.

Result:

If Daylight Savings Time is already in effect for an NE, and you
disable Spring Forward/Fall Back for an NE, requiring a
date/time synchronization, a pop-up window is displayed, asking
if you want to automatically initiate date/time synchronization
for the NE(s). Choose Yes to initiate automatic date/time
synchronization for the NE or No to skip date/time
synchronization for the NE.
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3 Topology mana gement

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains procedures for adding, modifying and deleting
trails and aggregates.

Contents
Add an Aggregate 3-2

Modify an Aggregate 3-4

Delete an Aggregate 3-5

Add a Trail 3-7

Delete a Trail 3-9
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Add an Aggregate
....................................................................................................................................................................................................................................

When to use Use this procedure to add an aggregate. An aggregate is a collection
of related NEs/aggregates that are grouped and named for purposes of
streamlining network monitoring and resynchronization. A new
aggregate is created by providing a unique aggregate name and alias
and adding NEs or other aggregates to it.

Related information For related information, see “Aggregates” (14-25).

Before you begin Before you begin this task, identify which NEs and/or aggregates you
want associate with the aggregate being created.

Instructions Complete the following steps to create a new aggregate.
............................................................................................................................................................

1 Select Administration → Network → Aggregates → Add from the
main menu bar on the Map window.

Result:

The Add an Aggregate window is displayed.

............................................................................................................................................................

2 Fill in the following fields, as needed:

• Aggregate Name – This is the aggregate name. The Aggregate
name can be 1-20 alphanumeric characters. Dashes are allowed.
This field is required. The Aggregate name must be unique.

• Aggregate Alias – This is the aggregate alias (alternate label).
The Aggregate alias can be 1-20 alphanumeric characters. Dashes
are allowed. This field is optional.

............................................................................................................................................................

3 Click the OK button.

Result:

The Status Dialog box is displayed and indicates that a new
aggregate has been created. When a new aggregate is created, it
is automatically placed into the TOP layer of the Map view. Any
NE or aggregate that is placed into the aggregate is removed
from the TOP layer.

The icon for the new aggregate is displayed in the current Map
view and the subnetwork explorer, and is automatically selected.

Topology management
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............................................................................................................................................................

4 To add NEs and/or aggregates to the newly created aggregate drag the
NE or aggregate icon into the parent (owner) aggregate.

Moving an NE or aggregate out of an aggregate

An NE or aggregate can be moved out of the current parent aggregate
into the top Map view by choosing Return to Top in the
NE/aggregate’s pop-up menu.

Add an Aggregate Topology management
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Modify an Aggregate
....................................................................................................................................................................................................................................

When to use Use this procedure to change an aggregate’s alias.

Related information For related information, see “Aggregates” (14-25).

Before you begin Before you begin this task, identify the aggregate to be modified. Be
aware that the aggregate name for the Top Level Aggregate (TOP),
which is the default parent of all member NEs in the network, cannot
be changed.

Instructions Complete the following steps to change the aggregate alias.
............................................................................................................................................................

1 Select the aggregate to be modified from the Map window or
subnetwork explorer and choose Administration → Network →
Aggregates → Modify Alias from the main menu bar on the Map
window.

Result:

The Modify an Aggregate window is displayed with the current
aggregate name and/or alias.

............................................................................................................................................................

2 Change the aggregate alias, as desired and click the OK button.

Result:

The Status Dialog box is displayed, indicating that the changes
to the aggregate are being made by WaveStar SNMS.

Selecting the aggregate from a list

If no aggregates were chosen from the Map window or Subnetwork
Explorer in Step 1, the Choose an NE/Aggregate window is
displayed for selection of the aggregate to be modified. Select the
aggregate to be modified and click the OK button.

Topology management

....................................................................................................................................................................................................................................

3 - 4 Lucent Technologies 365-371-524
Issue a, October 2001

E N D O F S T E P S............................................................................................................................................................



Delete an Aggregate
....................................................................................................................................................................................................................................

When to use Use this procedure to delete an aggregate from WaveStar SNMS.

Related information For related information, see “Aggregates” (14-25).

Before you begin Before you begin this task, be aware that NEs/aggregates that are
members of the aggregate being deleted must be reassigned to another
aggregate or to the TOP aggregate level by choosing Return to Top in
the NE/aggregate’s pop-up menu.

Instructions Complete the following steps to delete an aggregate.
............................................................................................................................................................

1 Select Administration → Network → Aggregates → Delete from the
main menu bar on the Map window.

Result:

The Choose an Aggregate Aggregate/Delete window is
displayed.

............................................................................................................................................................

2 Select the aggregate to be deleted and click the OK button.

Result:

The Re-Assign an Aggregate window is displayed.

............................................................................................................................................................

3 Choose an aggregate from the list to which you want to reassign any
member NEs/aggregates. You may also choose Return to TOP to
return the NE(s) to the TOP Level Aggregate, which includes all NEs.

............................................................................................................................................................

4 Click the OK button.

Result:

The Status Dialog window is displayed, indicating that the
aggregate is being deleted.

Topology management
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Distributing aggregates to other aggregates

If you are not moving the majority of NEs to a single aggregate, it is
recommended that you select the TOP Level Aggregate and modify
those aggregates that take the NEs from the deleted aggregate.

Delete an Aggregate Topology management
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Add a Trail
....................................................................................................................................................................................................................................

When to use Use this procedure to manually add a trail between two NEs. Trails
between identical Lucent Technologies NEs may be autodiscovered by
the DNO feature and do not have to be manually added. Manually
added trails may also be manually deleted.

DCN connection Trails have to be added manually only if the DCC is not working on
the respective connection.

Related information For related information, see “Trails” (14-27).

Before you begin Before you begin this task, verify that the NEs at either end of the
trail are compatible for the connection and that the AIDs at both ends
of the trail are using compatible software releases. DNO has to be
performed on the NEs at either end of the trail before manually
adding a trail.

When you are adding a trail between an NE managed by WaveStar
SNMS and a non-managed device (such as a DDM-2000), the AID(s)
may not be available for the non-managed device, and, subsequently,
will not be displayed in the AID list on the Add a Trail window. The
trail can still be added between the managed and non-managed NE.

To perform this task, access the Map window.

Instructions Complete the following steps to manually add a trail.
............................................................................................................................................................

1 Select Administration → Network → Trails from the main menu bar
on the Map window.

Result:

The Trail Manager window is displayed, showing the current
list of user-defined trails between NEs.

............................................................................................................................................................

2 Click the Add button.

Result:

The Add a Trail window is displayed.

This window consists of:

• Alias field

• From TID and To TID scroll lists for both NEs

• From AID and To AID explorers for both NEs

Topology management
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The Trail Termination Point (TTP) for either end of the trail
consists of the NE’s TID and AID.

............................................................................................................................................................

3 Select the first NE’s TID from the From TID list.

Result:

The corresponding AIDs for the first NE’s TID are displayed in
the From AID explorer.

............................................................................................................................................................

4 Select the second NE’s TID from the To TID list.

Result:

The corresponding AIDs for the second NE’s TID are displayed
in the To AID explorer.

If the TID chosen is for a non-managed device, the associated
AID list is empty and disabled. The trail can still be added
between the managed NE and non-managed device.

............................................................................................................................................................

5 Select a valid AID for the first NE’s TID from the From AID explorer.

............................................................................................................................................................

6 Select a valid AID for the second NE’s TID from the To AID explorer.

............................................................................................................................................................

7 Click the Apply button to create the trail, or click the OK button to
create the trail and close the window.

Add a Trail Topology management
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Delete a Trail
....................................................................................................................................................................................................................................

When to use Use this procedure to manually delete a trail between two NEs.
Automatically discovered trails are deleted automatically if one of the
NEs at either end is deleted.

Related information For related information, see “Trails” (14-27).

Before you begin Before you begin this task, be aware that if you delete a trail, it is
removed from the trail list in any open windows, including the Trail
Manager window. The deleted trail is also removed from all open
Map windows. Be aware that autodiscovered trails cannot be deleted.
To perform this task, access the Map window.

Instructions Complete the following steps to manually delete a trail.
............................................................................................................................................................

1 Select Administration → Network → Trails from the main menu bar
on the Map window.

Result:

The Trail Manager window is displayed, showing the current
list of user-defined trails between NEs.

............................................................................................................................................................

2 Select a trail to be deleted.

............................................................................................................................................................

3 Click the Delete button.

Result:

A pop-up window is displayed, asking if you really want to
delete the trail.

............................................................................................................................................................

4 Choose Yes to delete the trail.

Result:

The Status Dialog window is displayed, indicating that the trail
is being deleted.

Topology management
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4 Timing provisioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes the procedures which have to be performed for
the configuration of the system timing of the WaveStar® TDM 10G
(STM-64).

Contents
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Viewing the timing configuration
....................................................................................................................................................................................................................................

When to use Use this procedure to view the configuration of the external timing
input and output ports, the timing reference and the system timing.

Related information For related information, see Chapter 10, “Timing provisioning
concepts” and “Parameters of the “ViewSync” and “ConfigSync”
windows” (10-8).

Instructions Complete the following steps to query the data of the timing
configuration:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Synchronization → View... from the main
menu bar on the Map window.

Result:

This displays the Ext Timing I/P Ports tab of the ViewSync
window, containing synchronization information for the selected
NE. The corresponding parameters are described in “The Ext
Timing I/P Ports tab” (10-8).

............................................................................................................................................................

3 Click on the tab Ext Timing O/P Ports to query the data on the
timing output port. The corresponding parameters are described in
“The External Timing Output Ports tab” (10-8).

............................................................................................................................................................

4 Click on the Timing Reference tab to query the data on the
configured timing reference source. The corresponding parameters are
described in “The Timing Reference tab” (10-10).

............................................................................................................................................................

5 Click on the System Timing tab to query the data on the internal
SDH Equipment Clock (SEC). The corresponding parameters are
described in “The System Timing tab” (10-11).

............................................................................................................................................................

6 Click on Close to quit the window.

Timing provisioning
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Refresh of values

The displayed parameters can be newly retrieved from the NE by
pressing the Refresh button in the View screen.
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Configuring the external timing input ports
....................................................................................................................................................................................................................................

When to use Use this procedure to configure the external timing input ports.

Related information For related information, see Chapter 10, “Timing provisioning
concepts”, “The Ext Timing I/P Ports tab” (10-8).

Before you begin Prior to performing this task, you must connect the external timing
input ports to an external timing source.

Instructions Complete the following steps to configure the external timing
input ports:
............................................................................................................................................................

1 Select the desired NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Synchronization → Configure... from the
main menu bar on the Map window.

Result:

This displays the Ext Timing I/P Ports tab of the ConfigSync
window, containing synchronization information for the selected
NE. The corresponding parameters are described in “The Ext
Timing I/P Ports tab” (10-8).

............................................................................................................................................................

3 Select the Ext. Timing Port AID from the option menu. The following
values are possible:

• EXTTMG0

• EXTTMG1

............................................................................................................................................................

4 Select the Timing Input Format from the option menu. Select the
format according to the format of the external clock source. The
following values are possible:

• 2 MHz (initial value)

• 2 Mbit – framed

• 2 Mbit – unframed

............................................................................................................................................................

5 Apply the changes by clicking on Apply. If you wish to discard the
changes click on Close.

Timing provisioning
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Result:

If you have clicked on Close, the ConfigSync window closes.
If you have clicked on Apply, the window remains open and
you can select another tab.

Configuring the external timing input ports Timing provisioning
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Configuring the external timing output ports
....................................................................................................................................................................................................................................

When to use Use this procedure to configure the external timing output ports.

Related information For related information, see Chapter 10, “Timing provisioning
concepts”, “The External Timing Output Ports tab” (10-8).

Before you begin Prior to performing this task, you must connect the external timing
output ports to an external timing network.

Instructions Complete the following steps to configure the external timing
output ports:
............................................................................................................................................................

1 Select the desired NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Synchronization → Configure... from the
main menu bar on the Map window.

Result:

This displays the Ext Timing I/P Ports tab of the ConfigSync
window, containing synchronization information for the selected
NE.

............................................................................................................................................................

3 Select the Ext Timing O/P Ports tab of the ConfigSync window.

............................................................................................................................................................

4 Select the Ext. Timing Output Port AID from the option menu.

............................................................................................................................................................

5 Select the Timing Output Format from the option menu. Select the
format according to the format which is required for the external
network. The following values are possible:

• 2 MHz (initial value)

• 2 Mbit - framed
For framed 2 Mbit/s signals, the generation and evaluation of
timing marker information on the timing quality is supported as
per ITU-T Rec. G.703. If you want to use the timing marker,
select 2 Mbit - framed.

• 2 Mbit - unframed

............................................................................................................................................................

6 Enable the use of the external outputs in the option menu Derived
Output Timing Enable by clicking on Enable.

Timing provisioning
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Please note that there is only one timing output signal derived from
the system clock or line signals which is forwarded in parallel to the
two output ports which are physically available.

............................................................................................................................................................

7 Select the timing output source from the option menu Derived Output
Timing Source from which the external timing signal is derived.

The following values are possible:

• TLS (Timing Link Switch)
The external timing signal is derived from one of the timing
references. The currently active timing reference is selected in
this case.

• SETG
The external timing signal is derived from the system clock.

............................................................................................................................................................

8 Set the parameter Sync Msg Force DUS Enable. Via this parameter
you can define whether DNU is consistently transmitted from the
timing output ports.

The following values are possible:

• Enable

• Disable

............................................................................................................................................................

9 Set the parameter AIS/QL Mode to AISMODE or QLMODE.

............................................................................................................................................................

10 Set the parameter Timing Regen Loop Enable in order to avoid
timing loops between the timing output ports and one or both of the
timing inputs through a Stand-Alone Synchronization Equipment
(SASE) Office Clock. This might happen, if the NE forwards timing
to the SASE and at the same time receives a timing signal via one or
both of the external timing input ports. If additionally the system
clock is in the Locked Mode and derived from an external timing
signal, DNU is forwarded to the timing outputs.

The following values are possible:

• DISABLE
The Regenerator Loop functionality is disabled. Timing loops are
not considered.

• EXTREF1

Configuring the external timing output ports Timing provisioning
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If the quality level of the incoming framed 2 Mbit/s timing signal
at the exttmg0 input is equal to the quality level of the timing
signal that is transmitted to the external timing output ports,
DNU is inserted for the outgoing timing signal as the NE
assumes that a timing loop is present.

• EXTREF2
If the quality level of the incoming framed 2 Mbit/s timing signal
at the exttmg1 input is equal to the quality level of the timing
signal that is transmitted to the external timing output ports,
DNU is inserted for the outgoing timing signal as the NE
assumes that a timing loop is present.

• BOTH
The Regenerator Loop functionality is applied to both external
timing inputs.

............................................................................................................................................................

11 Select the impedance of the external timing output from the option
menu Timing Port Impedance.

The following values are possible:

• 120 ohms

• 75 ohms

............................................................................................................................................................

12 Set the parameter Loop Delay. This parameter defines the delay
during which DNU is transmitted from the timing outputs after the
Regenerator Loop conditions are no longer present. You can select a
value between 0 and 60 seconds.

............................................................................................................................................................

13 Apply the changes by clicking on Apply. If you wish to discard the
changes click on Close.

Result:

If you have clicked on Close the ConfigSync window closes. If
you have clicked on Apply, the window remains open and you
can select another tab.

Configuring the external timing output ports Timing provisioning
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Configuring the timing references
....................................................................................................................................................................................................................................

When to use Use this procedure to configure the timing references.

Related information For related information, see Chapter 10, “Timing provisioning
concepts”, “The Timing Reference tab” (10-10).

Instructions Complete the following steps to configure the timing references:
............................................................................................................................................................

1 Select the desired NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Synchronization → Configure... from the
main menu bar on the Map window.

Result:

This displays the Ext Timing I/P Ports tab of the ConfigSync
window, containing synchronization information for the selected
NE.

............................................................................................................................................................

3 Select the Timing Reference tab of the ConfigSync window.

............................................................................................................................................................

4 Select the timing reference which you wish to configure in the
drop-down list box Timing Reference.You can select the external
timing signals EXTREF1 or EXTREF2 or an SDH signal via LINE1,...,
LINE6.

..........................................................................................................................................................

5 Select the port AID in the drop-down menu Port AID.

IF THEN

the selected timing
reference shall not be used,

select NOT-CONNECTED

the selected timing
reference is EXTREF1

select EXTTMG0

the selected timing
reference is EXTREF2

select EXTTMG1

the selected timing
reference is from LINE1 to
LINE6 and you want to
assign a new SDH signal
as timing reference,

select NOT-CONNECTED first in order
to disable the currently assigned SDH
port, and then select the new SDH.

Timing provisioning
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............................................................................................................................................................

6 Select in the drop-down menu System Timing Reference Priority the
priority of the selected timing reference. The values can be

• DISABLE (initial value)

• 1, ..., 8

Make sure that all configured timing references have different
priorities assigned.

Result:

A priority list is created for the configured timing reference
signals. Initially the signal with the highest quality level is used
as timing reference signal. If it fails, the system switches to the
signal with the next lower quality level. If there are several
timing references with the same quality level, they are used
according to the priority list. If all possible timing reference
signals fail, the timing generator enters the holdover mode.

............................................................................................................................................................

7 Select the timing quality belonging to the timing reference in the
drop-down menu Provisioned QL. For LINE1 to LINE6 select AUTO.
This means that the timing marker is evaluated. For EXTREF1 and
EXTREF2 assign the actual quality level of the external timing source.

Result:

The timing references are now used in the order of their quality
level.

............................................................................................................................................................

8 Apply the changes by clicking on Apply. If you wish to discard the
changes click on Close.

............................................................................................................................................................

9 Repeat Step 4 to Step 8 until all timing references are configured.
Click on OK to close the window.

Configuring the timing references Timing provisioning
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Configuring the system timing
....................................................................................................................................................................................................................................

When to use Use this procedure to configure the system timing.

Related information For related information, see Chapter 10, “Timing provisioning
concepts”, “The System Timing tab” (10-11).

Instructions Complete the following steps to configure the system timing:
............................................................................................................................................................

1 Select the desired NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Configuration → Synchronization → Configure... from the
main menu bar on the Map window.

Result:

This displays the ConfigSync window, containing
synchronization information for the selected NE.

............................................................................................................................................................

3 Select the System Timing tab of the ConfigSync window.

............................................................................................................................................................

4 Select the clock mode in the option menu Provisioned Clock Mode.
You can select the following values:

• Free Running (The system is synchronized to the internal
oscillator.)

• Locked (The system is synchronized to a timing reference
signal.)

During normal operation in a network, the timing generator should be
locked to a timing reference signal as far as available. Normally the
free-running mode is used directly after the system start.

............................................................................................................................................................

5 Enable or disable the use of the timing marker for the system timing
option menu System SSM Mode. This means that the selection of
timing reference for the system timing is either determined only by
the provisioned priority list or by the quality level given by the timing
marker (SSM, Synchronization Status Message) and secondly by the
priority list.

The values can be

• ENABLED

• DISABLED

Timing provisioning
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............................................................................................................................................................

6 Type the wait-to-restore time in the group box Timing Reference
Wait To Restore. Click on the respective radio button. The values can
be:

• 0 (initial value)

• 20SEC

• 1MIN ... 60MIN

• 99 (infinite)

The wait-to-restore time is the wait which is made before every single
switching from one timing reference to another.

............................................................................................................................................................

7 Select the ASAP for the system timing with the option menu System
Timing ASAP.

............................................................................................................................................................

8 Select the Acceptance QL from the option menu. The values can be:

• PRC

• SSUT

• SSUL

• SEC

............................................................................................................................................................

9 Apply the changes by clicking on Apply. If you wish to discard the
changes, click on Close.

Result:

If you have clicked on Close, the ConfigSync window closes.
If you have clicked on Apply, the window remains open and
you can select another tab.

Configuring the system timing Timing provisioning
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Forced Switching of the timing generator to the holdover mode
....................................................................................................................................................................................................................................

When to use Use this procedure to switch the timing generator to the holdover
mode.

Related information For related information, see Chapter 10, “Timing provisioning
concepts”.

Instructions Complete the following steps to change the clock mode:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Fault → Synchronization → Operate... from the main menu
bar on the Map window.

Result:

This displays the OperateSync window.

............................................................................................................................................................

3 Set the option menu Sync Switch Modifier to System Clock Mode
Switch.

............................................................................................................................................................

4 Select the switch commmand via the option menu Switch Type. You
can select the following value via an option menu:

• Forced Switch
The Forced Switch command causes the system clock to be
switched to the holdover mode regardless of the state of the
timing references.
The mode switch is not carried out when the clock is provisioned
for the free running mode.

............................................................................................................................................................

5 Apply the changes by clicking on Operate. If you wish to discard the
changes, click on Cancel.

Important! After a switch to holdover or a clear mode switch, it takes
the system about 7 minutes to stabilize the holdover filter. So don’t do
any further timing action during these 7 minutes.

Timing provisioning
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Switching of the timing reference
....................................................................................................................................................................................................................................

When to use Use this procedure to switch between different timing reference
signals and to apply certain switch requests to a selected reference:

• Forced Switch

• Manual Switch

• Lockout Switch

• Clear Wait to Restore

Related information For related information see Chapter 10, “Timing provisioning
concepts”, “Configuring the timing references” (4-9).

Before you begin Prior to performing this task,

• Configure the timing references sources for the system via
Configuration → Synchronization → Configure... (cf.
“Configuring the timing references” (4-9)).

• verify that the timing generator is in the locked mode via
Configuration → Synchronization → View... (cf. “Viewing the
timing configuration” (4-2))

Please note that the switch requests are only applicable if the timing
generator is locked to a timing reference source. When the system is
provisioned to the free running mode, all present requests are cleared.

Instructions Complete the following steps to switch to another timing
reference:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Fault → Synchronization → Operate... from the main menu
bar on the Map window.

Result:

This displays the OperateSync window.

............................................................................................................................................................

3 Set the option menu Sync Switch Modifier to Timing Reference
Switch.

............................................................................................................................................................

4 Select the switch request you want to perform in the option menu
Switch Type. The following switch requests are possible:

• Forced Switch

Timing provisioning
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causes the system to be switched to the selected timing
references regardless of the state of the timing reference. Only if
a release synchronization switch or a Lockout command is
present the Forced Switch is denied. A Forced Switch remains
active until it is removed by a release synchronization switch or a
Lockout command.

• Manual Switch
causes the system to be switched to the selected timing reference
only if that timing reference is working fault free and no other
external request is present.

• Lockout Switch
allows manual selection of individual references, or manual
disabling of individual references.

• Clear Wait to Restore
the wait to restore period will be terminated. The signal status
will return to normal.

............................................................................................................................................................

5 Select the timing reference source to which you want to perform a
switch request in the option menu Destination. This can be:

• EXTREF1, EXTREF2

• LINE1 to LINE6

............................................................................................................................................................

6 Apply the changes by clicking on Operate. If you wish to discard the
changes, click on Cancel.

Important! After a timing reference switch, it takes the system about
7 minutes to stabilize the holdover filter. So don’t do any further
timing action during these 7 minutes.

Switching of the timing reference Timing provisioning
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Switching of the system clock
....................................................................................................................................................................................................................................

When to use Use this procedure to switch the system clock.

Related information For related information see Chapter 10, “Timing provisioning
concepts”.

Instructions Complete the following steps to switch the system clock:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Fault → Synchronization → Operate... from the main menu
bar on the Map window.

Result:

This displays the OperateSync window.

............................................................................................................................................................

3 Set the option menu Sync Switch Modifier to System Clock Mode
Switch.

............................................................................................................................................................

4 Select the switch request you want to perform in the option menu
Switch Type. The following switch requests are possible:

• Forced Switch
causes the system clock to be switched.

............................................................................................................................................................

5 Apply the changes by clicking on Operate. If you wish to discard the
changes, click on Cancel.

Timing provisioning
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Switching of the external timing output
....................................................................................................................................................................................................................................

When to use Use this procedure to switch the external timing outputs. The
following switch requests are possible:

• Forced Switch

• Manual Switch

• Lockout Switch

Related information For related information see Chapter 10, “Timing provisioning
concepts”.

Instructions Complete the following steps to switch an external timing output:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Fault → Synchronization → Operate... from the main menu
bar on the Map window.

Result:

This displays the OperateSync window.

............................................................................................................................................................

3 Set the option menu Sync Switch Modifier to External Timing
Output Switch.

............................................................................................................................................................

4 Select the switch request you want to perform in the option menu
Switch Type. The following switch requests are possible:

• Forced Switch
causes the system to be switched to the selected timing
references regardless of the state of the timing reference. Only if
a release a synchronization switch or a Lockout command is
present the Forced Switch is denied. A Forced Switch remains
active until it is removed by a release a synchronization switch or
a Lockout command.

• Manual Switch
causes the system to be switched to the selected timing reference
only if that timing reference is working fault free and no other
external request is present.

• Lockout Switch
allows manual selection of individual references, or manual
disabling of individual references.

Timing provisioning
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............................................................................................................................................................

5 Select the timing reference source to which you want to perform a
switch request in the option menu Destination. This can be:

• LINE1 to LINE6

............................................................................................................................................................

6 Apply the changes by clicking on Operate. If you wish to discard the
changes, click on Cancel.
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Releasing a synchronization switch
....................................................................................................................................................................................................................................

When to use Use this procedure to release switch requests of the

• Timing Reference

• System Clock Mode

• External Timing Output

The release switch request clears any lockout or forced switch request.

Related information For related information see Chapter 10, “Timing provisioning
concepts”.

Instructions Complete the following steps to release a switch:
............................................................................................................................................................

1 Select the NE in the Map pane portion of the Map window.

............................................................................................................................................................

2 Select Fault → Synchronization → Release... from the main menu
bar on the Map window.

Result:

This displays the ReleaseSync window.

..........................................................................................................................................................

3 If you want to
release the
switch of the

set the Switch
Modifier to

and the Destination to

Timing
Reference

Timing
Reference
Switch

EXTREF1, EXTREF2, LINE1,...,
LINE6

System Clock
Mode

System Clock
Mode Switch

—

External
Timing Output

External
Timing Output
Switch

—

............................................................................................................................................................

4 Apply the changes by clicking on Release. If you wish to discard the
changes, click on Cancel.

Timing provisioning
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5 Traffic provisioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains procedures for traffic provisioning.
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Port provisioning
....................................................................................................................................................................................................................................

When to use Use this procedure to provision a port.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”.

Instructions Complete the following steps to provision a port.
............................................................................................................................................................

1 Select the NE on the Map window for which the ports shall be
provisioned.

............................................................................................................................................................

2 Select Configuration → Provision... from the menu in the Map
window.

Result:

The Provisioning window is displayed.

............................................................................................................................................................

3 Expand the structure in the Network Element Explorer by pressing the
“+”signs until the port to be provisioned is displayed.

............................................................................................................................................................

4 Select the STM port or VC tributary and press Provision.

Result:

The port parameters are displayed on the provisioning side of
the Provisioning window.

............................................................................................................................................................

5 Make the settings as desired and press Apply.

Result:

The port is configured with the new settings.

Reference:

“STM port parameter description” (11-34), “Provisioning (VC-3)
Parameters” (11-37), “Substructuring In- and Output–Signals”
(5-4).
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Substructuring In- and Output–Signals
....................................................................................................................................................................................................................................

When to use Use this procedure to substructure in– and output–signals.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Port provisioning” (5-3).

Instructions Complete the following steps to substructure in– and
output–signals.
............................................................................................................................................................

1 Select the NE on the Map window for which the ports shall be
provisioned.

............................................................................................................................................................

2 Select Configuration → Provision... from the menu in the Map
window.

Result:

The Provisioning window is displayed.

............................................................................................................................................................

3 Expand the structure in the Network Element Explorer by pressing the
“+”signs until the port to be provisioned is displayed.

............................................................................................................................................................

4 Select the STM port and press Provision.

Result:

The port parameters are displayed on the provisioning side of
the Provisioning window.

............................................................................................................................................................

5 Press theDetails button next to the Tributary Input Signal Rate or
Tributary Unequipped Output Signal Rate. field

Result:

The Provisioning Inputsig or Provisioning Unequiposig
window opens.

............................................................................................................................................................

6 Select the signal to be substructured in the list in the upper part of the
window. The current signal structure is shown in the Values column.
The values 416c, 44c, 4 and 3 stand for VC4–16C, VC4–4C, VC4
and VC3 respectively.

Traffic provisioning
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Result:

The buttons for setting the signal structure (3, 4, 4–4c,
VC4–16C) become active. Dark buttons correspond to the
currently set structure.

............................................................................................................................................................

7 Structure the signal by means of the buttons 3, 4, 4–4c and VC4–16C.
Press Apply to confirm your settings.

Result:

The Value column displays the new structure.

............................................................................................................................................................

8 Repeat step 6 and 7 to structure the whole signal as desired. Press Ok
when you are done. (When you press Cancel the settings are lost.)

Result:

The window is closed and the new settings are displayed in the
Provisioning window.

............................................................................................................................................................

9 Repeat the procedure beginning at step 5 so that Tributary Input
Signal Rate and Tributary Unequipped Output Signal Rate are
structured identically. Then press Apply in the Provisioning window.

Result:

The port is configured with the new settings.

Reference:

“STM port parameter description” (11-34), “Provisioning (VC-3)
Parameters” (11-37).
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Enter/exit maintenance condition
....................................................................................................................................................................................................................................

When to use Use this procedure to enter or exit the maintenance condition for an
NE.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”.

Instructions Complete the following steps to enter or exit the maintenance
condition for an NE.
............................................................................................................................................................

1 Select the NE on the Map window.

............................................................................................................................................................

2 Select Configuration → Provision... from the menu in the Map
window.

Result:

The Provisioning window is displayed.

............................................................................................................................................................

3 Select the NE name on top of the Network Element Explorer and
press Provision.

Result:

The NE parameters are displayed on the provisioning side of the
Provisioning window.

............................................................................................................................................................

4 Switch Maintenance Condition to Y (yes) to enter or to N (no) to
exit the maintenance condition by means of the drop down list and
press Apply.

Result:

The maintenance condition for the NE is configured with the
new settings.
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View NE Cross-Connections –Textual
....................................................................................................................................................................................................................................

When to use Use this procedure to view a textual version list of existing
cross-connections.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Instructions Complete the following steps to display a textual version list of
existing cross-connections.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

You also can do a right mouse click on the NE to display a
pop-up menu, from which you can select Cross Connection
and proceed with Step 3.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 In the explorer area of the Cross-Connection window, use your
mouse to select the system, a bay, a shelf, a circuit pack, or a port
group for which you want to see the cross-connections.

............................................................................................................................................................

4 Select View → List Cross-Connections from the main menu of the
Cross-Connection window.

Result:

This displays the Cross-Connection List window.

............................................................................................................................................................

5 If desired, select another element from the explorer area of the
Cross-Connections window to change the information in the
Cross-Connection List window for the new selection. Also if
desired, select a row in the list and then click the Delete or Modify

Traffic provisioning
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button to display the windows used to delete and modify
cross-connections, respectively.
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Add a Single NE Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to add new NE cross-connections.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Several ways to access the
Cross-Connection window

There are several ways to access the Cross-Connection window
besides the method described in this procedure. Other ways to access
the Cross-Connection window:

• From the Map Main Menu
Choose the network element to work with in the Map and then
Configuration → Cross Connection from the main menu.

• Equipment View Window Menu
Choose Configuration → Cross Connection from the main
menu.

• Equipment View Pop-Up Menu
Right click over the equipment whose cross connection window
is to be displayed and choose Cross Connection from the popup
menu.

Instructions Complete the following steps to add a single new
cross-connection.
............................................................................................................................................................

1 Position the mouse cursor on the NE in the Map pane portion of the
Map window and click the menu (right) menu mouse button and
choose Cross Connection from the pop-up menu.

Result:

The Cross-Connect window is displayed.

............................................................................................................................................................

2 Position the mouse cursor on the NE’s TID displayed in the left
portion of the window below the Network Element Explorer heading.
Press the left mouse button twice to highlight the TID.

Result:

The explorer tree is expanded to show the bay(s) below the TID.
(You can also expand any item in the Network Element Explorer
by clicking the plus (+) sign next to the item. To collapse the
item, click the minus (-) sign next to it.)

Traffic provisioning
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............................................................................................................................................................

3 Position the mouse cursor on the bay displayed in the explorer tree.
Press the select (left) mouse button twice to highlight the bay and
expand the explorer tree to show the shelves beneath the bay.

............................................................................................................................................................

4 Position the mouse cursor on the shelf displayed in the explorer tree.
Press the select (left) mouse button twice to highlight the shelf and
expand the explorer tree to show the circuit packs beneath the shelf.

............................................................................................................................................................

5 Position the mouse cursor on the circuit pack displayed in the explorer
tree. Press the select (left) mouse button twice to highlight the circuit
pack and expand the explorer tree to show the port groups beneath the
circuit pack.

............................................................................................................................................................

6 Repeat steps 3–5 for all bays, shelves, and ports that need to be
displayed.

............................................................................................................................................................

7 Expand and display the associated port tributary in the Main View of
the Cross-Connect window.

There are two ways to do this:

• Position the mouse cursor on the port group in the explorer to be
expanded and click the menu (right) mouse button to display a
drop-down menu of positions. Select the position for the tributary
block from the drop-down menu list. (It is recommended to
position the source tributary block on the left).

• Position the mouse cursor on the port group in the explorer, click
and hold the select (left) mouse button and drag the selected port
into the left portion of the Main View of the Cross-Connect
window. The tributary block for the selected port is displayed in
the Main View.

To remove a tributary block from the Main View, position the mouse
cursor on the tributary block, click the right mouse button and select
Clear. The tributary block is cleared from the Main View.

If necessary, click the up/down and left/right arrow keys located next
to the tributary blocks displayed to scroll and locate the tributary you
want to use. When you position the cursor on a tributary block, the
status bar indicates the tributary address and whether the tributary is
available to be used as a source or destination.

Add a Single NE Cross-Connection Traffic provisioning
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............................................................................................................................................................

8 Select the destination port tributary and place it on the right side of
the Main View of the window.

............................................................................................................................................................

9 Move the mouse cursor to the source tributary block on the left side
of the window and click the select (left) mouse button to select the
source tributary for the cross-connection.

Result:

The available cross-connection type buttons are enabled at the
top toolbar portion of the window above the Main View and
Network Element Explorer. If a specific type of cross-connection
is not possible for the source tributary selected, these
cross-connection type buttons are greyed out.

............................................................................................................................................................

10 Select the cross-connection type by clicking on the appropriate
cross-connection type button at the top portion of the window.

Result:

The color of the selected source tributary block changes to
green.

............................................................................................................................................................

11 Select the destination port tributary block.

Result:

The Create Cross-Connection Attributes window is displayed.

............................................................................................................................................................

12 Set the attributes of the cross-connection depending on the
cross-connection type and press OK.

Result:

The line of the newly created cross-connection momentarily
changes to orange. When the cross-connection has been
established, the lines and arrows of the created cross-connection
change color from orange to black and then to blue, indicating
that the cross-connection has been made

Reference:

“1–Way Cross-Connection Parameters” (11-10), “2–Way
Cross-Connection Parameters” (11-10), “1–Way PP
Cross-Connection Parameters” (11-11).
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Add a Roll Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to add a roll cross-connection. A roll refers to the
operation of moving the input of an existing leg of a one-way or
two-way point-to-point cross-connection from the current input
tributary to a new input tributary, while leaving the output tributary
unchanged.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Before you begin Before you begin this task, determine the existing cross-connection for
which you want to create a roll cross-connection.

Instructions Complete the following steps to roll a cross-connection.
............................................................................................................................................................

1 Position the mouse cursor on the NE in the Map pane portion of the
Map window and click the menu (right) menu mouse button and
choose Cross Connection from the pop-up menu.

Result:

The Cross-Connection window is displayed.

............................................................................................................................................................

2 Expand the elements in the Network Element Explorer until you see
the end points of the cross-connection you want to roll and drag the
port groups to the main view of the Cross-Connection window.

............................................................................................................................................................

3 Click with the right mouse button on the existing cross-connection for
the roll and select the desired connection from the popup menu.

Result:

The selected cross-connection line is highlighted. The source
changes its color to green and the sink to magenta.

............................................................................................................................................................

4 Click the Roll button in the toolbar.

Result:

The confirmation dialog box asks you to select a new source.

............................................................................................................................................................

5 Click the OK button and then select a new source.

Traffic provisioning
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............................................................................................................................................................

6 Choose Yes.

Result:

The cross-connection is rolled to the new source tributary.
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Add an NE Multi-Cast Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to add a new multi-cast cross-connection. This is
accomplished via the Add a Multi-Cast Cross-Connection window,
which allows you to choose the number of destination AIDs for a
multi-cast cross-connection.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Instructions Complete the following steps to add a new multi-cast
cross-connection.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 Expand an item in the explorer tree (using the mouse) and locate the
port group that contains the tributaries/ports to display in the main
view area.

............................................................................................................................................................

4 Right click to see the pop-up menu and select a port area from the
menu.

Result:

The port group is expanded to display the tributaries/ports.

............................................................................................................................................................

5 Single click on a high speed line or low speed address at the
appropriate signal rate for the new multi-cast cross-connection.

............................................................................................................................................................

6 Choose the multi-cast button from the group of cross-connection
buttons at the top of the Cross-Connections window (if tooltips help
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is enabled, positioning the mouse pointer over the button will indicate
the correct button).

Result:

This displays the Add a Multi-Cast Cross-Connection window.

............................................................................................................................................................

7 In the Total Number of Destinations in this NE field on the Add a
Multi-Cast Cross-Connection window, enter the number of drops to
be included in the cross-connection.

............................................................................................................................................................

8 In the main view area of the Cross-Connections window, click on
each port/tributary that is to be a drop for the new multi-cast
cross-connection. Notice that as each drop is specified, it is added to
the Chosen Destinations area of the Add a Multi-Cast
Cross-Connection window. (If necessary, you can remove a
previously selected AID from the Chosen Destinations area by
selecting it with the mouse and then clicking the nearby Remove AID
button.) After you have specified the last drop, click the Done button.

Result:

The system asks you to specify additional information for the
cross connection, if any is needed. Specifically, for the purposes
of a multi-cast cross-connection, a destination TID must be
present for each and every destination that you specified. To get
this information the system displays the Additional
Cross-Connection Information window.

............................................................................................................................................................

9 Type the additional requested information into this window and click
OK.

Result:

The system displays the Cross-Connection Confirmation
window.

Reference:

“1–Way Cross-Connection Parameters” (11-10).

............................................................................................................................................................

10 Click the OK button to send the new cross-connection command to
the NE.
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Delete NE Cross-Connections – Graphical
....................................................................................................................................................................................................................................

When to use Use this procedure to delete a selected cross-connection using the
graphical representation.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Instructions Complete the following steps to delete a cross-connection.
............................................................................................................................................................

1 Position the mouse cursor on the NE in the Map pane portion of the
Map window and click the menu (right) menu mouse button. Choose
Cross Connection from the pop-up menu.

Result:

The Cross-Connection window is displayed.

............................................................................................................................................................

2 Double-click on the TID of the NE in the Network Element Explorer
portion of the window (or click the plus sign next to the NE TID) to
expand and show the bay, shelf, slot, circuit pack, and port that
contains the cross-connection to be deleted. If the equipment hierarchy
is not expanded to show all components down to port level,
double-click on the bay, shelf, slot, and circuit pack in successive
order until the explorer tree expands to show the desired port.

............................................................................................................................................................

3 Position the mouse cursor on the port in the explorer tree and click
the left mouse button to select it.

Result:

The port is highlighted in the explorer.

............................................................................................................................................................

4 Click the right mouse button to display a drop-down list and select the
position to place the associated tributaries in the Main View of the
Cross-Connection window. The other way to do this is to click and
hold the left mouse button and drag the port into the left, right, or
bottom position to display the associated tributaries in the Main View.

Result:

The window shows any existing cross-connections for the port.
(If the cross-connection is not displayed, click the Show/Hide
toolbar button to show the cross-connection. If there are multiple
cross-connections, position the mouse cursor over one of the
cross-connections and click the right mouse button to display a
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listing of the existing cross-connections. Then select the desired
cross-connection.)

............................................................................................................................................................

5 On the Cross-Connection window, position the mouse cursor on the
line that represents the cross-connection and click the right mouse
button.

Result:

The line of the selected cross-connection becomes thicker and
the color is black. If you want to delete a two-way
cross-connection, each leg of the two-way cross-connection must
be deleted, one at a time.

............................................................................................................................................................

6 Click the Delete button on the Cross-Connection window toolbar.

Result:

If a two-way cross-connection has been selected for deletion, a
Multiple Leg Cross Connection Deletion window is displayed.
Choose the two-way cross-connection or either one-way
cross-connection comprising the two-way cross-connection and
click the OK button. If a one-way cross-connection or another
type has been selected for deletion, this window is not
displayed.The system displays a confirmation window.

............................................................................................................................................................

7 Select Yes in the confirmation window to delete the cross-connection.
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Delete an NE Cross-Connection – Textual
....................................................................................................................................................................................................................................

When to use Use this procedure to delete a selected cross-connection using the
Cross-Connections List window, which lists the cross-connections
textually rather than graphically.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Denied deletion request The following three scenarios will cause a cross-connection deletion
request to be denied:

• a request to remove a red-lined cross-connection

• a request to remove a cross-connection from a tributary used in a
loop-back cross-connection

• a request to remove a cross-connection from a tributary used in a
test access connection.

Instructions Complete the following steps to delete an NE cross-connection.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 In the explorer area of the Cross-Connection window, select the
system, a bay, a shelf, a circuit pack, or a port group where the
cross-connection resides.

............................................................................................................................................................

4 Select View → List Cross-Connections the main menu of the
Cross-Connection window.

Result:

This displays the Cross-Connection List window, which
displays all cross-connections on the selected item.
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............................................................................................................................................................

5 Select the cross-connection to be deleted and click the Delete button.

Result:

The system displays a confirmation window.

............................................................................................................................................................

6 If you are certain you want to delete the cross-connection indicated
for deletion in the cross-connection window, click the Yes button.

Result:

The system deletes the indicated cross-connection. Upon
successful deletion of a cross-connection, all reference to that
cross-connection, in any window in the GUI, is removed.
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Modify NE Cross-Connections – Graphical
....................................................................................................................................................................................................................................

When to use Use this procedure to modify cross-connections graphically via the
Cross-Connections window.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Instructions Complete the following steps to modify cross-connections
graphically via the Cross-Connections window.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 Expand the elements in the Network element explorer until you see
the end points of the cross-connection you want to modify and drag
the port groups to the main view of the Cross-Connection window.

............................................................................................................................................................

4 Click with the right mouse button on the existing cross-connection to
be modified and select the desired connection from the popup menu.

Result:

The selected cross-connection line is highlighted. The source
changes its color to green and the sink to magenta.

............................................................................................................................................................

5 Click the Modify button on the toolbar or select Configuration →
Cross-Connections → Modify from the menu bar.

Result:

This displays the Additional Cross-Connection Information
window, with the current information for the selected
cross-connection.
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............................................................................................................................................................

6 Type the required changes into the displayed window and click the
Done button.

Result:

This displays the Cross-Connection Confirmation window.

Reference:

“1–Way Cross-Connection Parameters” (11-10), “2–Way
Cross-Connection Parameters” (11-10), “1–Way PP
Cross-Connection Parameters” (11-11), “Multicast
Cross-Connection Parameters” (11-11).

............................................................................................................................................................

7 Make sure you have entered the desired changes and then click the
Yes button.

Result:

The system modifies the selected cross-connection per the
entered changes.
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Modify NE Cross-Connections – Textual
....................................................................................................................................................................................................................................

When to use Use this procedure to modify cross-connections textually via the
Cross-Connections List window.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Instructions Complete the following steps to modify cross-connections.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 In the explorer area of the Cross-Connection window, use your
mouse to select the system, a bay, a shelf, a circuit pack, or a port
group where the cross-connection to be modified resides.

............................................................................................................................................................

4 Select View → List Cross-Connections from the main menu of the
Cross-Connection window.

Result:

This displays the Cross-Connection List window.

............................................................................................................................................................

5 Choose a cross-connection to modify and select Modify.

Result:

This displays the Additional Cross-Connection Information
window, with the current information for the selected
cross-connection.

............................................................................................................................................................

6 Type the required changes into the displayed window and click the
Done button.
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Result:

This displays the Cross-Connection Confirmation window.

Reference:

“1–Way Cross-Connection Parameters” (11-10), “2–Way
Cross-Connection Parameters” (11-10), “1–Way PP
Cross-Connection Parameters” (11-11), “Multicast
Cross-Connection Parameters” (11-11).

............................................................................................................................................................

7 Make sure you have entered the desired changes and then click the
Yes button.

Result:

The system modifies the selected cross-connection per the
entered changes.
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Convert NE Cross Connections
....................................................................................................................................................................................................................................

When to use Use this procedure to convert cross-connections via the
Cross-Connection window.

Related information For related information, see “Converting cross connections” (11-9), .

Instructions Complete the following steps to convert cross-connections.
............................................................................................................................................................

1 Select Configuration → Cross-Connection from the main menu bar
on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the Cross-Connection window.

............................................................................................................................................................

3 In the explorer area of the Cross-Connection window, use your
mouse to select the system, a bay, a shelf, a circuit pack, or a port
group where the cross-connection to be converted resides.

............................................................................................................................................................

4 Expand and display the associated port tributaries the Main View of
the Cross-Connect window.

There are two ways to do this:

• Position the mouse cursor on the port group in the explorer to be
expanded and click the menu (right) mouse button to display a
drop-down menu of positions. Select the position for the tributary
block from the drop-down menu list. (It is recommended to
position the source tributary block on the left).

• Position the mouse cursor on the port group in the explorer, click
and hold the select (left) mouse button and drag the selected port
into the left portion of the Main View of the Cross-Connect
window. The tributary block for the selected port is displayed in
the Main View.
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To remove a tributary block from the Main View, position the mouse
cursor on the tributary block, click the right mouse button and select
Clear. The tributary block is cleared from the Main View.

If necessary, click the up/down and left/right arrow keys located next
to the tributary blocks displayed to scroll and locate the tributary you
want to use.

Result:

The tributaries and the respective cross connection will be
displayed in the Main View.

............................................................................................................................................................

5 Select the cross connection you want to convert.

Result:

The Convert button will be enabled

..........................................................................................................................................................

6 The next window, that will be shown after clicking the Convert
button depends on the type of the chosen cross connection

If you want to convert a
...

Then ...

one-way cross connection
to a one-way path
protected cross
connection

a window pops up to ask you to select
the second source tributary. Confirm by
clicking OK. Select the second source
tributary and the Convert Cross Connect
Attributes windows pops up. In this
window the following parameters can be
set: NEWLOCA, XCAPPL, XCNUM,
PPGNAME; PPBV.
Click on OK to confirm
The Cross Connection Confirmation
window pops up.

one-way cross connection
to a one-way adjunct
cross connection

a window pops up to ask you to select
the second source tributary. Confirm by
clicking OK. Select the second source
tributary and the Convert Cross Connect
Attributes windows pops up. In this
window the following parameters can be
set: NEWLOCA, XCAPPL, XCNUM.
Click OK to confirm
The Cross Connection Confirmation
window pops up.
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If you want to convert a
...

Then ...

a leg of a two-way cross
connection

the Convert Leg of a Multiple Cross
Connect window pops up where you can
chose the desired leg. Confirm by
clicking OK.
Next a window pops up to ask you to
select the second source tributary.
Confirm by clicking OK.
Select the second source tributary and
the Convert Cross Connect Attributes
windows pops up. In this window the
following parameters can be set:
NEWLOCA, XCAPPL, XCNUM,
PGNAME; PPBV.
Click on OK to confirm.
The Cross Connection Confirmation
window pops up.

a one-way path protected
to a one-way point-to
point

The Convert Cross Connect Attributes
windows pops up. In this window the
following parameters can be set:
XCAPPL, XCNUM.
Click on OK to confirm
A warning window pops up, to inform
yopu, that this conversion may be
service affecting and asks you, if you
want to continue.
Click OK to confirm.
The Cross Connection Confirmation
window pops up.

one-way adjunct cross
connection to a one-way
cross connection

The Convert Cross Connect Attributes
windows pops up. In this window the
following parameters can be set:
XCAPPL, XCNUM.
Click on OK to confirm
A warning window pops up, to inform
yopu, that this conversion may be
service affecting and asks you, if you
want to continue.
Click OK to confirm.
The Cross Connection Confirmation
window pops up.

............................................................................................................................................................

7 Click on Yes in the Cross Connection Confirmation to convert the
cross connection
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Create a Local NPPA/NUT configuration
....................................................................................................................................................................................................................................

When to use Use this procedure to create a Local NPPA/NUT configuration for a
local NE in an 2-fiber MS-SPRing protected ring. The Local
NPPA/NUT configuration defines which working timeslots shall be
(temporarily ) not protected or, which protection timeslots shall be
(temporarily) not preempted by the MS-SPRing, respectively.

Related information For related information, see:

• “2-fiber MS-SPRing with Non-preemptible Unprotected Traffic
(NUT)” (11-30)

Before you begin Prior to performing this procedure you must have a detailed
knowledge on the cross-connections switched within the ring. You
must know in detail the priority of the traffic in each timeslot. Also a
2-fiber MS-SPRing must have been created.

Instructions Complete the following steps to create a Local NPPA/NUT
configuration.
............................................................................................................................................................

1 Select Configuration → NPPA/NUT Provisioningfrom the main
menu bar on the Map window.

Result:

This displays the Choose an NE window.

............................................................................................................................................................

2 Choose the network element you want to work with by double
clicking on it in the Choose an NE window and then clicking the OK
button.

Result:

This displays the NPPA/NUT Management window.

The NPPA/NUT Management window shows the existing
2–fiber MS-SPRing protection groups with the NE TID and the
PG AID (rate).

............................................................................................................................................................

3 Choose a NE TID from the explorer and click the Provision button.

Result:

This displays the NPPA/NUT Timeslot Provisioning window.

In the upper panel this window displays the ring map of the
selected protection group.
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............................................................................................................................................................

4 Select the Timeslot Provisioning Rate of the concatenated group of
timeslots for which the Protection Attribute is valid.

The possible values are

• VC3

• VC4

• VC4-4C

• VC4–16C

............................................................................................................................................................

5 Select the Timeslot Number.

Possible values are:

• for VC-3: 1...96

• for VC-4:<3n+1> (n = 0...31)

• for VC-4–4c: <12n+1> (n = 0...7)

• for VC-4–16c: <48n+1> (n = 0...1)

............................................................................................................................................................

6 Select a slot from a working timeslot to be protected, unprotected or
temporary unprotected by clicking the respective button.

• Protect

• UnProtect

• T UnProtect
The value for the corresponding protection timeslot is set
automatically.

Result:

The following message window pos up
You have chosen to change the status of timeslot(s)/

affected timeslot range (for more than one
timeslot) to Protected/Unprotected/Temporary
Unprotected on protection group “PG AID”. This may
affect timeslots on the ring. Do you wish to
continue?″

............................................................................................................................................................

7 Click the OK button to sent the changes to the NE

Result:

If the operation was successful the message Operation
completed is displayed in the Satus bar.

Otherwise the message Operation failed will be displayed
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Add NE Protection Groups
....................................................................................................................................................................................................................................

When to use Use this procedure to add a port protection group to an NE.

An SNCP cannot be created with this procedure.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Instructions Complete the following steps to create protection groups on the
Protection Provisioning window.
............................................................................................................................................................

1 Select Configuration → Protection Groups from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE to select it and click the OK button.

Result:

The Protection Provisioning Manager window is displayed for
the selected NE.

............................................................................................................................................................

3 Single-click on the protection group type to select it and click the
Add button.

Result:

The Add Protection Group wizard window to select a
transmission interface (rate) is displayed.

Reference:

“1+1 Protection Group Parameters” (11-14), “MS–SPRing
Protection Group Parameters” (11-15).

............................................................................................................................................................

4 Select the rate by clicking on the appropriate radio button and click
the Next button.

Result:

The Add Protection Group wizard window to identify the
protection group and select the member ports is displayed.
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............................................................................................................................................................

5 If this is 2-Fiber BLSR/MSPRing protection group, a Protection
Group Name field is displayed. Enter the protection group name (this
field is optional).

............................................................................................................................................................

6 Click the down arrow next to the Bay-Shelf field to display a
drop-down list of bays and shelves. Select the bay/shelf for the port
protection group.

Result:

The bay and shelf selected becomes part of the Protection
Group ID displayed on the window and is later used to identify
the protection group. The Protection Group (PG) ID (identifier)
is derived from the information you provide. The format for the
PG AID is {BayAID}{ShelfAID}{Entity Type
Qualifier}{Protection Group AID}, where the {Entity Type
Qualifier} is: T - 2 Fiber, O - 1+1 Optical

............................................................................................................................................................

7 Enter the Protection Group (PG) AID number(00-99) in the field next
to the PG AID label. This number is used to uniquely identify a
protection group of the same type provisioned on the same shelf. This
field is required.

............................................................................................................................................................

8 In the portion of the window labelled Current Value and New Value,
select the member ports for the protection group. Depending on the
protection group type chosen, the member ports may be labelled
East/West (2-Fiber BLSR/MSSPRing), Working/Protection (1+1
Optical, 1xN Electrical). The system enforces that the ports selected
are on the same shelf and the same transmission rate you selected.
Mixing of SONET and SDH rates is not allowed by the system. (At
any point on this window, you can click the Back button to go back
to the previous wizard window to change the rate for the protection
group. However, if you do this, the current selections you have made
on this wizard window to identify the protection group and select the
member ports will be removed.)

............................................................................................................................................................

9 To select the first port, click the down arrow under the New Value
column to display a list of available ports for the selected bay/shelf.
Click on a port in the displayed drop-down list.

............................................................................................................................................................

10 To select the next port, click the down arrow under the New Value
column to display a list of available ports for the selected bay/shelf.
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The system only displays a list of ports that are on the same bay/shelf
as the first (reference) port chosen and the rate chosen on the previous
wizard window. The system enforces that the working and protection
ports are the same rate.

............................................................................................................................................................

11 After selecting the member ports, click the Next button.

Result:

A window is displayed, informing you that the protection group
is in the process of being created for the network element. When
the process is finished, the text in the window informs you that
the protection group has been successfully created in the
network element.

............................................................................................................................................................

12 To view or modify any additional attributes for the protection group,
click the Next button. If you are finished at this point, click the
Finish button and skip the next step.

............................................................................................................................................................

13 If you clicked the Next button on the previous window to change
attributes, the Enter Protection Group Attributes window is
displayed. The Wait to Restore field is used to select the amount of
time (seconds) to wait before switching back to the working port
when it becomes available again. Click the down arrow next to this
field to display a list of choices. Click on the choice in the list to
select it. If you are finished changing the protection group attribute(s),
click the Next button.

Please note that the change of the Wait to Restore time has no effect
in the current software release.

Result:

A window is displayed, indicating whether you changed any
attributes and asking if you would like to view the protection
group (members, attributes, identifier).

............................................................................................................................................................

14 Click the Next button to view the protection group created, or click
the Finish button.

Result:

After clicking the Finish button, a status window is displayed
showing whether the protection group was successfully created.
If it was not successfully created, this is indicated on the status
window. If the protection group was not successfully created, it
may be that the protection group already exists or another
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problem with the NE or selections made. Click the Refresh
button to clear the status window or click the Close button to
close it.
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View NE Protection Groups
....................................................................................................................................................................................................................................

When to use Use this procedure to select an NE’s port protection group and view
all member ports and current attribute settings.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Instructions Complete the following steps to display protection groups on the
Protection Provisioning window.
............................................................................................................................................................

1 Select Configuration → Protection Groups from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE to select it. Click the OK button.

Result:

The Protection Provisioning Manager for the selected NE is
displayed.

............................................................................................................................................................

3 In the explorer portion of the window, click on the plus (+) sign next
to the protection group type under which is the protection group you
want to view.

Result:

The explorer expands to show the existing protection groups
under the type selected.

............................................................................................................................................................

4 Select the protection group to be viewed by clicking on its protection
group AID in the explorer tree. Click the View button.

Result:

The View Protection Group window for the selected protection
group is displayed. This window shows the Protection Group
Type, protection group (PG) AID, member ports and their value
(assignment), and the current setting of some provisionable
attributes.
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............................................................................................................................................................

5 Click the OK button to close the window. The Protection
Provisioning Manager window remains on the screen. Click the
Close button to close this window.
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Modify NE Protection Groups
....................................................................................................................................................................................................................................

When to use Use this procedure to modify NE protection groups. WaveStar SNMS
allows you to change any attributes associated with the protection
group.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Instructions Perform the following steps to modify a protection group.
............................................................................................................................................................

1 Select Configuration → Protection Groups from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE to select it. Click the OK button.

Result:

The Protection Provisioning Manager for the selected NE is
displayed.

............................................................................................................................................................

3 In the explorer portion of the window, click on the plus (+) sign next
to the protection group type under which is the protection group you
want to view.

Result:

The explorer expands to show the existing protection groups
under the type selected.

............................................................................................................................................................

4 Select the protection group to be modified by clicking on its
protection group AID in the explorer tree. Click the Modify button.

Result:

The Protection Group wizard window for the selected NE and
protection group is displayed. The top of this window shows the
Protection Group Type, Protection Group (PG) AID, and
bay/shelf of the protection group (all of which cannot be
modified).
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............................................................................................................................................................

5 Change the Wait to Restore time or the Protection Group Name if
desired and press the Next button.

Result:

A confirmation window pops up where you have to confirm
your changes.

............................................................................................................................................................

6 Press Yes to confirm the changes.

Result:

The protection group parameters are changed.

Modify NE Protection Groups Traffic provisioning

....................................................................................................................................................................................................................................

5 - 3 6 Lucent Technologies 365-371-524
Issue a, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete NE Protection Groups
....................................................................................................................................................................................................................................

When to use Use this procedure to delete an existing port protection groups from
an NE. Deleting a protection group removes all member ports from
the group.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Instructions Complete the following steps to delete protection groups on the
Protection Provisioning window.
............................................................................................................................................................

1 Select Configuration → Protection Groups from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE to select it. Click the OK button.

Result:

The Protection Provisioning Manager for the selected NE is
displayed.

............................................................................................................................................................

3 In the explorer portion of the window, click on the plus (+) sign next
to the protection group type under which is the protection group you
want to view.

Result:

The explorer expands to show the existing protection groups
under the type selected.

............................................................................................................................................................

4 Select the protection group ID of the port protection group to be
deleted by single-clicking on it. Click the Delete button.

Result:

A pop-up window is displayed, asking if you really want to
remove the port protection group.

............................................................................................................................................................

5 Choose Yes to remove the protection group.
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Result:

A status window is displayed, showing the progress of the
deletion. If the deletion is successfully completed, the status is
shown as “Completed” on the status window.
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Add a Path-Protected Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to create a path-protected cross-connection. This
type of cross-connection can be used in Bidirectional Line-Switched
Ring (BLSR)/Dual Node Interconnection (DNI) and Unidirectional
Path-Switched Ring (UPSR)/ Subnetwork Connection Protection
(SNCP) topologies.

For Dual Ring Interworking(DRI)/DNI applications, the path-protected
cross-connection comprises one add and one through cross-connection
with a working and protection leg.

For UPSR/SNCP applications, a 1-way path-protected
cross-connection is created at the drop node, consisting of two drop
cross-connections with a working and protection leg.

This type of cross-connection can be assigned to a Path Protection
Group Name, which allows all cross-connections with the same Path
Protection Group Name to be retrieved in a single request to the NE.
This is a 1-26 character name that can consist of, for example, a
combination of both input port AIDs.

The path protection behavior between the working and protection legs
of the cross-connection can be defined as non-revertive with no
hold-off time (the initial setting for UPSR/SNCP applications) or
revertive with a hold-off time enabled (the initial setting for DRI/DNI
applications).

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Instructions Complete the following steps to add a path-protected
cross-connection.
............................................................................................................................................................

1 Position the mouse cursor on the NE in the Map pane portion of the
Map window and click the menu (right) menu mouse button. Choose
Cross Connection from the pop-up menu. (If you choose
Configuration → Cross Connection from the main menu bar on the
Map window, the Choose an NE window is displayed. Double-click
on the NE in the window list and click the OK button.)

Result:

The Cross-Connection window for the selected NE is
displayed.
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The equipment hierarchy in the Network Element Explorer
portion of the window is automatically expanded to the slot
(circuit pack) level for the NE.

You can expand any item in the Network Element Explorer by
clicking the plus (+) sign next to the item. To collapse the item,
click the minus (-) sign next to it. If items in the explorer are
partially obscured, place the mouse cursor on the pane edge
between the right side of the explorer and Main View, click and
hold the left mouse button, and drag the edge to the right until
the explorer items can be seen clearly.

............................................................................................................................................................

2 Position the mouse cursor on the plus (+) sign next to each slot in the
explorer portion of the window, then click and expand the equipment
hierarchy until all ports for the cross-connection are shown.

Result:

All ports for the cross-connection are shown.

............................................................................................................................................................

3 Expand and display the desired source port tributary in the Main View
of the Cross-Connect window.

There are two ways to do this:

• Position the mouse cursor on the port in the explorer to be
expanded and click the menu (right) mouse button to display a
drop-down menu of positions. Select the position for the tributary
block from the drop-down menu list (left, right, top, or bottom)
or

• Position the mouse cursor on the port in the explorer, click and
hold the select (left) mouse button and drag the selected port into
the left, right, top, or bottom portion of the Main View of the
Cross-Connect window.

Result:

The tributary block for the selected port is displayed in the Main
View.

To remove a tributary block from the Main View, position the
mouse cursor on the tributary block and click the left mouse
button. Then click the right mouse button. A single option,
Clear, is displayed in a pop-up window. Move the mouse cursor
over the word Clear in the pop-up window to select it. The
tributary block is cleared from the Main View.

Add a Path-Protected Cross-Connection Traffic provisioning

....................................................................................................................................................................................................................................

5 - 4 0 Lucent Technologies 365-371-524
Issue a, October 2001



............................................................................................................................................................

4 Select and display the destination port tributary in the Main View,
using one of the methods described in step 3.

When you position the cursor on a tributary block, the status bar
indicates the tributary address and whether the tributary is available to
be used as a source or destination, or both.

Result:

The destination port tributary is displayed in the Main View.

............................................................................................................................................................

5 Select and display the secondary destination port tributary (to be used
initially for the protection leg of the cross-connection) in the Main
View, using one of the methods described in step 3.

Result:

The second destination port tributary is displayed in the Main
View.

............................................................................................................................................................

6 Select the tributary to be used for the working output/destination leg
of the cross-connection.

Result:

The color of the selected tributary changes to magenta.

............................................................................................................................................................

7 Click on the cross-connection type toolbar button, One Way PP (for
One Way Path-Protected).

If you are not sure which button is the One way PP cross-connection
type toolbar button, move the mouse cursor across each
cross-connection type toolbar button until the label One Way PP is
displayed in the status bar in the bottom portion of the window. A
tooltip help bubble with the label One Way PP will also be displayed.

Result:

The color of the selected source/input tributary changes to green.

............................................................................................................................................................

8 Position the cursor on the tributary to be used as the destination
tributary and click the left mouse button to select it.

............................................................................................................................................................

9 Select the tributary to be used for the protection/secondary source leg
of the cross-connection.

Add a Path-Protected Cross-Connection Traffic provisioning
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Result:

The color of the selected protection/secondary tributary block
changes to brown.

A pop-up Cross-Connections Attributes window is displayed.
This window is used to specify the attributes of the
path-protected cross-connection.

............................................................................................................................................................

10 Select values for the following fields as needed:

• LOCA – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the source
node for this cross-connection. The field defaults to the current
NE.

• LOCZ – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the
destination node for this cross-connection. The field defaults to
the current NE.

• LOCA2 – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the
secondary destination node (for DRI/DNI application of the
path-protected cross-connection). The field defaults to the current
NE.

• OMODE – click the down arrow next to this field to display a
drop-down list of options for the Output Mode for this
cross-connection.

• XCAPPL(Application) – click the down arrow next to this field
to display a drop-down list of choices for the application (type)
of cross-connection. Select 1-Way Path-Protected as the
application.

• XCNUM(Cross-Connection Number) – this field is pre-populated
with a Cross-Connection number (it functions as a drop-down
list; you can click the down arrow to display and select the
number). The Cross-Connection Number is used to associate all
atomic cross-connections that are created from the same
associated legs and leg-pairs so information can be retrieved from
the NE together. This Cross-Connection number can be used to
modify and delete associated legs of one or more
cross-connections with the same number on the List
Cross-Connections window at one time. The List
Cross-Connections window can be accessed by clicking the
List Cross-Connections toolbar button on the
Cross-Connectionwindow toolbar.

Add a Path-Protected Cross-Connection Traffic provisioning
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• PPGNAME (Path Protection Group Name) – this is an optional
field for entering a 1-26 character Path Protection Group Name
that identifies a path protection group for the path-protected
cross-connection. All cross-connections associated with a Path
Protection Group Name can be retrieved in a single request to the
NE.

• PPBV (Path Protection Behavior) – click the down arrow next to
this field to display a list of choices for the Path Protection
Behavior between the working and protection legs of the
cross-connection. The choices are: NN (Non-Revertive with No
Holdoff Time) and RH (Revertive with a Holdoff Time Enabled).

............................................................................................................................................................

11 Click the OK button to activate your attribute choices in the
Attributes window.

Result:

A pop-up confirmation window is displayed.

............................................................................................................................................................

12 Choose Yes.

Result:

The lines and arrows of the newly created cross-connection are
momentarily displayed in orange. When the cross-connection has
been established, the lines and arrows of the cross-connection
change to black and the tributary blocks change to blue,
indicating that they are cross-connected.

The protection leg of the cross-connection is represented by a
dashed line.

The path-protected cross-connection is represented on the Main
View as a cross-connection with multiple legs.

Add a Path-Protected Cross-Connection Traffic provisioning
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Add an Adjunct Path-Protected Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to add an adjunct path-protected cross-connection.
An adjunct path-protected cross-connection is created by using the
same input tributary as an existing path-protected cross-connection
with a different output tributary. Adjunct path-protected
cross-connections are used only for Unidirectional Path-Switched Ring
(UPSR)/Subnetwork Connection Protection (SNCP) NE ring
topologies. There must be an existing path-protected cross-connection
from which to form an adjunct path-protected cross-connection. The
adjunct path-protected cross-connection is not assigned to a separate
path protection group as the existing path-protected cross-connection.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection mechanisms” (11-23), “Multiplex section
protection” (11-24), “2-Fiber MS-SPRing” (11-26), “Protection
configurations” (11-32).

Before you begin Before you begin this task, determine if there is an existing
path-protected cross-connection for which an adjunct path-protected
cross-connection can be added.

Instructions Complete the following steps to add an adjunct path-protected
cross-connection.
............................................................................................................................................................

1 Position the mouse cursor on the NE in the Map pane portion of the
Map window and click the (right) menu mouse button. Choose Cross
Connection from the pop-up menu. (If you choose Configuration →
Cross Connection from the main menu bar on the Map window, the
Choose an NE window is displayed. Double-click on the NE in the
window list and click the OK button.)

Result:

The Cross-Connection window for the selected NE is
displayed.

The equipment hierarchy in the Network Element Explorer
portion of the window is automatically expanded to the slot
(circuit pack) level for the NE.

You can expand any item in the Network Element Explorer by
clicking the plus (+) sign next to the item. To collapse the item,
click the minus (-) sign next to it. If items in the explorer are
partially obscured, place the mouse cursor on the pane edge
between the right side of the explorer and Main View, click and

Traffic provisioning
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hold the left mouse button, and drag the edge to the right until
the explorer items can be seen clearly.

............................................................................................................................................................

2 Position the mouse cursor on the plus (+) sign next to each slot in the
explorer portion of the window, then click and expand the equipment
hierarchy until all ports for the cross-connection are shown.

Result:

All ports for the cross-connection are shown.

............................................................................................................................................................

3 Locate the tributary pair on the NE that have the path-protected
cross-connection to which the adjunct path-protected cross-connection
is being added.

There are two ways to do this:

• One method of locating existing cross-connections on the NE is
by clicking on the NE’s TID at the top level of the equipment
hierarchy in the Network Element explorer, then clicking the List
Cross Connections toolbar button on the Cross-Connection
window toolbar (which is identified by a message in the Status
bar) or

• by tooltips help (when you position the mouse cursor on the
correct button).

Result:

The List Cross Connections window for the entire NE is
displayed.

The first time you choose to list all cross-connections for the
NE, a pop-up window may be displayed, advising you that the
listing of all cross-connections for the NE may take a long time
and asks if you want to proceed. Choose Yes to display the List
Cross Connections window.

The tributary of the path-protected cross-connection’s working
leg has a type of “1WAYPSW” in the Type field of the List
Cross Connections display.

............................................................................................................................................................

4 Expand and display the source, destination, and secondary destination
tributaries for the path-protected cross-connection in the Main View of
the Cross-Connect window.

Add an Adjunct Path-Protected
Cross-Connection
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There are two ways to do this:

• Position the mouse cursor on the port in the explorer to be
expanded and click the menu (right) mouse button to display a
drop-down menu of positions. Select the position for the tributary
block from the drop-down menu list (left, right, top, or bottom).

• Position the mouse cursor on the port in the explorer, click and
hold the select (left) mouse button and drag the selected port into
the left, right, top, or bottom portion of the Main View of the
Cross-Connect window.

Result:

The tributary block for the selected port is displayed in the Main
View.

The lines and arrows of the existing path-protected
cross-connection are displayed in the Main View.

............................................................................................................................................................

5 Position the mouse cursor on the working leg of the existing
path-protected cross-connection closest to the input (source) tributary
block.

Result:

The color of the input (source) tributary block changes to green,
the lines of the working legs of the cross-connection become
thicker, and the One Way Adjunct cross-connection type button
is enabled.

............................................................................................................................................................

6 Click on the One Way Adjunct cross-connection type button on the
toolbar.

Result:

A message is displayed in the status bar, Please select

destination for One Way Adjunct cross-connection.

............................................................................................................................................................

7 Select the destination tributary for the adjunct cross-connection.

Result:

The color of the selected destination tributary changes from
yellow to brown, and the Cross-Connection Attributes window
is displayed. The Attributes window is used to specify the
attributes of the path-protected cross-connection.

Add an Adjunct Path-Protected
Cross-Connection
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............................................................................................................................................................

8 Select values for the following fields as needed:

• LOCA – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the source
node for this cross-connection. The field defaults to the current
NE.

• LOCZ – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the
destination node for this cross-connection. The field defaults to
the current NE.

• LOCA2 – click the down arrow next to this field to display a
drop-down list of NEs and select the NE to be used as the
secondary destination node (for DRI/DNI application of the
path-protected cross-connection). The field defaults to the current
NE.

• OMODE – click the down arrow next to this field to display a
drop-down list of options for the Output Mode for this
cross-connection.

• XCAPPL(Application) – click the down arrow next to this field
to display a drop-down list of choices for the application (type)
of cross-connection. Select 1-Way Path-Protected as the
application.

• XCNUM(Cross-Connection Number) – this field is pre-populated
with a Cross-Connection number (it functions as a drop-down
list; you can click the down arrow to display and select the
number). The Cross-Connection Number is used to associate all
atomic cross-connections that are created from the same
associated legs and leg-pairs so information can be retrieved from
the NE together. This Cross-Connection number can be used to
modify and delete associated legs of one or more
cross-connections with the same number on the List
Cross-Connections window at one time. The List
Cross-Connections window can be accessed by clicking the
List Cross-Connections toolbar button on the
Cross-Connectionwindow toolbar.

............................................................................................................................................................

9 Click the OK button to activate your attribute choices in the
Attributes window.

Result:

A pop-up confirmation window is displayed.

Add an Adjunct Path-Protected
Cross-Connection
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............................................................................................................................................................

10 Choose Yes.

Result:

The lines and arrows of the newly created cross-connection are
momentarily displayed in orange. When the cross-connection has
been established, the lines and arrows of the cross-connection
change to black and the tributary blocks change to blue,
indicating that they are cross-connected.

Add an Adjunct Path-Protected
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Manually Initiate DNO
....................................................................................................................................................................................................................................

When to use Use this procedure to manually initiate DNO for one or more NEs or
an aggregate. You can specify that all information be included in the
DNO update, or just port, cross-connection, port protection group,
subnetwork, NE parameters, or equipment information.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Dynamic Network Operations” (11-18).

Instructions Complete the following steps to manually initiate DNO.
............................................................................................................................................................

1 If you are performing
DNO...

then select...

on a single NE, group of
NEs, or aggregate

one or more NEs or an aggregate.

on a single bay or shelf the bay or shelf on the Network
Element Explorer

............................................................................................................................................................

2 Access the DNO function (as appropriate) through:

• Configuration → DNO on the main menu bar of the Map
window. The Choose an NE/Aggregatewindow is displayed.
Double-click on the NE(s)/aggregate(s) for which you want to
perform DNO. Click the OK button.

• The NE’s or aggregate’s pop-up menu – position the mouse
cursor over the NE/aggregate icon on the Map pane or
Subnetwork Explorer, and click the menu (right) mouse button. A
pop-up menu is displayed. Select DNO from the pop-up menu.

• The Equipment View window (for the chosen NE/ aggregate) –
Select Configurationfrom the main menu. A sub-menu is
displayed. Select DNO from the sub-menu.

• The Cross-Connection window (for the chosen NE/ aggregate)
– select Configuration from the main menu. A sub-menu is
displayed. Select DNO from the sub-menu.

Result:

The Manual DNO window is displayed. If the DNO channel is
down, a message is displayed in the status bar of the window,
indicating that you cannot perform a DNO at this time. Click the
Close button to close the window.

Traffic provisioning
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..........................................................................................................................................................

3 If you are initiating
DNO for...

then click on the radio button
labeled...

all configuration data All Information. If you choose All
Information for a bay or shelf, WaveStar
SNMS performs DNO for ports, port
protection groups, cross-connections,
and equipment.

a selected data type Only the following... and choose one of
the following data types:

• Port Parameters

• Cross Connections/ Reservations

• Port Protection Group

• NE Parameters

• Equipment

• Subnetwork

• Optical Associations
For a single bay or shelf, DNO can
be performed for just Port
Parameters, Cross-Connections, or
Equipment.
When you perform DNO the first
time on an NE, the system does
database synchronization on all data
types, even if you choose only one
data type.

............................................................................................................................................................

4 Click the Apply button to initiate DNO and select the next data type
for update, or click the OK button to initiate DNO and close the
window.

Result:

The DNO process is started.

To obtain DNO status for an NE before or after initiating DNO,
click on the GetStatus button.

When the DNO is completed, a message is displayed on the
window’s status bar, indicating whether the DNO is successful
or if there are any errors.

For certain NE types, such as the BWM and OLS 400G, DNO
command requests for some data may result in DENY messages
but the DNO process will continue, resulting in a
“COMPLETED” status even though all data has not been
updated in the database. In this case, your system administrator

Manually Initiate DNO Traffic provisioning
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may have to check the ERRORLOG file in the $oamlog
directory to check the NE responses to the DNO process.

If DNO cannot be performed for the selected NE(s), the system
issues a message.

If you choose to perform DNO on all NEs in your Target Group,
or for an NCC with the DSA function enabled, a pop-up
window is displayed, informing you that the DNO process may
take a long time and affect system performance. You can choose
to perform DNO or stop the process. Choose Yes to perform
DNO anyway or No to stop the DNO process.

Manually Initiate DNO Traffic provisioning
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6 Traffic maintenance

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains procedures for traffic maintenance.

Contents
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Operate Protection Switch (from the Manage
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6-9
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6-14
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Add a Loopback Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to add a loopback cross-connection to an NE’s port
tributary. A loopback cross-connection is created from an input
tributary to the output of the same tributary for testing purposes.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross connection loopbacks” (12-7), “Near-side facility
loopbacks” (12-9), “Far-side facility loopbacks” (12-11).

Before you begin Before you begin this task, you need to identify the port tributary in
the NE for which the loopback cross-connection will be created for
testing purposes. Information about the port tributary, including the
rate and AID, can be found by displaying the Cross-Connection
window for the NE, and expanding the equipment hierarchy in the
Network Element explorer portion of the Cross-Connection until the
desired port tributary is shown in the Network Element Explorer.

Be aware that WaveStar SNMS denies requests to add a
cross-connection to a tributary that is currently in loopback. To see if
a particular tributary is currently in loopback, open the
Cross-Connection window for the NE, click the NE’s TID in the
Network Element explorer portion of the Cross-Connection window,
and then click the List Cross Connections button on the
Cross-Connection window toolbar. The Cross-Connections List
window is displayed. A port tributary is displayed with a
cross-connect type of “LPBK” on the Cross-Connections List
window if it is in loopback.

When a loopback is removed from a tributary, any pre-existing
cross-connections on the tributary are automatically re-established in
the NE.

Instructions Complete the following steps to add a loopback cross-connection
to a port tributary in an NE for testing purposes.
............................................................................................................................................................

1 Display the Cross-Connection window for the selected NE and
obtain the AID of the port tributary to be put in loopback by
expanding the Network Element explorer on the Cross-Connection
window and “drilling down” the equipment hierarchy until the port
tributary is found.

The Cross-Connection window can remain open while you access
the Manage Loopbacks window to actually add the loopback to the
port tributary.
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Result:

The required port tributary is displayed.

............................................................................................................................................................

2 If the Cross-Connection window is open, the NE is already chosen.
Otherwise, click on the NE icon in the Map pane portion of the Map
window to select it or select no NE at this point.

............................................................................................................................................................

3 Go to the Map window and choose TestManagement → Loopbacks
on the Map window menu bar. If the NE for setting up the loopback
was not already chosen in step 1 or step 2, the Choose an NE
window is displayed. To choose the NE from this window,
double-click on the NE in the list and click the OK button.

Result:

The Loopback window is displayed

............................................................................................................................................................

4 Enter an AID for the Loopback you want to create.

............................................................................................................................................................

5 Click the Createbutton.

Result:

A secondary Loopback window is displayed.

............................................................................................................................................................

6 Fill in the following fields:

• Access Identifier – using the Subnetwork Explorer right-click on
the AID that you want. The AID is then entered in the AID field
automatically.

• Loopback Type – click the down arrow next to this field to
display a list of choices. The choices are: Cross-Connect
Loopback, Far-side Facility Loopback and Near-side Facility
Loopback (cf. “Cross connection loopbacks” (12-7), “Near-side
facility loopbacks” (12-9), “Far-side facility loopbacks” (12-11)).

• Rate – click the down arrow next to this field to display a
drop-down list of choices and select the rate of the port tributary
to be placed in loopback.

• Action – click the down arrow next to this field to display a list
of choices. The choices are: Operate Loopback or Forced
Loopback.

Reference:

“Loopback Parameters” (12-13).
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............................................................................................................................................................

7 Click the Create button to activate your choices, or click the OK
button to activate your choices and close the window.

Result:

A pop-up dialog window is displayed, informing you that the
loopback being created may affect service and asking if you
want to proceed.

............................................................................................................................................................

8 Choose Yes.

Result:

The newly created loopback cross-connection for the selected
port tributary is displayed on the Manage Loopback window.

If part of the AID is obscured in the display portion of the
window, position the mouse cursor on the pane edge between
the Network Element Explorer and the display portion of the
window, which displays a double-arrow cursor. Click and hold
the left mouse button and drag the cursor to the left or right
until the complete display of the loopback details is visible. You
can also use the left/right scrollbar buttons at the bottom of the
display portion to maneuver the display to the left or right.

............................................................................................................................................................

9 Repeat steps 5-7 to create more loopback cross-connections on
additional port tributaries, or click the Close button to close the
window.
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View Loopback Cross-Connections
....................................................................................................................................................................................................................................

When to use Use this procedure to view loopback cross-connections in an NE.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Before you begin Before you begin this task, determine the existing cross-connection for
which you want to view a loopback cross-connection.

Instructions Complete the following steps to view loopback cross-connections.
............................................................................................................................................................

1 Select an NE in the Map pane portion of the Map window or select
no NE at this point.

............................................................................................................................................................

2 Go to the Map window and choose TestManagement → Loopbacks
on the Map window menu bar. If the NE for setting up the loopback
was not already chosen in step 1, the Choose an NE window is
displayed. To choose the NE from this window, double-click on the
NE in the list and click the OK button.

Result:

The Loopback window is displayed

............................................................................................................................................................

3 Click the plus (+) sign next to each level of the equipment hierarchy
shown in the Network Element explorer portion of the window until
the display expands down the shelf level.

............................................................................................................................................................

4 Select the desired shelf in the explorer.

Result:

The List button, located at the bottom of the Network Element
Explorer portion of the window, is enabled.

............................................................................................................................................................

5 Click the List button.

Result:

The loopback cross-connections created for the selected piece of
equipment are displayed.

Use the left/right scroll buttons located at the bottom of the
loopback cross-connections display to move the display left or
right to view all data.
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Reference:

“Loopback Parameters” (12-13).
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Delete a Loopback Cross-Connection
....................................................................................................................................................................................................................................

When to use Use this procedure to delete a loopback cross-connection. After a
cross-connect loopback is deleted on a port tributary, any other
cross-connections defined for that tributary are automatically
re-established in the NE.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Cross-Connections” (11-2).

Before you begin Before you begin this task, you need to identify the port tributary in
the NE from which the loopback cross-connection will be deleted.
Information about the port tributary, including the rate and AID, can
be found by displaying the Cross-Connection window for the NE,
and expanding the equipment hierarchy in the Network Element
explorer portion of the Cross-Connection until the desired port
tributary is shown in the Network Element Explorer.

To see if a particular tributary is currently in loopback, open the
Cross-Connection window for the NE, click the NE’s TID in the
Network Element explorer portion of the Cross-Connection window,
and then click the List Cross Connections button on the
Cross-Connection window toolbar. The Cross-Connections List
window is displayed. A port tributary is displayed with a
cross-connect type of “LPBK” on the Cross-Connections List
window if it is in loopback.

Instructions Complete the following steps to delete a loopback
cross-connection.
............................................................................................................................................................

1 Select an NE in the Map pane portion of the Map window or Select
no NE at this point.

............................................................................................................................................................

2 Go to the Map window and choose TestManagement → Loopbacks
on the Map window menu bar. If the NE for setting up the loopback
was not already chosen in step 1 or step 2, the Choose an NE
window is displayed. To choose the NE from this window,
double-click on the NE in the list and click the OK button.

Result:

The Manage Loopbacks window is displayed
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............................................................................................................................................................

3 Click the plus (+) sign next to each level of the equipment hierarchy
shown in the Network Element explorer portion of the window until
the display expands down the shelf level.

............................................................................................................................................................

4 Select the desired shelf in the explorer.

Result:

The List button, located at the bottom of the Network Element
Explorer portion of the window, is enabled.

............................................................................................................................................................

5 Click the List button.

Result:

The loopback cross-connections created for the selected piece of
equipment are displayed.

Use the left/right scroll buttons located at the bottom of the
loopback cross-connections display to move the display left or
right to view all data.

............................................................................................................................................................

6 Double-click on the loopback cross-connection in the display portion
of the window to select it for deletion.

Result:

The Delete button is enabled.

............................................................................................................................................................

7 Click the Delete button.

Result:

A pop-up question dialog window is displayed, informing you
that deletion of the selected loopback cross-connect may affect
service and asking if you want to continue with the deletion.

............................................................................................................................................................

8 Choose Yes to delete the loopback cross-connection.

Result:

The deleted loopback cross-connection is removed from the
display.

............................................................................................................................................................

9 Click the Close button to close the window.

Delete a Loopback Cross-Connection Traffic maintenance
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Operate Protection Switch (from the Manage Protection Groups
Window)
....................................................................................................................................................................................................................................

When to use Use this procedure to provision a protection switch, for a specified
protection group, from the Manage Protection Groups window.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection Switch Management” (11-17), “Equipment
Protection Switch (Timing Pack Equ.) Parameters” (12-6),
“MS–SPRing Switch Parameters” (11-28), “Switch Fabric Pack
Equipment Parameters” (12-6), “1+1 Protection Group Parameters”
(11-14).

Before you begin Before you begin this task, identify the type of protection group and
type of protection switch you want to provision. To perform this task,
access the Map window.

Instructions Complete the following steps to create protection groups on the
Protection Provisioning window.
............................................................................................................................................................

1 Select Configuration → Protection Groups from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE to select it and click the OK button.

Result:

The Protection Provisioning Manager window is displayed for
the selected NE. The Protection Provisioning Manager
window has an explorer that shows the available protection
group types and port protection groups created for each type.

To display existing protection groups for a protection group
type, click the plus (+) sign next to the protection group type.
The explorer expands the list to show existing protection groups
for a type, if any. If there are no existing protection groups for a
given type, the explorer tree shows “No protection Groups”. To
collapse the listing, click the minus (-) sign next to the
protection group type.

Traffic maintenance
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The window also has a series of buttons:

• Add – click this button to add a new protection group.

• Modify – click this button to modify an existing protection
group.

• Delete – click this button to delete an existing protection
group.

• View – click this button to view the member ports and
attributes of an existing protection group.

• Operate Switch – click this button to bring up the Operate
Protection Switch window to provision a protection switch
for the selected protection group.

• Close – click this button to close the Protection
Provisioning Manager window.

• Help – click this button to display online help for this
window.

............................................................................................................................................................

3 Click the plus (+) sign next to the protection group type to expand
and see the protection groups set up for the selected protection group
type.

............................................................................................................................................................

4 Select the protection group to be provisioned for a protection switch
by single-clicking on it in the explorer portion of the window, under
the selected protection group type.

Result:

The buttons for actions that can be performed for the selected
protection group are enabled. For example, if you cannot add or
change the member entities of the selected protection group type
or delete the protection group itself, the Add, Modify, or Delete
buttons remain disabled.

............................................................................................................................................................

5 Click the Operate Switch button.

Result:

The Operate Protection Switch window for the selected
protection group is displayed. The fields shown on the Operate
Protection Switch window will vary, based on the Protection
Group Type selected.

Operate Protection Switch (from the
Manage Protection Groups Window)

Traffic maintenance
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The fields common to all Protection Group Types are:

• Protection Group Type – this is a display-only field that
shows the selected Protection Group Type.

• PG AID – this is a display-only field that shows the
Protection Group AID of the selected protection group.

• Switch Request – this is a display-only field that shows
the last message prompting a protection switch. If there is
no current message, this field indicates that there has been
No Request (“NR”).

• Switch Command – this field allows you to select the
command for provisioning the type of protection switch to
be performed. Click the down arrow next to the field to
display a drop-down list of commands.
The list of commands displayed depends on the selected
Protection Group Type. Possible choices from the command
list are:

- CLEAR

- LOCKOUT

- FRCED (Forced)

- MAN (Manual)

- CLEARFRCD (Clear Forced)
The list of available commands is also based on the current
switch status and the priority of the switch request. For
example, if the current switch status for the protection group
is “Forced Switch”, then the system does not allow a
manual switch.
Switch priorities for WaveStar TDM NEs, in descending
order, are: CLEAR, LOCKOUT, FRCD, MAN

............................................................................................................................................................

6 Select the switch command from the drop-down list of commands.

............................................................................................................................................................

7 Select the destination of the entity that should be active after
operation of the protection switch.

For the Protection Group Type shown in the example in the previous
steps of this procedure (Switch Fabric Pack Equipment), the entity
selected is a circuit pack, with a circuit pack ID. The Active Unit
field in this example indicates the ID of the circuit pack currently
active.

For the example shown (Switch Fabric Pack Equipment), click the
down arrow next to the Destination Entity field to display a
drop-down list of choices. In this case, the list contains the list of

Operate Protection Switch (from the
Manage Protection Groups Window)
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slots. Choose the slot to become active after the switch is operated if
both circuit packs are being switched to protection.

To choose an individual circuit pack in the slot to be switched, click
the down arrow next to the Destination Entity field to display a
drop-down list of choices and choose the AID of the circuit pack
being switched to protection.

This field should be chosen instead of the Destination Entity field if
you are switching an individual circuit pack on the shelf to protection.

If the entities to be switched are ports, the version of the Operate
Switch window displayed is different:

Identifying fields for this Protection Group Type (display-only) are:

• Protection Group Type

• Protection Group Ring ID (RID)

• Protection Group AID

The fields displayed to select the destination entity (port) for this type
of protection group are:

• Destination Entity – click the down arrow next to this field to
display a drop-down list and select the entity that is being
switched to protection, if both working or protection ports are
being switched to protection. The choices are WKG (Working) or
PROTN (Protection).

• Destination Side – click the down arrow next to this field to
display a drop-down list and select the port side that is being
switched to protection. The choices are east, west, or both.

• Destination Entity AID – click the down arrow next to this field
to display a drop-down list and select the individual port AID of
a working or protection group to be switched to protection.

• Switch Type – click the down arrow next to this field to display
a drop-down list and select the NE configuration involved in the
protection switch. The choices are span or ring.

............................................................................................................................................................

8 To review the details of the protection group affected by the switch,
click the Details button.

Result:

A second window is displayed, showing the Protection Group
Type, Protection Group Ring ID (if applicable), and Protection
Group AID. To close this details window, click the Close button.

Operate Protection Switch (from the
Manage Protection Groups Window)
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............................................................................................................................................................

9 After your choices are made, click the Apply button to initiate the
switch request and leave the Operate Switch window open, or click
the OK button to initiate the switch request and close the window.

Result:

A status window is displayed, showing the results of the request.
If it is completed successfully, the status is shown as
“Completed”. If the request fails for some reason, the status of
the request is shown as “Failed”.

Operate Protection Switch (from the
Manage Protection Groups Window)
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Operate Protection Switch (from the Protection Switch Status
Management window)
....................................................................................................................................................................................................................................

When to use Use this procedure to provision a protection switch for a selected
protection group type and protection switch message related to that
protection group type, from the Protection Status Management
window.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “Protection Switch Management” (11-17), “Equipment
Protection Switch (Timing Pack Equ.) Parameters” (12-6),
“MS–SPRing Switch Parameters” (11-28), “Switch Fabric Pack
Equipment Parameters” (12-6), “1+1 Protection Group Parameters”
(11-14).

Instructions Complete the following steps to provision a protection switch for
a given protection group type and protection switch message.
............................................................................................................................................................

1 Choose Configuration → Protection Switch from the main menu bar
of the Map window.

Result:

The Choose an NE/Aggregate window is displayed.

............................................................................................................................................................

2 Click the Network Elements radio button to obtain a list of NEs.
Click the Aggregates radio button to obtain a list of aggregates. For
the purposes of this function, click the Network Elements radio
button to obtain a list of NEs.

Once the list criteria is selected (Network Elements or Aggregates),
you can use the Filtering/Sorting option to filter and limit the list to
only the named items that you want (for details on how to use the
Filter/Sort option, see “Sorting Tables” (14-45)).

............................................................................................................................................................

3 Double-click on the NE in the list to select it and click the OK button.

Result:

The Choose Protection Type window is displayed showing the
available protection types to select.

............................................................................................................................................................

4 From the available valid protection types, choose the protection
type(s) to be displayed in the Protection Switching Status window

Traffic maintenance
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by positioning the mouse cursor in the box and clicking the select
(left) mouse button to select the box.

Result:

A checkbox is placed in the box and the OK button is enabled.

............................................................................................................................................................

5 Click the OK button.

Result:

The Protection Switching Status window is displayed,
showing protection switch status messages (if any), for the
selected protection group type(s).

Use the left/right scroll bar buttons located at the bottom of the
display area of this window to scroll left or right, to see the
complete status message.

............................................................................................................................................................

6 Once you have located the protection group type and message for
which you want to provision a protection switch, click on the message
in the display portion of the window to select it.

............................................................................................................................................................

7 Click the Operate Switch button.

Result:

The Operate Protection Switch window for the selected
protection group type and message is displayed. The fields
shown on the Operate Protection Switch window will vary,
based on the Protection Group Type selected.

Identifying fields for this Protection Group Type (display-only)
shown on the window are:

• Protection Group Type

• Protection Group Ring ID (RID)

• Protection Group AID

The fields common to all Protection Group Types are:

• Protection Group Type – this is a display-only field that
shows the selected Protection Group Type.

• PG AID – this is a display-only field that shows the
Protection Group AID of the selected protection group.

• Switch Request – this is a display-only field that shows
the last message prompting a protection switch. If there is
no current message, this field indicates that there has been
No Request (“NR”).

Operate Protection Switch (from the
Protection Switch Status Management
window)
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• Switch Command – this field allows you to select the
command for provisioning the type of protection switch to
be performed. Click the down arrow next to the field to
display a drop-down list of commands.
The list of commands displayed depends on the selected
Protection Group Type. Possible choices from the command
list are:

- CLEAR

- LOCKOUT

- FRCED (Forced)

- MAN (Manual)

- CLEARFRCD (Clear Forced)
The list of available commands is also based on the current
switch status and the priority of the switch request. For
example, if the current switch status for the protection group
is “Forced Switch”, then the system does not allow a
manual switch.
Switch priorities for WaveStar TDM NEs, in descending
order, are: CLEAR, LOCKOUT, FRCD, MAN

............................................................................................................................................................

8 Select the switch command from the drop-down list of commands.

............................................................................................................................................................

9 Select the destination of the entity that should be active after
operation of the protection switch.

The fields displayed to select the destination entity (port) for this type
of protection group are:

• Destination Entity – click the down arrow next to this field to
display a drop-down list and select the entity that is being
switched to protection, if both working or protection ports are
being switched to protection. The choices are WKG (Working) or
PROTN (Protection).

• Destination Side – click the down arrow next to this field to
display a drop-down list and select the port side that is being
switched to protection. The choices are east, west, or both.

• Destination Entity AID – click the down arrow next to this field
to display a drop-down list and select the individual port AID of
a working or protection group to be switched to protection.

• Switch Type – click the down arrow next to this field to display
a drop-down list and select the NE configuration involved in the
protection switch. The choices are span or ring.

Operate Protection Switch (from the
Protection Switch Status Management
window)
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............................................................................................................................................................

10 To review the details of the protection group affected by the switch,
click the Details button.

Result:

A second window is displayed, showing the Protection Group
Type, Protection Group Ring ID (if applicable), and Protection
Group AID. To close this details window, click the Close
button.

............................................................................................................................................................

11 After your choices are made, click the Apply button to initiate the
switch request and leave the Operate Switch window open, or click
the OK button to initiate the switch request and close the window.

Result:

A status window is displayed, showing the results of the request.
If it is completed successfully, the status is shown as
“Completed”. If the request fails for some reason, the status of
the request is shown as “Failed”.

Operate Protection Switch (from the
Protection Switch Status Management
window)
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Display Protection Switching Status
....................................................................................................................................................................................................................................

When to use para

Instructions Complete the following steps to display protection switching
status.
............................................................................................................................................................

1 From the main menu bar of the Map window, select Configuration →
Protection Switch.

Result:

This displays the Choose an NE/Aggregate window.

............................................................................................................................................................

2 Choose either Network Elements or Aggregates.

A Filtering/Sorting option is also available to the user by clicking on
the Filter/Sort button. After setting the parameters for this option,
click the Apply button to enter your data and then click the OK button
to return to the Choose an NE/Aggregate window.

............................................................................................................................................................

3 Double click on the desired selection from the list and click the OK
button.

Result:

The Choose Protection Type window is displayed showing the
available protection types to select.

............................................................................................................................................................

4 From the available valid protection types, choose the protection
type(s) to be displayed in the Protection Switching Status window
and click the OK button.

Result:

The Protection Switching Status window is displayed with the
correct information as indicated by the user.

............................................................................................................................................................

5 When you have finished viewing the data, click on the Close button.

Traffic maintenance
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Enable/Disable the PM Feature
....................................................................................................................................................................................................................................

When to use Use this procedure to globally enable or disable the Performance
Monitoring (PM) data collection feature for all supported NEs. When
the PM data collection feature is turned on, WaveStar SNMS
periodically collects PM data from each NE that has PM data
collection activated. When the PM feature is globally disabled, PM
data is not collected from any NE.

Related information For related information, see Chapter 11, “Traffic provisioning
concepts”, “NE PM Management Parameters” (12-5).

Before you begin Before you begin this task, access the Map window.

Instructions Complete the following steps to globally enable or disable the
PM feature.
............................................................................................................................................................

1 Select Performance → Global PM Management from the main menu
bar on the Map window.

Result:

The Global PM Data Administration window is displayed.

..........................................................................................................................................................

2 If you want to... click on the Collect PM Data box...

enable the PM feature to place a check there and select the
retention period for 15-minute and 1-
day PM data reports. To select the
retention period, move the slider bar for
each report type. You can set the
retention period from 1 to 30 days for
each report type. The number displayed
to the right of each slider bar shows the
setting selected. Click the Retrieve
button to display the current system
default retention periods.

disable the PM feature to remove the check or leave the box
blank.

............................................................................................................................................................

3 Click the Apply button to activate your choices.

Traffic maintenance
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Enable/Disable PM Data Collection
....................................................................................................................................................................................................................................

When to use Use this procedure to enable or disable PM data collection for the
specified NE and, if PM data collection is enabled, select the PM
reporting interval.

Related information For related information, see Chapter 12, “Traffic maintenance
concepts”.

Before you begin Before you begin this task, be aware that NE PM data collection will
not be performed until the PM feature is globally enabled. Be aware
that PM data collection is suspended during an alarm storm. WaveStar
SNMS resumes PM data collection after the alarm storm has subsided.

Instructions Complete the following steps to enable collection of the selected
PM data types or disable PM data collection for the entire NE.
............................................................................................................................................................

1 Select Performance → NE PM Management from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE in the list to select it and click the OK button
or

Select an NE on the Map or Subnetwork Explorer, right-click on the
NE to bring up a pop-up menu, select Performance → NE PM
Management.

Result:

The NE PM Data Administration window shows the EMS PM
Data Settings panel.

Reference:

“Global PM Management Parameters” (12-5).

..........................................................................................................................................................

3 If you want to... then...

collect PM data for the
selected PM data type in
15-minute intervals

check the Enable 15 Minute PM data
collection for this NE box.

Traffic maintenance
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If you want to... then...

collect PM data for the
selected PM data type in
1-day intervals

check the Enable 1-Day PM data
collection for this NE box.

collect both 15- minute
and daily PM data for the
PM data type

check both boxes.

collect no PM data
(disable PM data
collection for the NE)

click both boxes to remove the checks,
or leave both boxes blank.

collect PM data from all
data types

click the All Facility Types in This NE
radio button.

collect PM data specified
from a certain AID

click on PM Data Collection Per AID
Mode

collect PM data from one
or more types

click the Only these facility types radio
button and then check the data types for
PM data.

enable/ disable PM data
collection for the NE

click the Apply button to activate your
choices.

If you select All Facility Types in This NE, but the NE has no facility
type PM data collecting may be impeded.

Enable/Disable PM Data Collection Traffic maintenance
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Administer PM Data
....................................................................................................................................................................................................................................

When to use Use this procedure to display analog and/or digital PM data
parameters for the selected NE interface.

Related information For related information, see Chapter 12, “Traffic maintenance
concepts”.

Before you begin Be aware that the PM feature must be globally enabled and the
selected NE must have PM data collection activated for one or more
PM data types.

PM threshold values must be set by issuing TL1 commands via the
Cut-Through window.

Instructions Complete the following steps to display PM parameters for the
selected NE interface.
............................................................................................................................................................

1 Select Performance → NE PM Management from the main menu bar
on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double-click on the NE in the list to select it and click the OK button
or

Select an NE on the Map or Subnetwork Explorer, right-click on the
NE to bring up a pop-up menu, select Performance → NE PM
Management.

Result:

The NE PM Data Administration window shows the EMS PM
Data Settings panel.

Reference:

“NE PM Management Parameters” (12-5).

............................................................................................................................................................

3 Click the Apply button to activate your choices.

Result:

A pop-up question dialog window is displayed, informing you
that changing the PM parameter values may affect service, and
asks if you want to modify the values. Choose Yes to initiate the
PM data parameter changes.

Traffic maintenance
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View PM Data
....................................................................................................................................................................................................................................

When to use Use this procedure to view the PM data collected by WaveStar
SNMS. You can choose to view either current data from the NE(s) or
historical data stored in the WaveStar SNMS database, as well as for
what facility type, and whether to show 15-minute or 1-day PM data.
The data selected for viewing is shown in table format, sorted and
filtered according to your choices.

Related information For related information, see Chapter 12, “Traffic maintenance
concepts”, “NE PM Management Parameters” (12-5).

Before you begin Before you begin this task, the PM feature must be globally enabled
and the selected NE must have PM data collection activated for one
or more PM data types.

Instructions Complete the following steps to view PM data for a specified
NE.
............................................................................................................................................................

1 Select Performance → View PM Data from the menu bar on the Map
window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Select an NE and click the OK button or

Select an NE on the Map or Subnetwork Explorer, right-click on the
NE to bring up a pop-up menu, select Performance Management →
View PM Data.

Result:

The View PM Data window is displayed.

............................................................................................................................................................

3 Choose to show either current data or historical data by clicking on
the appropriate radio button. If you chose historical data, choose the
date and time of the data by using the date and time (if you choose
15-minute data, in hours) spinner fields.

If you configured the data retention period on the Global PM Data
Administration window for less than 30 days, you can only view the
data files that fall within the selected data retention period.

Traffic maintenance
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............................................................................................................................................................

4 Choose one of the NE facility types for viewing by clicking on the
appropriate radio button.

............................................................................................................................................................

5 Choose to show 15-minute or 1-day PM data by clicking on the
appropriate radio button.

............................................................................................................................................................

6 Click the OK button.

Result:

The PM Data window is displayed, showing the selected PM
data in table format. To save the contents of the table to a file
on the local system, click the Save button.

View PM Data Traffic maintenance
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7 Software upgrade

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides information for carrying out tasks regarding the
network element software.

Contents
Transfer NE Software 7-2

Setting Up the WaveStar SNMS Host for
Transferring NE Software from CD-ROM

7-4

View NE Software 7-6

Download NE Software 7-7

Activate NE Software 7-9

Delete NE Software 7-11

Back Up NE Data 7-12

Restore NE Data 7-13
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Transfer NE Software
....................................................................................................................................................................................................................................

When to use Use this procedure to transfer an NE software release from a Digital
Access Tape (DAT) or CD-ROM onto the WaveStar SNMS host for
eventual downloading to an NE.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“Software transfer via removable media” (13-10).

Before you begin Before you begin this task, the DAT must be physically mounted (if
the file source is tape) or the CD-ROM must be physically loaded and
the file system mounted on the WaveStar SNMS host (if the file
source is CD-ROM). If you are transferring the NE software from
CD-ROM, a special setup procedure must be performed for the
WaveStar SNMS host prior to doing the transfer; this procedure is
explained as part of the task. To perform this task, access the Map
window.

Instructions Complete the following steps to transfer NE software to WaveStar
SNMS.
............................................................................................................................................................

1 If you are transferring NE software form CD-ROM, then a special
setup procedure must be performed by the WaveStar SNMS
administrator once prior to the NE software transfer. If you are
transferring NE software form DAT, continue with the next step.

............................................................................................................................................................

2 Before transferring a software release, you may want to see what
software releases are already stored in WaveStar SNMS for the NE
type, using the View Software Release Descriptive Information
function.

............................................................................................................................................................

3 Select Configuration → Software Management → Import Software
to the EMS.

Result:

The NE Type Selection for NE Software Transfer window is
displayed.

............................................................................................................................................................

4 Choose CD or Tape for the media that you want to search for the
software release.

Software upgrade
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............................................................................................................................................................

5 Select TDM 10G (STM-64) from the NE Type list or type the NE type
in the text field and click the OK button.

Result:

The system begins a search for the software release on the tape
or CD. The NE Type Selection for NE Software Transfer
window is displayed. If the search is successful, a pop-up
confirmation window is displayed, indicating that the software
release was found on the tape or CD and asks if you want to
continue with the transfer.

............................................................................................................................................................

6 Click the OK button to start the software transfer.

Transfer NE Software Software upgrade
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Setting Up the WaveStar SNMS Host for Transferring NE
Software from CD-ROM
....................................................................................................................................................................................................................................

When to use Before NE software can be transferred from CD-ROM onto the
WaveStar SNMS host machine, the WaveStar SNMS system
administrator must do the following once while configuring the
WaveStar SNMS host or installing the host software.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“Software transfer via removable media” (13-10).

Instructions Perform the following steps to set Up the WaveStar SNMS host
for transferring NE software from CD-ROM
............................................................................................................................................................

1 Log into the WaveStar SNMS host machine as root.

............................................................................................................................................................

2 As root, use the following command to find the hardware path to the
CD-ROM drive: ioscan -fn -C disk

............................................................................................................................................................

3 In the output locate the line that contains the hardware path to the
CD-ROM drive.

The hardware path could be, for example, /dev/dsk/c4t2d0.

............................................................................................................................................................

4 Do a symbolic link between the above hardware path and /dev/cdrom
using the following command as root (replace the c4t2d0 by your
hardware path): ln -s /dev/dsk/c4t2d0 /dev/cdrom

Software upgrade
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Success or failure

If the Software Transfer function performed through the GUI is
successful, the file system for the CD-ROM drive will be mounted
each time the CD-ROM is physically loaded into the drive.

The CD-ROM drive may fail to mount because

• The CD is not physically loaded into the drive.

• The file system for the CD-ROM drive failed to be mounted.

In the latter case, log in as root (if not already logged in) and issue a
mount command (replace the c4t2d0 by your hardware path):
/etc/mount /dev/dsk/c4t2d0/SD_CDROM

To remove the CD-ROM, issue the following command (replace the
c4t2d0 by your hardware path): /etc/unmount
/dev/dsk/c4t2d0/SD_CDROM

Setting Up the WaveStar SNMS Host for
Transferring NE Software from CD-ROM

Software upgrade
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View NE Software
....................................................................................................................................................................................................................................

When to use This procedure is used to see what software releases are already
stored in WaveStar SNMS for an NE type.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE software generic information” (13-7).

Instructions Perform the following steps.
............................................................................................................................................................

1 Select Configuration → Software Management → View Software
Release Descriptive Information.

Result:

The NE Type Selection for Viewing Descriptive Files is
displayed.

............................................................................................................................................................

2 Select TDM 10G (STM-64) from the NE Type list or type the NE type
in the text field.

............................................................................................................................................................

3 Click the OK button.

Result:

A description of all the software releases stored in WaveStar
SNMS for the selected NE type is displayed.

Software upgrade
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Download NE Software
....................................................................................................................................................................................................................................

When to use Use this procedure to download a selected software release to a
specific NE.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE software download” (13-11).

Before you begin Before you begin this task, you must first access the Map window.
The software release to be downloaded to the NE must be transferred
to WaveStar SNMS from CD-ROM or tape.

Instructions Complete the following steps to download software to an NE.
............................................................................................................................................................

1 Select Configuration → Software Management → Download
Software To NE. from the main menu bar on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Select an NE by double-clicking on the NE’s TID and click the OK
button.

Result:

The Software Download to NE window is displayed.

............................................................................................................................................................

3 Select a software release from the Releases Available list and click
the Apply button. (You can abort the software download at this point,
if necessary, by clicking the Abort button. A pop-up window is
displayed, asking if you really want to abort the download. Choose
Yes to abort the download or No to continue it.)

Result:

The system verifies that the software release is not the same or
older than the version currently running on the NE and is
supported by WaveStar SNMS. If there is a problem with the
selected release, a pop-up information window is displayed,
asking if you want to continue with the software download.

............................................................................................................................................................

4 Choose Yes to perform the software download anyway or No to
cancel the software download.

Software upgrade
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Result:

A pop-up message window is displayed, informing you that the
download may take a certain amount of time and asks if you
want to proceed with the software download.

............................................................................................................................................................

5 Choose Yes to continue with the software download. (If you choose
No the software download is cancelled.)

Result:

The software download is initiated. The status bar shows when
the software download has been completed.

Download NE Software Software upgrade
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Activate NE Software
....................................................................................................................................................................................................................................

When to use Use this procedure to activate software that has previously been
transferred via software download or software copy.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE software activate” (13-13).

Before you begin Be aware that the NE Software Activate function provides the set of
allowable NEs for activation and only allows the user to select from
among those choices. Be aware that you may lose the NE visibility on
the Map window for some time as the NE reboots during this process.
To perform this task, access the Map window.

Instructions Complete the following steps to activate software that has
previously been transferred via software download or software
copy.
............................................................................................................................................................

1 Select the desired network element(s) in the WaveStar SNMS map
window.

............................................................................................................................................................

2 Select Configuration → Software Management → Activate NE
Software.

Result:

This displays the Activate Software window populated with the
selected NE(s) and their currently active software release.

............................................................................................................................................................

3 Select one or more NE(s) and click Get Standby Release to retrieve
the standby release number of the selected NE(s). You can also click
on Remove From List to remove the chosen NE from the list.

............................................................................................................................................................

4 Click on OK to initiate the activation of the new release.

Result:

EMS verifies that the NE release version that has been requested
for activation, is higher than the release version that is currently
running on the NE, and also if the selected release is supported
by the EMS. A warning box appears if there is a problem with
the selected software release. Once verified, a dialog box
confirms the software release number and NE.

Software upgrade
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............................................................................................................................................................

5 Click on Yes to continue with the activation if the information is
correct, or click on No to return to the Activate Software window.

Activate NE Software Software upgrade

....................................................................................................................................................................................................................................
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Delete NE Software
....................................................................................................................................................................................................................................

When to use Use this procedure to delete a specific executable software release for
an NE type from WaveStar SNMS.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE software delete” (13-14).

Before you begin Before you begin this task, access the Map window. The software to
be deleted must be transferred to the WaveStar SNMS from CD-ROM
or tape.

Important! When software is deleted from the system, it is not
recoverable. The only way to get the software back into the system is
to reload it from a tape. Make sure that you want to delete the
software release before executing the following procedure.

Instructions Complete the following steps to delete a specific software release
for the NE type.
............................................................................................................................................................

1 Select Configuration → Software Management → Delete Software
From the EMS from the main menu.

Result:

The Delete NE Software window displayed.

............................................................................................................................................................

2 Select TDM 10G (STM-64) from the Select NE Type list.

Result:

The Delete Software list shows the available software releases
for the selected NE type.

............................................................................................................................................................

3 Select the software release to be deleted from the Delete Software list
by double-clicking on it and click the Delete button.

Result:

A confirmation window is displayed, asking if you want to
proceed with the deletion.

............................................................................................................................................................

4 Choose Yes to perform the software deletion or No to cancel the
software deletion

Software upgrade
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Back Up NE Data
....................................................................................................................................................................................................................................

When to use Use this procedure to back up an NE’s provisioning data. The
provisioning data includes port parameters and cross-connections.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE data backup” (13-15).

Before you begin Before you begin this task, determine the NE for which you want to
perform a backup. Ensure that there are no alarms present on the NE.
You must access the Map window to perform this function.

Instructions Complete the following steps to perform an NE backup.
............................................................................................................................................................

1 Select Configuration → Software Management → Backup from the
main menu bar on the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double click on the desired NE and click the OK button.

Result:

A pop-up window is displayed, indicating how long the backup
process will take and asking if you want to proceed with the
backup.

............................................................................................................................................................

3 Choose Yes to perform the NE backup or No to cancel the NE
backup

Software upgrade
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Restore NE Data
....................................................................................................................................................................................................................................

When to use Use this procedure to restore NE provisioning data from a specified
backup file. You can specify the type of provisioning data to be
restored. You have the option of performing a Regular Restore or an
Intelligent Restore. A Regular Restore restores all backup data from
the selected NE file, including the default settings. For an Intelligent
Restore, the system compares each parameter setting from the backup
file against its default value. If the current setting matches the default
value, that parameter is excluded from the restore. If all parameters on
a given command issued during the restore request matches the
defaults, that command is skipped during the restore process. Only
parameters that do not currently have default settings are set, thus
reducing the amount of time it takes to restore the NE’s backup data.

Related information For related information, see Chapter 13, “Software upgrade concepts”,
“NE data restore” (13-17).

Before you begin Before you begin this task, determine the NE to which you want to
restore data. You must access the Map window to perform this
function.

Instructions Complete the following steps to restore an NE’s backup data.
............................................................................................................................................................

1 Select Configuration → Software Management → Restore →
Regular Restore or Intelligent Restore from the main menu bar on
the Map window.

Result:

The Choose an NE window is displayed.

............................................................................................................................................................

2 Double click on the desired NE and click the OK button.

Result:

The Restore – Select Backup File window is displayed.

............................................................................................................................................................

3 Select a backup file for restoral. To look at a description of the
backup data contained in the file before restoring it, click the View
Descriptive Files button.

............................................................................................................................................................

4 Click the OK button.

Software upgrade
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Result:

The restore process is started. As part of the restore process, the
system performs several validation checks, comparing the
software release, equipment, and switch settable parameters in
the backup file with the current NE values. If there are
discrepancies, a pop-up window is displayed with an error
message asking if you want to continue with the restore.

............................................................................................................................................................

5 Choose Yes to perform the NE restore anyway or No to cancel the
NE restore.

............................................................................................................................................................

6 If you respond Yes to perform the restore anyway the system
continues with the restore.

Result:

A pop-up message window is displayed, informing you that the
restore may take a long time and asking if you want to proceed
with the restore.

............................................................................................................................................................

7 Choose Yes to perform the NE restore or No to cancel the NE restore

Result:

If you respond Yes to perform the restore the restore is initiated.
The system informs you of the restore’s progress with a status
message. When the restore is completed, an information window
appears that notifies you of the completion. If the restore fails,
an error message is displayed in a pop-up window, indicating
the source of the problem.

Restore NE Data Software upgrade
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8 Management communication
setup concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter deals with the basic theoretical background of Data
Communication Networks (DCNs) and provides DCN configuration
guidelines for WaveStar® TDM 10G (STM-64) systems.
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Basic DCN principles
....................................................................................................................................................................................................................................

Overview This subsection serves as an entry point, it describes the basic DCN
principles. The following subsection describes common DCN
configurations. DCN configuration guidelines for WaveStar® products,
NSAP address formats and other related information are provided
thereafter.

Purpose of a Data
Communication Network

A Data Communication Network (DCN) is used for the exchange of
management data. This section provides an overview of the Data
Communication Network and describes the type of communication
between the nodes in the network and the used protocols.

SDH management network The SDH management network is an overlay network of the
transmission network. A management system and the network
elements together are the nodes of this network. The Q-LAN and Data
Communication Channels (DCCs; cf. “Data Communication
Channels” (8-19)) provide the physical connection between the nodes.

DCN physical components The following figure illustrates an OSI-DCN. The illustration only
gives the physical components and connections in the DCN, it does
not give the logical configuration.

The illustration of the OSI-DCN consists of 2 Q-LANs and a number
of Data Communication Channels (DCCs) in an SDH transmission
network (point-to-point configuration and two ring configurations
shown), with a management system (Element Management System
(EMS) or Craft Terminal) connected to it. The management system is
connected to the transmission network via gateway network elements
(GNEs) and the Q-LAN. The network elements are connected to each
other by DCCs.

NE NE

NE

Gateway
NE

NE NE

NE

Gateway
NEDCC DCC

Management
System

Q-LAN

NE

NE

NE

Q-LAN
(LCN)

DCC

DCC
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In the case where there is no DCC connectivity between nodes (see
the right part of the illustration), a Local Communication Network
(LCN) can be used to connect the nodes to each other.

“NE” versus “Node” A distinction has to be made between network elements and nodes.
Network elements can be identified by their target identifier (TID), i.e.
their NE name, whereas a node is identified by its Network Service
Access Point (NSAP) address. Each NSAP address within a network
constitutes a node which can individually be addressed.

Important! “NE name” and “TID” are used synonymously throughout
this Provisioning Guide. A WaveStar® TDM 10G (STM-64) network
element has exactly one TID but up to three NSAP addresses.

Example Distinction between NE and node:

A WaveStar® TDM 10G (STM-64) network element consisting of a
main shelf (with high speed part and low speed part) and an extension
shelf comprises three nodes since each single part of the NE has its
own DCC controller (ADJCTL/DCC32EI), i.e. its own NSAP address.

DCN protocols The Protocols used in the DCN between the nodes include:

• Media access protocols:

- Ethernet on the Q-LAN

- LAPD on the DCCs

• OSI network routing protocol (DCN wide)
The OSI network routing protocol (OSI-DCN) is used for routing
management data between nodes in the DCN.

High speed
part (NSAP 2)

Low speed
part (NSAP 1)

Management
system

LAN connection

Network element
(TID/NE Name)

Extension
shelf (NSAP 3)

ON
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ISO-OSI network protocols The network protocols used between nodes are the ISO-OSI network
protocols:

• Connectionless Network Service/Connectionless Network
Protocol (CLNS/CLNP) acc. to ISO 8473,

• ES-IS routing protocol acc. to ISO 9542,

• IS-IS routing protocol acc. to ISO 10589.

According to these protocols a node in the network can behave as an
end system (ES) or as an intermediate system (IS, sometimes also
called a router).

End systems Nodes behaving as end systems perform no forwarding of data
packets. They communicate with each other on an end-to-end basis
via intermediate systems.

End systems (ESs) periodically generate ES Hellos (ESHs) to
announce their presence. These ESHs are received and recorded by
neighboring intermediate systems. The interval between two ESHs is
determined by the End System Configuration Timer (ESCT).

Intermediate systems Intermediate systems (ISs) are used for routing data between nodes
and networks or parts of a network. The end system to intermediate
system protocol (ES-IS protocol) is responsible for the exchange of
data between an end system and an intermediate system. A network
element can act both as an end system as well as an intermediate
system. However, a management system, for example, can only act as
an end system.

Comparable to ESs, ISs periodically generate IS Hellos (ISHs). The
interval between two ISHs is determined by the Intermediate System
Configuration Timer (ISCT).

ES - IS protocol The end system to intermediate system protocol (ES-IS protocol)
provides information to ISs on the existence of ESs within an area.
This information is sent periodically to the ISs via a broadcast
mechanism. The ES-IS protocol permits ESs to discover the existence
and reachability of ISs and vice versa. Furthermore, the ES-IS
protocol provides information to ISs supporting the computation of the
shortest path first (SPF) algorithm. WaveStar® products make use of
the ES-IS protocol acc. to ISO 9542.

Basic DCN principles Management communication setup concepts
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IS - IS protocol The intermediate system to intermediate system protocol (IS-IS
protocol) is used between intermediate systems in the DCN. The IS-IS
protocol maintains the IS Routing Information Base (RIB). The
information in the RIB is used by the SPF algorithm for the routing of
management data packets in the DCN by the intermediate systems.
WaveStar® products make use of the IS-IS protocol acc. to ISO
10589.

Routing information base
and LSPs

Each Routing Information Base comprises a number of routing tables
containing information on NSAP addresses of nodes in the network
and ports of the IS through which these nodes can be reached.

Intermediate systems exchange routing information regularly with one
another as part of the IS-IS protocol by the use of Link State PDUs
(Link State Protocol Data Units, LSPs). A Link State PDU contains
information about the node itself, about its neighboring ES nodes, and
about its neighboring IS nodes.

LSPs exchanged within a level 1 area are called L1-LSPs, LSPs
exchanged across level 2 areas are called L2-LSPs.

OSI routing map and OSI
neighbor map

The OSI Routing Map and the OSI Neighbor Map information that
can be retrieved by using the WaveStar® SNMS is derived from a
node’s internal routing tables and the LSP databases. The LSP
database contents are equal in all nodes within an area (distributed
database concept).

Please note that when a DCC controller (ADJCTL/DCC32EI) is
restarted then the LSP databases and the internal routing tables may
temporarily contain inconsistent information. As a consequence, the
information displayed in the OSI Routing Map and the OSI Neighbor
Map may also be inconsistent. After the DCC controller restart has
finished Link State PDUs are exchanged to resynchronise the
databases.

Management protocol: TL1 The management of WaveStar® products is based on the use of the
Transaction Language 1 (TL1, defined by Telcordia Technologies,
formerly Bellcore, standards) on the OSI application layer.

Please also refer to the WaveStar® TDM 10G (STM-64) TL1
Reference Manual.

Basic DCN principles Management communication setup concepts
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DCN configurations
....................................................................................................................................................................................................................................

Hierarchical routing Hierarchical routing is used for large networks when the number of
NSAP entries in the RIB databases of the intermediate systems
becomes too large. When this happens, it causes an exponential
increase of exchanged LSPs between intermediate systems. This in
turn causes the performance of the DCN to decrease due to the
computation of the shortest path first (SPF) algorithm.

Definition of hierachical
routing

In hierachical routing, the addressing domain of the DCN is divided
into a number of areas. Each area is assigned a unique area identifier.
The value of the area identifier of the NSAP address of each node is
set according to which area a node belongs (cf. “NSAP address
format” (8-15)).

Level 1 IS and level 2 IS Each area contains a number of end systems as well as level 1 and
level 2 intermediate systems. level 1 intermediate systems (level 1
ISs) provide interconnectivity between nodes in an area. level 2
intermediate systems (level 2 ISs) provide interconnectivity between
areas.

Level 2 subdomain The adjacent set of level 2 ISs is also referred to as the level 2
subdomain. All areas in a network are connected via the level 2
subdomain

Area-divisioning of a DCN Divisioning is configuring the DCN in such a way that the exchange
of LSPs between intermediate systems is limited.

When networks are divisioned into areas, the RIB databases in the
systems are much smaller and hence the routing overhead is
significantly reduced. Intermediate systems in an area only exchange
information (L1-LSPs) on nodes with other systems in their own area.
Information on other areas is exchanged by level 2 ISs only and
maintained by the level 2 ISs of the area.

In this way, the load of management data in the network is strongly
reduced, while keeping the dynamic re-routing capabilities of
intermediate systems in case of failures intact. It is important to notice
that although the DCN is divided into areas, ES-ES communication
between all nodes in the DCN is still possible.

Area-divisioning of a DCN
illustration

The following figure illustrates how a network can be divisioned into
areas, connected by level 2 ISs. Each area has at least one level 2 IS

Management communication setup concepts
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assigned and can have a number of level 1 intermediate systems and
end systems.

Divisioning at network
protocol level

Divisioning of the DCN is usually done at the network protocol level.
Communication between intermediate systems is disabled or enabled
using different techniques, but this does not necessarily have to affect
the physical DCN topology. The SDH transmission network should in
general not be affected by DCN engineering.

Example: Routing of
management data

Suppose a node “A” wants to send messages to another node. If this
node is in the same area (determined by means of the area identifier
of the node’s NSAP address), the messages from “A” to this particular
node (“B” in “Area-divisioning of a DCN illustration” (8-7)) are
routed directly using a level 1 intermediate system.

Alternatively, if the desired destination is in a different area (“C” in
“Area-divisioning of a DCN illustration” (8-7)), the messages are sent
to a second, higher level (level 2) intermediate system. This level 2 IS
routes the messages coming from node “A” to other level 2 ISs until
they reach a level 2 intermediate system attached to the destination
area of “C”. From there the messages are routed to “C” within the
area using one or more level 1 ISs.

Types of OSI-DCN
networks

In general the OSI-DCN network can be classified in two types:

• Undivided DCN, or

• IS-IS area-divided DCN.

ES

Level 1 IS

Level 2 IS

Level 2 subdomain

A

B

C

Area 4

Area 3

Area 2

Area 1
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These two types of OSI-DCN network are illustrated in the following
figure.

Undivided DCN An undivided DCN consists of a single area. There is no division
between the nodes on network protocol level. All nodes in the
network and especially the intermediate systems can exchange routing
information with each other. Although a network element can only be
managed by one management system at a time, the IS-IS protocol is
running between all nodes in the network. This leads to the exchange
of LSPs between all intermediate systems in the network.

IS-IS area-divided DCN The divisioning of the DCN into areas can be accomplished by
introducing level 2 intermediate systems (cf. “Area-divisioning of a
DCN” (8-6)).

Advantages of areas

Among others, areas have the following advantages:

• Management systems can be connected to any point in the DCN.
As a rule, management systems should be connected to the
backbone of the DCN, i.e. to a level 2 intermediate system in the
center of their management domain, to prevent them from being
overloaded with too much data in the case of a failure resulting
in re-routing data traffic.

• The exchange of data is still possible between all nodes in the
DCN (cf. “Example: Routing of management data” (8-7)).

Management
System

Management
System

Management
System

Management
System

Q-LAN

ES

Level 1 IS

Level 2 IS

LCN

Management
System

Undivided IS-IS Area-Divided

(sub-) network
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DCN configuration guidelines
....................................................................................................................................................................................................................................

Background information Please refer to “Basic DCN principles” (8-2) and to “DCN
configurations” (8-6). These two sections provide theoretical
background information on data communication networks.

Guidelines Please observe the following engineering guidelines when configuring
a DCN with WaveStar® TDM 10G (STM-64) systems involved:

• A maximum of 50 nodes (i.e. NSAP addresses) is supported in an
area.
Notice that a WaveStar® TDM 10G (STM-64) network element
may comprise up to three nodes (please refer to ““NE” versus
“Node”” (8-3)).

• A maximum of 50 areas is supported in a subnetwork.

• All nodes in an area must have the same area address (cf.
“ISO-DCC NSAP address format” (8-15)).

• All nodes in an area must have DCC connectivity within the
area to all other nodes in the same area.

• At least one level 2 IS is required per area in area-divided DCNs
for communication across area boundaries. Two level 2 ISs are
recommended in each area for DCC communications redundancy
to/from each area.

• All level 2 ISs must have DCC connectivity, either directly or
indirectly via other level 2 ISs, to all other level 2 ISs in the
subnetwork to form a single level 2 subdomain that provides
connectivity to all areas.

• To distribute the load of management data in a subnetwork, it is
recommended, when feasible, but not required that:

- all area sizes be approximately the same,

- and the number of level 2 ISs be about the same as the
average area size.

For example, a perfectly balanced subnetwork of 200 nodes
would include 20 nodes per area in each of 10 areas and 20 level
2 ISs in the level 2 subdomain (two level 2 ISs per area).

Related information Please refer to “NSAP address format” (8-15) and to “Data
Communication Channels” (8-19) for further information.
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DCN protocols and services
....................................................................................................................................................................................................................................

Overview

WaveStar® TDM 10G (STM-64) network elements support the
exchange of management information over DCC, OSI LAN, or
TCP/IP. This network operations capability uses the section DCC
bytes in the SDH overhead of the optical signals. WaveStar® CIT
dialogues and OS messages are transmitted in these DCC bytes.

The WaveStar® TDM 10G (STM-64) OS interface is accessed
through one of the 10BaseT Ethernet IAO LAN rear panel connectors.
The WaveStar® TDM 10G (STM-64) interface supports Transaction
Language 1 (TL1) for commands/messages, and File Transfer and
Access Management (FTAM) for software downloads and
provisionable data backup and restore.

The WaveStar® TDM 10G (STM-64) OS interfaces supported include
the following:

• OSI LAN/WAN

• TL1 TCP/IP (using the internal gateway function)

• FTP/FTAM (for software download, etc.)

Standard 7-layer OSI stack WaveStar® TDM 10G (STM-64) network elements support the
exchange of management information over the standard 7-layer OSI
protocol stack over Local Area Networks (LAN) and over Data
Communication Channels (DCC) acc. to the Telcordia Technologies
(formerly Bellcore) GR-253 standard.

Management communication setup concepts
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Protocols and services The following figure shows how WaveStar® TDM 10G (STM-64)
network elements support the protocols and services.

FTAM File Transfer, Access and Management (FTAM), defined by ISO 8571,
is an Application Service Element (ASE). FTAM facilitates file
transfer and allows file manipulation across a network. The FTAM
protocol is used for WaveStar® TDM 10G (STM-64) software
management purposes, such as software download, backup or
restoration.

IAO LAN access The IAO LAN serves two main purposes:

• It provides a standard means of connecting a network element to
a central office (CO) data communications network (DCN) to
provide OS access

• It provides an alternate path for data communications channel
(DCC) communications to travel within a subnetwork.

The WaveStar® TDM 10G (STM-64) IAO LAN is internally
connected to the DCC subnetwork so that operations messages on the
IAO LAN can be seamlessly delivered to a remote network element
by the DCC and vice-versa (DCC to IAO LAN).

LAPD (AITS/UITS)
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Internal IAO LAN hub

The system supports an internal 4-port 10BaseT Ethernet IAO LAN
hub (located on the ADJCTL/DCCEI circuit pack in each shelf). The
WaveStar® TDM 2.5G/10G (2-Fiber) 10BaseT Ethernet IAO LAN
backplane connectors and the WaveStar CIT port on the user panel are
all connected to this internal hub. The internal LAN hub supports
direct connection of the WaveStar CIT (or NCC or SNMS) without
requiring an external LAN hub.

Daisy chain

The internal IAO LAN hub also supports daisy-chaining of multiple
WaveStar® TDM 10G (STM-64) shelves, for example, in the same
bay. A daisy-chain connection is similar to a null-modem connection.
Reference is made to a 10BaseT connection where there is no hub. In
this connection, the receive pair on one end of the cable is connected
to the transmit pair on the opposite end. Conversely, the transmit pair
on one end is connected to the receive pair on the opposite end.

Important! A daisy-chain connection can only be repeated five times.
A preferred connection would go through an external office LAN hub.

TL1 over TCP/IP A TL1 TCP/IP gateway may be used to connect multiple collocated
WaveStar® TDM 10G (STM-64) systems to a remote OS equipped to
communicate through a TCP/IP WAN. Since the OS communicates
through TCP/IP, a gateway is required to provide a mapping between
TCP/IP and OSI. That gateway function is included as a feature of the
WaveStar® TDM 10G (STM-64) system.

The gateway is provisioned to provide a TL1 TCP/IP gateway
between TCP/IP and OSI. This process is bidirectional, mapping
messages originating in the OS to the proper NE NSAP, as well as
mapping messages originating in the NE to the proper OS IP address
and returning then to the OS.

This interface supports TL1 messages only.

IP tunneling The IP tunneling feature provides a way to

• manage IP managed devices (e.g. SNMP) through the OSI based
DCN network (called ″IP fringe″),

• manage NEs in an OSI based DCN via an IP based access
network, using IP based protocols like FTP and SNMP (called
″IP access″).

In both cases it is necessary to transport IP messages through an OSI
based network.
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The figure below shows the ″IP fringe″ and ″IP access″ topologies:

A (bidirectional) tunnel can be seen as a set of two static routing
entries in nodes of the OSI network. The term tunnel may be
misleading because it is often associated with connections which must
be set up in advance. In this case, only some routing information
needs to be provisioned and no communication between two systems
is needed to set up the ″tunnel″ between them. To avoid confusion, it
is better to speak of encapsulation and to think of the OSI network as
an NBMA (non broadcast multiple access) subnetwork within the IP
network. The NEs need to be configured with one IP address on the
LAN side, connected to the IP subnet with the IP NE or the IP
NEs.The LAN can be used for both OSI and IP traffic. The same
ethernet address will be used for both protocols.

In the figure below, a simple example of an ″IP access″ network is
given. OS is the operations system (IP based), R is an IP router, GNE

Network with any number of
elements and connections

NE with IP based management
in an OSI based network

IPNE

IP management

IP management

IP managed equipment

IPNE

IPNE

IP

IP

IP

IP

IP

IP OSI

OSI

LAN

IP

IP
OS

OS
“IP fringe”

“IP access”

DCN protocols and services Management communication setup concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 8 - 1 3



is a Gateway Network Element (any NE supporting IP tunneling can
fulfill this role)

IP tunneling for FTP
access

WaveStar® TDM 10G (STM-64) supports IP Tunneling as a means of
enabling file transfers from TCP/IP networks across the OSI network
to terminating NEs. The tunneling encapsulates the TCP/IP message
and protocol in an OSI envelope. The receiving unit can then regain
the TCP/IP protocol as well as the message.

File transfer between manager and NE is used for two purposes:

• Software download, to upgrade the software of a network
element.

• Configuration backup and restore, to make copies of the
configuration of an NE so that the status can be restored after a
crash.

The following figure illustrates the IP tunneling for FTP access.
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NSAP address format
....................................................................................................................................................................................................................................

Related information Please refer to “Basic DCN principles” (8-2) and to “DCN
configurations” (8-6). These two sections provide theoretical
background information on Data Communication Networks.

For related task oriented procedures, please refer to Chapter 1,
“Management communication setup”.

NSAP address The Network Service Access Point (NSAP) address is used by the
network protocol for location information. The NSAP address of a
node is its DCN wide identifier which uniquely identifies the node in
the network.

ISO-DCC NSAP address
format

Although different NSAP formats exist, preferably all nodes in a
network should use the same address structure. The WaveStar® TDM
10G (STM-64) supports the 20-byte ISO Data Country Code (DCC)
NSAP address format in accordance with ISO 8348.

The structure of the ISO-DCC NSAP address format is shown in the
following figure.

The NSAP address consists of the Initial Domain Part (IDP) and the
Domain Specific Part (DSP).

The first 13 bytes (“AFI” to “AREA” fields) of the NSAP address
make up the area address.

The meaning of the individual fields of the ISO-DCC NSAP address
is explained in “NSAP address fields” (8-16).

Flexible NSAP address
format

Alternatively to the ISO-DCC NSAP address format the flexible
NSAP address format can be used.

AFI IDI DFI ORG Reserved RD AREA SYSTEM SEL

Area Address (13 Bytes)

IDP DSP

Network Entity Title (NET; 19 Bytes)
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The structure of the flexible NSAP address format is shown in the
following figure.

The flexible NSAP address format has an Area Address part consisting
of the AFI part and a flexible part of 12 bytes length (the contents of
this part can cary). Notice that the flexible NSAP address format can
be used to derive the other formats.

NSAP address fields The following table lists the NSAP address fields and describes their
meaning.

Field Meaning Description

Initial Domain Part (IDP):

AFI Authority and Format
Identifier specifying the
NSAP address format.

The predefined value is
0x39 (hex.), indicating that
the ISO Data Country Code
(ISO-DCC) is the address
format.

This field is configurable.

IDI Initial Domain Identifier
specifying the country
code.

The predefined value is
0x840F (hex.).

This field is configurable.

Domain Specific Part (DSP):

DFI DSP Format Identifier
specifying the DSP
format.

The predefined value is
0x80 (hex.).

This field is configurable.

ORG Organization identifier
(or Operator identifier)
representing the Network
Service Provider (NSP).

The predefined value is
0x000000 (hex.).

This field is configurable.

Reserved Reserved portion of the
NSAP.

The predefined value is
0x0000 (hex.).

This field is configurable.

AFI Flexible Part SYSTEM SEL

Area Address (1 -13 Bytes)

IDP DSP

Network Entity Title (NET; 7 - 19 Bytes)
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Field Meaning Description

RD Routing Domain The predefined value is
0x0000 (hex.).

This field is configurable.

AREA Area identifier indicating
the routing area to which
a node belongs (cf.
“Hierarchical routing”
(8-6)).

The predefined value is
0x0000 (hex.).

This field is configurable.

SYSTEM System identifier
representing the node.
The IEEE 802.3 MAC
address, stored on the
DCC controller
(ADJCTL/DCCEI circuit
pack) during the
manufacturing process, is
used as the system
identifier.

The system identifier is the
field that makes the NSAP
address unique throughout
the DCN.

This field is not
configurable.

When a new DCC
controller is inserted, then
the system identifier, and so
the NSAP address,
automatically changes.

SEL The selector field is used
to direct the Protocol
Data Units (PDUs) to the
correct destination
making use of the CLNP
network layer service.

The predefined value is:

• 0x1D (hex.) for PDUs
to be processed via the
OSI stack

• 0xAF (hex.) for PDUs
to be processed via the
TID Address Resolution
Protocol (TARP cf.
“Name-to-address
translation” (8-26)).

This field is not
configurable.

Network entity title The area address together with the system identifier (SYSTEM field)
of the NSAP address is also called the Network Entity Title (NET; cf.
“ISO-DCC NSAP address format” (8-15)).

DCC controller reset All parameters related to DCC communication including all fields of
the NSAP address are retained over a DCC controller reset. All
parameters are kept in non-volatile memory.

Configuring the NSAP
address

You can configure the NSAP address on each active DCC controller
individually.
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Important! Changing the NSAP address causes the DCC controller to
be restarted, thus causing momentary loss of communication with the
system via that circuit pack.

Additional information For information on how to change the configurable fields of the
network element’s NSAP address, please refer to “Modify a Network
Element” (1-9).
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Data Communication Channels
....................................................................................................................................................................................................................................

Exchange of network
management information

Network management information can be exchanged between SDH
network elements via Data Communication Channels (DCCs) using
the D1-D12 Section Overhead (SOH) bytes of the first STM-1 frame
within an STM transmission signal.

This makes it possible to set up a Data Communication Network
(DCN; cf. “Basic DCN principles” (8-2)) which uses SDH
connections for exchanging network management data.

Please note that all nodes in an area must have DCC connectivity
within the area to all other nodes in the same area (cf. “DCN
configuration guidelines” (8-9)).

The DCC uses OSI protocols. IP traffic is carried on the DCC by
encapsulating it in CLNP PDUs.

DCC-R (Section DCC) The Regenerator Section Data Communication Channel (DCC-R or
Section DCC) makes use of the RSOH bytes D1-D3 thus providing a
transmission channel with a capacity of 192 kbit/s. The DCC-R is
automatically set as the default DCC for provisioned (configured) or
pre-provisioned optical interface ports.

DCC-M (Line DCC) The Multiplex Section Data Communication Channel (DCC-M or Line
DCC) uses the MSOH bytes D4-D12 thus providing a transmission
channel with a capacity of 576 kbit/s.

Supported Data
Communication Channels

The Data Communication Channels are supported for the following
optical interfaces:

• STM-1

• STM-4

• STM-16

• STM-64

Termination of Data
Communication Channels

The WaveStar® TDM 10G (STM-64) system supports the 7-layer OSI
protocol stack over the DCC links which terminate on the DCC
controller (ADJCTL/DCC32EI). The ADJCTL/DCC32EI circuit pack
provides the source and sink of the DCC bytes to and from the active
DCC links via LAPD devices. The LAPD protocol acc. to ITU-T Rec.
Q.921 is used. You can define DCC links by assigning DCC
terminations to optical interface ports.

Management communication setup concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 8 - 1 9



The following figure illustrates the functional principle.

Max. number of active DCC
links

The maximum number of simultaneously supported LAPD channels
per DCC controller is 32. Each DCC controller thus can support up to
32 active DCC links. Upon circuit pack insertion, DCCs will
automatically be enabled and a LAPD channel assigned as long as
LAPD channels are available.

DCC provisioned state A Data Communication Channel (either DCC-R or DCC-M) can be in
one of the following provisioned states:

• Enabled

- The corresponding DCC bytes are associated to an optical
interface port.

- The DCC is assigned a LAPD channel.

• Disabled

- The corresponding DCC bytes are no longer associated to an
optical interface port.

- The DCC is no longer accessed by a LAPD channel.

The provisioned state of a DCC as well as the LAPD channel
assignments are persistent over a DCC controller or NE reset.

No DCC protection
switching!

The WaveStar® TDM 10G (STM-64) system does not support DCC
protection switching. However, the system allows for protection
switching of the DCC overhead bytes with the optical interfaces on
which they reside. If no protection of the optical interface is
provisioned, then the DCC bytes are unprotected as well.

Mandatory DCC access
for MS-SPRing

When an MS-SPRing protection group is created and the MS-SPRing
management mode is “automatic discovery”, then two DCCs must be
enabled (one for the east and one for the west port), and each of the
DCCs must be assigned a LAPD channel; otherwise the creation of
the MS-SPRing protection group will fail due to insufficient resources
(LAPD channels).

Src

SinkLAPD

OSI

Optical

DCC Bytes STM-N opt.

DCC controller

Src = DCC Source

Sink = DCC Sink

(ADJCTL/DCC32EI)

protocol
stack

(layer 3-7)

interface port
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Important! The following has to be observed:

1. Data Communication Channels used for MS-SPRing management
cannot be disabled as long as the MS-SPRing protection group
exists and the MS-SPRing management mode is “automatic
discovery”.

2. If the neighboring node in an SDH MS-SPRing is an ADM-16/1,
then you must enable the DCC-M on the side connected to the
ADM-16/1.

Enabling of DCCs A Data Communication Channel can be enabled in either of the
following ways, always provided that the required number of LAPD
channels is available:

• Automatically upon circuit pack initialization
When a port unit is initialized (e.g. after circuit pack insertion)
the DCC-R will be enabled for each port provided that the
required number of LAPD channels is available.

• Automatically upon creation of a protection group

• Manually by user provisioning
Please refer to “Modify a Network Element” (1-9).

A DCC will be successfully enabled if an LAPD channel exists that

• can be assigned to this DCC in the unprotected mode, or

• can be shared with this DCC in a protected mode.
A DCC channel with its own LAPD channel when in the
unprotected mode, can share its LAPD channel when in the 1+1,
1:1 or 1:N protection mode.

DCC pre-provisioning A DCC can be pre-provisioned to be enabled for a provisioned or
pre-provisioned optical interface port even if the DCC controller or
port is not physically equipped.

Disabling of DCCs A Data Communication Channel can be disabled in either of the
following ways:

• Automatically when an optical interface port is de-provisioned
When an optical interface port is provisioned to be removed
(de-provisioned), then all enabled DCCs will be disabled, and the
corresponding LAPD channels will be released.

• Manually by user provisioning
Please refer to “Modify a Network Element” (1-9).

Important! Disabling a previously enabled DCC at a local NE needs
to be coordinated with disabling the same DCC at the opposite end of
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the DCC link (remote NE) to avoid persistent communications alarms
from the remote NE.

LAPD mode The LAPD protocol, which controls communication between the
network elements, operates in either of the following modes:

• Network Side
The LAPD is assigned as Network. This mode is according to the
standards and will interoperate successfully with other LAPDs
operating in user_side mode.

• User Side
The LAPD is assigned as User. This mode is according to the
standards and will interoperate successfully with other LAPDs
operating in network_side mode.

Important! The DCCs work according to the master/slave principle,
i.e. the LAPD modes of two interconnected SDH ports must be set
different. A corresponding “User-Network Side Failure” alarm will be
generated if the LAPD mode is the same at both ends of a DCC.

AITS and UITS supported WaveStar® TDM 10G (STM-64) network elements support the
Acknowledged Information Transfer Service (AITS) and the
Unacknowldeged Information Transfer Service (UITS) as the basis for
the LAPD protocol with the AITS mode being the default mode of
operation.

AITS and UITS functional
principles

In the LAPD protocol, all PDUs are sent with a checksum to verify
that the data was not corrupted in transmission over the DCC link. If
a PDU is received with a bad checksum, it is not acknowledged and
will be resent:

• In the Unacknowldeged Information Transfer Service (UITS)
corrupted PDUs are ignored and no further actions taken. Upper
layers of the OSI stack are responsible for recovery actions.

• In the Acknowledged Information Transfer Service (AITS)
PDUs are numbered and transmitted sequentially, and
acknowledgement PDUs are sent back from the receiver to the
sender. If a PDU is lost, that is, if the sender gets no
acknowledgement, the PDU is retransmitted.
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The following figure illustrates the functional principle of the AITS.

Routing metric The shortest path first (SPF) algorithm calculates the preferred route
between two nodes based on the cost of a route. The cost of a route is
described by a single dimensionless routing metric.

The WaveStar® TDM 10G (STM-64) system makes use of the default
routing metric as defined in ISO 10589.

1Node A Node B23

Ack. 1 Ack. 2
no Ack. 3 !

3retransmission of

Ack. 3

PDU 3 corrupted
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LAN access
....................................................................................................................................................................................................................................

Internal LAN Individual parts of a WaveStar® TDM 10G (STM-64) network
element are interconnected via an internal LAN, the so-called
Operations Network (ON), for the purpose of exchanging management
information.

External LAN access Both the low-speed part and the high-speed part of the main shelf
facilitate the access to an external LAN, the so-called Intraoffice LAN
(IAO-LAN), by means of three 10-BaseT Ethernet interfaces on
4-wire RJ-45 connectors.

The following figure illustrates the WaveStar® TDM 10G (STM-64)
LAN connections.

Intraoffice LAN The Intraoffice LAN (IAO LAN) is an IEEE 802.3 CSMA/CD
(Carrier Sense Multiple Access with Collision Detection) type LAN at
a data rate of 10 Mbit/s and a baseband signalling type. It is used to
connect other NEs in the same office which do not have optical
connectivity to the WaveStar® TDM 10G (STM-64) network, or to
connect management systems.

LAN connectors The RJ-45 LAN connectors are located on the User Panel (connector
labelled “CIT”; this is the LAN 1 interface of the low speed part of
the main shelf) and on the LAN I/O-Panel at the rear.

Network Element

Extension
shelf

Operations Network (ON)

High speed
part

Low speed
part

IAO-LAN

IAO-LAN

3

3
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The following figure illustrates the LAN I/O-panel.

LAN 2 LAN 3 LAN 1 LAN 2 LAN 3

(1-1) DCC (1-2) DCC

Low speed part... High speed part... ... of the main shelf
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Name-to-address translation
....................................................................................................................................................................................................................................

Overview The communication between WaveStar® TDM 10G (STM-64)
network elements and their management systems, such as the
WaveStar® SNMS, is established by using TL1 command messages.

A TL1 message addresses a network element by its “name”, also
referred to as its target identifier (TID), whereas nodes within an OSI
network are identified by their NSAP address. Hence a
name-to-address translation becomes necessary.

TARP The TID Address Resolution Protocol (TARP) acc. to Telcordia
Technologies (formerly Bellcore) GR-253 standard provides a means
to perform the TID to NSAP address translation dynamically by
means of TARP Protocol Data Units (TARP PDUs), originating from
an end system such as the WaveStar® SNMS.

Three basic TARP functionalities can be distinguished:

• TARP originator functionality

• TARP propagation functionality

• TARP responder functionality

TARP originator
functionality

The TARP originator functionality means the ability to spontaneously
originate a TARP PDU type 1, 2 or 5 query (cf. “Types of TARP
PDUs” (8-27)) and broadcast it over the OSI network.

TARP propagation
functionality

The TARP propagation functionality means the ability to evaluate a
received TARP PDU type 1, 2 or 5 query and to further broadcast it
over the OSI network if the requested TID or NSAP address does not
match the NE’s TID or NSAP address, and if the requested TID or
NSAP address could not be found in the TARP Data Cache (TDC; cf.
“TARP data cache” (8-27)).

A TARP propagator decrements the lifetime of a received TARP PDU
by one and broadcasts the modified PDU to all of its network
neighbors (with the exeption of the previous PDU sender). When the
TARP PDU lifetime becomes zero, then no further propagation takes
place.

TARP responder
functionality.

The TARP responder functionality means the ability to respond to a
TARP PDU type 1, 2 or 5 query via a type 3 response (cf. “Types of
TARP PDUs” (8-27)).

Types of TARP PDUs The following table shows the five defined types of TARP PDUs.
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Type Characteristic Description

1 Query Given an NE name (TID), the
corresponding NSAP address is requested
(restricted to IS-IS level-1 area).

2 Query Given an NE name (TID), the
corresponding NSAP address is requested
(IS-IS level-1 and 2 areas).

3 Response Response to a TARP Query.

4 Autonomous
notification

Autonomous notification of a TID or
NSAP address change, or a reset
indication.

5 Query Given an NSAP address, the corresponding
NE name (TID) is requested.

Supported TARP
functionality

The WaveStar® SNMS supports the TARP originator functionality
which is permanently enabled. WaveStar® TDM 10G (STM-64)
network elements support the TARP propagation and TARP responder
functionalities. These functionalities can be either enabled or disabled.

Network
services/protocols

TARP depends on the network layer services and protocols provided
by the Connectionless Network Service/Connectionless Network
Protocol (CLNS/CLNP) and the ES-IS and IS-IS routing protocols (cf.
“ISO-OSI network protocols” (8-4)) to obtain information about the
network neighbors of an NE.

TARP data cache A local database, the TARP Data Cache (TDC), is used in each NE to
store information on the NE’s adjacencies, i.e. its direct neighbors in
the network. Hence an NE may be able to respond to a TARP query,
even if the requested TID or NSAP address does not match the NE’s
own TID or NSAP address. Thus, the network performance can be
enhanced.
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TARP manual adjacencies By using TARP manual adjacencies it is possible to route TARP PDUs
over subnetworks which do not support the TARP functionality.
However, a precondition is that the nodes within the non-TARP
subnetwork are “generic routers”. A TARP manual adjacency is simply
the Network Entity Title (NET; cf. “Network entity title” (8-17)) of a
node that supports TARP.

Loop detection WaveStar® TDM 10G (STM-64) nodes provide a loop detection
mechanism to prevent a repeated processing of previously processed
TARP PDUs. A loop detection buffer (LDB) in conjunction with an
LDB entry timer and an LDB flush timer is used for this purpose. A
previously processed and again received TARP PDU is discarded.

Configuration of TARP
parameters

For information on the configuration of TARP parameters, please refer
to the following procedures:

• “Configuring the TARP parameters for an NE” (1-27),

• “Assigning TARP manual adjacencies” (1-30).

DCC

DCC

TARP supporting node

Generic router

Q-LAN
(LCN)

Q-LAN
(LCN)

TARP manual adjacency
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NE name administration
....................................................................................................................................................................................................................................

Definition NE Name (TID) The NE name, also referred to as the NE’s
target identifier (TID), is an alphanumeric string of up to 20
characters, used to uniquely identify a network element within
the network. “NE name” and “TID” are used synonymously
throughout this Provisioning Guide.

Configuration rules The following NE name configuration rules must be observed:

• The following characters are allowed in an NE name:

- Upper case letters (‘A’ .. ‘Z’),

- Lower case letters (‘a’ .. ‘z’),

- Digits (‘0’ .. ‘9’),

- Hyphen (“-”).

• Each NE name must be unique within the network.

• Each NE name must be maximally 20 characters in length.

• The NE name may contain segments separated by hyphens (“-”),
but each segment must begin with a letter.

Important! NE names are case insensitive.

Examples:

The following are examples for valid and invalid NE names.

• “NE-A1”, “CHICAGO7” or “NY-B3-C5” are valid NE names.

• “NE-01”, “CHICAGO-7” or “NY-3-5” are invalid NE names.

Changing the NE name For information on how to change the NE name, please refer to
“Modify a Network Element” (1-9).
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9 Equipment provisioning concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter gives you an overview of the hardware components of
the WaveStar® TDM 10G (STM-64) which have to be configured.
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Equipment provisioning and autoprovisioning
....................................................................................................................................................................................................................................

What does equipment
provisioning mean?

Equipment provisioning is the pre-configuration of network element
components before protection groups and cross-connections can be
defined.

Provisioning can take place for the first time after the installation of
the equipment (initial provisioning) or when re-configuration of the
WaveStar® TDM 10G (STM-64) in an existing SDH network is
necessary.

The following components have to be provisioned initially:

• System (optional)

• Shelves

• Slots/circuit packs

• Optical and electrical ports

• Tributaries

Equipment provisioning can be carried out with the WaveStar® CIT.
The configuration data is placed in the NE and stored in a
non-volatile memory (NVM) on the PCMCIA card.

Autoprovisioning Some of the components are autoprovisioned. This means some
system parameters are assigned automatically after installation and
system start. These are:

• Bay 1

• The low-speed shelf

• System control circuit packs

• Synchronization circuit packs

• Switch circuit packs

• Synchronization default mode (free running)

• Synchronization equipment protection (if two timing circuit packs
are available)

• DCC default modes: LAPD role is User-Side for all ports, DCCR

(Section DCC) is enabled, DCCM (Line DCC) is disabled

• All mandatory circuit packs in a shelf and all circuit packs which
are already plugged-in during system start.

A modification of the autoprovisioned parameters is possible.
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Provisioning of new components
....................................................................................................................................................................................................................................

Overview You can add new components to an existing system. This can be
necessary during reconfiguration or after installation. The following
components can be added:

• Bays (additionally to Bay 1; Bay 1 is autoprovisioned)

• Shelves

• Circuit packs

• Protection groups

Parameters Already while creating a component you can define some parameters
of the respective component:

• Bay
A new Bay with a selectable AID (1...99) can be created.

• Shelf
A new Shelf (Extension Shelf) can be created. The following
parameters can be provisioned:

- Shelf AID: 1-3

- ON Cable Identifier: 1...4
The ON Cable Identifier is the controller address of a shelf
for the connection to the low-speed shelf which contains the
main controller for the whole network element. For the
high-speed shelf it is always 1. For the extension shelf it
should be 2.

- shelf type (2.5or 10G)

- ASAP (only default)

• Circuit Pack
New circuit packs can be established. The circuit pack types can
be selected. In the following chapter “Main shelf configuration”
(9-7) and “Extension shelf configuration” (9-13) the slot
distribution for the main shelves and the extension shelf is
described. In the selection window for new circuit packs only the
circuit packs which are suitable for the respective slot can be
selected.

• Protection Group
All entities which are necessary for the creation of a new
protection group can be selected. They can be part of the
following protection types:

- 1+1 MSP

- 2-Fiber MS-SPRing

Equipment provisioning concepts
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For further information on the protections, please refer to
“Protection mechanisms” (11-23).
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Exchangeability of circuit packs
....................................................................................................................................................................................................................................

Overview You can physically exchange the line and tributary circuit packs with
different application codes (LEY), if they are functionally compatible,
as far as the feature sets are concerned (transmission rate, FEC-Type).

The provisioned connections will be restored without deprovisioning
or reprovisioning of the circuit pack and all its traffic. Thus service
interruptions are minimized.

Full exchangeability Full exchangeability allows exchanging port units with different port
attributes (but same line rate and same number of ports).

It includes exchanging direct-optics and non-direct-optics of the same
(line) rate.

Exchangeability table The following table gives an overview over the exchangeable circuit
packs. Only the packs of the same Exchangeability Group can be
exchanged.

Circuit Pack Application Code Exch.
Group

Comments

Name Qualifier

OC192/STM64

(10 Gbit/s)

1.5SR1 LEY67 1 40km (SH)=DA!

1.5IR1 LEY69 1 60km (SH) 1.5u EIR (with
ADP)

1.5IRS1 LEY97 1 60km (SH) 1.5u IR (with
PIN)

WDM [nnnn] LEY201-240 1 OLS400G-40 colors

POU [nnnn] LEY284-299 1 16×OLS_passive optics

OC48/STM16

(2.5 Gbit/s)

1.3LR1 LEY7 2 51km (LH);
+LEY307=CR(M)

1.3SR1 LEY182 2 VSR; 2km (intra-office)

1.5LR1 LEY8 2 80km (LH);
+LEY308=CR(M)

DWDM
[01-16]

LEY50-65 2 OLS40/80G-16 colors

WDM [nnnn] LEY101-180 2 OLS400G-80 colors 1.5u

POU [nnnn] LEY80-95 2 16× OLS_passive optics

OC12/STM4

(622 Mbit/s)

1.3SR2 LEY14 3 IR/SR-2 port 15km (SH)

1.3LR2 LEY13 3 2 port, 51km (LH)

1.5LR2 LEY190 3 2 port, 80km (LH)
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OC3/STM1

(155Mbit/s)

1.3SR4 LEY16 4 4 port; 15km (SH)

1.3LR4 LEY15 4 4 port; 51km (LH)

1.3SR8 LEY23 8 IR/SR-8 port 15km (SH)

4 LEY44 5 STM1E (4 ports,
electrical)

4 LEY40 5 STM1EE4 (never E4)

OBA-10G Booster 1.5LR1 SEN3 6 25mm; 80km (LH)

OBPA-10G Booster +
Amplifier

1.5VR1 SEN4 9 25mm; 120km (VLH)

SH/LH = Short/long Haul

DA = Discontinued Availability

Exchangeability of circuit packs Equipment provisioning concepts
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Main shelf configuration
....................................................................................................................................................................................................................................

Overview This chapter describes the configuration of the main shelf of the
WaveStar® TDM 10G (STM-64).

Layout (front view) The following figure depicts the WaveStar® TDM 10G Main Shelf
plug-in units and circuit pack slots (front view), including the 16 slots
used for STM-1(o), STM-1(e), STM-4, STM-16, GE1/SX2 or
GE1/LX2 (Gigabit Ethernet) tributary port units. The minimum
required circuit packs are highlighted..

NOTE: For configurations with 2 or 3 Expansion Shelves the
SWITCH/STS576 (0/1) circuit packs in high-speed part of the main
shelf and also the corresponding PPROC/STS192 (DM0/1) circuit
packs have to be replaced by the SWITCH/STS768 and
PPROC/STS384 circuit packs.
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The following table lists all possible tributary port units.

Port unit
with

Apparatus
Code

Description

STM-64 LEY69 OC192/STM64/1.5IR1

LEY97 OC192/STM64/1.5IRS1

LEY201–240 OC192/STM64/WDM9580–9190

LEY284–299 OC192/STM64/POU9590–9210

STM-16 LEY7 OC48/STM16/1.3LR1

LEY307 OC48/STM16/1.3LR1

LEY8 OC48/STM16/1.5LR1

LEY308 OC48/STM16/1.5LR1

LEY50–65 OC48/STM16/DWDM01–16

LEY101–180 OC48/STM16/WDM9585–9190

LEY182 OC48/STM16/1.3SR1

GE1/SX2 LEY309 1 Gigabit Ethernet

GE1/LX2 LEY310 1 Gigabit Ethernet

STM-4 LEY13 OC12/STM4/1.3LR2

LEY14 OC12/STM4/1.3SR2

LEY190 OC12/STM4/1.5LR2

STM-1o LEY15 OC3/STM1/1.3LR4

LEY16 OC3/STM1/1.3SR4

LEY23 OC3/STM1/1.3SR8

STM-1e LEY44 STM1E/4

Circuit pack slot equipage The following table shows the relation between slot designations and
required circuit packs used in the Main Shelf of the WaveStar® TDM
10G. The slots designations in the low speed part of the shelf begin
with the string “(1-1)”, the high speed part of the shelf is referred to
as “(1-2)”.
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Slot
designation

Slot equipage

(1-1) 01 to
(1-1) 16

STM1e:

LEY40

STM1o:

LEY16, 23

STM4:

LEY13, 14,
190

STM16:

LEY7, 8,
101-180, 182,
307, 308

Any mix of transmission interface circuit packs
(optical and electrical):

• STM-1(e) port units (STM1E/4, STM1EE4/4)

• STM-1(o) port units (STM1)

• STM-4 port units (STM4)

• STM-16 port units (STM16), incl. 16 colours
DWDM interfaces.

• 1 Gigabit Ethernet interface (GE1/SX).

Each of the STM-16 port units as well as the 1
Gigabit Ethernet circuit pack GE1/SX (LEY
309) requires two slots. Allowed slots are: 02,
04, 06, 08, 10, 12, 14, 16.

If the slot (1-1)16 is configured for an optical
port unit (STM-1(o), STM-4 or STM-16), no
1:N equipment protection of the STM-1(e) port
units is possible.

If 1:N equipment protection of the STM-1(e)
port units is configured, slot (1-1)16 must be
left empty.

(1-2) trw

(1–2) tre

LEY67, 69, 97,
201-240,
284-299

STM-64 port units (STM64), incl. 56 colours
DWDM interfaces. Depending on the distance,
different STM-64 port units are required (see table
above).

(1-1) eprn

LEY44

Electrical protection. Equipped with an STM1E/4
circuit pack to protect STM1E/4 port units. This
slot can also be left empty if no protection is
required.

(1-1) eprotnsw

LEY42

Electrical protection switch. Equipped with an
EPS-64 protection switching circuit pack to
provide the 1:N switching function for protected
STM1E/4 port units. This slot can also be left
empty, if no protection is required.

(1–1) switch0

LEY4

Fabric switch 0. The SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. This switch is paired
with fabric (1-1) switch 1 in a 1+1 non-revertive
protection mode configuration.
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Slot
designation

Slot equipage

(1-1) ctlmem0

LEY10B

Controller for the system including non-volatile
memory. The CTL/SYS50DM circuit pack in this
slot is the working controller for the low speed
part of the shelf and additionally the system
controller for the whole shelf.

(1-1) dccei

LEY1

Adjunct controller, DCC and external interface.
The ADJCTL/DCC32EI circuit pack in this slot
terminates up to 32 data communications channels
and interfaces them to the shelf 10Base-T LAN.

(1-1) ctlmem1 The slot is left empty for the current release of
WaveStar® TDM 10G.

(1-1) switch1

LEY4

Fabric switch 1. The SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. This switch is paired
with fabric (1-1) switch 0 in a 1+1 non-revertive
protection mode configuration.

(1-1) tmg1

(1-1) tmg0

LLY2

Two half-height Stratum 3 timing generator circuit
packs are located one above the other in this slot.
They are the master TMGs in the shelf (and also
for the Expansion Shelf). When WaveStar® TDM
10G is initially powered on after shipment from
the factory, the lower TMG/STRAT3 is the active
circuit pack and the upper TMG/STRAT3 is the
standby circuit pack. However, both circuit packs
are of equal level and protection switching is
non-revertive, so there is no default configuration.

(1-2) oaw

(1-2) oae

SEN3 or SEN4

OBAs or OBPAs (depending on the optical
distance, see table above).

(1-2) pprocw

LEY3

The PPROC/STS192 circuit pack in this slot
supports the STM64 port unit function assigned to
the western aggregate port. The CP is responsible
for pointer processing and synchronisation to the
system clock and for POH monitoring.

(1-2) switch0

LEY4

Fabric switch 0. A SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. A SWITCH/STS768
circuit pack in this slot can make cross-connections
for 256 STM-1 equivalent circuits. This switch is
paired with fabric (1-2) switch 1 in a 1+1
non-revertive protection mode configuration.
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Slot
designation

Slot equipage

(1-2) ppls0

LEY3

The PPROC/STS192 or PPROC/STS384 circuit
pack in this slot provides frame delay management
between the switch functions of the low speed part
of the shelf and the high speed part ((1-1) sw. 0).

(1-2) ctlmem0

LEY10B

The CTL/SYS50DM circuit pack in this slot is the
working shelf controller for the high speed part.
The system controller for the whole shelf is
located in slot (1-1) ctlmem0.

(1-2) dccei

LEY1

Adjunct controller, DCC and external interface.
The ADJCTL/DCC32EI circuit pack in this slot
terminates up to 32 data communications channels
and interfaces them to the shelf 10Base-T LAN.

If Orderwire support is required, use LEY301
instead.

(1-2) ctlmem1 The slot is left empty for the current release of
WaveStar® TDM 10G.

(1-2) switch1

LEY4

Fabric switch 1. A SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. A SWITCH/STS768
circuit pack in this slot can make cross-connections
for 256 STM-1 equivalent circuits.This switch is
paired with fabric (1-2) switch 0 in a 1+1
non-revertive protection mode configuration.

(1-2) tmg1

(1-2) tmg0

LLY2

Two half-height Stratum 3 timing generator circuit
packs are located one above the other in this slot.
They are slave TMGs. Their function is to
distribute the system clock from the active master
TMG to the circuit packs in the high speed part of
the shelf or to the Expansion Shelf. When
WaveStar® TDM 10G is initially powered on after
shipment from the factory, the lower
TMG/STRAT3 is the active circuit pack and the
upper TMG/STRAT3 is the standby circuit pack.
However, both circuit packs are of equal level and
protection switching is non-revertive, so there is no
default configuration.

(1-2) ppls1

LEY3

The PPROC/STS192 or PPROC/STS384 circuit
pack in this slot provides frame delay management
between the switch functions of the low speed part
of the shelf and the high speed part ((1-2) sw. 1).
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Slot
designation

Slot equipage

(1-2) pproce

LEY3

The PPROC/STS192 circuit pack in this slot
supports the STM64 port unit function assigned to
the eastern aggregate port. The CP is responsible
for pointer processing and synchronisation to the
system clock and for POH monitoring.
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Extension shelf configuration
....................................................................................................................................................................................................................................

Layout (front view) The following figure depicts the WaveStar® TDM 10G Extension
Shelf plug-in units and circuit pack slots (front view), including the
16 slots used for STM-1(o), STM-1(e), STM-4, STM-16, GE1/SX2 or
GE1/LX2 (Gigabit Ethernet) tributary port units. The minimum
required circuit packs are highlighted.

The following table lists all possible tributary port units.

Port unit
with

Apparatus
Code

Description

STM-16 LEY7 OC48/STM16/1.3LR1

LEY307 OC48/STM16/1.3LR1

LEY8 OC48/STM16/1.5LR1

LEY308 OC48/STM16/1.5LR1

LEY50–65 OC48/STM16/DWDM01–16

LEY101–180 OC48/STM16/WDM9585–9190

LEY182 OC48/STM16/1.3SR1

GE1/SX2 LEY309 1 Gigabit Ethernet

GE1/LX2 LEY310 1 Gigabit Ethernet

STM-4 LEY13 OC12/STM4/1.3LR2

LEY14 OC12/STM4/1.3SR2

LEY190 OC12/STM4/1.5LR2
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Port unit
with

Apparatus
Code

Description

STM-1o LEY15 OC3/STM1/1.3LR4

LEY16 OC3/STM1/1.3SR4

LEY23 OC3/STM1/1.3SR8

STM-1e LEY44 STM1E/4

Circuit pack slot equipage The following table identifies the circuit packs used in the WaveStar®
TDM 10G.

Slot
designation

Slot equipage

01 to 16

STM1e:

LEY40

STM1o:

LEY16

STM4:

LEY13, 14,
190

STM16:

LEY7, 8,
101–180, 182,
307, 308

Any mix of transmission interface circuit packs:

• STM-1(e) port units (STM1EE4/4)

• STM-1(o) port units (STM1)

• STM-4 port units (STM4)

• STM-16 port units (STM16).

Each of the STM-16 port units as well as the 1
Gigabit Ethernet circuit pack GE1/SX
(LEY309) requires two slots. Allowed slots are:
02, 04, 06, 08, 10, 12, 14, 16.

switch0

LEY4

Fabric switch 0. A SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. A SWITCH/STS768
circuit pack in this slot can make cross-connections
for 256 STM-1 equivalent circuits. This switch is
paired with fabric switch 1 in a 1+1 non-revertive
protection mode configuration.

ctlmem0

LEY10B

The CTL/SYS50DM circuit pack in this slot is the
working controller for the shelf. It can be used for
CIT and EMS connections. Furthermore it collects
all alarms and signals them on the User Panel and
the office alarm interface.
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Slot
designation

Slot equipage

dccei

LEY1

Adjunct controller, DCC and external interface.
The ADJCTL/DCC32EI circuit pack in this slot
terminates up to 32 data communications channels
and interfaces them to the shelf 10Base-T LAN.

If Orderwire support is required, use LEY301
instead.

ctlmem1 The slot is left empty for the current release of
WaveStar® TDM 10G.

tmg1, tmg0

LLY2

Two half-height Stratum 3 timing generator circuit
packs are located one above the other in this slot.
They are slave TMGs. Their function is to
distribute the system clock from the active master
TMG (Main Shelf) to the circuit packs in the
Expansion Shelf. When WaveStar® TDM 10G is
initially powered on after shipment from the
factory, the lower TMG/STRAT3 is the active
circuit pack and the upper TMG/STRAT3 is the
standby circuit pack. However, both circuit packs
are of equal level and protection switching is
non-revertive, so there is no default configuration.

switch1

LEY4

Fabric switch 1. A SWITCH/STS576 circuit pack
in this slot can make cross-connections for 192
STM-1 equivalent circuits. A SWITCH/STS768
circuit pack in this slot can make cross-connections
for 256 STM-1 equivalent circuits. This switch is
paired with fabric switch 0 in a 1+1 non-revertive
protection mode configuration.

Extension shelf configuration Equipment provisioning concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 9 - 1 5



Overview of access identifiers
....................................................................................................................................................................................................................................

Overview Access identifiers (AIDs) are used for addressing particular
components within a WaveStar® TDM 10G (STM-64) system, like a
shelf, circuit pack, slot or port, for example. An AID is case
insensitive, but AID values are usually given in lower case.

Hierarchical structure AIDs are hierarchically structured. The following table provides an
overview of the general AID structure by presenting some examples.

Entity Format Example

Network element bay (synonym for ″rack″) 1

Shelf bay-shelf 1-1

Protection group bay-shelf-protectiongroup 1-1-t01

Slot bay-shelf-#-#-slot 1-1-#-#-01

Circuit pack bay-shelf-#-#-slot-CP 1-1-#-#-01-cp

Port bay-shelf-#-#-slot-port 1-1-#-#-01-1

Tributary bay-shelf-#-#-slot-port-
trib

1-1-#-#-01-1-1

The network element entity refers to a logical unit which can be
composed of up to three shelves, high-speed shelf, low-speed shelf
and optional extension shelf. The extension shelf is physically located
in a different rack.

The “#” character serves as a placeholder if a particular AID field
cannot be specified, instead of leaving the field empty (see “General
AID structure” (9-16) below).

General AID structure The general AID structure is based on the assumption that there exists
a hierarchy associated with the system entities in the order of bay,
shelf, protection group, line/side, slot, port/circuit pack and tributary.
Therefore, the general structure consists of these entities separated by
“-”:

• bay-shelf-protection group-line/side-slot-port/circuit
pack-tributary

Some entities such as the system itself fall out of this hierarchy and
are handled separately.

An AID may not exceed 20 characters in length (including “-”).
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Simple and compound
AIDs

Access identifiers can be distinguished into simple and compound
AIDs. For example, “system”, “extref1”, “line1” or “exttmg0_out” are
simple AIDs. Compound AIDs follow the general AID structure given
in the previous paragraph.

Please refer to “Overview of AIDs” (9-17) for an overview of
WaveStar® TDM 10G (STM-64) AIDs.

The “all” AID entry Access identifiers allow for the specification of a range of entities by
using the term all. The all AID entry may be used in the bay, shelf,
slot, port, and tributary fields. It can neither be used in the protection
group field nor in the side/line field.

Important! If all is used in the bay and/or shelf AID fields, it cannot
be used in any other AID fields.

Overview of AIDs The following table gives an overview of the access identifiers
defined for WaveStar® TDM 10G (STM-64). If there are several
values possible for an entry, they are given in curly braces ({ }).

Entity Access Identifier

System

system system

system switch group esysswitchgrp

Bay

Bay with Main Shelf and
optionally one Extension Shelf

1

I/O Bay 2

Shelf

Main Shelf (low speed part) 1-1

Main Shelf (high speed part) 1-2

Extension Shelf {1..2}-{1..3}

Protection Group

1+1 Facility Protection Group {1..2}-{1..3}-o{01..99, all}

1:N Facility Protection Group {1..2}-{1..3}-n{01..99, all}

2-fiber MS-SPRing Facility
Protection Group

{1..2}-{1..3}-t{01..99, all}

1+1 Timing Equipment
Protection Group

{1..2}-{1..3}-etmggrp
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Entity Access Identifier

1+1 DCC Equipment
Protection Group (DCC and
DCCEI)

{1..2}-{1..3}-edccgrp

1:N Equipment Protection
Group (STM1EE4)

{1..2}-{1..3}-stm1ee4grp

1+1 ctlmem Group {1..2}-{1..3}-esysctlgrp

Side/Line

2-fiber MS-SPRing Facility
Protection Group East/West
Side

{1..2}-{1..3}-t{01..99}-{e,w}

Note: {e,w} stands for east or west
side.

Slot

All slots of a specified shelf {1..2}-{1..3}-#-#-all

Main Shelf - low speed part

port card slot

1-1-#-#-{01..16}

Main Shelf - low speed part

stm1(e) slot

1-1-#-#-{01..16}

Main Shelf - low speed part

OC-3/STM-1 slot

1-1-#-#-{01..16}

Main Shelf - low speed part

OC-12/STM-4 slot

1-1-#-#-{01..16

Main Shelf - low speed part

OC-48/STM-16 slot

1-1-#-#-{02, 04, 06, 08, ..14, 16}

Main Shelf - low speed part

electrical protection pack slot

1-1-#-#-eprn

Main Shelf - low speed part

electrical protection switch
pack slot

1-1-#-#-eprotsw

Main Shelf - low speed part

(576) switch0 slot

1-1-#-#-switch0

Main Shelf - low speed part

ctlmem0 slot (for shelf
controller)

1-1-#-#-ctlmem0

Main Shelf - low speed part

dccei slot

1-1-#-#-dccei
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Entity Access Identifier

Main Shelf - low speed part

ctlmem1 slot (for shelf
controller)

1-1-#-#-ctlmem1

Main Shelf - low speed part

tmg0 slot

1-1-#-#-tmg0

Main Shelf - low speed part

tmg1 slot

1-1-#-#-tmg1

Main Shelf - low speed part

(576) switch1 slot

1-1-#-#-switch1

Main Shelf - low speed part
Gigabit Ethernet slot

1-1-#-#-{02,04,06,08,...14,16}

Main Shelf - high speed part

trw slot

1-2-#-#-trw

Main Shelf - high speed part

tre slot

1-2-#-#-tre

Main Shelf - high speed part

oaw slot

1-2-#-#-oaw

Main Shelf - high speed part

oae slot

1-2-#-#-oae

Main Shelf - high speed part

pprocw slot

1-2-#-#-pprocw

Main Shelf - high speed part

switch 0 slot

1-2-#-#-switch0

Main Shelf - high speed part

pproc 0 slot

1-2-#-#-pproc0

Main Shelf - high speed part

dccei slot

1-2-#-#-dccei

Main Shelf - high speed part

ctlmem 0 slot

1-2-#-#-ctlmem0

Main Shelf - high speed part

ctlmem 1 slot

1-2-#-#-ctlmem1

Main Shelf - high speed part

tmg0 slot

1-2-#-#-tmg0

Main Shelf - high speed part

tmg1 slot

1-2-#-#-tmg1
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Entity Access Identifier

Main Shelf - high speed part

pproc 1 slot

1-2-#-#-pproc1

Main Shelf - high speed part

switch 1 slot

1-2-#-#-switch1

Main Shelf - high speed part

pproce slot

1-2-#-#-pproce

Extension Shelf

Port unit slot

{1..2}-{1..3}-#-#-{01-16}

Extension Shelf

stm1(e) slot

{1..2}-{1..3}-#-#-{01..06, 11-16}

Extension Shelf

OC-3/STM-1 slot

{1..2}-{1..3}-#-#-{01..16}

Extension Shelf

OC-48/STM-16 slot

{1..2}-{1..3}-#-#-{02, 04, 06, 08,
..14, 16}

Extension Shelf

(576) switch0 slot

{1..2}-{1..3}-#-#-switch0

Extension Shelf

ctlmem0 slot (for shelf
controller)

{1..2}-{1..3}-#-#-ctlmem0

Extension Shelf

dccei slot

{1..2}-{1..3}-#-#-dccei

Extension Shelf

ctlmem1 slot (for shelf
controller)

{1..2}-{1..3}-#-#-ctlmem1

Extension Shelf

tmg0 slot

{1..2}-{1..3}-#-#-tmg0

Extension Shelf

tmg1 slot

{1..2}-{1..3}-#-#-tmg1

Extension Shelf

(576) switch1 slot

{1..2}-{1..3}-#-#-switch1

Extension Shelf Gigabit
Ethernet

1-3-#-#-{01-16}{2-4}-{1-3}-#-#-{02,
04,06,08,...14,16}

Port

All the ports on a shelf {1..2}-{1..3}-#-#-all-all

STM1(e) port {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}
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Entity Access Identifier

OC-3/STM-1(o) port {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}

OC-12/STM-4 port {1..2}-{1..3}-#-#-{01..16}-{1..2,
all}

OC-48/STM-16 port {1..2}-{1..3}-#-#-{02, 04, 06, 08,
..14, 16}-{1,all}

OC-192/STM–64 port {1..2}-{1..3}-#-#-{tre,trw}-{1,all}

Electrical Port (unprotected) {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}

Optical Port (unprotected) {1..2}-{1..3}-u-#-{01..16}-{1..4,
all}

1+1 Port

(Port in a 1+1 facility
protection group)

{1..2}-{1..3}-o{01..99}-{w,p}-
{01..16}-{1..4,all}

{1..2}-{1..3}-o{01..99}-{w,p}-#-#

{1..2}-{1..3}-#-#-{01..16}-{1..4,
all}

Note: {w,p} stands for working or
protection side.

1:N Port

(Port in a 1:N facility
protection group)

{1..2}-{1..3}-n{01..99}-{1-n,p}-
{01..16}-{1..4,all}

{1..2}-{1..3}-n{01..99}-{1-n,p}-#-#

{1..2}-{1..3}-#-#-{01..16}-{1..4,
all}

Note: The ‘n’ in ‘1-n’ is the
number of lines in the 1:N
protection group. When a port is
added to a protection group, it is
assigned a line number. ‘p’ stands
for protection.

STM-16 2-fiber MS-SPRing
port

(Port in a 2-fiber MS-SPRing
facility protection group)

{1..2}-{1..3}-t{01..99}-{e,w}-{02,
04, 06, 08, ..14, 16}-{1,all}

{1..2}-{1..3}-t{01..99}-{e,w}-#-#

{1..2}-{1..3}-#-#-{02, 04, 06,
08,...14, 16}-{1,all}

Note: {e,w} stands for east or west
side.
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Entity Access Identifier

STM-64 2-fiber MS-SPRing
port

(Port in a 2-fiber MS-SPRing
facility protection group)

{1..2}-{1..3}-t{01..99}-{e,w}-{tre,
trw}-{1,all}

{1..2}-{1..3}-t{01..99}-{e,w}-#-#

{1..2}-{1..3}-#-#-{tre,trw}-{1,all}

Note: {e,w} stands for east or west
side.

Generic Gigabit Ethernet port 1-{1,3}-#-#-{02,04,06,08,...14,16}-
{1-2,all} {2-4}-{1-3}-#-#-{02,04,06,
08,...14,16}-{1-2,all}

Generic Gigabit Ethernet port
(VCG group)

1-{1,3}-#-#-{02,04,06,08,...14,16}-
v{1-2,all} {2-4}-{1-3}-#-#-{02,04,
06,08,...14,16}-v{1-2,all}

Tributary

All the tributaries on all the
ports on all the slots

{1..2}-{1..3}-#-#-all-all-all

STM1(e) tributary {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}-{1..3,all}

OC-3/STM-1(o) tributary {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}-{1..3,all}

OC-12/STM-4 tributary {1..2}-{1..3}-#-#-{01..16}-{1..2,
all}-{1..12,all}

OC-48/STM-16 tributary {1..2}-{1..3}-#-#-{02, 04, 06,
08,...14, 16}-{1,all}-{1..48,all}

OC-192/STM–64 tributary {1..2}-{1..3}-#-#-{tre,trw}-{1,all}-
{1..192,all}

Electrical tributary {1..2}-{1..3}-#-#-{01..16}-{1..4,
all}-{1..48,all}

Unprotected optical tributary {1..2}-{1..3}-u-#-{01..16}-{1..4,all}-
{1..48,all}

1+1 Optical tributary {1..2}-{1..3}-o{01..99}-{w,p}-
{01..16}-{1..4,all}-{1..48,all}

{1..2}-{1..3}-o{01..99}-{w,p}-#-#-
{1..48,all}

{1..2}-{1..3}-#-#-{01..16}-{1..4,
all}-{1..48,all}

Note: {w,p} stands for working or
protection side.
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Entity Access Identifier

1:N Electrical and optical
tributary

{1..2}-{1..3}-n{01..99}-{1..n,
p}-{01..16}-{1..4,all}-{1..48,all}

{1..2}-{1..3}-n{01..99}-{1..n,
p}-#-#-{1..48,all}

{1..2}-{1..3}-#-#-{01..16}-{1..4,
all}-{1..48,all}

Note: The ‘n’ in ‘1-n’ is the
number of lines in the 1:N
protection group. When a port is
added to a protection group, it is
assigned a line number. ‘p’ stands
for protection.

Generic Gigabit Ethernet port
VCG tributary

1-{1,3}-#-#-{02,04,06,08,...14,16}-
v{1-2,all}-{1-24,all}
{2-4}-{1-3}-#-#-{02,04,06,08,...14,
16}-v{1-2,all}-{1-24,all}

STM-16 2-fiber MS-SPRing
tributary

{1..2}-{1..3}-t{01..99}-{e,w}-{02,
04, 06, 08,...14, 16}-{1,all}-{1..48,
all}

{1..2}-{1..3}-t{01..99}-{e,w}-#-#-
{1..48,all}

{1..2}-{1..3}-#-#-{02, 04, 06,
08,...14, 16}-{1,all}-{1..48,all}

Note: {e,w} stands for east or west
side.

STM-64 2-fiber MS-SPRing
tributary

{1..2}-{1..3}-t{01..99}-{e,w}-{tre,
trw}-{1,all}-{1..192,all}

{1..2}-{1..3}-t{01..99}-{e,w}-#-#-
{1..192,all}

{1..2}-{1..3}-#-#-{tre,trw}-{1,all}-
{1..192,all}

Note: {e,w} stands for east or west
side.

Fans

Main Shelf Fan (low speed
part)

1-1-fan1

Main Shelf Fan (high speed
part)

1-2-fan1

Extension Shelf Fan {1..2}-{1..3}-fan1

External Timing References
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Entity Access Identifier

External Timing reference 1 extref1

External Timing reference 2 extref2

External Line Timing reference
1

line1

External Line Timing reference
2

line2

External Line Timing reference
3

line3

External Line Timing reference
4

line4

External Line Timing reference
5

line5

External Line Timing reference
6

line6

Timing Ports

External Timing Input Port 0 exttmg0

External Timing Input Port 1 exttmg1

External Timing Output Port 0 exttmg0_out

External Timing Output Port 1 exttmg1_out

Miscellaneous Discrete Inputs and Outputs

Miscellaneous Discrete Input misc_in{1..8}, misc_inall

Miscellaneous Discrete Output misc_out{1..8}, misc_inall
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Shelf provisioning
....................................................................................................................................................................................................................................

Introduction Shelf provisioning allows the user to configure parameters associated
with a specific shelf.

Parameters The following parameters can be viewed:

• Shelf AID

• ON Cable Identifier
The ON Cable Identifier is the Controller Address of a shelf for
the connection to the low-speed shelf which contains the main
controller for the whole network element. For the high-speed
shelf it is always 1. For the extension shelf it should be 2.

The following parameter can be set:

• Alarm Severity Assignment Profile.
An Alarm Severity Assignment Profile (ASAP) is a list of alarms
that can occur in an NE and which have each an alarm severity
assigned. Several ASAPs for different functional categories are
predefined for the WaveStar® TDM 10G system.

For the current release only the default Alarm Severity Assignment
Profile is available.
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Slot/circuit pack provisioning
....................................................................................................................................................................................................................................

Slot provisioning Slot provisioning allows the user to configure parameters associated
with a specific slot. This is a pre-provisioning measure for a future
upgrade of the system.

Parameter The Alarm Severity Assignment Profile can be selected.

For the current release only the default Alarm Severity Assignment
Profile is available.

Circuit pack provisioning Currently, no parameters concerning circuit pack provisioning can be
set. For future releases, Alarm Severity Assignment Profile (ASAP)
settings will be possible.

Parameters The following parameters can be set:

• Equipment Alarm Severity Assignment Profile

• System Event Alarm Severity Assignment Profile.

ASAPs An Alarm Severity Assignment Profile (ASAP) is a list of alarms that
can occur in an NE and which have each an alarm severity assigned.
Several ASAPs for different functional categories are predefined for
the WaveStar® TDM 10G system.
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Port and tributary provisioning
....................................................................................................................................................................................................................................

Introduction Lucent Technologies NEs can change the state of ports without
issuing a rept-dbchg message. WaveStar SNMS therefore cannot
detect these changes. To ensure that you receive an accurate list of
available Access Identifiers (AIDs) when selecting ports to provision,
first do a manual DNO (see “Manually Initiate DNO” (5-49)) for the
NE or NEs that you plan to provision.

Port aliases on GUI WaveStar® SNMS has an option which allows you to specify whether
port AIDs or port labels/aliases are used to represent ports on GUI
windows, such as in explorer lists on the Cross-Connection or
Provisioning windows. The port label/alias values must be unique for
all ports within an NE.

Cross-connections and the
port provisioning list

When cross-connections are added or deleted, the AID list in the port
provisioning window is not updated automatically. To ensure that the
AID list information is accurate, perform a manual DNO (see
“Manually Initiate DNO” (5-49)) on the NEs that have had
cross-connections added or deleted prior to any port provisioning.

Port configuration
discovery

There is generally a fixed relationship between circuit packs and their
number and type of ports. Upon discovery of an NE, for ports of a
fixed type, WaveStar® SNMS may automatically retrieve an NE’s
current set of ports and their type, or it may automatically retrieve an
NE’s current equipment and derive the set of ports and their type.
(This is the automatic discovery portion of DNO.) Deriving the port
information from the equipment is the preferred method. Regardless
of the method of obtaining the information, the system maintains the
ports and their type in its configuration management database.

For NEs managed via TL1, obtaining the port information directly
from the NE is done via TL1 RTRV- rrcommands (where rr represents
the various port types). For NEs managed using CMISE, the NE’s
current port configuration is obtained via CMISE M-GET commands.
The responses to these commands include the NE’s current ports and
their attributes.

Port configuration
provisioning

WaveStar® SNMS provides a GUI-based function to enable you to
select an NE and port or tributary, and view the current values of that
port’s or tributary’s attributes.
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Cut-Through commands
....................................................................................................................................................................................................................................

Introduction In order for the user to execute NE native commands that may not be
explicitly supported by a particular release of WaveStar SNMS, a
cut-through capability has been developed. In addition, with the
command builder and broadcaster, TL1 cut-through gives the user
powerful capabilities. See “Perform Cut-Through Commands” (2-10),
“Build TL1 Commands” (2-11), “Broadcast TL1 Commands” (2-13).

Two additional points to remember

• WaveStar SNMS allows the user access to only the NEs and
associated commands defined by the Target and Command
groups for which the user is validated.

• Not all TL1 commands displayed in the Cut-Through window
can be executed. The capability to execute commands depends on
the subnetwork equipment.

TL1 commands Instructions about actual TL1 commands can be found in WaveStar®
TDM 10G (STM-64) TL1 Reference Manual.

Initiating an NE
cut-through session

The NE Cut-Through window allows you to access and communicate
with an NE, using the TL1 command set. You can submit TL1
cut-through commands to the NE directly. (For specific NE command
information, see the appropriate NE documentation.)

Building TL1 commands The TL1 macro builder allows you to create a TL1 command file to
assist in performing maintenance and provisioning activities on one or
more NEs (such as download of standard configuration), without
having to manually enter a set of TL1 command strings. This feature
both reduces the amount of manual entry needed to create TL1
command strings and allows for the reuse, at a later time, of the
commands built on the same NE or other NEs of the same type.

Broadcasting TL1
commands to NEs

The broadcasting TL1 commands feature allows you to perform
maintenance and provisioning activities (such as download of standard
configuration) on one or more NEs, utilizing the TL1 command files
created by the TL1 macro builder feature, and broadcasting those files
to multiple NEs of the same type. This feature saves you time by
performing similar tasks on multiple NEs in one step, and by reducing
the manual entry required in the creation of TL1 command strings.
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Gigabit Ethernet (GE1/SX2) Interface
....................................................................................................................................................................................................................................

Introduction WaveStar® TDM 10G supports a Gigabit Ethernet (GE1/SX2)
interface. The GE1/SX2 interface conforms to the standards outlined
in IEEE 802.3, and supports the 1000BASE-SX protocol.

Capabilities The GE1/SX2 interface supported by the WaveStar® TDM 10G
allows you to transport GE1/SX2 signals over SDH networks by
encapsulating Ethernet packets in virtually concatenated VCs. The
GE1/SX2 interface supports point-to-point connectivity. Each
GE1/SX2 port unit offers two 1000BASE-SX Ethernet LAN ports.
Each port supports two bidirectional, Ethernet lines (one transmit and
one receive). Each line can be associated with a WAN link. The
capacity per Gigabit Ethernet line is user provisionable to a maximum
of 7 VC-4s. All connections to the 1000BASE-SX ethernet interface
on the GE1/SX2 port unit require Dual SC Connectors.

Virtual Concatenation VC-4 concatenation can be used for the transport of payloads that do
not fit efficiently into the standard set of virtual containers. Two
methods for concatenation are defined, contiguous and virtual
concatenation. Both methods provide concatenated bandwith of X
times Container-N at the path termination. The difference is the
transport between the path termination. Contiguous concatenation
maintains the contiguous bandwidth throughout the whole transport. It
requires concatenation functionality at each network element. Virtual
concatenation breaks the contiguous bandwidth into individual VCs,
transports these VCs and recombines them to a contiguous
functionality only at the path termination equipment i.e. the GE1/SX2
Gigabit Ethernet port unit.

The H4 POH byte is used for the sequence and multiframe indication
specific for virtual concatenation.

Due to different propagation delay of the VC-4s a differential delay
will occur between the individual VC-4s. This differential delay has to
be compensated and the individual VC-4s have to be realigned for

10G NE10G NE

WANWAN LANLAN

EthernetEthernet

frameframe

VC-4-7V (max.)VC-4-7V (max.) VC-4

VC-4

VC-4

VC-4

VC-4

VC-4
VC-4
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access to the contiguous payload area. The realignment process covers
at least a differential delay of 125 µs.

Point-to-point connectivity The following figure shows a point-to-point Gigabit Ethernet (GbE)
network application. Protection of the VC-4-Xv traffic is possible via
SNCP and MS-SPRing protection schemes.
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Equipment Configuration
....................................................................................................................................................................................................................................

Introduction The equipment window gives a set of hierarchically arranged
equipment views. The shelf view is the lowest level view. There may
also be a system view and a bay/line-up view, depending on how
large and complex the NE is. The Equipment Configuration window
also allows you to “drill down” into the NE equipment hierarchy.

Unknown equipment If WaveStar SNMS does not recognize a circuit pack on the requested
shelf, the window shows that slot filled with unknown equipment.
Circuit packs may not be recognized when the vendor firmware is
nonstandard or when the board is a new release that is not yet
supported.

Equipment discovery and
inventory maintenance

Upon discovery of an NE, WaveStar SNMS automatically retrieves an
NE’s current equipment configuration and maintains this information
in its database. This is the automatic discovery portion of DNO. An
NE’s equipment includes any item that it is able to report; for
example, bays, shelves, and circuit packs. For network elements
managed via TL1, the network element’s current equipment
configuration is obtained through TL1 RTRV-EQPT commands.

Equipment graphical
display

To graphically depict the varying NE types effectively, WaveStar
SNMS decomposes them into different numbers of hierarchically
arranged graphical displays.

Alarm status on equipment
display

WaveStar SNMS indicates whether an alarm has been generated by a
bay, shelf, or slot (circuit pack) in the NE on the graphical display of
equipment, and what level of alarm it is.

On the Equipment View window, a round dot is displayed on the
selected piece of equipment with the color indicating the alarm state.
The color of the dot indicates the level of alarm that has been issued
by the selected equipment component, or if there have been no alarms
issued.

The default colors for the alarm levels are:

Alarm Color
(default)

Alarm Severity Level
(SONET)

Alarm Severity Level
(SDH)

Red Critical Prompt

Yellow Major Deferred

Cyan Minor

Gray Throttled

Equipment provisioning concepts
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Green No Active Alarms

Magenta Loss of
Communications

White Not Alarmed state Not Alarmed state

The default Alarm display colors shown in the above table can be
modified through the Preferences option of the View menu on the
Map window main menu bar. For more details, see “Map preferences”
(14-33).

Equipment Configuration Equipment provisioning concepts
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Date/Time Synchronization
....................................................................................................................................................................................................................................

Introduction Periods of time when an NE is out of service, as during a software
upgrade, can cause the NE’s date/time setting to be out of sync with
the WaveStar SNMS host and the other NEs in the network. Lack of
date/time synchronization can create problems in determining the
order in which alarms occurred on the network.

WaveStar SNMS uses the Network Time Protocol (NTP) to ensure the
accuracy of its internal clock. WaveStar SNMS, in turn, provides
centralized remote date/time synchronization between its internal clock
and those of its managed NEs. Synchronization can be performed on a
single NE, on an aggregate of NEs, or on all of the NEs in a user’s
Target Group. Synchronization can be performed on demand or set up
on a periodic schedule using the SNMS Scheduler. The transition from
standard time to daylight savings time is also supported as a user
selected option.

NE time zone As part of the date/time synchronization feature, WaveStar SNMS can
take into account whether the NE is located in a different time zone
from the system host.

Standard time and daylight
savings time

You can use the Spring Forward/Fall Back option to have WaveStar
SNMS automatically make time adjustments for Daylight Savings
Time (Spring Forward) and standard time (Fall Back) when doing
date/time synchronization for an NE, a group of NEs, an aggregate, or
all NEs under system control, 20 NEs at a time or more, depending
on system load. The Spring Forward/Fall Back option can be enabled
or disabled, as needed. This option is enabled, by default. If the
option is disabled for an NE, the NE’s time is always set to standard
time.

The Spring Forward/Fall Back option should be set by the system
administrator.

Ways to perform date/time
synchronization

NE Date/time synchronization can be performed in three ways:

• Scheduled – NE date/time synchronization can be scheduled to
be performed on a daily, weekly, or monthly basis. A scheduled
date/time synchronization will only be done if the time difference
between the NE and the system host is more than 15 seconds.

• Automatically – You can have the system automatically perform
date/time synchronization on an NE when it is manually added or
autodiscovered by the system, or when communications between
the NE and the system host are lost and then regained. Automatic
date/time synchronization will be performed on an NE only if the

Equipment provisioning concepts
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time difference between the NE and system host is more than 15
seconds, or the drift threshold set via the Set Date/Time
Synchronization Drift window. The drift threshold is the
maximum time difference allowed (in seconds) between the NE
and the EMS host before date/time synchronization is performed
automatically. Automatic date/time synchronization can be
enabled or disabled; the default is enabled.
Automatic date/time synchronization should be enabled/disabled
by the WaveStar SNMS system administrator or a user with a
privileged login.

• Manually – Date/time synchronization can be performed on
demand for an NE, a group of NEs, an aggregate, or all NEs
under system control, up to 20 NEs at a time or more, depending
on system load.

Date/Time Synchronization Equipment provisioning concepts
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Miscellaneous Discrete Inputs and Outputs
....................................................................................................................................................................................................................................

Introduction The WaveStar® TDM 10G provides 8 input and 8 outputs which can
be used for the supervision and control of external devices.

Description The miscellaneous discrete inputs (MDIs) and outputs (MDOs) allow
the user to control and monitor equipment co-located with the
WaveStar ™ TDM 10G through a set of input and output relay contact
closures. There are 8 miscellaneous inputs that can monitor conditions
such as open doors or high temperature, and 8 miscellaneous discrete
outputs to control equipment such as fans and generators. These can
be set by the user.

The status of the miscellaneous discrete inputs can be configured and
queried from the WaveStar ™ CIT. The WaveStar® TDM 10G collects
miscellaneous discrete alarms and automatically sends them to the OS.

Equipment provisioning concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 9 - 3 5





10 Timing provisioning concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes the timing features WaveStar® TDM 10G
(STM-64) provides.

WaveStar® TDM 10G synchronizes all incoming and outgoing signals
to one timing source which is normally locked to an external
reference signal. This reference signal is configurable. Various signals
can be used as a timing reference signal. Furthermore WaveStar®
TDM 10G provides different clock modes (see “Clock modes”
(10-2)). Clock protection can also be established by using two timing
generator circuit packs within one shelf.

More detailed information on the timing concept is given in the
section “Synchronization” in the WaveStar® TDM 10G (STM-64)
Applications, Planning, and Ordering Guide, chapter 4, “Product
Description”.

Contents
Timing generator 10-2

Timing configuration 10-3

Timing quality 10-4

Timing protection 10-6

Parameters of the “ViewSync” and “ConfigSync”
windows

10-8
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Timing generator
....................................................................................................................................................................................................................................

Function of the timing
generator

WaveStar® TDM 10G synchronizes all add, drop and through signals
by using one timing source. The timing is ensured by the
TMG/STRAT 3 circuit packs which generate one common internal
clock. The master timing generator for all configurations is located in
the low-speed part of the Main Shelf. The output clock signals of the
slave timing generators in the high-speed part of the Main Shelf and,
if any, in the Extension Shelf, are coupled to the output clock of the
master.

The timing generator and the clock distribution within the network
elements is described in more detail in the section “Synchronization”
in the WaveStar® TDM 10G (STM-64) Applications, Planning, and
Ordering Guide, chapter 4, “Product Description”.

Clock modes The WaveStar® TDM 10G timing generator circuit packs can run in
the following clock modes:

• Free-running operation
The active timing generator circuit pack is not locked to an
external timing reference, but the standby timing generator is
locked to the active one.

• Holdover mode
The active timing generator circuit pack enters the holdover
mode if all timing reference signals fail. The active timing
generator keeps its internal oscillator at the point at which it was
synchronized to the last known good reference signal. The
standby timing generator remains locked to the active one.

• Locked mode, internal SDH Equipment Clock (SEC) locked to:

- One of the two external netclock inputs (2048 kHz or
2048 kbit/s)

- One STM-64 line input (choice of input is provisionable)

- Up to six line inputs STM1, STM4, STM16 or STM64 are
possible, if they are only even slots, only on first port, max.
4 lines in HS and max 4 lines in LS, not referenced from
expansion shelfs and only worker port of 1+1 MSP group.
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Timing configuration
....................................................................................................................................................................................................................................

Querying timing
configuration

The WaveStar® SNMS allows you to query the timing configuration
of the WaveStar® TDM 10G (STM-64). Please refer to “Viewing the
timing configuration” (4-2).

Timing configuration In the Configuration → Synchronization → Configure... menu it is
possible to change the timing configuration.

This includes:

• the configuration of the external timing input ports (cf.
“Configuring the external timing input ports” (4-4))

• the configuration of the external output port (cf. “Configuring the
external timing output ports” (4-6))

• the selection and configuration of the timing references (cf.
“Configuring the timing references” (4-9))

• the configuration of the system timing, this means the
configuration of the master timing generator (cf. “Configuring the
system timing” (4-11))

Timing provisioning concepts
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Timing quality
....................................................................................................................................................................................................................................

Timing marker The timing quality of all SDH data signals is coded in the timing
marker (Synchronization Status Marker, SSM) as per ITU-T Rec.
G.783 and G.707. The timing marker is located in the lower four bits
of the S1 byte of the STM-N signal SOH.

The bit combinations are listed in the following table. The remaining
combinations are interpreted as “invalid”.

S1 Bits Quality level

0010 Primary Reference Clock

0100 SSU Transit Node Traceable

1000 SSU Local Node Traceable

1011 SDH Equipment Clock Traceable

1111 Do not use for Synchronization (DUS)

The quality level “DUS” is inserted if AIS, LOS or LOF is detected
in the incoming signal. Insertion of “DUS” in an outgoing timing
signal can also be configured by the operator in order to avoid timing
loops in the network.

SSM of lower quality than
the internal system clock

If the SSM of a reference clock source indicates a lower quality than
the internal clock (SEC), this reference is considered to be failed and
the system switches to the reference with the highest quality (above
SEC), if SSM is enabled.

The selection criteria are:

• signals which are not locked out and have their priority not
disabled

• signals with highest quality

• if there is more than one signal with highest quality the one with
the priority is selected

• if there is more than one signal with highest priority one of those
is chossen randomly.

When all assigned references are considered to be failed, the system
enters the holdover mode.

No SSM available As long as no SSM value has been accepted and evaluated at STM-N
interfaces, DUS is assumed. This also applies at the initial system
start-up.
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SSM for 2048 kbit/s
synchronization signals

WaveStar® TDM 10G supports the interpretation and generation of
SSM values for framed 2048 kbit/s timing input and output ports
(“G.703.9 ports”). The coding conforms to ITU-T Rec. G.704. One set
of the Sa4 to Sa8 bits can be allocated for the Synchronization Status
Marker (SSM). The message set is similar to the SSM messages
defined for bits 5 to 8 of the byte S1 belonging to an SDH signal.

User operation You can define whether the SSM is evaluated for the selection of the
timing reference from which the system timing is derived.
Furthermore, you can define the quality level of the outgoing timing
signal.

Timing quality Timing provisioning concepts
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Timing protection
....................................................................................................................................................................................................................................

Timing reference
protection switching

During configuration of the timing references, a priority list is created
for the configured timing reference signals. The signal with the
highest priority is initially used as the timing reference signal. If it
fails, the system switches to the signal with the next lower priority. If
all possible timing reference signals fail, the timing generator enters
the holdover mode.

The following signals can be used as a timing reference:

• 2 external netclock input signals (2048 kHz or 2048 kbit/s acc. to
G.703)

• Up to six line inputs STM1, STM4, STM16 or STM64 are
possible, if they are only even slots, only on first port, max. 4
lines in HS and max 4 lines in LS, not referenced from
expansion shelfs and only worker port of 1+1 MSP group.

The following alarms cause a protection switch from a G.703 2048
kbit/s signal to another timing reference signal (acc. to the priority
list):

• SSF (Server Signal Fail)

- LOS (Loss of Signal)

- AIS (Alarm Indication Signal)

- LOF (Loss of Frame)

- LOM (Loss of Multiframe)

• DFF (Defect Frequency Fail)

The following alarm causes a protection switch from a G.703 2048
kHz signal to another timing reference signal (acc. to the priority list):

• Loss of Signal

The following alarms and fault criteria cause a protection switch from
an SDH signal to another timing reference signal (acc. to the priority
list):

• LOS

• AIS

• LOF

• LOM

• EXC (Excessive Bit Error Ratio)

Timing provisioning concepts
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Timing equipment
protection switching

There are two timing circuit packs TMG 0 and TMG 1 in the
high-speed part and two in the low-speed part of each network
element. Thus there are four timing circuit packs in each main shelf.
Furthermore, there are two timing circuit packs in each extension
shelf.

When two timing circuit packs are present the timing is derived from
one circuit pack, called the active timing circuit pack. The other
timing circuit pack is standby. It is locked to the active clock and
produces a timing signal, which is not used, unless the active timing
circuit pack fails.

For the initial start-up of the system and initial provisioning of the
1+1 protection group, the default state of operation is TMG 0 as the
active timing circuit pack. For the system reset after the 1+1
protection was in operation, the system restores the timing circuit
pack as the active one which was active before the system reset
operation.

Wait-to-restore time The timing reference protection is working in a revertive mode (only
if the signal after the WTR is selected highest quality and highest
priority). If a timing reference is restored the system has to make a
wait for a defined time (wait-to-restore time, WTR) to see whether the
signal is stable, before the system switches back to it. There is no
protection switch if the system clock already was on reference with
the same qualification.

Timing protection Timing provisioning concepts
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Parameters of the “ViewSync” and “ConfigSync” windows
....................................................................................................................................................................................................................................

Overview The ViewSync and ConfigSync windows contain four tabs:

• Ext Timing I/P Ports

• Ext Timing O/P Ports

• Timing Reference

• System Timing

The corresponding parameters are described as follows.

Buttons The displayed data can be refreshed via the Refresh button. Close
closes the window. The seleced data can be applied via the Apply
button and the online help can be displayed via Help.

The Ext Timing I/P Ports
tab

The following table gives an overview of the parameters in the Ext
Timing I/P Ports tab.

Field Possible values Meaning

External Timing Port
AID

EXTTMG0, EXTTMG1 This parameter defines the Access Identifier
(AID) of the external timing input ports.

Timing Input Format 2 MHz, 2 Mbit/s -
framed, 2 Mbit/s -
unframed

This parameter defines the format of the
incoming timing signal.

QL In - Output Timing
Port

DNU, PRC, SSUT,
SSUL, SEC, Invalid

This parameter displays the quality of the
incoming timing signal.

The External Timing
Output Ports tab

The following table gives an overview of the Ext Timing O/P Ports
tab.

Field Possible values Meaning

Ext. Timing Output
Port AID

exttmg0_out This field displays data on the timing output
port (exttmg0_out).

Timing Output
Format

2 MHz, 2 Mbit/s -
framed, 2 Mbit/s -
unframed

This parameter shows the signal format of the
outgoing timing signal.

Derived Output
Timing Enable

ENABLE, DISABLE This parameter shows whether a timing signal
is derived from the system clock and
forwarded to the output port.

Derived Output
Timing Source

TLS The external timing signal is derived rom one
of the six line timing references

SETG The timing output is derived from the system
clock

Timing provisioning concepts
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Output Signal Status NORMAL, DISABLE,
UNACCEPTABLE

This parameter describes the status of the
outgoing timing signal.

QL Out - Output
Timing Port

DNU, PRC, SSUT, SSUL,
SEC

This parameter indicates the quality lever for
the output timing port.

Timing Port
Impedance

75, 120 This parameter displays the impedance of the
external timing input and output ports.

Sync Msg Force DUS
Enable

ENABLE, DISABLE This parameter defines whether DUS is
inserted in the outgoing timing signal.

AIS/QL Mode AISMODE, QLMODE AIS (AISMODE) or DNU/DUS (QLMODE) is
sent when the signal quality level is below the
value set.

Timing Regen Loop
Enable

This parameter indicates that a timing loop
may be present from the timing output to one
or both of the timing inputs through a
Stand-Alone Synchronization Equipment
(SASE) Office Clock. This might happen, if
the NE forwards timing to the SASE and the
same time receives a timing signal via one or
both of the external timing input ports. If
additionally the system clock is in the Locked
Mode and derived from an external timing
signal, DNU is forwarded to the timing
outputs.

DISABLE The Regenerator Loop functionality is
disabled. Timing loops are not considered.

EXTREF1 If the quality level of the incoming framed 2
Mbit/s timing signal at the exttmg0 input is
equal to the quality level of the timing signal
that is transmitted to the external timing output
ports, DNU is inserted for the outgoing timing
signal as the NE assumes that a timing loop is
present.

EXTREF2 If the quality level of the incoming framed 2
Mbit/s timing signal at the exttmg1 input is
equal to the quality level of the timing signal
that is transmitted to the external timing output
ports, DNU is inserted for the outgoing timing
signal as the NE assumes that a timing loop is
present.

BOTH The Regenerator Loop functionality is applied
to both external timing inputs.

Loop Delay 1, 2, ... 60 Delay during which DNU is maintained after
the Regnerator Loop conditions are no longer
present.

Parameters of the “ViewSync” and
“ConfigSync” windows
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Acceptance QL PRC, SSUT, SSUL, SEC This parameter defines the quality level of the
derived timing output signal below which AIS
is inserted (in a framed 2 Mbit/s signal) or
squelched respectively (2 MHz or unframed 2
Mbit/s signals).

The Timing Reference tab The Timing Reference tab displays data on the configured timing
reference source.

Active Timing Reference In the System Timing Reference group box, the Timing Reference
information field displays the reference timing signal which is
currently selected. The timing reference is an external signal to which
the internal SDH Equipment Clock (SEC) is locked.

The following signals can be used as timing reference:

• 2 external net clock input signals (2048 kHz or 2048 kbit/s acc.
to G.703)

• 6 reference signals derived from the incoming STM-16, STM-4
or STM-1 tributary signals or the incoming STM-64 line signals.

Thus the following values can be displayed:

• extref1 or extref2 for the external net clock input signals

• line1 to line6 for the SDH signals

Settings The table on the Timing Reference tab in the ViewSync window gives
an overview of the possible settings of the timing references.

Column Possible values Meaning

Active — The currently active timing reference is marked.

Timing
Reference

EXTREF1, EXTREF2 Logical designation of the external timing reference
signals

LINE1, ..., LINE6 Designation of the SDH timing reference

Port AID EXTTMG0, EXTTMG1 An external net clock input signal is used as timing
reference

NOT-CONNECTED The respective timing reference source is not used

<port AID of an SDH
timing reference>

The respective SDH timing reference signal is used as
timing reference

Reference
Priority

DISABLE (initial
value),

1, 2,3, ..., 8

Configured priority of the timing reference signals

Parameters of the “ViewSync” and
“ConfigSync” windows
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Column Possible values Meaning

Signal Status NORMAL The timing reference signal is fault-free.

FAILED The timing reference signal failed.

WAIT-TO- RESTORE The timing reference signal has been failed and is now
restored. A wait is made for a defined time
(wait-to-restore time) to see whether the signal is
stable, before the system switches back to it.

NOT-CONNECTED The timing reference is not used.

Lockout Status LOCKOUT The clock protection is deactivated

NO-LOCKOUT The clock protection is activated

Output Priority DISABLE, 1 ... 6 This parameter defines the priority according to which
the reference for the timing output signal is selected.
DISABLE indicates that the reference is not used.

Timing Ref QL AUTO, PRC, SSUT,
SSUL, SEC

This parameter shows the synchronization messaging
quality level value for timing references. This is the
value which is forwarded to the timing output ports.

Input QL Status DUS, PRC, SSUT,
SSUL, SEC

This shows the synchronization messageing quality
level value for timing references. This is the value
which is forwarded to the timing input ports.

Timing Ref List VALID, INVALID,
NOT-SUPPORTED,
NOT-APPLICABLE

This parameter shows the synchronization messageing
quality level status for the timing reference.

Clock O/T
Lockout State

LOCKOUT,
NO-LOCKOUT

This parameter shows whether a certain timing
reference is locked out as reference from which the
timing output signal can be derived.

Only one of the timing references at a time can be selected as the
active one.

The System Timing tab The System Timing tab on the ViewSync window displays data on the
internal SDH Equipment Clock (SEC).

Description The tab consists of three group boxes Synchronization Signal, Clock
and System Timing Reference.

The Synchronization
Signal group box

The following table lists the information fields of the Synchronization
Signal group box, the possible values and their meaning.

Information
field

Possible values Meaning

System Quality
Level Status

PRC, SSUT, SSUL, SEC, DUS The current quality level of the system clock.

Parameters of the “ViewSync” and
“ConfigSync” windows

Timing provisioning concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 0 - 1 1



Information
field

Possible values Meaning

System Timing
Signal Status

NORMAL The system clock works correctly.

Failed The system clock has failed.

Stratum Level
Status

SEC Timing quality of the internal equipment clock
acc. to ITU-T Rec. G.813.

Acceptance QL SEC, PRC, SSUT, SSUL. This parameter defines the quality level of the
derived timing output signal below which AIS is
inserted (in a framed 2 Mbit/s signal) or
squelched respectively (2 MHz or unframed
2–Mbit/s signals). .

The Clock group box The following table lists the information fields of the Clock group
box, the possible values and their meaning.

Information field Possible value Meaning

Provisioned Clock
Mode

FREE- RUNNING
(initial value)

For the internal timing generator the Free
Running Mode is selected. It is not locked to an
external timing reference signal. The system
clock is generated by an internal oscilllator.

LOCKED The Locked Mode is selected. The internal timing
generator is locked to an external timing
reference signal.

System Clock Mode
Status

FREE-RUNNING
(initial value)

The internal timing generator is not locked to an
external timing reference signal. The system
clock is generated by an internal oscillator.

HOLDOVER The current operating system clock mode is the
holdover mode. The active timing generator
enters the holdover mode if all timing reference
signals fail. In the holdover mode, the active
timing generator keeps its internal Stratum 3
clock at the point at which it was synchronized to
the last known good reference signal.

LOCKED The internal timing generator is locked to an
external timing reference signal.

System Clock Switch
Request State

FORCED–HOLD-
OVER

A forced switch to the holdover mode has been
carried out.

ALL-REFERENCES-
FAILED

All external timing reference signals failed.

NO-REQUEST No switch request is currently active.

Parameters of the “ViewSync” and
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Information field Possible value Meaning

Fast Start Status NORMAL Fixed value.

FAST-START This is an attribute of the timing pack hardware
design. It is used when fast pull-in of the clock is
necessary.

Warm Up Status NORMAL The timing circuit pack works normally.

WARMING-UP After a timing circuit pack has been plugged into
the shelf, a warm-up period of 5 minutes has to
pass before the circuit pack is operational. This is
displayed via this message.

The System Timing
Reference group box

The following table lists the information fields of the System Timing
Reference group box , the possible values and their meaning.

Information field Possible values Meaning

System Timing ASAP Default This parameter sets a timing Alarm Severity
Assignment Profile (ASAP) name to which the
system timing points. This is an alphanumerical
string with a maximum of 24 characters

System SSM Mode DISABLE, ENABLE The use of SSM information is disabled or
enabled. This means that the selection of timing
reference for the system timing is either
determined only by the provisioned priority list
or by the quality level given by the SSM and
secondly by the priority list.

Switch Request State NO-REQUEST,
MANUAL, FORCED

Value of the Switch Request activated by the
user or initiated by the system.

Timing Reference Wait
To Restore

0, 20 Seconds, 1
Minute,2 Minutes... 60
Minutes, infinite

Selected value of the wait-to-restore time which
has to pass before the system switches to another
timing reference signal.

Active Output Timing
Reference

EXTREF1, EXTREF2,
LINE1 ... LINE6

Shows which external reference signal is used,
either one of the external clock input signal or
one of the SDH signals.

Output Timing
Reference

MANUAL, FORCED
WAIT-TO-RESTORE,
NO-REQUEST

Value of the Switch Request activated by the
user or initiated by the system.

Parameters of the “ViewSync” and
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11 Traffic provisioning concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides you with information about traffic provisioning.
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Cross-Connections
....................................................................................................................................................................................................................................

Introduction WaveStar SNMS provides a graphical means of viewing and
provisioning NE cross-connections via the Cross-Connection window.
This window is designed to display connection termination points and
cross-connections for a selected NE. This section provides information
about cross-connection functionality and the Cross-Connection
window.

The Cross-Connection
window

The Cross-Connection window provides the user with access to all
cross-connection features. It contains an interface tailored to the large,
modern cross-connection fabrics now supported by the system. The
window for instructions on displaying the Cross-Connection window)
consists of a menu bar, a toolbar, a status bar, a net work element
explorer, and a main view. The main view area is further broken down
into four (or eight) port areas. This window is used for all
cross-connection operations, including viewing, adding, modifying,
and deleting cross-connections.

Toolbar The Cross-Connection window contains a toolbar (at the upper left)
that contains a series of buttons used for specifying different types of
cross-connections or tributary reservations. If you are unsure of the
operation that a certain toolbar button will perform, point at it with
the cursor and after 2 seconds a tooltip is displayed, showing the
operation of that button. This information is also displayed in the
status bar.

The following graphic shows the toolbar.

The toolbar contains the following buttons (from left to right):

• 10 buttons for different types of cross-connections
Used to initiate the creation of a cross-connection. (They are
disabled until the user chooses a port.)

• Delete cross-connection
used to delete an existing cross-connection. (It is disabled until
the user chooses a cross-connection that can be deleted.)

• Modify cross-connection
used to modify a cross-connection. (It is disabled until the user
chooses a cross-connection that can be modified.)

• Reservation
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Click this button after you have chosen a tributary to reserve.
The system displays a pop-up window for selection of tributary
parameters for the reservation. (The Reservation feature is only
available for BWM NEs.)

• Show/Hide
Click this button to show cross-connection lines - click it again
to hide the cross-connection lines.

• List existing cross-connection
If you click on the NE’s TID in the explorer portion of the
window, and click this button, a complete listing of all
cross-connections for the NE is displayed. The listing shows the
source and destination tributary AIDs, the cross-connect type, the
rate, the TID of the source NE and the TID of the destination
NE. Clicking on any equipment level in the explorer (such as a
specific shelf or port), and then clicking this button, displays a
list of cross-connections for the selected equipment in the NE.

• Cancel
Click this button when you have started a cross-connection and
want to terminate the operation. (This button is disabled until you
select a cross-connection type.)

• Toggle view
Click this button to change the number of port areas displayed in
the view panel. Initially the view is set to Toggle to Four, which
shows four port areas (and the contents of the pop-up menus in
the explorer accommodate all eight ports). When you click the
Toggle View button, the view changes to Toggle to Eight, which
shows eight port areas (and the contents of the pop-up menus in
the explorer accommodate four ports).

Status bar The status bar, at the bottom of the Cross-Connections window,
provides the following information to the user:

• The source and destination AID and the cross-connection type of
a selected cross-connection in the cross-connection view area.

• The cumulative information about a cross-connection being
added, as it is selected by the user.

• Information about the status of add/delete/modify operations that
have been requested.

When a port tributary is displayed in the Main View of the
Cross-Connection window, and you position the mouse cursor on the
tributary block, a message is displayed next to the tributary address in
the status bar identifying it as a “Source” or “Destination” tributary.
The “Source” and “Destination” literal displayed in the status bar is

Cross-Connections Traffic provisioning concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 1 - 3



used to indicate whether the tributary could act as a “Source” or
“Destination” , or both, for additional cross-connections.

Displaying ports Ports are displayed on the Cross-Connection window between the
arrow buttons surrounding the main view area. Top and Bottom port
areas appear between the left and right arrow buttons, while Left and
Right port areas appear between the up and down arrow buttons.

Cross-connection prerequisites for some NE types may prevent the
user from provisioning a cross-connection to or from a tributary only
if the port unit slot containing the tributary has already been
provisioned (or pre-provisioned) with information that determines the
number of ports and the rate of the ports in the port unit slot.

Display of STM-4 and
STM-1

The cross-connection window displays three STM-1 ontop of one
STM-4 in the following way.

When the cursor is positioned over one of the signal components the
status line displays the respective AID.

Display of STM-4, STM-1
and VC-3

The cross-connection window displays three VC-3 ontop of four
STM-1 ontop of one STM-4 in the following way.

When the cursor is positioned over one of the signal components the
status line displays the respective AID.

Color conventions Listed in the following table are the default color conventions used to
represent cross connection and tributary properties. These colors may
be changed through the Preferences window (see “Map preferences”
(14-33)).

See the next table for color conventions for cross connection and
tributary properties.
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Color Representation

Green Tributary is selected as a source for
cross-connection

Magenta Cross connection destination(s) (shows when
selected)

Red Cross connection line whose redline property is
enabled

Black dashed
line

Standby cross connection

Orange Cross connection on tributary is in the process of a
pending operation (such as creation, deletion,
modification).

Light yellow Tributary which is not being used for any cross
connection or reservation

Blue Tributary which is being used for a cross
connection

Dark blue Tributary changes to this color when a
cross-connection is created. Also indicates a
reserved tributary.

Purple Tributary which is a destination tributary for a
cross-connection

Dark green Tributary which is uni-directional

Grey Tributary not available for cross-connection

A grey box is also displayed when:

• A multiple level graphic is displayed and there are cross
connections at a lower rate than the highest rate in the graphic.
For example, the graphic showing both STM-1 and VC-3
tributaries may have a grey STM-1 box if any of the VC-3 boxes
are blue (already cross-connected in both directions).

• A multiple level graphic is displayed and for some reason the
network element will not allow cross connection at a particular
rate in the graphic. This will sometime occur when a specific
setting in the network element is made to disable a certain rate.

For network element which allow cross-connections at multiple rates
within a single tributary, for which no graphic exists (such as STM-1
and VC-3), the explorer will allow the user to drag and drop either the
STM-1 tributary, or the VC-3 tributary to the View Area. In all other
cases, only the bottom most level of tributaries shown in the explorer
can be dragged to the View Area.
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Entering cross-
connections

The general steps for entering cross-connections on the
Cross-Connection window in the GUI are as follows:

1. Find the tributaries that are to be cross connected together and
display them in the view area.

2. Choose the box that represents the source tributary for the cross
connection by clicking on the box. The box will turn green. The
cross connection type buttons on the toolbar will become
enabled, but only those that can use the tributary chosen as a
source.

3. Choose a cross connection type by clicking on the button in the
toolbar for that cross connection type.

4. Choose the box that represents the destination tributary for the
cross connection by clicking on it. Both the source and
destination boxes will now turn orange (an operation is pending
on these tributaries).

5. If it is necessary to provide further information before the cross
connection can be completed, an additional information
(Cross-Connect Attributes) window is opened. It contains
parameter names and lists of values for each parameter. Choose
the parameter values for this cross connection and choose OK.

6. Confirm entry of the cross connection when the confirmation
window is displayed.

The cross-connection command is now sent to the network element.
When the command has completed (either correctly or with errors),
the orange color is removed from the chosen tributaries. If the cross
connection was created in the network element, the tributaries will
turn blue. If the command failed, they will revert to their original
colors.

Cross-connection
topologies

Cross-connection topologies supported by the system include the
following:

• One-way point-to-point cross-connection

• Two-way point-to-point cross-connection

• Multicast cross-connection. Also encompasses bridge
cross-connections. A bridge cross-connection allows the addition
of a second leg to an existing one-way point-to-point
cross-connection, resulting in a 1:2 one-way cross-connection
from one input tributary to two output tributaries.

• Roll cross-connection: this refers to the operation of moving the
input of an existing leg of a one-way or two-way point-to-point
cross-connection from the current input tributary to a new input
tributary, while leaving the output unchanged.
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• Path-switching and dual ring interworking cross-connections.

• Path-protected cross-connections to support Dual Node
Interworking for TDM 10G (STM-64) NEs; or Unidirectional
Path-Switched Ring (UPSR)/Subnetwork Connection Protection
(SNCP) topologies for TDM 10G (STM-64 R2.0 or later) NEs.

• Loopback cross-connection: a cross-connect loopback is created
from an input tributary to the output of the same tributary for
testing purposes. A loopback cross-connection can be set up on
any logical tributary, whether or not there are cross-connections
to that tributary. A loopback cross-connection is a temporary
cross-connect; after it is removed, any pre-existing
cross-connections that were affected are automatically
re-established in the NE.

The system also provides the ability to provision cross-connections at
VC-4/STS-3 ports between tributaries on SDH and SONET ports.

Adjunct path-protected
cross-connections

WaveStar SNMS supports the establishment of adjunct path-protected
cross-connections. An adjunct path-protected cross-connection is
established when you create a cross-connection from the same input
tributary as an existing path-protected cross-connection, so that both
cross-connections have adjunct working legs, but to different output
tributaries. The adjunct cross-connection differs from the existing
path-protected cross-connection in that it is not established with
assignment to a path protection group and depends on the existence of
the path-protected cross-connection.

This combination of a path-protected cross-connection with adjunct
cross-connections off the same protected input tributary to different
output tributaries can serve the following applications:

• A connection between two UPSR rings (SONET) or SNCP rings
(SDH). This type of connection requires path selection to drop
the circuit from the first ring and bridging to add the circuit into
the second ring.

• Dropping traffic at many tributary interfaces in a UPSR/SNCP
ring for applications such as video distribution. The path-selected
signal is dropped to multiple ports.

Textual display of
cross-connections

When you display a path-protected cross-connection textually, by
clicking the List Cross Connections toolbar button on the
Cross-Connection window, each output leg is displayed and identified
as either working (PSW) or protection (PSP).When an adjunct
cross-connection is displayed on the List Cross Connections window
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Compound cross-
connections

WaveStar SNMS supports the establishment of compound
cross-connections between input and output tributaries in a network
element, which may be needed in a network element for some
network application.

To make it easier to identify an individual cross-connection’s function
in a compound arrangement, and to facilitate retrieval of information
about cross-connections with associated legs and leg pairs, WaveStar
SNMS allows you to assign a Cross-Connection Application and
Cross-Connection Number to each cross-connection when it is being
added.

Cross connection
application

The Cross-Connection Application is a parameter that can be assigned
to a cross-connection to identify the cross-connection type. This
parameter can be modified for the cross-connection.

The following application (cross-connection types) can be optionally
assigned when creating or modifying a cross-connection:

• 2-Way Point-to-Point

• 1-Way Point-to-Point

• 1-Way Path-Protected

• 1-Way Adjunct Path-Protected

Cross connection number The Cross-Connection Number is a parameter that can be assigned to
a cross-connection to associate all atomic cross-connections being
established in one step, so the associated legs and leg-pairs with the
same Cross-Connection can be retrieved and displayed together on the
List Cross-Connections window. When you add a cross-connection or
compound cross-connections from the same output tributary, WaveStar
SNMS populates the Cross-Connection Number drop-down list for
this field with a Cross-Connection Number for each of the atomic
cross-connections with the same value. The number is a 9-digit
number based on the AID of one of the logical output tributaries.

On the List Cross-Connection window (which is accessed by clicking
the List Cross Connections toolbar button on the Cross-Connection
window), if you select a leg of a cross-connection with the same
Cross-Connection Number that has been assigned to associated legs in
compound cross-connections, you can modify or delete all legs of
compound cross-connections with the same Cross-Connection number.
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Deleting cross-connections WaveStar® SNMS denies the request to delete (remove) a
cross-connection in the following scenarios, unless some modification
is made to the cross-connection to be deleted:

1. A request to remove redlined cross-connections. The modification
necessary to delete a redlined cross-connection is to change the
redline status of the cross-connections.

2. A request to remove a cross-connection from a tributary also
being used in a loopback cross-connection. The modification
necessary to remove this type of cross-connection is to remove
the loopback cross-connection.

3. A request to remove a cross-connection from a tributary used in a
test access connection. The modification necessary to remove this
type of cross-connection is to take the tributary out of test access
mode using the proper TL1 command (see the vendor NE’s
documentation for the appropriate TL1 command/syntax to
perform this action).

4. A request to remove a path-protected cross-connection that has an
adjunct cross-connection associated with the same input tributary.
In this case, the adjunct cross-connection associated with the
same input tributary as the path-protected cross-connection must
be deleted before the path-protected cross-connection can be
deleted.

Modifying cross-
connections

The system allows you to modify various cross-connection
information, including the source TID, destination TID,
cross-connection application, cross-connection number, and source
NE.

The working and protection legs of a path-protected cross-connection
can be modified by being switched.

For compound cross-connections from the same set of input and
output tributaries, WaveStar SNMS allows you to change the
cross-connection application of the cross-connection.

Converting cross
connections

The WaveStar® SNMS allows you to convert one-way point-to-Point
(or a leg of a two-way cross connection), one-way path protected or
one-way adjunct cross connections.

The following cross connection types can be converted

• one-way point-to-point to one-way path protected

• one-way point-to-point to one-way adjunct

• one-way path protected to one-way point-to-point

• one-way adjunct to one-way point-to-point
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The leg being converted may be either the working leg or the
protecting leg of the path protected or adjunct cross-connection.

1–Way Cross-Connection
Parameters

The following table gives an overview over the parameters in the
1–way cross-connection parameters window.

Field Possible values Meaning

LOCA (name) NE name of the source
location. In an
MS-SPRING this should
be the location were the
path enters the ring.

LOCZ (name) NE name of the sink
location. In an
MS-SPRING this should
be the location were the
path exits the ring.

OMODE NORM,
IDLE/UNEQ, AIS

If the cross-connection is
not in a normal (NORM)
operation mode, either
IDLE/UNEQ or AIS can
be inserted into the signal.
The OMODE refers to the
“To” port.

2–Way Cross-Connection
Parameters

The following table gives an overview over the parameters in the
2–way cross-connection parameters window.

Field Possible values Meaning

LOCA (name) NE name of the source
location. In an
MS-SPRING this should
be the location were the
path enters the ring.

LOCZ (name) NE name of the sink
location. In an
MS-SPRING this should
be the location were the
path exits the ring.
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Field Possible values Meaning

OMODE NORM,
IDLE/UNEQ, AIS

If the cross-connection is
not in a normal (NORM)
operation mode, either
IDLE/UNEQ or AIS can
be inserted into the signal.
The OMODE refers to the
“To” port.

RTNOMODE NORM,
IDLE/UNEQ, AIS

If the cross-connection is
not in a normal (NORM)
operation mode, either
IDLE/UNEQ or AIS can
be inserted into the signal.
The RTNOMODE refers to
the “From” port.

1–Way PP Cross-
Connection Parameters

The following table gives an overview over the parameters in the
1–way path protected parameters window.

Field Possible values Meaning

LOCA (name) NE name of the source
location. In an
MS-SPRING this should
be the location were the
path enters the ring.

LOCZ (name) NE name of the sink
location. In an
MS-SPRING this should
be the location were the
path exits the ring.

LOCA2 (name) NE name of the second
source location.

OMODE NORM,
IDLE/UNEQ, AIS

If the cross-connection is
not in a normal (NORM)
operation mode, either
IDLE/UNEQ or AIS can
be inserted into the signal.
The OMODE refers to the
“To” port.

Multicast Cross-
Connection Parameters

The following table gives an overview over the parameters in the
multicast cross-connection parameters window.
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Field Possible values Meaning

LOCA (name) NE name of the source
location. In an
MS-SPRING this should
be the location were the
path enters the ring.

LOCZ (name) NE name of the sink
location. In an
MS-SPRING this should
be the location were the
path exits the ring.

OMODE NORM,
IDLE/UNEQ, AIS

If the cross-connection is
not in a normal (NORM)
operation mode, either
IDLE/UNEQ or AIS can
be inserted into the signal.
The OMODE refers to the
“To” port.
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Protection Groups
....................................................................................................................................................................................................................................

Introduction Protection group management can include both equipment and port
protection groups. There are several types of protection strategies,
including:

• 1+1 protection (where a service entity and a protection entity
serve as a pair, with only one of them active at any given time)

• 1xN equipment protection (where a single protection entity is
shared by multiple service entities)

• 2-fiber MS-SPRing protection (for SDH)

• Path/DRI for TDM 10G (STM-64) and 2.5G NEs

• Unprotected entities (0x1 protection)

WaveStar SNMS allows you to retrieve an NE’s current protection
configuration for its transmission interfaces and to configure, at NE
level, the rate, member ports, and attributes of its protection groups.
Protection group modifications are done per NE for its associated
protection groups. WaveStar SNMS also provides the capability to
select a protection group and then to provision a protection switch
between the working and protection entities in that group.

Protection group discovery WaveStar SNMS retrieves an NE’s current protection group data for
transmission interfaces and stores this information in its database
when DNO is performed upon discovery of the NE or update of this
information is requested while performing a manual DNO on the NE.
For NEs with multiple bays/shelves, such as the WaveStar BWM,
DNO can be performed to update protection group data for a selected
single bay or shelf.

Provisioning protection
groups

Protection groups can be added, modified, or deleted from an NE. You
can also view the member ports and attributes for a protection group
in an NE.

To add a new protection group for an NE, you select a protection
group type from a list of available protection group types for the NE
type, pick the rate of the protection group, assign a user-specified
protection group ID which is associated with the selected bay and
shelf, choose the members (ports) of the protection group, and
provision the attributes for the group. In creating or modifying
protection groups, WaveStar SNMS enforces that all members (ports)
of the group are within the same shelf and bay and of the same
transmission rate. When you select the first member port on the shelf,
the first port becomes the reference port for the other members of the
protection group and the remaining allowable choices are other ports
on the same shelf.
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For the optical interfaces, protection switching provides protection
against both equipment and facility (line) failures. For the WaveStar
NEs, one universal constraint is that all the entities, service and
protection, must be within the same shelf.

Modifying protection
groups

Once a protection group has been added for member ports in an NE,
you can modify the given attributes of a protection group or swap
ports in certain protection group types as shown in the following
table.

Protection Group Type Swap

1+1 Optical Working and Protection Ports

2-Fiber BLSR/MS-SPRing East and West Ports

When modifying a protection group, the type, rate, and member ports
of the group cannot be changed.

Deleting protection groups Deleting a protection group removes it from an NE.

Provisioning a protection
switch

A protection switch in a protection group occurs automatically when a
signal failure, signal degradation, equipment failure, or similar cause
prompts a switch from the working entity in a protection group to the
protection entity. WaveStar SNMS also allows you to provision a
protection switch on demand through a GUI-based function on the
Protection Group Management window. To provision a protection
switch, you specify the protection group type, protection group AID,
protection switch type (command), and the destination of the entity
that should be active after the protection switch is activated. In some
types of protection groups (for example, 2-Fiber BLSR), the
protection switch is made between the working and protection ports,
while in equipment protection groups (for example, 1xN Electrical),
the protection switch is made between working and protection circuit
packs.

1+1 Protection Group
Parameters

The following table gives an overview over the parameters in the 1+1
protection group parameters window.

Field Possible values Meaning

STM1, STM16 (via radio button) Capacity of the 1+1
protection.

PG AID:
Bay-Shelf-O

(AID) AID of the protection
group.
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Field Possible values Meaning

Bay-Shelf 1–1, 1–2, 1–3 The bay and shelf on
which the protection group
is located.

Working New
Value

(AID) AID which will be the
defined as the working
port.

Protocol 1+1_UNI,
1+1_BIDIR,
1+1_OPT

The type of the protection
either it is unidirectional
(1+1_UNI) or a
bidirectional or a
optimized (1+1_OPT)
protection. In an optimized
protection the working
port becomes the
protecting and vice versa
if a switch occurs.

Revertive Mode
Enable

enable, disable If the revertive mode is
enabled, the signal is
switched back to the
defined working line after
the interruption is over.
(Not for Protocol
1+1_OPT)

MS–SPRing Protection
Group Parameters

The following table gives an overview over the parameters in the
MS–SPRing protection group parameters window.

Field Possible values Meaning

STM64, STM16 (via radio button) Capacity of the
MS–SPRing.

Protection Group
Name

(name) Name of the protection
group.

PG AID:
Bay-Shelf-T

(AID) AID of the protection
group.

Bay-Shelf 1–1, 1–2, 1–3 The bay and shelf on
which the protection group
is located.

East New Value (AID) AID of the east side of the
protection group.

West New Value (AID) AID of the west side of
the protection group.
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Field Possible values Meaning

Wait to Restore 0, 1, ..., 12, 99 The time in minutes after
which a signal is switched
back to the working line
after the interruption is
over.
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Protection Switch Management
....................................................................................................................................................................................................................................

Overview WaveStar SNMS has the capability to monitor and control protection
switches that can occur as a result of a fiber cut, signal degradation,
equipment failure, or loss of signal, thereby provoking a switch from
the working to the protection facility. Protection switches can occur
automatically or be manually provisioned by the user.

Protection switch status information is generated by NEs for:

• ports involved in 1+1 optical line protection

• circuit packs involved in 1xN equipment protection

• ports involved in 2-fiber BLSR/2-fiber MSSPRing protection

• signal rates that are path protected

• optical ports involved in optical channel path protection

Protection switch
management functions

The protection switch management functions provided by WaveStar
SNMS are:

• monitoring the messages generated by the NE in response to
protection switch requests that occur automatically due to
incoming signal failure, incoming signal degrade, circuit pack
failure, or similar cause

• maintaining the status of protection switches in the WaveStar
SNMS database based on the protection switch messages
received by the system

• provisioning protection switches for a given protection group
type, while viewing autonomous messages received about
protection switch activity for that protection group type, from the
Protection Status Management window.

• logging all autonomous and user-generated (CIT/WaveStar
SNMS) protection switch requests and NE messages generated in
response to switch requests. Protection switch requests and
resulting messages can be viewed through the Network
Notification Log.

• notifying the user of a protection switch status change (see
“Display Protection Switching Status” (6-18)).

• displaying the current protection switch status for a protection
type for one or more NEs on demand (see “Display Protection
Switching Status” (6-18)).

• displaying the history of protection switch status changes for a
protection type for one or more NEs on demand (see “Display
Protection Switching Status” (6-18)).
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Dynamic Network Operations
....................................................................................................................................................................................................................................

Introduction The Dynamic Network Operations (DNO) feature performs two major
functions in WaveStar SNMS:

• Subnetwork discovery

• Database synchronization

Subnetwork discovery The DNO feature retrieves the internal configurations of NEs and
external connectivity relationships. This allows the system to discover
all NEs in a subnetwork as well as the trails between NEs where
available. As a result, the subnetwork topology (NEs and trails) is
automatically displayed on the Map window as soon as it is
discovered.

When the subnetwork discovery aspect of DNO is executed on a
per-NE basis, the neighbors of the target NE are also discovered. The
system uses the DNO feature to query the SONET Directory Service
(SDS) to discover these node types. When subnetwork discovery is
initiated with the SDS, the system queries the DSA of the chosen SDS
for discovering NEs, then sends commands to neighboring NEs for
discovering trails.

Database synchronization The DNO feature synchronizes the system database with current
configuration data from the NEs. The information that DNO gathers
from NEs includes:

• NE parameters

• NE equipment inventory

• NE port parameters

• NE port protection groups

• NE cross-connections

As part of subnetwork discovery, the system retrieves an NE’s current
equipment configuration and stores this information in the system
database. NE equipment data can include bays, shelves, and circuit
packs.
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Ways to initiate DNO There are three ways that the DNO feature is initiated in the system:

• Automatically – The DNO subnetwork discovery/database
synchronization process is initiated automatically when an NE is
discovered or added manually to the WaveStar SNMS database.

• Manually – The DNO subnetwork discovery/database
synchronization process is executed for the NE, when you
request it. When you request a manual DNO for an aggregate,
DNO is executed for all NEs in the aggregate.

• Scheduled – You can schedule DNO to be performed for one or
more NEs on a daily, weekly, or monthly basis.

DNO options You can invoke DNO to perform automatic subnetwork discovery or
database synchronization for one or more of the following: NE
parameters, equipment inventory, port parameters, port protection
groups, cross-connections, reservations. You can also invoke DNO to
perform subnetwork discovery and resynchronize the system database
for all data types.
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Cross-connection management
....................................................................................................................................................................................................................................

Overview The WaveStarTM TDM 10G add/drop multiplexer is in its basic
configuration a single shelf that interfaces electrical STM-1, optical
STM-1 and optical STM-16 lines to an SDH-standard 2-fiber
MS-SPRing protected ring. It has 16 tributary slots that support
flexible optical and electrical port unit mixing. If additional capacity
for tributary port units is required, the system can be expanded by an
extension shelf.

Definitions Port A physical transmission interface, consisting of both an
input and an output, which may be used to carry traffic between
network elements. Operational differences between ports
determined by port provisioning include pointer processing, fault
and performance monitoring, path maintenance (e.g. Unequipped,
AIS, RDI), cross-connections (supported rates), and protection
switching.

Port protection group A user-provisioned association of optical
interface ports which is used for protection in a particular type of
network configuration. Two types of port protection groups are
defined:

• 2-fiber MS-SPRing port protection group used for SDH 1+1
MS-SPRing

• 1+1 port protection group used for SDH 1+1 Multiplex Section
Protection (MSP) The operations on a port protection group

include the provisioning, control, and status of the protection
switching.

Tributary A path-level unit of bandwidth within a port, or the
signal(s) being carried in this unit of bandwidth, e.g. a VC-3 or
VC-4 within an STM-N port.

Cross-connection A reconfigurable SDH path-level
interconnection within a network element between input and
output tributaries of specific ports.

Cross-connection leg A one-way connection provisioned from
one input tributary to one output tributary. Each leg is identified
as an entity by its input and output tributaries, its
cross-connection rate, and the type of cross-connection it is part
of. A leg pair is a pair of cross-connection legs which are
reported as a two-way connection between two tributaries.

Cross-connection types All meaningful cross-connection types can be reduced to three basic
types:
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- Unidirectional point-to-point connection

- Unidirectional point-to-multipoint connection (broadcasting/multi-
casting)

- Bidirectional connection

You can provision and reconfigure cross-connections. WaveStarTM

TDM 10G provides an STM-1 rate time slot assignment capability
that supports the following types of cross-connection:

• 1 - way (unidirectional) point-to-point

• 2 - way (bidirectional) point-to-point

Transmission interfaces WaveStarTM TDM 10G includes the following optical and electrical
port units:

- Optical Interfaces

Cross-connection management Traffic provisioning concepts
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STM-64 port units are available in the 1.5 µm wavelength
(intermediate reach).

STM-16 port units are available in two wavelengths:

• 1.3 µm wavelength (long reach)

• 1.5 µm wavelength (long reach)

Each STM-16 port unit contains one bidirectional port.

STM-1 port units are available for 1.3 µm wavelength (long reach).
The STM-1 port units feature four bidirectional ports per circuit pack.

- Electrical Interfaces. The electrical STM-1 port units are capable of
transmitting and receiving signals at the 155 Mbit/s rate. Each port
contains four independent bidirectional ports.

Switch capacity The 192 x 192 switch fabric of the WaveStarTM TDM 10G supports
simultaneous cross-connections from each of up to 128 source STM-1
equivalents to all of the up to 128 sink STM-1 equivalents. The
cross-connections are fully non-blocking.

Cross-connection levels The following cross-connection levels are supported in WaveStarTM

TDM 10G:

• VC-3

• VC-4

• VC-4-4c (Concatenated VC-4)

Output mode The cross-connection output mode for the: (a) destination-to-source
direction, and/or (b) source-to-destination direction, is a provisionable
parameter. If some of the facilities are not in place whenever the
cross-connection is being established then you can provision this field
as AIS or IDLE/UNEQ and an AIS or an unequipped signal will be
inserted to function as a keep-alive signal.

If all of the involved facilities are in place when the cross-connection
is established, the field should be provisioned as NORMAL. The
end-to-end signal path is then established and the signal can be
passed.

Cross-connection management Traffic provisioning concepts

....................................................................................................................................................................................................................................

1 1 - 2 2 Lucent Technologies 365-371-524
Issue a, October 2001



Protection mechanisms
....................................................................................................................................................................................................................................

Overview The reliability of a transmission system can be considerably increased
by means of redundant transmission routes. In the event of a
transmission error, e.g. if LOS (Loss of Signal) is signalled due to a
cable break, or in the event of an excessive bit error ratio, the signals
can be switched to a protection line.

Types Network protection

The following types of protection switching can be realized:

• STM-64 and STM-16 2-fiber MS-SPRing

• STM-16 and STM-1 1+1 Multiplex Section Protection (MSP)

Principle Equipment Protection

An equipment protection always involves one or more plug-in units
which carry traffic (working plug-in unit) and one or more protection
plug-in unit(s) which will assume the function of a plug-in unit that
has failed. Together they form a protection group.

Types For the following circuit packs equipment protection is supported:

• Timing Generator circuit pack (TMG): 1+1

• Cross-connect circuit pack (SWITCH/STS576 and
PPROC/STS192): 1+1

• Power feed is maintained duplicated throughout the system

Creation The equipment protection groups are created automatically if the
required circuit packs are plugged in the shelves (cf. “Protection
configurations” (11-32)).

Operation The equipment protections operate non-revertive.
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Multiplex section protection
....................................................................................................................................................................................................................................

Overview In multiplex protection switching, the complete (physical)
transmission path between two multiplexers is duplicated. This means
that a separate Optical Interface Unit is connected in each multiplexer
for the main (working) and standby (protection) section.

1+1 MSP In case of a 1+1 MSP each main line is assigned to one standby line.
As for other types of protection switching the signals are duplicated in
the transmit direction. In the receive direction, this type of switching
either selects, depending on the signal quality, the input signals of the
main section or that of the standby section for transmission. The
network elements are equipped with an MSP function which carries
out the selection and changeover processes. The switching activities
are monitored by the K1-K2 byte protocol according to ITU-T Rec.
G.783. This takes place in the receive direction on the circuit pack,
which is connected to the standby section.

The following figure illustrates the schematic diagram of a 1+1
Multiplex Section Protection.

1+1 MSP is implemented in compliance with ITU-T G.841 and ETSI
300 417.

Switching criteria The switchover is triggered by the following switching criteria, which
are generated by the MST functional block after evaluation of the
SOH:

• Signal Degrade (SD)
Bit error ratio (BER) in the range 10-3 ... 10-9

• Loss of Signal (LOS)

• Loss of Frame (LOF)

• Multiplex Section Excessive Bit Error Ratio (MS-EXC)

Multiplex section

SDH/PDH signals

PDH signals
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Bit error ratio ≥ 10-3

• Multiplex Section Alarm Indication Signal (MS-AIS)

Mode of operation In the WaveStarTM TDM 10G systems the MSP can be operated
unidirectional or bidirectional and revertive or non-revertive each.
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2-Fiber MS-SPRing
....................................................................................................................................................................................................................................

Overview A 2-fiber Multiplex Section - Shared Protection Ring (MS-SPRing) is
a self-healing ring configuration in which traffic is bidirectional
between each pair of adjacent nodes and is protected by redundant
bandwidth on the bidirectional lines that interconnect the nodes in the
ring. Because traffic flow is bidirectional between nodes, traffic can
be added at one node and dropped at the next without traveling
around the entire ring. This leaves the spans between other nodes
available for additional traffic. Therefore, with many traffic patterns a
bidirectional ring can carry much more traffic than the same facilities
could carry if configured for a unidirectional ring. Additionally, the
protection capacity can be used to provide unprotected transport for
extra traffic when no failures are present.

MS-SPRing in WaveStar®
TDM 10G (STM-64)

WaveStar® TDM 10G (STM-64) provides the possibility to configure
MS-SPRing for one STM-64 ring and for up to four STM-16 rings
per shelf.

The STM-16 and STM-64 2-fiber MS-SPRing is compliant with ETS
300 417 and ITU-T G.841.

Traffic capacity The following figure shows working and protection traffic capacities
in a WaveStar® TDM 10G STM-64 2-fiber MS-SPRing.
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Self-healing rings WaveStar® TDM 10G 2-fiber MS-SPRings are self healing in that
transport is automatically restored after node or fiber failures. In case
of STM-64 MS-SPRing, each line carries 32 STM-1 equivalent
timeslots of working capacity plus 32 STM-1 equivalent timeslots of
protection capacity. For STM-16 MS-SPRing, the working capacity is
8 STM-1 equivalents, the protection capacity 8 STM-1. In the event
of a fiber or node failure, service is restored by switching traffic from
the working capacity of the failed line to the protection capacity in the
opposite direction around the ring. (See “Fiber cut example” (11-28).)

Low-priority traffic Unprotected traffic can be established on the protection channels
(low-priority traffic). This traffic is preempted in case of a protection
switch.

2-Fiber MS-SPRing traffic
flow

The following figure shows normal (non-protection-switched) traffic
flow in a WaveStar® TDM 10G 2-fiber MS-SPRing.

Protection switching When a line-level event triggers a protection switch, the affected
nodes switch traffic on to protection capacity and transport it to its
destination by looping it back the long way around the ring. (See
“Fiber cut example” (11-28).) Service is reestablished on the
protection capacity in less than 50 milliseconds after detection of the
failure (for catastrophic failures in rings without existing protection
switches or extra traffic).

2-Fiber MS-SPRing Traffic provisioning concepts

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 1 - 2 7



Fiber cut example The following figure illustrates a 2-fiber MS-SPRing protection switch
that results from a fiber cut.

Protection traffic flow In the example (see “Fiber cut example” (11-28)), traffic going from
Node A to Node C that normally passed through Node E and Node D
on “working 2” capacity, is switched onto the “protection 2” capacity
of the line leaving Node E in the opposite direction. The traffic loops
back around the ring and reaches Node C by way of Node B.
Similarly, traffic going from Node C to Node A that normally passed
through Node D and Node E on “working 1” capacity is switched on
to the “protection 1” capacity of the line leaving Node D in the
opposite direction.

The same approach is used for a node failure. For example, if Node D
were to fail, Nodes C and E would perform loopback protection
switches to provide an alternate route for ring traffic.

MS–SPRing Switch
Parameters

The following table gives an overview over the parameters in the
MS–SPRING switch parameters window.

2-Fiber MS-SPRing Traffic provisioning concepts
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Field Possible values Meaning

Switch Command CLEAR,
LOCKOUT,
FRCD, MAN

The switch commands
have the following
meaning

• CLEAR—Clears a
previous LOCKOUT
or FRCD request.
Allows the protection
to switch
automatically

• LOCKOUT—The
protection switch is
disabled.

• FRCD—A forced
switch is issued even
if the other line would
be faulty.

• MAN—A manual
switch is issued only
if the other line is
error free.

Destination Entity WKG, PROTN Entity for which the
switch is issued. This is
either the working (WKG)
or the protecting
(PROTN).

Destination Side east, west The transmission direction
(east or west) to which
the traffic shall be
switched.

Destination Entity
AID

AID AID of the entity for
which the switch is
issued.

Switch Type ring, span The switch type should be
set to span.
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2-fiber MS-SPRing with Non-preemptible Unprotected Traffic
(NUT)
....................................................................................................................................................................................................................................

Overview Non-preemptible Unprotected Traffic (NUT) offers the possibility to
exclude timeslots from the MS-SPRing protection.

NUT allows the operator to selectively exclude individual HO-VCs
from the MS-SPRing in a flexible way. This feature extends the traffic
availablity and optimizes the utilization of the bandwidth.

Low priority traffic In a normal MS-SPRing the protection bandwidth can be used for low
priority traffic, but this traffic is lost, if a protection switch is carried
out. In this case the whole working bandwidth is switched to the
protection bandwidth.

Non-preemptible
Unprotected Traffic

A better availability can be achieved by deciding not to access a
portion of the protection bandwidth (temporary or definitely), i.e.
making some of the protection timeslots unaccessible for protection
purposes. The traffic in these timeslots is called non-preemptible. As
there is a 1:1 relationship between the working and the protection
timeslots, the corresponding working timeslots are thus unprotected.
Traffic contained in such working timeslots is called Non-preemptible
Unprotected Traffic (NUT).

The following graphic illustrates the switch behaviour in an
MS-SPRing protected network element.

Protection attribute and
Local NUT configuration

Each timeslot of an MS-SPRing protected optical signal gets an
attribute, the Protection Attribute, which indicates whether a working
timeslot is protected or not or whether a protected timeslot may be
preempted by the MS-SPRing or not.

1  Not Protected

2  Protected

63  Not Preempted

64 Preempted

Traffic provisioning concepts

....................................................................................................................................................................................................................................

1 1 - 3 0 Lucent Technologies 365-371-524
Issue a, October 2001



For working timeslots the following values are possible:

• Protected

• Not Protected

• Temporarily Not Protected

If a timeslot is set to Temporarily Not Protected, an alarm is
generated in the local NE.

For protection timeslots the following values are possible:

• Preemptible

• Non-Preemptible

• Temporarily Non-Preemptible

As working and protection timeslots are always paired, the value of
the Protection Attribute of a working timeslot determines the value of
the corresponding protection timeslot.

Local NUT configuration The Local NUT configuration is a table with all timeslot and their
corresponding Protection Attribute value. It represents the
provisioning made by the user in the local node.

Operational NUT
configuration

The Operational NUT configuration provides the real NUT
configuration of the ring. It contains a unique and identical set of
Protection Attributes as they have to be used by the nodes. It must be
identical in all nodes.

The Operational NUT configuration is created according to the
following rules:

• It is autpoprovisiond out of the Local NUT configurations

• It contains up to 96 entries, one per timeslot

• all default values are set to protected/preemptible

• If in any node the Protection Attribute of a certain timeslot is
set to Not Protected/Non-preemptible, this will be indicated in
the Operational NUT configuration and is valid for the whole
ring.

• If two or more nodes have the same setting for a specific time
slot (Not Protected or Temporarily Not Protected), this will
only be indicated once for the node with the highest Node ID.

Modifications of the Local NUT configuration in any node are
broadcasted to all other nodes in the ring via DCC. Settings which
have been carried out in a ceratin node can only be modified from the
same node. Duplicate settings from two nodes have to be changed in
both nodes.

2-fiber MS-SPRing with Non-preemptible
Unprotected Traffic (NUT)
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Protection configurations
....................................................................................................................................................................................................................................

Overview This section describes the shelf configuration guidelines that have to
be observed in case of the following protection mechanisms:

• 2-fiber MS-SPRing

• 1+1 MSP.

All protection mechanisms are only supported within one shelf, so it
is not possible to have a circuit pack in the Main Shelf be protected
by a circuit pack in the Extension Shelf.

MS-SPRing The MS-SPRing related STM-16 circuit pack pairs have to be plugged
in to the following dedicated port unit slot pairs: 02-04, 06-08, 10-12,
14-16, 02-16, 04-14, 06-12, 08-10.

MSP MSP can only be established between two separate circuit packs
(which are of the same type), i.e. it is not allowed to establish MSP
between 2 ports on the same circuit pack. MSP between different
ports on different circuit packs can be configured independently, e.g.
one port of circuit pack 1 can be protected with one port of circuit
pack 2 while the second port on circuit pack 1 is protected by circuit
pack 3. The MSP related circuit packs are not restricted to specific
slots.

For STM-16 port units, any pair combination of allowed slot positions
can be applied: 02, 04, 06, 08, 10, 12, 14, 16.

For optical STM-1 port units, any pair combination of allowed slot
positions can be applied: 01...16.

Cross-connect unit
protection

The SWITCH/STS576 circuit pack in slot (1-1) switch0 in the Main
Shelf is paired with the circuit pack in slot (1-1) switch1 in a 1+1
non-revertive protection mode configuration.

The SWITCH/STS576 circuit pack in slot (1-2) switch0 in the Main
Shelf is paired with the circuit pack in slot (1-2) switch1 in a 1+1
non-revertive protection mode configuration.

The PPROC/STS192 circuit pack in slot (1-2) ppls0 provides frame
delay management between the switch functions of the low speed part
of the shelf and the high speed part ((1-1) sw. 0).

The PPROC/STS192 circuit pack in slot (1-2) ppls1provides frame
delay management between the switch functions of the low speed part
of the shelf and the high speed part ((1-2) sw. 1).
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The SWITCH/STS576 circuit pack in slot switch0 in the Extension
Shelf is paired with the circuit pack in slot switch1 in a 1+1
non-revertive protection mode configuration.
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Port parameters
....................................................................................................................................................................................................................................

STM port parameter
description

The following table gives an overview over the parameters in the
STM port parameters window.

Field Possible values Meaning

Excessive
Maintenance
Inhibit

TRUE, FALSE When this parameter is set
to false an AIS (Alarm
Indication Signal) will be
inserted as consequent
action of the alarm EBER
(Excessive Bit Error
Ratio).

Optical
Wavelength

1310, 1550 The wavelength of the
optical signal in nm.

Optical Distance INTRA-OFFICE,
SHORT-HAUL,
LONG-HAUL

The length of the optical
line.

Forward Error
Correction

ENABLE,
DISABLE

The forward error
correction can be enabled
or disabled for the output.
An enabled FEC allows for
greater spans.

FEC Correction
Enable

ENABLE,
DISABLE

The forward error
correction can be enabled
or disabled for the input.
An enabled FEC allows for
greater spans.

Tributary Input
Signal Rate List

signal structure is
shown. e.g. 644 (=
64xVC-4), 44C(=
4xVC-4–4C),
VC-4-16C

This parameter defines the
VC-n signal substructure
across the port’s bandwidth
for the input signal. For
each STM-n the
substructure can be
selected. The substructure
for the Tributary Input
Signal Rate List and the
Tributary Unequipped
Output Signal Rate List
need not be the same. For
example, 64 VC-4s on the
input signal and 4
VC-4-4cs on the ouptu
signal is allowed.
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Field Possible values Meaning

Tributary
Unequipped
Output Signal
Rate List

signal structure is
shown. e.g. 644 (=
64xVC-4), 44C (=
4xVC-4–4C)

This parameter defines the
VC-n signal substructure
across the port’s bandwidth
for an output signal which
does not contain real
traffic. For each STM-n
the substructure can be
selected. The substructure
for the Tributary Input
Signal Rate List and the
Tributary Unequipped
Output Signal Rate List
need not be the same. For
example, 64 VC-4s on the
input signal and 4
VC-4-4cs on the ouptu
signal is allowed.

FEC Type INBAND,
OUTBAND

In-band FEC yields an
OSNR improvement of
approx. 3 dB at a BER of
10 -12 . It is primarily
used to compensate
insufficiencies of optical
components. Out-of-band
FEC yields an OSNR
improvement of approx. 5
dB at a BER of 10 -12 . It
enables high-speed
transmission more reliably
and for longer distances.

Multiplex Section
Degrade
Threshold

-5, ..., -9 This parameter defines the
threshold for the tolerable
signal degradation. If the
threshold is exceeded
MS-DEG is signalled.

Multiplex Section
DEXC Threshold

-3, ..., -5 This parameter defines the
threshold for the Excessive
Bit Error Ratio (EXC)
related to the Multiplex
Section. If the threshold is
exceeded MS-EXC is
signalled.
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Field Possible values Meaning

Port Mode The Port Mode defines
whether a port causes
alarms or not.

AUTO If a valid signal is present
at the port, the Port Mode
is set to MON
automatically.

MON The port causes alarms, if
necessary.

NMON The port does not cause
alarms.

Far-end Multiplex
Section PM
Enable

ENABLE,
DISABLE

The performance
monitoring for the far-end
of the multiplex section
can be enabled or disabled.

PM Multiplex
Section Far-end
SES threshold

0, 5, ..., 50 The threshold of severely
errored seconds (in %) can
be set for the far-end of
the multiplex section. If
the threshold is exceeded
an alarm is raised. (Should
be set to 30.)

PM Multiplex
Section Near-end
SES threshold

0, 5, ..., 50 The threshold of severely
errored seconds (in %) can
be set for the near-end of
the multiplex section. If
the threshold is exceeded
an alarm is raised. (Should
be set to 30.)

PM Regenerator
Section Near-end
SES threshold

0, 5, ..., 50 The threshold of severely
errored seconds (in %) can
be set for the near-end of
the regenerator section. . If
the threshold is exceeded
an alarm is raised. (Should
be set to 30.)

RSMS TCA
Profile Name

Default0, Default The threshold crossing
alert profile for the
regenerator and multiplex
section.

Port parameters Traffic provisioning concepts
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Field Possible values Meaning

RS/Near End
Multiplex Section
PM

ENABLE,
DISABLE

The performance
monitoring for the
near-end of the regenerator
section can be enabled or
disabled.

Provisioning (VC-3)
Parameters

The following table gives an overview over the parameters in the
VC-3 parameters window.

Field Possible values Meaning

DEXC Threshold -3, -4, -5 This parameter defines the
threshold for the Excessive
Bit Error Ratio (EBER). If
the threshold is exceeded
Signal Fail (SF) is
signalled.

Path degrade
threshold

-5, ..., -9 This parameter defines the
threshold for the signal
degrade condition.

Path Trace J1
Read Format

1, 15, 16, 64 (Setting not supported by
the current NE release.)

Path Trace (J1) (number) (Setting not supported by
the current NE release.)

Tributary
Monitoring Mode

NMON, MON If set to MON an alarm is
caused, if necessary. If
NMON is set, no alarms
are caused by the
tributary.
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12 Traffic maintenance concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides you with information about traffic maintenance
regarding performance monitoring and measurements.
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Performance monitoring background
....................................................................................................................................................................................................................................

Performance Monitoring Performance Monitoring provides the user with the facility to
systematically track the quality of a particular transport entity. This is
done by means of continuous collection and analysis by of the data
derived from defined measurement points.

Definitions The following definitions explain expressions which are important for
the performance monitoring.

Anomaly An anomaly is a discrepancy between the actual and
the desired characteristic of a system component.

Defect A defect is the limited interruption of the ability of a
system component to perform a required function.

Block A block is a set of consecutive bits associated with the
path/section. Each bit belongs to one and only one block.
Consecutive bits may not be contiguous in time.

Errored block An errored block is a block in which one or more
bits are in error.

Errored second An errored second (for in-service measurements)
is a one-second interval with one or more errored blocks or at
least one anomaly.

Severely errored second A severely errored second (for
in-service measurements) is a one-second interval which contains
a configurable amount of errored blocks (default: 30 %) or at
least one defect

Background block error An errored block not occurring as part
of a severely errored second is a background block error.

Unavailable seconds Unavailable seconds determine the period
of time during which a path is in the unavailable state. A period
of unavailable time begins at the onset of ten consecutive
severely errored second events. These ten seconds are considered
to be part of unavailable time. A new period of available time
begins at the onset of ten consecutive non severely errored
second events. These ten seconds are considered to be part of
available time.
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Performance measurements
....................................................................................................................................................................................................................................

Basic Measurement
Parameters

The following definitions explain expressions which are important for
the performance monitoring.

Near-end parameters, related to the receive direction:

• Near-End Errored Seconds (N-ES)

• Near-End Severely Errored Seconds (N-SES)

• Near-End Unavailable Seconds (N-UAS)

• Near-End Background Block Errors (N-BBE)

The following basic parameters are used for the performance
monitoring:

Far-end parameters, related to the transmit direction:

• Far-End Errored Seconds (F-ES)

• Far-End Severely Errored Seconds (F-SES)

• Far-End Unavailable Seconds (F-UAS)

• Far-End Background Block Errors (F-BBE)

Enabling Performance
Measurement Points

Performance measurement points can be enabled via the Element
Manager WaveStar® SNMS and via the WaveStar® CIT.

Supported Counter Types The following table gives an overview which performance monitoring
counter type can be configured for certain termination points. As no
path termination is done within the WaveStar ™ TDM 10G (STM-64)
network element, an intermediate higher-order path performance
monitoring is implemented on VC-3, VC-4, VC-4-4c and VC-4-16c
level.

Counter Type Multiplex
Section

Regenerator
Section

HO VC
Intermediate
Path

N-ES X X X

N-SES X X X

N-UAS X X X

N-BBE X X X

F-ES X – X

F-SES X – X

F-UAS X – X
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Counter Type Multiplex
Section

Regenerator
Section

HO VC
Intermediate
Path

F-BBE X – X

Data Storage All the data is stored in the current bin. The managed NE has a
current data register (current bin) for 15 minutes and 24 hours. Once a
termination point for measurements has been configured, you are able
to get a snapshot view of the data gathered at any time (default).

Data Retrieval Performance Data can be polled via the WaveStar® SNMS and via
the WaveStar® CIT.

Historic Bins The network element keeps a store of the historic 15 minute and 24
hour bins as shown in the following table.

Interval Number of historic bins Total storage time

15 minute 32 8 hours

24 hours 1 1 day

Performance measurements Traffic maintenance concepts

....................................................................................................................................................................................................................................

1 2 - 4 Lucent Technologies 365-371-524
Issue a, October 2001



Performance management parameters
....................................................................................................................................................................................................................................

Global PM Management
Parameters

The following table gives an overview over the parameters in the
global performance management parameters window.

Field Possible values Meaning

Collect PM Data (checked, not
checked)

Switch on or off the
collection of PM data by
SNMS.

For 15 minute
Reports: (1 to 30
days)

1, ..., 30 (slider) Number of days for which
15 minute reports are
collected.

For 1 day
Reports: (1 to 30
days)

1, ..., 30 (slider) Number of days for which
1 day reports are collected.

NE PM Management
Parameters

The following table gives an overview over the parameters in the NE
performance management parameters window.

Field Possible values Meaning

Enable 15 minute
PM data
collection for this
NE

(checked, not
checked)

The 15 minute PM data
collection for this NE is
enabled or disabled.

Enable 1 day PM
data collection for
this NE

(checked, not
checked)

The 1 day PM data
collection for this NE is
enabled or disabled.

All facility types
in this NE

on, off (radio
button)

The performance date
from all facility types in
this NE are collected.

Only these
facility types

on, off (radio
button)

The performance data
from the below checked
facility types in this NE
are collected.

STM-64, STM-16,
STM-1, STM-1E,
VC3, VC4,
VC4-4C,
VC4-16C

(checked, not
checked)

Only data from the here
checked facility types are
collected, if Only these
facility types is selected.
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Equipment protection switch parameters
....................................................................................................................................................................................................................................

Equipment Protection
Switch (Timing Pack Equ.)

Parameters

The following table gives an overview over the parameters in the
global performance management equipment protection switch
parameters for timing pack equipment window.

Field Possible values Meaning

Switch Command CLEARFRCD,
FRCD, MAN

A previous forced
protection switch can be
cleared (CLEARFRCD) or
a manual (MAN) or forced
(FRCD) switch can be
issued.

Destination Entity 0, 1 Entity for which the
switch is issued.

Destination Entity
AID

(AID) AID of the entity for
which the switch is issued.

Switch Fabric Pack
Equipment Parameters

The following table gives an overview over the parameters in the
switch fabric pack equipment parameters window.

Field Possible values Meaning

Switch Command CLEARFRCD,
FRCD, MAN

The switch commands
have the following
meaning

• CLEARFRCD—Clears
a previous FRCD
request. Allows the
protection to switch
automatically

• FRCD—A forced
switch is issued even if
the other line would be
faulty.

• MAN—A manual
switch is issued only if
the other line is error
free.

Destination Entity 0, 1 Entity for which the switch
is issued.

Destination Entity
AID

AID AID of the entity for
which the switch is issued.
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Cross connection loopbacks
....................................................................................................................................................................................................................................

Purpose of cross
connection loopbacks

Cross connection loopbacks (also referred to as “XC loopbacks”)
make it possible to loop an input tributary back to the output of the
same tributary. The selected input tributary is looped back in the
switch unit (SWITCH/STS576 circuit pack).

Cross connection loopbacks can be used for testing purposes.

Functional principle The following schematical diagram depicts the functional principle of
cross connection loopbacks.

A cross connection loopback can be regarded as a temporary cross
connection of indeterminate duration. If a cross connection already
exists on the selected tributary, an alarm indication signal (AIS) is
inserted downstream during the loopback. If a cross connection exists
in the opposite direction, the signal is terminated during the loopback.
When the cross connection loopback is released, any cross
connections that were affected by the loopback are automatically
re-established and the insertion of AIS is brought to a termination.

Active cross connection loopbacks are indicated via the ABN LED on
the user panel.

Permitted signal levels Cross connection loopbacks can be performed on any tributary
regardless of whether there exists a cross connection for the selected
tributary or not.

The permitted signal level of the tributary to be looped back depends
on the respective port unit, possible signal levels are:

STM-1 port units (opt.
or electr.)

VC-3 or VC-4

SWITCH/STS576

AIS

Tributary

Port Unit

Pre-existing Tributary

Legend:

Termination
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STM-4 port units VC-3, VC-4 or VC-4-4C

STM-16 port units VC-3, VC-4, VC-4-4C or VC-4-16C

STM-64 port units VC-3, VC-4, VC-4-4C or VC-4-16C

Cross connection loopbacks Traffic maintenance concepts
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Near-side facility loopbacks
....................................................................................................................................................................................................................................

Purpose of near-side
facility loopbacks

Near-side facility loopbacks can be used to test the correct cabling
between two network elements including the involved port unit’s
physical interfaces.

Functional principle The following schematical diagram depicts the functional principle of
near-side facility loopbacks. For simplification, only one tributary port
unit is shown.

The incoming signal at the port unit input is, where appropriate after
optical-to-electrical conversion, entirely looped back to the port unit
output.

OC192/STM64

* Possible port units are:
OC3/STM1
OC12/STM4
OC48/STM16
STM1E, STM1EE4

The PPROC/STS192
pointer processor circuit
pack is shown!not

OC192/STM64SWITCH/
STS576

SWITCH/
STS576

TP

AP AP

AIS

Port Unit*

O
/E

O
/E

AP Aggregate Port
TP Tributary Port

Optical-to-electrical conversion

From/to other network
elements or external
test equipment

Insertion of AISAIS

O/E
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Non-transparent and complete

Near-side facility loopbacks are non-transparent and complete.
“Non-transparent” means that the signal transmitted downstream is
different from the signal looped back. “Complete” means that the
signal is not changed before it is looped back. AIS is inserted in the
downstream direction after the near-side facility loopback.

Supported port unit types

Near-side facility loopbacks are supported on all optical or electrical
tributary port units (STM1E, STM1EE4, OC3/STM1, OC12/STM4,
OC48/STM16) but not on OC192/STM64 aggregate port units.

Near-side facility loopbacks Traffic maintenance concepts
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Far-side facility loopbacks
....................................................................................................................................................................................................................................

Purpose of far-side facility
loopbacks

Far-side facility loopbacks can be used to test paths through a network
element.

Functional principle The following schematical diagram depicts the functional principle of
far-side facility loopbacks. For simplification, only one tributary port
unit is shown.

The electrical transmission signal at the port unit output, on both
electrical and optical port units, is looped back to the corresponding
port unit input with passing through as many equipment components
as possible.

* Possible port units are:
OC3/STM1
OC12/STM4
OC48/STM16
STM1E, STM1EE4

The PPROC/STS192
pointer processor circuit
pack is shown!not

OC192/STM64

SWITCH/
STS576

O
/E

O
/E

SWITCH/
STS576

OC192/STM64

Port Unit*

AP

AP AP

Aggregate Port
TP

TP

Tributary Port

Optical-to-electrical conversionO/E
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Transparent and complete

Far-side facility loopbacks are transparent and complete.
“Transparent” means that the signal is both looped back and continued
in the original direction. “Complete” means that the signal is not
changed before it is looped back.

Supported port unit types

Far-side facility loopbacks are supported on all optical or electrical
tributary port units (STM1E, STM1EE4, OC3/STM1, OC12/STM4,
OC48/STM16) but not on OC192/STM64 aggregate port units.
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Loopback parameters
....................................................................................................................................................................................................................................

Loopback Parameters The following table gives an overview over the parameters in the
loopback parameters window.

Field Possible values Meaning

Access Identifier (AID) AID for which the
loopback shall be
operated.

Loopback Type Cross-Connect
Loopback,
Near-side Facility
Loopback, Far-side
Facility Loopback

Type of the loopback

Rate VC4, VC3,
VC4–4C,
VC4–16C, STM-1,
STM-1E, STM-4,
STM-16, STM-64

Signal rate at which the
loopback operates.

Action Operate Loopback,
Force Loopback

A loopback can be
operated in a normal way
or being forced.
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13 Software upgrade concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides background information on features relating to
the NE Software Management.

Contents
NE memory concept 13-2

Software download 13-3

Software activation 13-5

Configuration backup and restoration 13-6
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NE memory concept
....................................................................................................................................................................................................................................

Overview The WaveStar® TDM 10G (STM-64) system is equipped with volatile
working memory and non-volatile memory (NVM). WaveStar® TDM
10G (STM-64) systems make use of a PCMCIA card (“flash disk”) as
a nonvolatile memory.

PCMCIA flash disk The PCMCIA flash disk is used to store the currently active and a
previous version of the executable NE software and configuration
data. The PCMCIA flash disk is inserted into the PCMCIA slot of the
CTL/SYS50DM system controller. The “previous” store area is the
one into which data can be downloaded using the SNMS network
management system or the WaveStar® CIT. Activating (“installing”) a
newly downloaded software version changes the current/previous
assignment automatically.

The following figure illustrates the partitioning of the PCMCIA flash
disk.

Preparing a PCMCIA flash
disk

When initially delivered, the PCMCIA card is empty. WaveStar® CIT
can be used to copy the initial software generic from CD-ROM to the
PCMCIA card.

NE software

Configuration Data

NE software

Configuration Data
previous

current

PCMCIA flash disk
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Software download
....................................................................................................................................................................................................................................

Definition Software download is the process of transferring a software
generic from a remote entity to a target NE’s memory. The
remote entity may be a network management system or a CIT.
The download process is responsible for establishing the
association between the source of the software generic and the
target NE and ensuring the integrity of the data during the
transfer. The download procedure uses bulk transfer to move an
uninterpreted binary file into an NE.

Types of software
download

Depending on the state of the network element, there are two possible
types of software download:

• Initial software download

• Software download for upgrade purposes.

Initial software download Typically, when a software generic is installed for the first time, it is
necessary for a craft person to be present on site to monitor the
installation. The on-site installation is supported via removable storage
media (PCMCIA card) associated with WaveStar® CIT.

The software is initially delivered to the customer via CD-ROM. The
PCMCIA card is initially empty. The software generic has to be
copied from the CD-ROM to the empty PCMCIA card via WaveStar®
CIT. Afterwards, the PCMCIA card is being inserted into the NE.

Software download for
upgrade purposes

After a software generic is initially installed on-site, its future releases
may be downloaded remotely from a centralized location supported by
a configuration management application. Remote downloading of
software generics not only minimizes dispatching of technicians, but
also provides tighter coordination and synchronization among the
activation of these software generics across multiple NEs.

Upgrading a software generic in the NE

• causes no disruption to customer services

• causes no disruption to operations support, such as performance
monitoring and protection switching

• does not alter any of its existing option settings, e.g.,
performance monitoring parameters

• requires no re-entry of site-dependent data (e.g., provisioned
parameters) into the service database of the NE.

Before accepting the loading of a software generic, the NE verifies a
match between its type and the type specified in the software generic
control information.
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The download time for a software generic to the non-volatile memory
(NVM) of the NE from SNMS connected indirectly via a LAN
network is approx. 1 hour, via DCC approx. 2 hours.

After completion of the software download, there are now two
versions of the software on the NE, the currently active version and
the newly downloaded version which has replaced the former backup
version.

After a software generic has successfully been loaded onto the NE,
the NE waits for an activation or apply command.

Software download Software upgrade concepts

....................................................................................................................................................................................................................................

1 3 - 4 Lucent Technologies 365-371-524
Issue a, October 2001



Software activation
....................................................................................................................................................................................................................................

Definition Activation is the process of actually interpreting and unpacking
the binary program or data that was loaded in the non-volatile
memory (PCMCIA card) by a previous download operation, and
copying the constituent data items to their designated locations
within the NE.

Concept Software activation is initiated by the user who sends a
software-activate command to the NE.

The NE activates the software by transferring it from the non-volatile
memory (PCMCIA card) into working memory.

The NE automatically verifies the new software application and
commits the new software application if the tests were successful, or
backs out of the software installation to the previous software in case
of unsuccessful test results.
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Configuration backup and restoration
....................................................................................................................................................................................................................................

Definition Configuration backup and restoration To recover from loss of
NE data because of human error, power failure, NE design flaws,
software bugs etc, the system provides a backup and restoration
capability.

Backup The backup operation deals with saving an image of the current data
and program of an NE in a non-volatile storage area in a remote file
store. The remote location could be a network management system or
a CIT (e.g. on-demand backup).

Restore In the restoration process the backup data is copied back into the
working memory. After the binary image is loaded the OS sends the
incremental changes to the NE. The NE verifies a match between the
destination of the binary image against its TID before accepting a
restoration file. All command processing is suspended during
restoration.

No impact on service The backup and restore operation does not interfere with or interrupt
the service.

Software upgrade concepts

....................................................................................................................................................................................................................................

1 3 - 6 Lucent Technologies 365-371-524
Issue a, October 2001



NE software generic information
....................................................................................................................................................................................................................................

General Via SNMS you can retrieve the current software version ID. Software
updates, or patches, are identified and included in the current version,
if appropriate.

Software version
numbering

The version number of a software generic (e.g., new, point, or patch)
is identified by a numeric scheme by which a new release and its
subsequent point and patch releases can unambiguously be identified
and related. Each field in the version numbering has two digits.

As an example of version numbering, x.y.z, which signifies the z
patch release to the y point release associated with the x release,
corresponds to the successive edits for the first release.
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Software Management
....................................................................................................................................................................................................................................

Introduction The WaveStar SNMS Software Management feature provides a set of
functions that automates the process of transferring NE software from
Digital Access Tape (DAT) or CD-ROM to the WaveStar SNMS host
machine, and downloading, activating, and copying software to NEs.
The Software Management functions assist you in doing a generic
software upgrade of a given NE type in the network by providing the
ability to download NE software to NEs. The Software Management
features also provides backup and restore functions to protect against
NE data loss. Software management functions can be performed on
demand or scheduled to be performed at a later time.

Software management
functions

The following functions are provided for executables:

• NE Software Transfer

• NE Software Download

• NE Software Activate

• NE Software Delete

The following functions are provided for data:

• NE Software Backup

• NE Software Restore

The following function is provided for Software Release Information:

• View software release descriptive information

Ways to perform software
management functions

Some of the Software Management functions can be performed either
on-demand or scheduled. Scheduled tasks are set up to be performed
once or periodically at a certain time. As with other scheduled tasks,
you can specify the number of times to retry a failed or incomplete
Software Management activity, as well as the time interval between
attempts.

The following table indicates how the various Software Management
functions can be performed.

Software Management Function On-Demand Scheduled

NE Software Transfer x

NE Software Download x x

NE Software Copy x x

NE Software Activate x x

NE Software Delete x
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Software Management Function On-Demand Scheduled

NE Software Backup x x

NE Software Restore x
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Software transfer via removable media
....................................................................................................................................................................................................................................

DAT and CD-ROM For file transfer from Digital Access Tape (DAT), the WaveStar
SNMS hosts are configured so that all the user has to do is physically
mount the tape and then use the WaveStar SNMS application to
transfer the files to the WaveStar SNMS file system. For file transfer
from CD-ROM, the user must both physically load the CD-ROM and
use UNIX utilities to mount the file system for the CD-ROM. Once
the CD-ROM has been inserted and mounted, a user can use the EMS
GUI application to transfer the files from the CD-ROM to the EMS
file system.

Other tools It is also possible to use other commonly available tools and
applications to get software files into the EMS file system (for
example, use file transfer software, such as File Transfer Protocol
(FTP), to transfer software to WaveStar SNMS over a network).

Viewing descriptive
information for an NE

software release

Prior to transferring a new software release or after the software
transfer, WaveStar SNMS provides a function for viewing descriptive
information for all software releases that are currently maintained on
the WaveStar SNMS host machine for a given NE type.

Maximum number of
software releases on
WaveStar SNMS host

The maximum number of software releases for a given NE type than
can reside on the WaveStar SNMS host machine varies with the host
type.

The following table shows the maximum number of NE software
release copies by host type.

Host Type Number of NE Software
Release Copies Per NE Type

K580 3

K460 3

K360 2

K380 3

If the host limit is exceeded, and you attempt to transfer a new
software release, WaveStar SNMS informs you of this and instructs
you to delete at least one of the existing software releases. You can
use the NE Software Delete function to do this (see “Delete NE
Software” (7-11)).
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NE software download
....................................................................................................................................................................................................................................

Software Download
function

The Software Download function allows you to download a specific
software release from the WaveStar SNMS host to a specified NE.
Software downloads are done by specifying the NE type and the
software release to download. Software downloads are performed by
WaveStar SNMS via an IAO-LAN interface using File Transfer
Access Method (FTAM) protocol.

Verifying software
downloads

When a software download is performed WaveStar SNMS checks if
the release identified for the download is older than or the same
version currently running on the NE, or if it is a release that is not
supported by WaveStar SNMS. If any of these conditions occur,
WaveStar SNMS informs you of this, and asks if you want to proceed
with the software download anyway. You have the option of
continuing with the software download or cancelling it. WaveStar
SNMS informs you of the status of the download. If the software
download fails for some reason, WaveStar SNMS issues an error
message.

Maximum number of
software downloads

The number of simultaneous software downloads allowed by
WaveStar SNMS is 4.

The WaveStar NE Software
Download Process

The following figure illustrates the software download/activation
process for WaveStar NEs
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When software is downloaded from WaveStar SNMS to a WaveStar
NE, it replaces the non-working copy in the NE’s Non-Volatile
Memory (NVM). When you perform a software download and click
the Apply button on the Software Download to NE window, the
currently non-working release is activated and becomes the active
version. The software release that it replaces in working memory
remains in the NVM and becomes the previous software version.
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NE software activate
....................................................................................................................................................................................................................................

Software Activate function The Software Activate function allows you to activate a specific
software release on an NE. When new software is downloaded to an
NE, it is placed in “standby” until it is activated; it then replaces the
old software.

Software activation for the
WaveStar NEs

WaveStar NEs maintain two copies of software in Non-Volatile
Memory (NVM), one of which corresponds to the installed and
working software and the other is typically the previous version that
was replaced by the current working version. When a new version is
downloaded using the Software Download function, it replaces the old
version in the NE’s NVM. When a software activation is performed,
the new software release is installed from the NVM and current
running version becomes the standby version in NVM.

Verifying software
activations

When a software activation is performed, WaveStar SNMS checks if
the software being activated is the same as the current version, older
than the current version, or is currently not supported by ITM SNC. If
either of these conditions exist, WaveStar SNMS informs you of this,
and asks if you want to continue with the software activation anyway.
You have the option of continuing with the software activation or
cancelling it.

Software activation failures When WaveStar SNMS is unable to complete an on-demand request
to activate NE software on one or more NEs because some of the NEs
rejected the software activation request, WaveStar SNMS displays an
error message for each failed NE request.

Loss of communications When WaveStar SNMS loses its connection to the NE as a result of a
software activation request, and determines that the activation request
was unsuccessful upon re-establishment of the connection with the
NE, a failure message is logged in the Activity Log and WaveStar
SNMS issues a failure message in the status bar for failed on-demand
requests.
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NE software delete
....................................................................................................................................................................................................................................

Software Delete function The Software Delete function allows you to delete a specific software
release from WaveStar SNMS for an NE type.

Deleted SW not
recoverable

When software is deleted from WaveStar SNMS, it is not recoverable.
The only way to get the software back into WaveStar SNMS is to
reload it from a tape on CD-ROM. WaveStar SNMS informs you of
this prior to actually deleting the software. You have the option of
continuing with the software deletion anyway or cancelling the
deletion.
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NE data backup
....................................................................................................................................................................................................................................

NE Software Backup The NE Software Backup feature lets you perform an on-demand
backup of an NE’s provisioning data. The provisioning data includes
port parameters and cross-connections.

Check for necessary
backup

To avoid unnecessary redundant backups of NE data that has not
changed since the last backup, WaveStar SNMS checks the selected
NE to make sure a backup is necessary. If there is no change in the
NE’s configuration status since the last backup, a backup is not
necessary and you are informed of this and given a choice of
performing the backup anyway or cancelling it. If you choose to do a
backup anyway, all data is backed up.

Storage of backup data NE backup data is stored in flat ASCII files with header information,
including the NE type, software release, NE’s TID, equipment/slot
information, the ID of the user performing the backup, date/time of
the backup, and the system release that created the backup.

Simultaneous backups The number of simultaneous NE backups (either on-demand or
scheduled) that can be performed depends on the WaveStar SNMS
host type.

The following table indicates the number of simultaneous backups that
can be performed by host type.

Host NE Simultaneous Backups

K580 (6 CPU) 6

K580 (4 CPU) 6

K580 (2 CPU) 6

K460 6

K360/K380 4

If you attempt to perform more than the maximum number of
simultaneous backups than can be performed for the WaveStar SNMS
host type, the new backup is not accepted and WaveStar SNMS
informs you that no more backups can be performed at the current
time.
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Backups/Restorals for the
WaveStar NEs

Some of the WaveStar NEs and NCCs have both a primary NVM that
mirrors the current working memory configuration and a local
secondary storage device that provides a local memory backup and
restore capability. WaveStar SNMS supplements the local memory
backup and restore, by both managing the local backup and restore
capability and providing additional capabilities to back up and restore
NE configuration data to/from WaveStar SNMS as is done for other
NE types.

The WaveStar NEs Memory
Backup and Restore

Process

The following figure illustrates the basic memory backup and restoral
scheme for the WaveStar NEs.

Data transfers between the NE’s primary NVM and secondary storage
use local file system copy functions. WaveStar SNMS allows you to
choose whether to back up the NE data to WaveStar SNMS memory
or the NE’s local secondary storage.

Alarms present during
backups

If an on-demand NE backup is performed on an NE with alarms
present, you are informed of this and given a choice of proceeding
with the backup anyway or cancelling it.

NE data backup Software upgrade concepts
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NE data restore
....................................................................................................................................................................................................................................

NE Restore function The NE Restore function allows you to restore NE data that was
backed up using the NE Backup function.

Backup/Restore in
progress

When a backup or restore is in progress, WaveStar SNMS prevents
the execution of any command that may change the settings of NE
parameters until the backup or restore is completed.

Backup/Restore requested When a restore is requested, WaveStar SNMS compares the NE type,
software release, and equipment of the NE with the data in the
selected backup file. If the NE type or software release does not
match, a message is issued and you are given the option of continuing
with the restore anyway.

Types of NE restorals There are two types of NE restorals that can be performed:

• Regular Restore

• Intelligent Restore

Regular restore A Regular Restore restores all backup data from the selected NE file,
including parameters set to the default settings.

Intelligent restore If you select the Intelligent Restore option, WaveStar SNMS compares
each parameter setting from the backup file against its default value.
If the current setting matches the default value, that parameter is
excluded from the restore. If all parameters on a given command
issued during the restore request match the defaults, that command is
skipped during the restore process. Only parameters that do not
currently match the default settings are set, thus reducing the amount
of time it takes to restore the NE to the backup data.

The Intelligent Restore option is not available for NEs that use file
transfer-based (FTAM) restorals, such as the OLS 400G R. 2.0 NE.

Restoring NE backup data The files that are created by the NE Backup function are accessible
through the NE Restore function. WaveStar SNMS stores up to seven
files for each NE. When seven backup files exist and another backup
file is created, the oldest backup file is removed.

Verifying NE restorals WaveStar SNMS keeps you informed about the status of the NE
restoral in progress. If the restoral fails for some reason, WaveStar
SNMS informs you of the problem via a pop-up message window.
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14 SNMS tutorial

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides information on the WaveStar® TDM 10G
(STM-64), of SNMS and its graphical user interface. It also includes
descriptions of simple basic procedures which are useful when
provisioning a NE, like fault management.
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Purpose This section introduces the WaveStar® TDM 10G (STM-64).
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WaveStar® TDM 10G (STM-64) network solutions
....................................................................................................................................................................................................................................

Overview The WaveStar™ 10G Time Division Multiplexer (TDM) is a global
platform design supporting both the SONET product version as well
as the SDH product version.

This Provisioning Guide applies to the SDH version only which is
referred to as the WaveStar® TDM 10G (STM-64). For information
on the SONET version please ask for the WaveStar TDM 10G
(OC-192) Application, Planning and Ordering Guide.

The WaveStar® TDM 10G (STM-64) supports high-capacity,
self-healing transport by means of an SDH-standard STM-64 line rate
signal in an SDH-standard 2-fiber MS-SPRing protected ring. The
feature set in the first release (R1.x) provides commonality with
existing SDH transport products as well as an advanced set of
market-proven features. The feature set will grow continuously in
future releases. For planning reasons, major future features (R2.0) will
also be mentioned within this Application, Planning and Ordering
Guide.

Key features Key features of the WaveStar® TDM 10G (STM-64) include:

• STM-64 and STM-16 2-fiber MS-SPRing transmission

• STM-1 (el), STM-1(o), STM-4 and STM-16 interfaces

• 1+1 Multiplex Section Protection (MSP) for optical tributary
interfaces

• 100% (64 x STM-1) add/drop capability to/from the STM-64
aggregate interfaces using any combination of available tributary
interfaces

• flexible, non-blocking VC-4 (and VC-3, VC-4-4c) granularity
cross connect

• TL1 operations interface

• manageable by WaveStar™ SNMS element and subnetwork
manager and WaveStar™ CIT
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Applications WaveStar® TDM 10G is equipped with two STM-64 lines. It accesses
the STM-64 signals with an unrestricted Time Slot Assignment (TSA)
capability. Low-speed hairpin applications are supported to directly
interconnect any tributary interfaces. Multiple ring applications are
supported to directly interconnect added/dropped tributaries between
STM-64 and STM-16 rings. The ability to support and efficiently
interconnect multiple STM-16 rings and an STM-64 ring using a
single Network Element provides the basis for advanced networking
capabilities and potentially large cost savings.

The start-up configuration consists of a single shelf. The design is
compliant to ETSI specifications.

Differentiators The main differentiators of the product are:

• High drop capacity

• Distributed cross-connect capabilities

• No single point of failure in the network element (DNI, Dual
Node Interworking)

• Extended range of low speed interfaces

• Integrated design (supports multiple ring applications in the
network element)

• Compact design (one-shelf solution)

• Flexibility in applications and protection capabilities

• Easy installation & maintenance.

These features make the WaveStar® TDM 10G (STM-64) one of the
most cost-effective, future-proof and flexible network elements
available on the market today.

Configurations Because of the modular design of the WaveStar® TDM 10G
(STM-64), the system can be configured as a:

• Add/Drop Multiplexer (ADM) system working at STM-64 level
in rings or linear chains

Management Like all network elements of Lucent Technologies SDH product
portfolio the WaveStar® TDM 10G (STM-64) is managed by Lucent
Technologies Integrated Transport Management (ITM) system, a
user-friendly network and element level management system. A local
craft terminal is available as well, the WaveStar™ Customer Interface
Terminal (CIT)
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Interworking The WaveStar® TDM 10G (STM-64) is a next-generation SDH
transport system. The system can be deployed together with other
Lucent Technologies SDH products e.g. WaveStar™ ADM-16/1,
WaveStar™ BandWidth Manager. This makes the WaveStar® TDM
10G (STM-64) one of the main building blocks of today’s and future
SDH networks.
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The WaveStar™ product family
....................................................................................................................................................................................................................................

Overview Lucent Technologies offers the industry’s widest range of high-quality
transport systems and related services designed to provide total
network solutions. Included in this offering is the WaveStar® family
of products. The WaveStar® product family offers telecommunications
service providers advanced services and revenue-generating
capabilities.

Family members The WaveStar® family includes products designed to bring your
networks forward into the next century.

The following table lists WaveStar® products that are currently
available or under development.

WaveStar® Product SONET SDH

WaveStar™ BandWidth Manager Yes Yes

WaveStar™ 2.5G Yes No

WaveStar™ ADM 4/1 No Yes

WaveStar™ ADM 16/1 No Yes

WaveStar™ LXC-16/1 No Yes

WaveStar™ TDM 10G Yes Yes

WaveStar™ TDM 40G Yes Yes

WaveStar™ Optical Line System (OLS) 40G Yes No

WaveStar™ Optical Line System (OLS) 80G No Yes

WaveStar™ Optical Line System (OLS) 400G Yes Yes

WaveStar™ DACS 4/4/1 No Yes

WaveStar™ DVS Yes No

WaveStar™ Subnetwork Management System
(SNMS)

Yes Yes

Family features The WaveStar® product family offers customers

• SDH and/or SONET-based services

• Scalable cross-connect, multiplex and transport services

• Network consolidation and reliability

• Interoperability with other vendors’ products

• Coordination of network element and element management
services
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WaveStar® TDM 10G description
....................................................................................................................................................................................................................................

Overview The WaveStar® TDM 10G add/drop multiplexer is in its basic
configuration a single shelf that interfaces electrical and optical
STM-1, optical STM-16 Mbit/s lines to a SDH-standard 2-fiber
MS-SPRing protected ring. It has 16 tributary slots that support
flexible optical and electrical port unit mixing. The shelf is in
accordance with Rec. ETS 300 119-4 and can be mounted in an ETSI
rack.

Transmission interfaces WaveStar® TDM 10G includes the following optical and electrical
port units.

• Optical interfaces

• Electrical interfaces

Optical interfaces STM-64 port units are available in the 1.5 µm wavelength
(intermediate reach).

STM-16 port units are available in two wavelengths:

• 1.3 µm wavelength (long reach)

• 1.5 µm wavelength (long reach)

Each STM-16 port unit contains one bidirectional port. Two STM-16
port units are necessary to terminate one STM-16 MS-SPRing
protection.

STM-1 port units are available for 1.3 µm wavelength (short reach)
single-mode fiber applications. The STM-1 port units feature four
bidirectional ports per circuit pack.

Electrical interfaces The electrical STM-1 port units are capable of transmitting and
receiving signals at the 155 Mbit/s rate. Each port unit contains four
independent bidirectional ports.

Control and
synchronization

WaveStar® TDM 10G uses a single control system and a dual
synchronization system.

Switch capacity The 192x192 switch fabric of the WaveStar® TDM 10G supports
simultaneous cross-connections from each of up to 128 input STM-1
equivalents to all of the up to 128 output STM-1 equivalents. The
cross-connections are fully non-blocking and can have unlimited
broadcasting within a shelf.

Introduction to WaveStar® TDM 10G SNMS tutorial

....................................................................................................................................................................................................................................

1 4 - 8 Lucent Technologies 365-371-524
Issue a, October 2001



WaveStar® TDM 10G main
shelf

The following figure illustrates the WaveStar® TDM 10G (STM-64)
main shelf.
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The WaveStar SNMS Graphical User Interface

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides background and introductory information about
the WaveStar SNMS GUI. It includes available features and references
to specific task-related instructions.

After learning the information in this chapter, the user should be able
to do the following:

• Identify the mouse buttons and know how to use them to perform
various GUI functions.

• Obtain their user ID and password and be able to log into the
WaveStar SNMS GUI.

• Identify and use the different parts of the WaveStar SNMS Map
window, including the main menu bar, the toolbar, the alarm
directional button, the subnetwork explorer, and the Map pane.

• Recognize on the Map window the difference between Network
Elements, aggregates, the Host, trails, and managed/non-managed
devices.

• Display and use the WaveStar SNMS system help documentation.

• Use GUI lists and tables.
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Background
....................................................................................................................................................................................................................................

Introduction The WaveStar SNMS Graphical User Interface (GUI) is a Java-based,
multilevel windowing environment that provides fault, provisioning,
configuration, and security management functions and allows you to
graphically monitor the status of the network. The WaveStar SNMS
GUI is designed to be an intuitive, consistent, easy-to-use interface.
Status bar messages and windows keep you informed of the outcome
of an operation. The GUI offers point-and-click, menu-driven
operation, as well as a cut-through interface to issue TL1 commands
to connected NEs. Several types of online help are available to assist
you in performing any task. The GUI runs on PCs. Once a GUI
session is started, the GUI server can support multiple
platform-independent GUI client connections simultaneously.
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Using the Mouse
....................................................................................................................................................................................................................................

Mouse The mouse is used to move a pointer around the screen. A mouse
usually has three buttons, two of which are used to select items on the
display.

Mouse buttons The select mouse button, which is the leftmost button on the mouse,
is used to select an item in WaveStar SNMS. The terms “click” and
“select” are used interchangeably throughout the WaveStar SNMS
documentation. Both terms represent the following operations:

Mouse button Description

Select mouse button The select mouse button, which is the
leftmost button on the mouse, is used to
select an item in WaveStar SNMS. The terms
“click” and “select” are used interchangeably
throughout the WaveStar SNMS
documentation. Both terms represent the
following operations:

• Activating a button, such as OK, Cancel,
or Help

• Activating a menu, such as a pull-down
menu on the menu bar

• Selecting an item from a menu

• Selecting an NE/aggregate symbol on the
Map window

• Selecting an item from a scroll list

• Moving window focus to a text field to
type an entry in the field

To do a click or select operation, position
the mouse pointer over the desired list
item, NE/aggregate icon, button, field, or
menu, and double click the select mouse
button.

Menu mouse button The menu mouse button, which is the
rightmost button on the mouse, is used to
bring up (activate) a pop-up menu.

To activate a pop-up menu, position the
mouse pointer over the object (like an NE or
aggregate icon on the Map pane or
Subnetwork Explorer), and single-click the
menu mouse button.
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Manipulating Fields and Text
....................................................................................................................................................................................................................................

Entering text The following guidelines explain how to enter text in windows that
contain text fields:

• Press the Tab key to enter text that you have typed in a field.
Pressing the Tab key in a text field accepts the data in the text
field and moves the cursor focus to the next field that accepts
input. If the cursor is positioned in the last enterable field on the
window, pressing the Tab key moves the cursor to the first text
field on the window.

• Use the Tab key for field-to-field navigation within a window.

• Use the Backspace key to delete text field input.

• You can cut and paste text between text fields and/or text areas
using the standard cut and paste hot keys for Microsoft Windows
and HP Vue.
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Logging Into WaveStar SNMS
....................................................................................................................................................................................................................................

Start GUI To start up an instance of the GUI on your PC or workstation, click
on the desktop or menu bar icon representing the WaveStar SNMS
application. When you click on this icon, a command is sent to the
WaveStar SNMS host machine to start up the application. The
WaveStar SNMS Login window is then displayed for logging into
WaveStar SNMS. Click on the same icon/menu item to start up
another instance and log into the same host. Click on a separate
icon/menu item to start up a GUI instance and log into a different
host.

Log in To log into WaveStar SNMS, you must enter a valid user ID (login)
and password that you been supplied to you by your WaveStar SNMS
system administrator.

First Log-in When you log into WaveStar SNMS for the first time with a new user
login, you must change your password from the default password
given for the login. A pop-up window is displayed, indicating that you
must change your password before being allowed to log into WaveStar
SNMS. You are given the option of continuing the session or exiting
the system at this point. If you choose to continue the login session,
the Change Password window is displayed, prompting you to change
your password from the default password. The system validates your
new password. If it is valid, the system re-displays the Login window
to re-enter your user ID and your new password.

Successful login If the user ID and password that you entered are valid, WaveStar
SNMS displays an advisory message, the Alarm Notification window
and Map window are displayed.

Unsuccessful login
attempts

If you cannot log into WaveStar SNMS the first time, because you
entered an invalid user login or password, the system allows you to
retry a certain number of times (as defined by the system
administrator) before you are denied access. You must enter a valid
user ID (login) and valid password. See the Valid user ID and Valid
password sections in this chapter for definitions of a valid user ID and
password.
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Password expiration Passwords must be changed after a period of time, as defined by the
system administrator. If you attempt to log into WaveStar SNMS with
a password that is about to expire, the system informs you of this via
a pop-up window and asks if you want to change your password to
log into the system immediately. If you choose to change your
password at this time, the Change Password window is displayed. If
you choose not to change your password at this time, but the
password expiration period has not yet been reached, you can
continue to log into the system. If the password has expired, and you
do not change it, the login session will be terminated.

Valid user ID A valid User ID (login) is 1-10 alphanumeric characters in any
combination. Special characters (such as ;*&@) are not allowed.

Valid password A valid password is 6-10 characters. A password must include at least
two uppercase and/or two lowercase letters, at least one numeric, and
at least one special character (!#$%^&*()-+_=?). The following
special characters are not permitted (:,;).

Alarm notification window Once you have logged in and the GUI is running, the Alarm
Notification window is displayed. The Alarm Notification window
displays a running tally of the number of Critical, Major, Minor
alarms, Not Alarmed (which represents Standing Condition events that
require clearing), and Communication alarms for SONET, or Prompt,
Deferred alarms, No Alarms (which represents Standing Condition
events that require clearing), and Communication alarms for SDH.
The number displayed below the box for each alarm severity increases
by one whenever a new alarm of that severity occurs. You can click
on any of the severity type boxes to display the Alarm List window,
filtered for that severity type. If you click on the Communications
alarms box, a list of NEs that are currently not communicating with
the system is displayed. The Alarm List window is only displayed if
there is one or more active alarms or standing condition events in the
selected alarm severity category. Once displayed, the Alarm
Notification window remains open during the GUI session. When a
new alarm is received by WaveStar SNMS, the Alarm Notification
window is brought to the forefront of the GUI display to signal the
arrival of the new alarm.

GUI application not
running

If the WaveStar SNMS host is successfully contacted, but the
application and/or GUI server is not functioning on the host, a pop-up
message window is displayed, indicating that the WaveStar SNMS
application is not currently running on the host machine.
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Multiple GUI instances If the WaveStar SNMS host machine is successfully contacted, and
the application is running, but no more GUI instances can be started
by the GUI server, a pop-up warning message window is displayed,
informing you that no more GUIs can be connected to the host
machine, and to retry later.

Session time out When you do not use a GUI session for 15 minutes (or another time
interval specified by the system administrator), a pop-up window is
displayed, stating that the GUI session will time out in 60 seconds
and asking if you want to exit WaveStar SNMS at this time. If you
choose Yes or make no choice, you are automatically logged out of
WaveStar SNMS. If you choose No, the GUI session keeps running
and the session timeout clock is reset.
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Logging Out of WaveStar SNMS
....................................................................................................................................................................................................................................

Introduction When you log out of WaveStar SNMS, all open windows associated
with the current session are closed and the GUI client/server sessions
are terminated.

Changes made during GUI
session

If you have made changes during the GUI session to certain settings,
such as user-specified preferences for the GUI or NE positions, a
pop-up window is displayed, asking if you want to save the settings.
Choose Yes if you want to save the settings or No if you do not want
to save them.
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The WaveStar SNMS Map Window
....................................................................................................................................................................................................................................

Introduction After you have logged into WaveStar SNMS, the Map window is
displayed. This window provides access to all of the WaveStar SNMS
functions and features.

The Map window The following figure shows the WaveStar SNMS Map window.

Parts of the Map window The Map window is divided into several different but interrelated
areas.

Window area Description

Main menu bar It is located just below the Map window
label, it provides access to all the main
WaveStar SNMS functions.

Tool bar A series of buttons just below the main menu
bar that control the Map view and provide a
shortcut way of accessing some of the
WaveStar SNMS functions.
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Window area Description

Status bar A status bar—a text bar at the bottom of the
window that displays messages related to
system activity, the current date/time, and the
User ID of the user currently logged in.

Alarm Directional
button

An icon used to indicate that an alarm exists
in some portion of the map that is currently
not visible.

Subnetwork Explorer An explorer tree that is used to show a
textual list of the aggregates and NEs in a
subnetwork, along with the subnetwork’s
hierarchy.

Map pane The portion of the Map window that
provides a graphical representation of the
network, displaying the NEs, aggregates, and
trails between them.

The Map window menu All of the main WaveStar SNMS functions are accessed through the
main menu bar on the Map window. When you select a main
functional menu (for example, Configuration), this displays an
associated drop-down menu, which lists a series of related options for
you to select. The following summarizes each of the main functional
menu categories.

Menu Description

File This menu provides access to a set of
options for saving, restoring, and copying
user preferences, constructing a TL1 Macro
Builder File, and logging out of WaveStar
SNMS.

View This menu provides access to a set of
options for setting Alarm Severity and Alarm
Indications, for viewing the Trail Alarm List,
for clearing the Map window status line, for
viewing the Alarm Tally window, for
zooming in/out of the Map view, and for
setting user preferences.

Fault This menu provides access to the set of Fault
Management options for monitoring alarms
and conditions in the network.
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Menu Description

Configuration This menu provides access to the set of
Configuration Management options for
viewing and/or modifying Network Element,
port, and line parameters.

Performance This menu provides access to the set of
options for collecting and viewing
Performance Monitoring (PM) data.

TestManagement This menu provides access to the set of
functions for creating, viewing and deleting
cross-connection loopbacks and testing
purposes.

Administration This menu provides access to the set of
options for Security Management and
Network Element administration.

Logs This menu provides access to the set of
options for viewing logs generated by
WaveStar SNMS that track network and EMS
performance and activity.

Help This menu provides access to the set of
online Help options.

Map Window toolbar These series of buttons allow you to control the Map view and
provide a quick way to access many of the frequently used GUI
functions. The toolbar, from left to right, provides the following
buttons.

Button Description

Save User
Preferences

Details about this function are provided in
“Save Preferences / Map Positions” (14-35).

View User
Preferences Window

Details about this function are provided in
“Modify User Preferences” (14-33).

Turn On/Off Map
Pan

Enables or disables use of the Map Pan
feature to reposition the Map view.

Zoom in on the map Zoom into a portion of the Map pane
display.

Zoom out on the
map

Displays an enlarged view of the portion of
the Map pane display.

Reset the Zoom on
the map

Resets the Map pane view.
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Button Description

Add an Aggregate Details about this function are provided in
“Add an Aggregate” (3-2).

Clear the Status Line Details about this function are provided in
“Clearing status messages” (14-32).

Alarm Severity Changes the severity level of active alarms
displayed on the Map window. The number
and the color of the balls shown on the
toolbar button indicate the type and severity
of alarms currently being displayed on the
Map window. You can also change the alarm
severity level of displayed alarms using the
Preferences function. For details, see
“Modify User Preferences” (14-33).

Audible
Enable/Disable

Details about this function are provided in
“Audible alarms” (14-28).

Global Acknowledge Acknowledges all active alarms for an NE or
aggregate. Displays a Choose an
NE/Aggregate window. Double-click on the
NE or aggregate in the list to select it and
click the OK button. All active alarms for
the selected NE or aggregate are
acknowledged. For more details about this
function, refer to “Alarm indication and
acknowledgement” (14-50) and “Fault
Management” (14-46).

Global
Unacknowledge

Unacknowledges all active alarms for an NE.
Displays a Choose an NE/Aggregate window.
Double-click on the NE or aggregate in the
list to select it and click the OK button. All
active alarms for the selected NE or
aggregate are unacknowledged. For more
details about this function, refer to “Alarm
indication and acknowledgement” (14-50)
and “Fault Management” (14-46).

Transient Condition
Event Browser

Displays a list of transient condition (TC)
events that occur in the host’s NE network.
Transient events do not require a clear
message by the NE because they do not
change the NE’s condition over an extended
period of time. The Transient Condition
Event Browser can be displayed via Fault →
Transient Condition Event Browser.
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Button Description

Status Dialog Details about this function are provided in
“Status window” (14-36).

Help Brings up an online help window which
explains the Map window.

Alarm directional button A monitored network can be larger than can be viewed on the Map
pane at any one time and alarms can occur on network objects that
are not currently being displayed. The Alarm Directional button,
which is located in the left-hand portion of the Map window, above
the Subnetwork Explorer, shows the relative location and highest
severity alarm of the area not visible. When an alarm exists, an arrow
point is lit with the color of the alarm level, showing the direction to
go on the Map pane to view the map item in an alarm state.
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The subnetwork explorer
....................................................................................................................................................................................................................................

Subnetwork explorer The Subnetwork Explorer, located in the left-hand portion of the Map
window, is a tree diagram that shows the content and hierarchical
relationship of aggregates and NEs in the portion of the network
currently being viewed on the Map pane.

Improving the display of
the subnetwork explorer

If the TID/alias of one or more NEs/aggregates in the Explorer is
obscured, use the scroll bars below and to the right of the Explorer to
view the complete TID/alias of the item. If the display of the Explorer
list is still obscured by Map pane, position the mouse pointer on the
window bar just to the right of the Explorer. A two-sided arrow is
displayed in place of the mouse’s arrow pointer. Click and hold the
left (select) mouse button, and drag the two-sided arrow symbol to the
right until the desired view of the Explorer is obtained. Then, release
the mouse button. If the NE TID/alias listing is in complete view, the
scroll bars disappear. You can adjust the display by clicking and
dragging the bar between the Map pane and the Explorer to the left or
right, as desired.

Element labels NEs and aggregates are labeled by their Target Identifier (TID), by
default. The label format can be changed through the Preferences
option from the View menu on the Map window menu bar.

Selecting an item To select an item on the Subnetwork Explorer, position the mouse
pointer on the item and click the mouse select button. The selected
item is highlighted.

Expanding/collapsing an
item

To expand an item (such as an aggregate) in the Subnetwork Explorer,
single-click on the plus (“+”) sign next to the item. To collapse the
item, single-click on the minus (“-”) sign next to the expanded item.

Pop-Up menu A pop-up menu of WaveStar SNMS functions for the NE or aggregate
can be accessed by positioning the mouse pointer and clicking the
menu mouse button.

Map pane display Any change on the Subnetwork Explorer, such as expansion or
contraction of an aggregate, causes a corresponding change in the
network display on the Map pane.
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The Map pane
....................................................................................................................................................................................................................................

Map pane The Map pane displays a graphical representation of the network
automatically when you log into WaveStar SNMS and the Map
window is brought up.

Map pane preferences The system defaults for different characteristics of the Map pane
display, such as NE symbol sizes, shapes, alarm colors, and
NE/aggregate labels, can be changed through the Preferences option
on the View menu. See “Map preferences” (14-33) for more
information on changing characteristics of the Map pane display.

Network elements Each square on the Map pane represents an NE in your Target Group.
A square is the default shape for NEs. The shape used to represent
NEs can be changed through the Shapes panel on the Preferences
window. By positioning the mouse pointer over a specific NE symbol
on the Map pane, you can display the NE type and alias of the NE. If
tooltips help is enabled via the Preferences option, the NE type and
alias is displayed as a callout and in the status bar at the bottom of
the Map window. If tooltips help is disabled, the NE type and alias
are just displayed in the status bar on the Map window.

Aggregates The diamond-shaped symbols on the Map pane represent aggregates.
The diamond shape is the default for aggregates; this can be changed
through the Shapes panel of the Preferences window. Aggregates are
collections of NEs that do not necessarily correspond to any physical
connectivity or other NE attributes. An aggregate can consist of a
group of related NEs, such as a subnetwork, or a group of collocated
NEs that are not necessarily in the same subnetwork. An aggregate
can be moved under another parent aggregate on the Map pane or
Subnetwork Explorer by selecting it and then dragging it to the parent
aggregate symbol.

Non-managed devices A non-managed device is an NE or other telecommunications entity
that is part of the network of NEs that communicate with WaveStar
SNMS but is not managed by the system. These NE types are treated
as “non-managed devices” and appear on the Map pane display as
circles (the default shape) about the same size as the squares that
represent managed NEs.

Non-managed devices that are discovered are added to the WaveStar
SNMS database to complete the network map and to avoid retries by
WaveStar SNMS to log into a non-managed device.

Certain non-managed devices can only be manually added using the
Add an NE window on the GUI, specifying it as a non-managed
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device, when WaveStar SNMS is not communicating with the NE.
You can also change the NE type to a non-managed device through
the Modify an NE window. Once a non-managed device has been
added, WaveStar SNMS does not attempt to log into it.

EMS alarm icon The Map window pane contains an additional square-shaped icon,
labeled with the WaveStar SNMS host name, that displays the highest
severity alarm present on the host. Although this icon looks similar to
the NE symbols, it cannot be included in an aggregate or have trails
connected to it.

The EMS Alarm icon receives alarms from various application
processes and monitors the communication links between the
WaveStar SNMS host and the NEs. It indicates, for example, whether
a file system has exceeded capacity, whether there are remote printer
problems, or whether the UNIX message queues are getting full. The
icon is shown with the machine name of the host that is running the
EMS application.

Like NEs and aggregates, colors are used on the EMS Alarm icon to
show the current state of the application or its communications links.
The default colors are the same as for NEs (see “Alarms” (14-27)).
The icon shows the current highest severity alarm for the application.
Alarm clearing methods used for NEs and aggregates also apply to the
EMS application alarms.

DSA icon If the EMS-based DSA feature has been enabled, the upper right
portion of the Map window pane contains an oval-shaped icon, below
the EMS Alarm icon, that represents the Directory Services Agent
(DSA) providing NE directory information to WaveStar SNMS. An
oval shape is the default; it can be changed through the Shapes panel
of the Preferences window. This icon is labeled “DSA”. This icon
cannot be included in an aggregate or have trails connected to it.

The only pop-up menu function that is available for the DSA icon is
the manual DNO feature for Subnetwork Discovery on the DSA.

Like NEs and aggregates, colors are used on the DSA icon to show
the current alarm state. The default colors are the same as for NEs
(see “Alarms” (14-27)). The icon shows the current highest severity
alarm for the application. Alarm clearing methods used for NEs and
aggregates also apply to the DSA alarms.
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Trails The lines that run between NEs and/or aggregates represent trails.
Trails are physical links between NEs or aggregates. If there is more
than one trail between two NEs, the phrase “Multiple Trails” is
displayed when you position the mouse cursor on the trail line in the
Map pane.

Alarms The color of a map item symbol or trail indicates the level of the
most severe active alarm.

The default alarm colors for the Map pane display are as follows.

Alarm Color
(default)

Alarm Severity
Level (SONET)

Alarm Severity
Level (SDH)

Alarm Color
(default)

Alarm Severity Level
(SONET)

Alarm Severity Level
(SDH)

Red Critical Prompt

Yellow Major Deferred

Cyan Minor

Gray Throttled

Green No Active Alarms

Magenta Loss of
Communications

White Not Alarmed state Not Alarmed state

Color of an NE The center of an NE symbol may show a different color than the
border of an NE/aggregate symbol. When more than one alarm type
has occurred, the center of an NE symbol shows the highest severity
alarm that has occurred and the border shows the next highest severity
alarm. Communication alarms are always top priority and always
color the center of the NE symbol. If alarms are being throttled for an
NE, the throttled alarm color (gray) is always shown in the center of
the symbol, with the color indicating the severity of the last occurring
alarm shown in the border. If automatic alarm throttling is enabled,
the alarm throttling color is not displayed until the alarm throttling
threshold has been passed.
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White color When the color of an NE is white on the Map window (the default
color), this indicates that the NE is in a “Not Alarmed” state, or has
received one or more Standing Condition (SC) events which require
clearing by the NE. This can occur, for example, during an NE data
restore operation (for more details, see “Restore NE Data” (7-13)). SC
events which occur against the NE are counted in the alarm tallies on
the Alarm Notification window. When the SC event has been cleared
by the NE, the color of the NE returns to green, indicating that there
are not active alarms present and the NE is communicating.

Modify colors The default Alarm display colors shown in the above table can be
modified through the Preferences option of the View menu on the
Map window main menu bar. For more details, see “Modify User
Preferences” (14-33).

Blinking NE A flashing (blinking) NE symbol indicates that there are one or more
unacknowledged alarms against that NE or aggregate. For more
details see “Alarm indication and acknowledgement” (14-50).

Audible alarms A speaker-shaped symbol in the middle of the toolbar on the Map
window indicates whether the Audible Alarm feature is enabled or
disabled. This symbol has a slash through it if the Audible Alarm
feature is disabled. To enable the Audible Alarms feature, click on the
symbol. The slash is removed from the symbol. To disable the
Audible Alarm feature, click on the symbol again. A slash appears on
the speaker-shaped symbol.

The Audible Alarm feature can also be enabled or disabled by
selecting Fault from the main menu bar on the Map window and then
selecting Audible from the displayed sub-menu. If the Audible Alarm
feature is currently enabled, selecting Audible disables the feature. If
the Audible Alarm feature is currently disabled, selecting Audible
enables the feature.

When the Audible Alarm feature is enabled, an audible sound is
triggered each time a new alarm occurs on the network. Once
triggered, the audible alarm will sound for a short time and then
repeat until the alarm is cleared or it is silenced through the GUI. The
sound characteristics of the audible alarm correspond to the most
severe prevailing alarm condition (Critical, Major, Minor). The alarm
sound interval can be changed by the WaveStar SNMS system
administrator. See “Audible alarms/events” (14-55) for more details
about the Audible Alarms feature.
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Actions in the Map pane
....................................................................................................................................................................................................................................

Selecting one NE To select a single NE or aggregate on the Map pane, position the
mouse pointer over the NE or aggregate icon and click the select
mouse button.

Selecting NEs and
aggregates

To select one or more NEs or aggregates on the Map pane:

............................................................................................................................................................

1 Position the mouse pointer over a portion of the background adjacent
to the items to be selected.

............................................................................................................................................................

2 Click the mouse select button and drag the mouse pointer. As you
drag the mouse pointer, an outlined box appears over the selected area
As items in the Map pane are selected, they change color. Release the
mouse select button.

Result:

The items are selected.

Deselect NEs and aggregates

To deselect a selected item in the Map pane, position the mouse
pointer over the item and single-click the mouse select button. To
deselect a group of items, position the mouse pointer within the boxed
region and single-click the mouse select button. Any item in the box
that is already selected becomes deselected.

Moving NEs and
aggregates

To move a single NE or aggregate on the Map pane:

............................................................................................................................................................

1 Position the mouse pointer over the icon to move and press and hold
the select mouse button.

............................................................................................................................................................

2 Drag the icon to the new position and release the mouse button.
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Moving a group of NEs or
aggregates

To move a group of NEs or aggregates on the Map pane:

............................................................................................................................................................

1 Select a group of NEs or aggregates by positioning the mouse pointer
in an area of the background adjacent to the items, clicking the select
mouse button and dragging the mouse pointer (a faint dashed box
appears) to surround the items, and release the mouse select button.

............................................................................................................................................................

2 Position the mouse pointer over one of the chosen icons and press and
hold the select mouse button.

............................................................................................................................................................

3 Drag the icons to the new position and release the mouse button.

Expanding and collapsing
aggregates

To expand an aggregate and show its member NEs on the Map
pane perform the following steps.
............................................................................................................................................................

1 Select the aggregate and click the right (menu) mouse button.

Result:

A pop-up menu is displayed.

............................................................................................................................................................

2 Select Expand from the displayed pop-up menu.

Result:

The aggregate is expanded to show the member NEs on the
Map pane.
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Collapse an aggregate

To collapse the expanded aggregate, select one of the member NEs
and double-click on it. The aggregate is collapsed and the aggregate
symbol replaces the member NEs on the Map pane display.

Moving an NE to the TOP
aggregate level

To move an NE out of an aggregate to the TOP level (which
includes all NEs):
............................................................................................................................................................

1 Make sure the aggregate is expanded and then select the NE.

............................................................................................................................................................

2 Once the NE is selected, click the right (menu) mouse button to
display a pop-up menu. Choose Return to TOP.

Result:

The NE is brought to the TOP aggregate level and is taken out
of the aggregate.

Zooming the Map view
If you want to... then...

make the Map pane show
fewer map items in the
same size space

select View → Zoom In on the main
menu.

make the Map pane show
more in the same size
space

select View → Zoom Out on the main
menu.

reset the Zoom level to
zero (which is the
default)

select View → Zoom Reset on the main
menu.

Zoom buttons

You can also zoom in, zoom out, and reset the zoom by using the
Zoom In, Zoom Out, and Zoom Reset buttons on the Map window
toolbar.

Finding a Network Element WaveStar SNMS assists you in locating an NE on the Map
window if you cannot find it on the Map pane display or
Subnetwork Explorer. To find an NE:
............................................................................................................................................................

1 Select View → Find an NE from the main menu bar on the Map
window.
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............................................................................................................................................................

2 Enter the TID and/or alias of the NE and click the OK or Apply
button.

Result:

The Map pane display is repositioned to show the NE and the
NE is selected in the Map pane and Subnetwork Explorer. If
more than one match is found, the item which is found first is
indicated in the Subnetwork Explorer portion of the Map pane.
If the NE is contained in an unexpanded aggregate, the
aggregate is expanded and the NE is highlighted in the Map
pane.

Clearing status messages Status messages that are displayed in the status bar on the Map
window can be cleared at any time. To clear the status bar
message display:
............................................................................................................................................................

1 Select View → Clear Status Line from the main menu bar on the
Map window or click the Clear Message Line button on the Map
window toolbar.

Result:

The message area in the status bar is cleared.
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Map preferences
....................................................................................................................................................................................................................................

Overview There are system defaults for how map items are displayed. WaveStar
SNMS allows you to change certain characteristics of the Map pane
display, such as NE size, NE labels, NE/aggregate shapes, and alarm
colors, to suit your own needs. The appearance of Map items on the
Map pane can be changed through the Preferences option on the View
menu. Preferences are stored on a per-user basis.

Modify User Preferences Complete the following steps to modify user preferences.
............................................................................................................................................................

1 Select View → Preferences from the main menu bar on the Map
window.

Result:

The View Preferences window is displayed.

..........................................................................................................................................................

2 If you want to change... select the tab...

NE size or thickness of
trail lines between NEs

Nodes & Lines

Size, content, or
alignment of map item
labels

Labels

Colors associated with
alarms and/or
cross-connections

Colors

Shapes used to represent
NEs, aggregates, EMS
host, DSA, and
non-managed devices on
the Map window

Shapes

Alarm severity level
displayed in the Map and
Alarm Notification
windows
(Critical/Major/Minor for
SONET, Prompt/Deferred
for SDH)

Fault

tooltips help on/off
setting

Other
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If you want to change... select the tab...

date format for items on
the Map window, alarm
lists, and tallies

Other

display of Bidirectional
Line Switched Ring
(BLSR) Protected Port
Groups on the
Cross-Connect View
window

Other

............................................................................................................................................................

3 When the selected panel of options is displayed on the View
Preferences window, change the display characteristics as needed.

To change the shape for an item in the Shapes panel, double-click on
the current shape in the scroll list. A pop-up window is displayed,
showing the shapes available for selection. Click on the desired shape.
The changed shape is displayed next to the Map item in the scroll list.

To change the color indications for alarms and cross-connections on
the Map window through the Colors panel, double-click on the item
in the Colors scroll-bar list to display a palette of colors. Click on the
desired color box in the palette to select it. The color selected is
applied to the item.

..........................................................................................................................................................

4 If you want to... then click on...

save the changes made to
user preferences on each
panel, to be applied each
time the Map window is
brought up

Save

restore the saved values
for the user

Restore

retrieve and displays the
system defaults for the
preferences category,
overriding the displayed
settings

Get Defaults

............................................................................................................................................................

5 Click the Apply button to apply the changes to the Map window
display or click the OK button to apply the changes to the Map
window display and close the View Preferences window.
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Save Preferences / Map
Positions If you want to save... then select...

User preferences File → Save → Preferences

Map item positions File → Save → Positions

User preferences and Map
item positions

File → Save → Both

Restore Preferences / Map
Positions If you want to restore... then select...

User preferences File → Restore → Preferences

Map item positions File → Restore → Positions

User preferences and Map
item positions

File → Restore → Both

Copy Preferences / Map
Positions

Complete the following steps to copy another user’s preferences
and/or Map item positions.
............................................................................................................................................................

1 If you want to copy a
user’s...

choose...

Preferences File → Copy → Preferences

Map item positions File → Copy → Positions

Preferences and Map item
positions

File → Copy → Both

Result:

The Choose a User window is displayed.

............................................................................................................................................................

2 Choose a user and click the OK button.

Result:

If you are copying map item positions, the new positions are
applied to your Map pane display once a user is chosen. If you
are copying another user’s preferences, the View Preferences
window is displayed. Make any changes as necessary to the
other user’s preferences before applying them. When you are
finished making necessary changes, click the OK button.
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Status window
....................................................................................................................................................................................................................................

Overview WaveStar SNMS provides a Status window, which allows you to
check on the status of on-demand functions you requested to be
performed by the system, such as a manual DNO on an NE or manual
addition of an NE. The status dialog window is also displayed after
the completion of certain GUI functions.

The Status window can be accessed at any time, by clicking the
Status Dialog toolbar button on the Map window toolbar, or by
selecting View → Status Window from the main menu bar on the
Map window.

Status window elements The Status window is a single table with three columns.

Column Description

Processing contains a text string which describes the
function that is being performed.

Time indicates the host time, in hours/minutes, that
the function was requested.

Status indicates the status of the requested function
(see below).

Possible status of a
function

The status of a function is labeled as shown in the following table.

Status Meaning

Working A simple operation is still in progress. When
the request has finished processing, the
status of the operation changes to show the
result, as Completed, Incomplete, or Failed.

Completed The function has completed successfully. If it
is a multi-step function, such as a backup or
restore, the percentage of the function
completed successfully is shown. Example:
25%

Incomplete The function is still in the process of being
completed, or the function did not complete
due to non-communicating NE or another
problem.

Failed The function did not complete successfully
due to some problem or error.

Aborted The function was aborted by the user.
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Order of items Items on the Status window are shown in the order requested, with
the most recent function requested shown at the top of the list.
Successfully completed items are removed from the list when you
click the Close or Refresh button on the window. Click the Close
button to close the Status window.

Display status of a group Many of the functions in WaveStar SNMS can be performed on a
single NE or a group of NEs, including aggregates. To view the status
of a function being performed on a group of NEs, double-click on the
row in the Status Dialog window table that refers to the aggregate or
group of NEs.
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Help options
....................................................................................................................................................................................................................................

Overview WaveStar SNMS provides various types of online information to assist
you in using the system’s functions and features.

Help types The types of help available are:

Help type Description

Tooltips help Tooltips help assists you in identifying a
toolbar button on the Map window toolbar,
the function of a window button, or the alias
and NE type of a network element on the
Map window pane.

To identify a toolbar button, window button,
or network element, position the mouse
button on the item. The item is identified
either by a message in the status bar or a
message callout to the right of the item.

Tooltip help can be enabled or disabled
through the Preferences option accessible
through either the Map window toolbar or
through the View option on the main menu.
See “Modify User Preferences” (14-33) for
instructions on how to enable/disable tooltip
help.

Window help Window help provides specific information
about the window’s purpose or function.

Window help is accessed by clicking the
Help button on any functional window in
WaveStar SNMS.

Online
documentation

A complete version of the User Guide is
available to view online through Adobe
Acrobat Reader.

An online version of the WaveStar SNMS
documentation is accessed by selecting Help
→ User Guide from the main menu bar on
the Map window.

Product information General information about WaveStar SNMS,
including the full product name, copyright
information, the product release number, and
other related information is available at any
time from a pop-up window that is accessed
by selecting Help → About the EMS from the
main menu bar on the Map window.
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Network Element Explorer
....................................................................................................................................................................................................................................

Introduction The Network Element Explorer is a tool displayed on the Port
Provisioning, Cross-Connections, and Equipment Configuration
windows that provides a graphical, step-down, hierarchical view of the
equipment to be provisioned. The Network Element Explorer consists
of a tree diagram that shows the configurable hardware that comprises
the Network Element, and the relationship between each hardware
component.

Using the network element
explorer

The purpose of the Network Element Explorer is to graphically
display the desired hardware component and then select it for
provisioning purposes.

Equipment hierarchy The possible equipment levels that can be displayed and configured
on the Network Element Explorer are as follows: TID ⇒ Lineup ⇒
Bay ⇒ Shelf ⇒ Slot ⇒ Circuit Pack ⇒ Port ⇒ Tributary

The content and relationship of equipment shown on the explorer
varies by NE type. Not every NE contains every level of the
hierarchy. Generally, access to a shelf provides access to circuit packs
that exist on the shelf. Ports exist on circuit packs, which are placed
in slots. Slots are in shelves, shelves are in bays, and bays are in NEs.

Selecting an item To select an equipment component on the Network Element Explorer,
position the mouse pointer on the equipment component and click the
mouse select button. The selected item is highlighted.

Expanding/collapsing an
equipment component

level

There are the following ways of expanding or collapsing an
equipment component level on the Network Element Explorer:

• A select mouse button click on the plus (“+”) or minus (“-”) sign
causes the branch associated with the component level to expand
(“+”) or collapse (“-”).

• A double-click on any equipment level selects it and expands to
show the component parts. For example, if you double-click on a
shelf in the explorer, the diagram expands to show the associated
slots, by number.

• A double-click on the expanded component collapses it back to
the next higher component level.

Equipment view display Any change on the Network Element Explorer, such as expansion or
collapse of the equipment level, causes a corresponding change on the
Equipment View window.
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Window Buttons
....................................................................................................................................................................................................................................

Types of window buttons All of the windows in WaveStar SNMS from which you perform a
function have standard buttons that work the same way regardless of
the function. The following table lists the standard window buttons
and their function on windows.

Button Function

OK Accepts input on the window, validates the
input, initiates the requested operation, and
closes the window.

Apply Accepts input on the window, validates the
input, initiates the requested operation, but
leaves the window open.

Cancel Cancels the operation and dismisses the
window. Any insertions or changes made
during the use of the window are not saved.

Help Accesses online help for information about a
particular window, function, feature, or task.

Close Closes the window without performing an
operation.

Greyed-out buttons If a button is greyed out (dimmed) on a window, it means that a
function is not available. In some cases, an item has to be selected or
specified on the window before the dimmed button is activated.

Exclusive choice buttons Exclusive choice buttons in WaveStar SNMS let you choose one item
or setting from a list of two or more settings. When you change an
exclusive choice setting, the previous setting is automatically
deactivated.

Exclusive choice buttons are also called “radio buttons” because they
work like car radio preset buttons that let you change stations with the
press of a button.

To change an exclusive choice setting, click the mouse select button
with the pointer positioned on the button. Your choice is activated
when the button is darkened.

Push buttons Some of the function windows in WaveStar SNMS have push buttons
that are used to transfer one or more items (such as NEs) between
lists on the window.

The following table shows each push button label, its name, and its
purpose.
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Push
Button
Label

Push Button
Name

Purpose

> Push Right When this button is clicked, the selected
item is transferred to the list on the right
and removed from the list on the left

>> Push All Right When this button is clicked, all items on
the corresponding list on the left are
transferred to the corresponding list on
the right

< Push Left When this button is clicked, the selected
item is transferred to the list on the left
and removed from the list on the right

<< Push All Left When this button is clicked, all the items
on the corresponding list on the right are
transferred to the corresponding list on
the left
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Lists
....................................................................................................................................................................................................................................

Introduction A majority of the WaveStar SNMS functions are performed by picking
a function to perform (for example, Cut-Through) and then selecting
the item (such as a specific NE) on which to perform the function,
from a list of similar items.

To select an item from a list, position the mouse pointer over the
item(s) and click the select mouse button. The selected item(s) is
highlighted. On the type-ahead lists, it may be necessary to
double-click the select mouse button to select the item and perform
the operation.

WaveStar SNMS provides different methods of locating items on lists
to narrow the search to only the item(s) you want. These methods are:

• Scrollable lists

• A filtering/sorting function

• A type ahead field

Scrollable lists When a window in WaveStar SNMS cannot display all of the
information available to you, the information is presented in a
scrollable list. The information that you cannot see is available by
paging through the scrollable list.

Using a scrollable list The vertical bar on the right side of the window is the scroll bar. The
scroll bar consists of an up-arrow, a down-arrow, and an elevator box
between the two arrows.

The scroll bar on the window works as follows:

If you want to... then...

Display the next page click under the elevator box.

Display the next line click on the down-arrow.

Display the previous
page

click above the elevator box.

Display the previous line click on the up-arrow.

Display the bottom of
the list

drag the elevator box to the bottom of
the scroll bar and release the mouse
select button.

Display the top of the
list

drag the elevator box to the top of the
scroll bar and release the mouse select
button.
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You can select a single item from a scrollable list by positioning the
mouse pointer over the item and clicking the mouse select button.
This causes the item to become highlighted and indicates your
selection.

Filtering and sorting items WaveStar SNMS has a filter/sort function to further narrow a list to
only the item(s) you want. This function allows you to:

• Narrow a list by filtering out all items on the list that do not
match all or part of the filename, NE/aggregate name, TID, or
alias you supply.

• Sort a list by placing the items in ascending or descending order.

WaveStar SNMS allows you to filter and/or sort the list. Many of the
scrollable list windows in WaveStar SNMS provide this function.

Sorting items When you click the Filter/Sort button on a list window, a Filter and
Sort Options window is displayed to allow you to filter and/or sort
the list according to the criteria you specify.

Filter and Sort Options
window

The Filter and Sort Options window allows for the following settings:

• Alphanumeric/Wildcard Filter – This is a text field for entering
all or part of the name/label to narrow the list to only those items
that match these criteria. An asterisk (*) can be used as a
wildcard character to match one or more characters in the name
or label. Use the Backspace key to erase what you have entered
in this field.

• Sorting Optionbuttons – These exclusive choice buttons are used
to determine the sort order of the list. Click on the Ascending
button to display the list in ascending order. Click on the
Descending button to display the list in descending order. Click
on the Not Sorted button to leave the list as it is.

• OK – After making your filtering/sorting choices, click on the
OK button to apply your criteria to the list and close the
Filter/Sort window.

• Close – Click on this button to close the window without
applying any filtering/sort criteria to the list.

• Apply – After making your filtering/sorting choices, click the
Apply button to apply your criteria to the list and leave the Filter
and Sort Options window open.

• Help – Click on the Help button to obtain online help for the
Filter and Sort Options window.

The WaveStar SNMS Graphical User
Interface
Lists
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Type ahead field Many of the list windows have a “type ahead” field. This is a text
field which is usually located above the first item in the list. As you
start to type the item name or label in this field, the system
automatically selects an item from the list that matches what you have
typed. An asterisk (*) can be used in the type ahead field as a
wildcard character to match one or more characters of the item name
or label. You can also enter the entire name of the item in the type
ahead field to expedite the search and selection of an item on the list.

If you select an item from the list, the name of the item appears in the
type ahead field. The status bar on the list window indicates whether
the list has also been filtered.

The WaveStar SNMS Graphical User
Interface
Lists
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Sorting Tables
....................................................................................................................................................................................................................................

Introduction Some of the data that WaveStar SNMS retrieves from its managed
NEs, such as alarm data, is displayed in multi-column tables. Data is
displayed in table format on may windows.

WaveStar SNMS allows you to sort and display data displayed in
tables in the exact order that you need it.

Moving and dragging table
columns

To change the display order of columns in a table, position the mouse
pointer on column heading, click and hold the select (left) mouse
button, and drag the column to a different position in the table.

Example: sorting a table The following figure shows a sample Alarm Summary window where
you may want to change the order of the alarm summary data.

The default order for data on the Alarm Summary window to be
displayed is by Critical, Major, and Minor alarms. To change the sort
order in which alarm data is displayed on this type of window, you
would click on one of the column headers or select the View → Sort
option for the Alarm Summary window. Either action brings up a
Sort window.

Sort window The Sort window allows you to select three categories from the table
list on which to sort. Each category consists of a drop-down list that
contains all of the column names (in column order) from the table list
on which to sort, and two exclusive choice radio buttons, labeled
Ascending and Descending.

To sort a table, choose a column name from the First sort by
drop-down list. The item you select becomes the primary sort key for
the table list. Then, click the Ascending radio button next to the first
drop-down list to sort the table by this item in ascending order or
click the Descending radio button to sort by this item in descending
order. Ascending order is the default.

To further sort the table data, choose an item from the first Then Sort
By drop down list and then the second Then Sort By drop down list.
Choose none from the drop down list to indicate no sort at this level.
For each level, choose whether to sort the item in Ascending or
Descending order. Ascending order is the default.
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Fault Management

Overview
....................................................................................................................................................................................................................................

Purpose Fault Management monitors alarms and conditions in the subnetwork.
Users can access Fault Management functions from the Main Menu,
or by accessing the pop-up menu on an NE or Aggregate icon in the
Map window, or on the items listed in tables or other screens. Some
important Fault Management features include the alarm summary and
alarm list, viewing autonomous alarms as they are received, alarm
throttling, and visible alarm indicators.
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Alarm notification
....................................................................................................................................................................................................................................

General Another way WaveStar SNMS keeps you informed about current
alarms is via the Alarm Notification window. This window contains
information on the type and number of current alarms in the
subnetwork. It remains open (unless iconified) on your screen, and
comes to the front each time another alarm is tallied.

Alarm Notification window The Alarm Notification window contains for SDH, four buttons
labeled Prompt, Deferred, No Alarm, and EMS Communications,
corresponding to the types of alarms that may appear. The “No
Alarm” (for SDH) represents the number of Standing Condition (SC)
events that have been received which require clearing. Below each of
these buttons is a number that indicates the current number of
alarms/events for each category.

Colors When the color of an NE is white on the Map window (the default
color), this indicates that the NE is in a “Not Alarmed” state, or has
received one or more Standing Condition (SC) events which require
clearing by the NE. When the SC event has been cleared by the NE,
the color of the NE returns to green, indicating that there are no
active alarms present and the NE is communicating.

Getting more information
about an alarm

To see more information about a specific alarm severity level or the
event, just point to the desired severity button on the Alarm
Notification window and click. The system then displays the Alarm
List window, filtered by the severity type of the clicked button.

Fault Management SNMS tutorial

....................................................................................................................................................................................................................................

365-371-524
Issue a, October 2001

Lucent Technologies 1 4 - 4 7



Alarm summary
....................................................................................................................................................................................................................................

Alarm summary The Alarm Summary feature provides a single-line overview of alarm
information for each node and trail in an aggregate. This information
is provided via the Alarm Summary window on the GUI. This
window lists the NEs in your Target Group and displays the number
of critical, major, and minor alarms for each NE. The alarms can be
listed by severity or TID.

Accessing the Alarm
Summary

The Alarm Summary for a single NE can be accessed by selecting this
NE and choosing Fault → Alarm Summary form the menu in the
Map window. When no NE was selected, the Alarm Summary is
shown for all NEs.

The Alarm Summary window contains the following two sections:

• NE/Aggregate Alarm Summary Table – Each line in this table
provides, for the listed TID, a color code indicating the highest
severity alarm for the NE/aggregate, as well as a count of the
Critical, Major, and Minor alarms for SONET or Prompt and
Deferred alarms for SDH, and count of Standing Condition (SC)
events (shown under the “NA” category) for the NE/aggregate.
For the NEs listed, you can initiate cut-throughs, access the
Alarm List, define the level of alarms to be monitored/displayed,
provision the NE system parameters and port, and display
equipment. To access these tasks, point to an NE’s summary line
with the mouse, click the left mouse button to select it, and then
click the menu mouse button. A pop-up menu appears, from
which you can select the desired operation.

• Trail Alarm Summary Table – This table lists a count of critical,
major, and minor alarms for the AIDs that terminate the trail
between two NEs. A color code indicates the highest severity
alarm for the trail.

Fault Management SNMS tutorial
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Alarm list
....................................................................................................................................................................................................................................

General The Alarm List contains a line of various information about each
active alarm in an NE. You can sort the list using various criteria,
such as alarm severity and age, age alone, condition, date/time logged,
and acknowledged vs. unacknowledged. You can also acknowledge or
unacknowledge the alarms listed here.

Accessing the Alarm List The Alarm List can be accessed by pointing on an NE, pressing the
right mouse button and selecting Alarm List from the cursor menu. If
the colored region (below Critical, Major, Minor, Not Alarmed or
EMS Comm) in the Alarm Notification window is selected, the Alarm
List opens and alarms of this severity are shown only.

The Alarm List window provides the following data for each alarm
for the selected NE:

• Color – a color code associated with the alarm severity

• Alarm ID – an identifying code for the alarm

• TID – the TID of the NE that originated the message or target
TID that receives a command.

• AID – the Access Identifier, or address, of the equipment
component or facility. If this is part of an SLC NBS (Narrow
Band Shelf), an asterisk (*) appears.

• Ack – the user ID of the user that acknowledged the alarm

• Severity – Critical, Major, or Minor

• SA/NSA – whether the problem is service affecting (SA) or
non-service affecting (NSA)

• Date/Time of OCC – the date/time the alarm occurred

• Date/Time of Log DateTime – the date/time the alarm was
logged by the EMS

• Condition – a code that indicates the type of failure or status
condition

• SLA – the Signal Level Affected (category)

Fault Management SNMS tutorial
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Alarm indication and acknowledgement
....................................................................................................................................................................................................................................

General The Alarm Indicator feature graphically indicates the arrival of new
alarms by flashing the impacted nodes and aggregates. If there are one
or more alarms against an NE and alarm indication is enabled, that
node will flash (in the color of the highest severity alarm). Likewise,
if there are one of more alarms against one or more NEs in an
aggregate and alarm indication is enabled, that aggregate will flash.
(When all the alarms against an NE or aggregate are acknowledged it
no longer flashes.) Users should acknowledge alarms for which they
are responsible. (The system tags the acknowledgment so that other
users will not attempt to troubleshoot the same problem.)

Acknowledging /
unacknowledging alarms

One or more alarms can be acknowledged or unacknowledged by
selecting the alarms in the alarm list and choosing Fault →
Acknowledge Selected or Fault → Unacknowledge Selected.
Multiple alarms can be selected by pressing the Ctrl-key while
selecting the alarm. A range of alarms can be selected by selecting the
first alarm of the range as usual and pressing the Shift-key while the
last alarm in the range is selected.

All alarms in the Alarm List can be acknowledged or unacknowledged
at the same time by choosing Fault → Acknowledge All in List or
Fault → Unacknowledge All in List.

Fault Management SNMS tutorial
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Alarm details
....................................................................................................................................................................................................................................

General Alarm Details are available to the user via the Alarm List window.
This window contains a line of information about each active alarm in
an NE or aggregate. Before acknowledging an alarm, it is a good
practice to display it on the Alarm List window to check the details
and make sure you want to acknowledge it. You can then perform the
acknowledgement right from the Alarm List window.

Viewing alarm details Alarm details can be displayed by double clicking on an alarm in the
Alarm List.
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Trail alarms
....................................................................................................................................................................................................................................

General Trails are physical links between NEs. The system monitors all
existing trails for alarm conditions.

Discovery of trails NEs can only automatically discover and report to WaveStar SNMS
trails over which there is an active DCC. Users can, however, add
trails between any pair of termination points on NEs.

Information about trail The following Information about trail alarms that have occurred can
either be displayed on the Alarm Summary window or by selecting
the trail:

• Trail Alarm SummaryWindow – this lists a count of critical,
major, and minor alarms for the AIDs that terminate the trail
between two NEs.

• Trail Alarm List – this contains a line of information about each
active alarm for the trails between two NEs. This information
includes alarm severity, occurrence date/time, condition, and
date/time logged.

Displaying informations
about trails

The Trail Alarm Summary window and the Tail Alarm List can be
accessed by positioning the mouse over a trail, pressing the right
mouse button and choosing Trail Alarm Summary... or Tail Alarm
List....
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Alarm resynchronization
....................................................................................................................................................................................................................................

General Alarm Resynchronization provides the ability for the system to update
its alarm list, autonomous message log, and command/response log
from network elements in the subnetwork whenever any outage of NE
communications occurs. The system automatically resynchronizes
alarms whenever the communications status with an NE changes from
“down” to “up.” In addition, users can initiate resynchronization of
alarms on demand.

Resynchronizing alarms Alarms for a single NE can be resynchronized by pointing on the NE,
clicking the right mouse button and choosing Resynchronize Alarms
from the cursor menu. Alarms for all NEs can be resynchronized by
not choosing Fault → Resynchronize Alarms from the menu in the
Map window while no NE is selected. This opens the Choose an NE
window, where ALL must be selected and confirmed with OK.

Disable alarm throttling Please note, before resynchronizing alarms for an NE, the user should
disable the automatic/manual alarm throttling control for the NE.
Alarm resynchronization does not work unless the NE is in an
unthrottled state.

GUI and list display not
cleared

The alarm resynchronization process does not clear the existing GUI
display and alarm notification/list displays during the
resynchronization process, but rather retains the existing alarms until
the resynchronization is completed.

The system can distinguish between:

• standing alarms that already exist in the GUI and
alarm/notification list displays

• new alarms

• alarms that are cleared by the NE between resynchronizations.

This allows the system to incrementally update the GUI display and
alarm notification/list displays to accurately indicate the subnetwork
status to the user.
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Alarm throttling
....................................................................................................................................................................................................................................

General The Alarm Throttling feature enables you to limit the amount of
autonomous messages and Critical autonomous messages that should
be monitored for an NE.

Recommended values Alarm throttling can be done on demand for an NE through the Alarm
Throttling option on the NE’s pop-up menu or be set up to occur
automatically when the number of alarms exceed a specified
threshold. An alarm throttle level between zero and 3,600 per hour
can be specified in the Automatic Alarm Throttling window. The
recommended initial level is 100 messages per hour (and this is the
default). If an NE has been enabled for alarm throttling and the
number of alarms in the NE exceeds the set level, the NE is
automatically put on throttled, or partial, alarm monitoring.

Throttle alarms The automatic throttling of alarms can be changed by choosing
Administration → Fault → Alarm Throttling... from the menu in the
Map window. Select the desired NE in the Subnetwork Explorer
portion of the window and enable or disable the alarm throttling under
Set Alarm Throttling to. Set the messages per hour either by using
the slider or entering a number in the text field.

Maintenance activity The Alarm Throttling feature is useful during events, such as an initial
network turn-up (or maintenance activity), where large numbers of
messages are generated by an NE. Throttling alarm only allows alarms
of a Critical priority to be displayed on the GUI, sent upstream to an
OS, or retrieved via alarm queries. (Non-maintenance-related
messages are not affected by alarm throttling and continue to be
logged in the normal manner.)

View only throttled alarms
/ all alarms

If only thottled alarms shall be viewed for one or all NEs, choose
Fault → Alarm Monitoring → Throttled, which opens the Choose an
NE window. Choose the desired NE or choose All if the alarm
messages from all NEs should be throttled. Confirm your selection
with OK. (If all alarm messages should be viewed again, repeat the
above procedure but choose Fault → Alarm Monitoring → All
Messages.)

View alarm statistics The alarm statistics for an NE can be viewed by selecting the NE and
choosing Fault → Alarm Monitoring → Statistics from the menu in
the Map window. Statistics for all NEs can be displayed when no NE
is selected and Fault → Alarm Monitoring → Statistics and then
ALL in the Choose an NE window is chosen.
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Audible alarms/events
....................................................................................................................................................................................................................................

Audible alarm
specifications

The audible alarm provides an alternative way to alert the user to
existing alarms or standing condition (SC) events.

The following list provides an overview of audible alarm
specifications:

• Audible alarms are generated at each system interface screen.

• To eliminate possible confusion, the characteristics of the audible
alarm (that is, sound, duration, and interval between sounds) is
common to all users of the host.

• Individual user interface users can enable or disable the audible
alarm feature for their respective system user interface screens.

• The Map window contains the audible alarm symbol near the
upper middle of the screen. The symbol is a speaker if the
audible alarm is enabled, or a speaker with a slash through it if
disabled.

• When the audible alarm is enabled, an audible alarm is initiated
at the onset of each new alarm or SC event, with sound
characteristics that correspond to the severity level of the most
severe alarm/SC event. When there are multiple concurrent
alarms or SC events of different severity levels, the sound
emitted corresponds to the most severe unacknowledged
prevailing alarm or SC event.

• Audible alarms last for a short duration and are repeated after a
set time interval, until quieted by the user.

When you log off WaveStar SNMS and then log in again, the Audible
Alarm feature is enabled. You can disable it The audible alarm sounds
are initially loaded with system default settings. These settings can be
adjusted by the system administrator.

Enable/disable audible
alarms

The audible alarms sound can be switched on or off by choosing
Fault → Audible Alarms → Audible or Fault → Audible Alarms →
Quiet Audible Alarms in the Map window. Alternatively, you can
click the speaker icon in the icon bar of the Map window.
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Alarm browser
....................................................................................................................................................................................................................................

General The Alarm Browser lets you view alarms and clear messages for the
NEs in your Target Group as they occur. Specifically, it captures
alarm, event, and clear messages that are received from NEs in your
Target Group and displays them in the Browsing Alarm Audit Log
window on your workstation screen.

Activate Alarm Browser The Alarm Browser is activated by choosing Fault → Alarm Browser
in the Map window.
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Alarm filtering
....................................................................................................................................................................................................................................

General Alarm filtering is the selective removal of alarm messages from being
forwarded to the GUI. Alarm filtering can be applied to reduce the
number of alarms forwarded to the GUI caused by intermittent failure,
or to filter symptomatic alarms associated with a reported signal
failure, such as those that occur during a fiber cut. All alarms that are
filtered out are logged in WaveStar SNMS and can be viewed through
the Alarm Browser (Fault → Alarm Browser).

Types of Alarm Filtering WaveStar SNMS uses three basic methods to reduce the number of
alarms to be displayed:

• Aging – waiting for a pre-set time period to eliminate alarms that
are caused by temporary failures (and are cleared within a time
period shorter than the aging interval)

• Event-per-Time (EPT) Filtering – EPT, which is primarily an
alarm reduction technique, filters transient condition (TC) events
such as PM Threshold Crossing Alerts (TCAs). To forward all
TC events, set the EPT count to zero. Both the time and number
of TEs can be adjusted to only log TCs that exceed the expected
normal level.

• Symptomatic Alarm Filtering – Symptomatic Alarm Filtering
(SAF) filters out a set of pre-defined symptomatic NE alarms and
standing condition (SC) events. The filtering is based on the
Probable Cause (Condition Type) of the alarms and SC events
received from all NEs, including the EMS-based alarms. The list
of Probable Causes for SAF filtering is specified in the SAF
filter parameter file, which is a UNIX flat file that can be edited
using standard UNIX editing tools such as vi. Any alarm
(including NE and EMS alarms) that match a Probable Cause
specified in the SAF filter parameter file is filtered out. Alarms
and events that are filtered out are not shown in the Map window
or alarm lists. The SAF filter does not differentiate between NE
types for the source of the alarms/events.
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Glossary

µ
Microns

NUMERICS
0x1 Line Operation
0x1 means unprotected operation. The connection between network elements has one
bidirectional line (no protection line).

1+1 Line Protection
A protection architecture in which the transmitting equipment transmits a valid signal on both
the working and protection lines. The receiving equipment monitors both lines. Based on
performance criteria and OS control, the receiving equipment chooses one line as the active line
and designates the other as the standby line.

1xN Equipment Protection
1xN protection pertains to N number of circuit pack/port units protected by one circuit pack or
port unit. When a protection switch occurs, the working signals are routed from the failed pack
to the protection pack. When the fault clears, the signals revert to the working port unit.

12NC (12-digit Numerical Code)
Used to uniquely identify an item or product. The first ten digits uniquely identify an item. The
eleventh digit is used to specify the particular variant of an item. The twelfth digit is used for
the revision issue. Items with the first eleven digits the same, are functionally equal and may be
exchanged.

....................................................................................................................................................................................................................................

A ABN
Abnormal (condition)

ABS (Absent)
Used to indicate that a given circuit pack is not installed.

AC
Alternating Current

ACO (Alarm Cut-Off)
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A button on the user panel used to silence audible alarms.

ACT (Active)
Used to indicate that a circuit pack or module is in-service and currently providing service
functions.

ADM (Add/Drop Multiplexer)
The term for a synchronous network element capable of combining signals of different rates and
having those signals added to or dropped from the stream.

AEL
Accessible Emission Limits

Agent
Performs operations on managed objects and issues events on behalf of these managed objects.
All SDH managed objects will support at least an agent. Control of distant agents is possible
via local “Managers”.

AGNE
Alarm Gateway Network Element

AID (Access Identifier)
A technical specification for explicitly naming entities (both physical and logical) of an NE
using a grammar comprised of ASCII text, keywords, and grammar rules.

AIS (Alarm Indication Signal)
A code transmitted downstream in a digital network that indicates that an upstream failure has
been detected and alarmed if the upstream alarm has not been suppressed.

AITS
Acknowledged Information Transfer Service: Confirmed mode of operation of the LAPD
protocol.

Alarm
Visible or audible signal indicating that an equipment failure or significant event/condition has
occurred.

Alarm Correlation
The search for a directly-reported alarm that can account for a given symptomatic condition.

Alarm Severity
An attribute defining the priority of the alarm message. The way alarms are processed depends
on the severity.

Alarm Suppression
Selective removal of alarm messages from being forwarded to the GUI or to network
management layer OSs.
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Alarm Throttling
A feature that automatically or manually suppresses autonomous messages that are not priority
alarms.

Aligning
Indicating the head of a virtual container by means of a pointer, for example, creating an
Administrative Unit (AU) or a Tributary Unit (TU).

AMI (Alternate Mark Inversion)
A line code that employs a ternary signal to convert binary digits, in which successive binary
ones are represented by signal elements that are normally of alternative positive and negative
polarity but equal in amplitude and in which binary zeros are represented by signal elements
that have zero amplitude.

Anomaly
A difference between the actual and desired operation of a function.

ANSI
American National Standards Institute

APD
Avalanche Photo Diode

APS (Automatic Protection Switch)
A protection switch that occurs automatically in response to an automatically detected fault
condition.

ASCII (American Standard Code for Information Interchange)
A standard 7-bit code that represents letters, numbers, punctuation marks, and special characters
in the interchange of data among computing and communications equipment.

ASN.1
Abstract Syntax Notation 1

Assembly
Gathering together of payload data with overhead and pointer information (an indication of the
direction of the signal).

Association
A logical connection between manager and agent through which management information can be
exchanged.

Asynchronous
The essential characteristic of time-scales or signals such that their corresponding significant
instants do not necessarily occur at the same average rate.

ATM (Asynchronous Transfer Mode)
A high-speed transmission technology characterized by high bandwidth and low delay. It utilizes
a packet switching and multiplexing technique which allocates bandwidth on demand.
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Attribute
Alarm indication level: critical, major, minor, or no alarm.

AU (Administrative Unit)
Carrier for TUs.

AU PTR (Administrative Unit Pointer)
Indicates the phase alignment of the VC-N with respect to the STM-N frame. The pointer
position is fixed with respect to the STM-N frame.

AUG
Administrative Unit Group

AUTO (Automatic)
One possible state of a port or slot. When a port is in the AUTO state and a good signal is
detected, the port automatically enters the IS (in-service) state. When a slot is in the AUTO
state and a circuit pack is detected, the slot automatically enters the EQ (equipped) state.

Autolock
Action taken by the system in the event of circuit pack failure/trouble. System switches to
protection and prevents a return to the working circuit pack even if the trouble clears. Multiple
protection switches on a circuit pack during a short period of time cause the system to autolock
the pack.

Autonomous Message
A message transmitted from the controlled Network Element to the SNMS which was not a
response to an SNMS originated command.

AVAIL
Available

....................................................................................................................................................................................................................................

B Bandwidth
The difference in Hz between the highest and lowest frequencies in a transmission channel. The
data rate that can be carried by a given communications circuit.

Baud Rate
Transmission rate of data (bits per second) on a network link.

BER (Bit Error Rate )
The ratio of error bits received to the total number of bits transmitted.

Bidirectional Line
A transmission path consisting of two fibers that handle traffic in both the transmit and receive
directions.

Bidirectional Ring
A ring in which both directions of traffic between any two nodes travel through the same
network elements (although in opposite directions).
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Bidirectional Switch
Protection switching performed in both the transmit and receive directions.

BIP-N (Bit Interleaved Parity-N)
A method of error monitoring over a specified number of bits (BIP-3 or BIP-8).

Bit
The smallest unit of information in a computer, with a value of either 0 or 1.

Bit Error Rate Threshold
The point at which an alarm is issued for bit errors.

BLD OUT LG
Build-Out Lightguide

Bridge Cross-Connection
The setting up of a cross-connection leg with the same input tributary as that of an existing
cross-connection leg. Thus, forming a 1:2 bridge from an input tributary to two output
tributaries.

Broadband Communications
Voice, data, and/or video communications at greater than 2 Mb/s rates.

Broadband Service Transport
STM-1 concatenation transport over the WaveStar® TDM 10G (STM-64) for ATM applications.

Byte
Refers to a group of eight consecutive binary digits.

....................................................................................................................................................................................................................................

C C
Container

CC (Clear Channel)
A digital circuit where no framing or control bits are required, thus making the full bandwidth
available for communications.

CC (Cross-Connection)
Path-level connections between input and output tributaries or specific ports within a single NE.
Cross-connections are made in a consistent way even though there are various types of ports
and various types of port protection. Cross-Connections are reconfigurable interconnections
between tributaries of transmission interfaces.

Cell Relay
Fixed-length cells. For example, ATM with 53 octets.

CEPT
Conférence Européenne des Administrations des Postes et des Télécommunications
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Channel
A sub-unit of transmission capacity within a defined higher level of transmission capacity.

Circuit
A set of transmission channels through one or more network elements that provides transmission
of signals between two points, to support a single communications path.

CIT or WaveStar™ CIT (Customer Interface Terminal)
The user interface terminal used by craft personnel to communicate with a network element.

CL
Clear

CLEI
Common Language Equipment Identifier

Client
Computer in a computer network that generally offers a user interface to a server.

CLLI
Common Language Location Identifier

Closed Ring Network
A network formed of a ring-shaped configuration of network elements. Each network element
connects to two others, one on each side.

CM (Configuration Management)
Subsystem that configures the network and processes messages from the network.

CMI
Coded Mark Inversion

CMIP
Common Management Information Protocol. OSI standard protocol for OAM&P information
exchange.

CMISE
Common Management Information Service Element

CO (Central Office)
A building where common carriers terminate customer circuits.

Co-Resident
A hardware configuration where two applications can be active at the same time independently
on the same hardware and software platform without interfering with each others functioning.

Collocated
System elements that are located in the same location.

....................................................................................................................................................................................................................................
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Command Group
An administrator-defined group that defines commands to which a user has access.

Concatenation
A procedure whereby multiple virtual containers are associated one with each other resulting in
a combined capacity that can be used as a single container across which bit sequence integrity
is maintained.

Correlation
A process where related hard failure alarms are identified.

CP
Circuit Pack

CPE
Customer Premises Equipment

CPU
Central Processing Unit

CR (Critical (alarm))
Alarm that indicates a severe, service-affecting condition.

CRC
Cyclical Redundancy Check

Cross-Connect Map
Connection map for an SDH Network Element; contains information about how signals are
connected between high speed time slots and low speed tributaries.

Crosstalk
An unwanted signal introduced into one transmission line from another.

CSMA/CD
Carrier Sense Multiple Access with Collision Detection

CTIP
Customer Training and Information Products

CTS
Customer Technical Support within Lucent Technologies

Current Value
The value currently assigned to a provisionable parameter.

....................................................................................................................................................................................................................................

D DACS/DCS
Digital Access Cross-Connect System
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Data
A collection of system parameters and their associated values.

Database Administrator
A user who administers the database of the application.

dB
Decibels

DC
Direct Current

DCC (Data Communications Channel)
The embedded overhead communications channel in the synchronous line, used for end-to-end
communications and maintenance. The DCC carries alarm, control, and status information
between network elements in a synchronous network.

DCE (Data Communications Equipment)
The equipment that provides signal conversion and coding between the data terminating
equipment (DTE) and the line. The DCE may be separate equipment or an integral part of the
DTE or of intermediate equipment. A DCE may perform other functions usually performed at
the network end of the line.

DCF
Data Communications Function

DCN
Data Communications Network

Default
An operation or value that the system or application assumes, unless a user makes an explicit
choice.

Default Provisioning
The parameter values that are preprogrammed as shipped from the factory.

Defect
A limited interruption of the ability of an item to perform a required function. It may or may
not lead to maintenance action depending on the results of additional analysis.

Demultiplexing
A process applied to a multiplexed signal for recovering signals combined within it and for
restoring the distinct individual channels of these signals.

DEMUX (Demultiplexer)
A device that splits a combined signal into individual signals at the receiver end of
transmission.

....................................................................................................................................................................................................................................
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Deprovisioning
The inverse order of provisioning. To manually remove/delete a parameter that has (or
parameters that have) previously been provisioned.

Digital Link
A transmission span such as a point-to-point 2 Mb/s, 34 Mb/s, 140 Mb/s, VC12, VC3 or VC4
link between controlled network elements.

Digital Multiplexer
Equipment that combines by time-division multiplexing several digital signals into a single
composite digital signal.

Digital Section
A transmission span such as an STM-N signal. A digital section may contain multiple digital
channels.

Disassembly
Splitting up a signal into its constituents as payload data and overhead (an indication of the
direction of a signal).

Dispersion
Time-broadening of a transmitted light pulse.

Dispersion Shifted Optical Fiber
1330/1550 nm minimum dispersion wavelength.

Divergence
When there is unequal amplification of incoming wavelengths, the result is a power divergence
between wavelengths.

DNI (Dual Node Ring Interworking)
A topology in which two rings are interconnected at two nodes on each ring and operate so that
inter-ring traffic is not lost in the event of a node or link failure at an interconnecting point.

Doping
The addition of impurities to a substance in order to attain desired properties.

Downstream
At or towards the destination of the considered transmission stream, for example, looking in the
same direction of transmission.

DPLL
Digital Phase Locked Loop

DRAM
Dynamic Random Access Memory

....................................................................................................................................................................................................................................
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Drop and Continue
A circuit configuration that provides redundant signal appearances at the outputs of two network
elements in a ring. Can be used for Dual Node Ring Interworking (DNI) and for video
distribution applications.

Drop-Down Menu
A menu that is displayed from a menu bar.

DSNE (Directory Service Network Element)
A designated Network Element that is responsible for administering a database that maps
Network Elements names (node names) to addresses (node Id). There can be one DSNE per
(sub)network.

DTE (Data Terminating Equipment)
The equipment that originates data for transmission and accepts transmitted data.

DTMF
Dual Tone Multifrequency

DUS
Do not Use for Synchronization

DWDM (Dense Wavelength Division Multiplexing)
Transmitting two or more signals of different wavelengths simultaneously over a single fiber.

....................................................................................................................................................................................................................................

E EBER (Excessive Bit Error Rate)
The calculated average bit error rate over a data stream.

ECC
Embedded Control Channel

EEPROM
Electrically Erasable Programmable Read-Only Memory

EIA (Electronic Industries Association)
A trade association of the electronic industry that establishes electrical and functional standards.

EM (Event Management)
Subsystem of WaveStar SNMS that processes and logs event reports of the network.

EMC (Electromagnetic Compatibility)
A measure of equipment tolerance to external electromagnetic fields.

EMI (Electromagnetic Interference)
High-energy, electrically induced magnetic fields that cause data corruption in cables passing
through the fields.

EMS
Element Management System
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Entity
A specific piece of hardware (usually a circuit pack, slot, or module) that has been assigned a
name recognized by the system.

Entity Identifier
The name used by the system to refer to a circuit pack, memory device, or communications
link.

EPROM
Erasable Programmable Read-Only Memory

EQ (Equipped)
Status of a circuit pack or interface module that is in the system database and physically in the
frame, but not yet provisioned.

ES (Errored Seconds)
A performance monitoring parameter. ES “type A” is a second with exactly one error; ES “type
B” is a second with more than one and less than the number of errors in a severely errored
second for the given signal. ES by itself means the sum of the type A and type B ESs.

ESD
Electrostatic Discharge

ESP
Electrostatic Protection

Establish
A user initiated command, at the WaveStar CIT, to create an entity and its associated attributes
in the absence of certain hardware.

ETSI
European Telecommunications Standards Institute

Event
A significant change. Events in controlled Network Elements include signal failures, equipment
failures, signals exceeding thresholds, and protection switch activity. When an event occurs in a
controlled Network Element, the controlled Network Element will generate an alarm or status
message and send it to the management system.

Event Driven
A required characteristic of network element software system: NEs are reactive systems,
primarily viewed as systems that wait for and then handle events. Events are provided by the
external interface packages, the hardware resource packages, and also by the software itself.

Externally Timed
An operating condition of a clock in which it is locked to an external reference and is using
time constants that are altered to quickly bring the local oscillator’s frequency into approximate
agreement with the synchronization reference frequency.
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Extra traffic
Unprotected traffic that is carried over protection channels when their capacity is not used for
the protection of working traffic.

....................................................................................................................................................................................................................................

F Fault
Term used when a circuit pack has a hard (not temporary) fault and cannot perform its normal
function.

Fault Management
Collecting, processing, and forwarding of autonomous messages from network elements.

FCC
Federal Communications Commission

FDA/CDRH
The Food and Drug Administration′s Center for Devices and Radiological Health.

FDDI (Fiber Distributed Data Interface)
Fiber interface that connects computers and distributes data among them.

FE (Far End )
Any other network element in a maintenance subnetwork other than the one the user is at or
working on. Also called remote.

FEBE (Far-End Block Error)
An indication returned to the transmitting node that an errored block has been detected at the
receiving node. A block is a specified grouping of bits.

FEPROM (Flash EPROM)
A technology that combines the nonvolatility of EPROM with the in-circuit reprogrammability
of EEPROM (electrically-erasable PROM).

FERF (Far-End Receive Failure)
An indication returned to a transmitting Network Element that the receiving Network Element
has detected an incoming section failure. Also known as RDI.

FIT (Failures in Time)
Circuit pack failure rates per 109 hours as calculated using the method described in Reliability
Prediction Procedure for Electronic Equipment, BellCore Method I, Issue 6, December 1997.

Folded Rings
Folded (collapsed) rings are rings without fiber diversity. The terminology derives from the
image of folding a ring into a linear segment.

Forced
Term used when a circuit pack (either working or protection) has been locked into a
service-providing state by user command.

FR (Frame Relay)
....................................................................................................................................................................................................................................
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A form of packet switching that relies on high-quality phone lines to minimize errors. It is very
good at handling high-speed, bursty data over wide area networks. The frames are variable
lengths and error checking is done at the end points.

Frame
The smallest block of digital data being transmitted.

Framework
An assembly of equipment units capable of housing shelves, such as a bay framework.

Free Running
An operating condition of a clock in which its local oscillator is not locked to an internal
synchronization reference and is using no storage techniques to sustain its accuracy.

....................................................................................................................................................................................................................................

G GB
Gigabytes

Gbit/s
Gigabits per second

GHz
Gigahertz

Global Wait to Restore Time
Corresponds to the time to wait before switching back to the timing reference. It occurs after a
timing link failure has cleared. This time applies for all timing sources in a system hence the
name global. This can be between 0 and 60 minutes, in increments of one minute.

GNE (Gateway Network Element)
A network element that passes information between other network elements and management
systems through a data communication network.

....................................................................................................................................................................................................................................

H Hard Failure
An unrecoverable nonsymptomatic (primary) failure that causes signal impairment or interferes
with critical network functions, such as DCC operation.

HDB3 (High Density Bipolar 3 Code)
Line code for 2 Mb/s transmission systems.

HDLC (High Level Data Link Control)
OSI reference model datalink layer protocol.

HMI
Human Machine Interface

HML (Human Machine Language)
A standard language developed by the ITU for describing the interaction between humans and
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dumb terminals.

HO
High Order

Holdover
An operating condition of a clock in which its local oscillator is not locked to an external
reference but is using storage techniques to maintain its accuracy with respect to the last known
frequency comparison with a synchronization reference.

Hot Standby
A circuit pack ready for fast, automatic placement into operation to replace an active circuit
pack. It has the same signal as the service going through it, so that choice is all that is required.

HPA (Higher Order Path Adaptation)
Function that adapts a lower order Virtual Container to a higher order Virtual Container by
processing the Tributary Unit pointer which indicates the phase of the lower order Virtual
Container Path Overhead relative to the higher order Virtual Container Path Overhead and
assembling/disassembling the complete higher order Virtual Container.

HPC (Higher Order Path Connection)
Function that provides for flexible assignment of higher order Virtual Containers within an
STM-N signal.

HPT (Higher Order Path Termination)
Function that terminates a higher order path by generating and adding the appropriate Virtual
Container Path Overhead to the relevant container at the path source and removing the Virtual
Container Path Overhead and reading it at the path sink.

HS
High Speed

HW
Hardware

Hz
Hertz

....................................................................................................................................................................................................................................

I I/O
Input/Output

IAO LAN
Intraoffice Local Area Network

ID
Identifier
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IEC
International Electro-Technical Commission

IEEE
Institute of Electrical and Electronics Engineers

IMF
Infant Mortality Factor

Insert
To physically insert a circuit pack into a slot, thus causing a system initiated restoral of an
entity into service and/or creation of an entity and associated attributes.

Interface Capacity
The total number of STM-1 equivalents (bidirectional) tributaries in all transmission interfaces
with which a given transmission interface shelf can be equipped at one time. The interface
capacity varies with equipage.

Intermediate System (IS)
A system which routes/relays management information. An SDH Network Element may be a
combined intermediate and end system.

IS (In-Service)
A memory administrative state for ports. IS refers to a port that is fully monitored and alarmed.

IS-IS Routing
The Network Elements in a management network, route packets (data) between each other using
an IS-IS level protocol. The size of a network running IS-IS Level 1 is limited, and therefore
certain mechanisms are employed to facilitate the management of larger networks.
For STATIC ROUTING, the capability exists for disabling the protocol over the LAN
connections, effectively causing the management network to be partitioned into separate IS-IS
Level 1 areas. In order for the network management system to communicate with a specific
Network Element in one of these areas, the network management system must identify through
which so-called Gateway Network Element this specific Network Element is connected to the
LAN. All packets to this specific Network Element are routed directly to the Gateway Network
Element by the network management system, before being re-routed (if necessary) within the
Level 1 area.
For DYNAMIC ROUTING an IS-IS Level 2 routing protocol is used allowing a number of
Level 1 areas to interwork. The Network Elements which connect an IS-IS area to another area
are set to run the IS-IS Level 2 protocol within the Network Element and on the connection
between other Network Elements. Packets can now be routed between IS-IS areas and the
network management system does not have to identify the Gateway Network Elements.

ISDN
Integrated Services Digital Network

ITM
Integrated Transport Management
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365-371-524
Issue a, October 2001

Lucent Technologies G L O S S A R Y
G L - 1 5



ITM-NM
Integrated Transport Management Network Module

ITU
International Telecommunications Union

ITU-T
International Telecommunications Union — Telecommunication standardization sector. Formerly
known as CCITT: Comité Consultatif International Télégraphique & Téléphonique; International
Telegraph and Telephone Consultative Committee.

....................................................................................................................................................................................................................................

J Jitter
Short term variations of amplitude and frequency components of a digital signal from their ideal
position in time.

....................................................................................................................................................................................................................................

K kbit/s
Kilobits per second

....................................................................................................................................................................................................................................

L LAN (Local Area Network)
A communications network that covers a limited geographic area, is privately owned and user
administered, is mostly used for internal transfer of information within a business, is normally
contained within a single building or adjacent group of buildings, and transmits data at a very
rapid speed.

LBC
Laser Bias Current

LBFC
Laser Backface Currents

LBO (Lightguide Build-Out )
An attenuating (signal-reducing) element used to keep an optical output signal strength within
desired limits.

LCN
Local Communications Network

LED
Light-Emitting Diode

LH
Long Haul

Line
A transmission medium, together with the associated equipment, required to provide the means
of transporting information between two consecutive network elements. One network element
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originates the line signal; the other terminates it.

Line Protection
The optical interfaces can be protected by line protection. Line protection switching protects
against failures of line facilities, including the interfaces at both ends of a line, the optical
fibers, and any equipment between the two ends. Line protection includes protection of
equipment failures.

Line Timing
Refers to a network element that derives its timing from an incoming STM-N signal.

Link
The mapping between in-ports and out-ports. It specifies how components are connected to one
another.

LO
Low Order

Location
An identifier for a specific circuit pack, interface module, interface port, or communications
link.

Lockout of Protection
The WaveStar CIT command that prevents the system from switching traffic to the protection
line from a working line. If the protection line is active when a “Lockout of Protection” is
entered – this command causes the working line to be selected. The protection line is then
locked from any Automatic, Manual, or Forced protection switches.

Lockout State
The Lockout State shall be defined for each working or protection circuit pack. The two
permitted states are: None – meaning no lockout is set for the circuit pack, set meaning the
circuit pack has been locked out. The values (None & Set) shall be taken independently for
each working or protection circuit pack.

LOF (Loss of Frame)
A failure to synchronize an incoming signal.

LOM
Loss Of Multiframe

Loop Timing
A special case of line timing. It applies to network elements that have only one OC-N/STM-N
interface. For example, terminating nodes in a linear network are loop timed.

Loopback
Type of diagnostic test used to compare an original transmitted signal with the resulting
received signal. A loopback is established when the received optical or electrical external
transmission signal is sent from a port or tributary input directly back toward the output.
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LOP (Loss of Pointer )
A failure to extract good data from a signal payload.

LOS (Loss of Signal)
The complete absence of an incoming signal.

Loss Budget
Loss (in dB) of optical power due to the span transmission medium (includes fiber loss and
splice losses).

LPA (Lower order Path Adaptation)
Function that adapts a PDH signal to a synchronous network by mapping the signal into or
de-mapping the signal out of a synchronous container.

LPC (Lower Order Path Connection )
Function that provides for flexible assignment of lower order VCs in a higher order VC.

LPT (Lower Order Path Termination)
Function that terminates a lower order path by generating and adding the appropriate VC POH
to the relevant container at the path source and removing the VC POH and reading it at the path
sink.

LS
Low Speed

LTE
Line Terminating Equipment

....................................................................................................................................................................................................................................

M µm
Micrometer

MAF
Management Application Function

Maintenance Condition
An equipment state in which some normal service functions are suspended, either because of a
problem or to perform special functions (copy memory) that can not be performed while normal
service is being provided.

Management Connection
Identifies the type of routing used (STATIC or DYNAMIC), and if STATIC is selected allows
the gateway network element to be identified.

Manager
Capable of issuing network management operations and receiving events. The manager
communicates with the agent in the controlled network element.
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Manual Switch State
A protection group shall enter the Manual Switch State upon the initiation and successful
completion of the Manual Switch command. The protection group leaves the Manual Switch
state by means of the Clear or Forced Switch commands. While in the Manual Switch state the
system may switch the active unit automatically if required for protection switching.

Mapping
The logical association of one set of values, such as addresses on one network, with quantities
or values of another set, such as devices or addresses on another network.

MB
Megabytes

Mbit/s
Megabits per second

MCF (Message Communications Function)
Function that provides facilities for the transport and routing of Telecommunications
Management Network messages to and from the Network Manager.

MD (Mediation Device)
Allows for exchange of management information between Operations System and Network
Elements.

MDI
Miscellaneous Discrete Input

MDO
Miscellaneous Discrete Output

MEC (Manufacturer Executable Code)
Network Element system software in binary format that after being downloaded to one of the
stores can be executed by the system controller of the network element.

MEM
Memory

Mid-Span Meet
The capability to interface between two lightwave network elements of different vendors. This
applies to high-speed optical interfaces.

MIPS
Millions of Instructions Per Second

Miscellaneous Discrete Interface
Allows an operations system to control and monitor equipment collocated within a set of input
and output contact closures.

MJ (Major (alarm))
Indicates a service-affecting failure, main or unit controller failure, or power supply failure.
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MMI
Man-Machine Interface

MML
Human-Machine Language

MN (Minor (alarm))
Indicates a non-service-affecting failure of equipment or facility.

MO
Managed Object

MS
Multiplexer Section

ms
Millisecond

MS-SPRING (Multiplexer Section Shared Protection Ring)
A protection method used in Add-Drop Multiplexer Network Elements.

MSOH (Multiplexer Section OverHead)
Part of the Section Overhead. Is accessible only at line terminals and multiplexers.

MSP (Multiplexer Section Protection)
Provides capability for switching a signal from a working to a protection section.

MST (Multiplexer Section Termination)
Function that generates the Multiplexer Section OverHead in the transmit direction and
terminates the part of the Multiplexer Section overhead that is acceptable in the receive
direction.

MTBF
Mean Time Between Failures

MTBMA
Mean Time Between Maintenance Activities

MTIE
Maximum Time Interval Error

MTPI
Multiplexer Timing Physical Interface

MTS (Multiplexer Timing Source)
Function that provides timing reference to the relevant component parts of the multiplex
equipment and represents the SDH Network Element clock.

MTTR
Mean Time To Repair
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Multiplexer
A device (circuit pack) that combines two or more transmission signals into a combined signal
on a shared medium.

Multiplexing
A procedure by which multiple lower order path layer signals are adapted into a higher order
path, or the multiple higher order path layer signals are adapted into a multiplex section.

....................................................................................................................................................................................................................................

N NA
Not Applicable

NE (Network Element)
A node in a telecommunication network that supports network transport services and is directly
manageable by a management system.

NEBS
Network Equipment-Building System

NET (Network Entity Title)
The area address together with the system identifier (SYSTEM field) of the NSAP address is
called the Network Entity Title.

nm
Nanometer (10–9 meters)

NMON (Not Monitored )
A provisioning state for equipment that is not monitored or alarmed.

NMS
Network Management System

No Request State
This is the routine-operation quiet state in which no external command activities are occurring.

Node
A network element in a ring or, more generally, in any type of network. In a network element
supporting interfaces to more than one ring, node refers to an interface that is in a particular
ring. Node is also defined as all equipment that is controlled by one system controller. A node
is not always directly manageable by a management system.

Non-Revertive Switching
In non-revertive switching, an active and stand-by line exist on the network. When a protection
switch occurs, the standby line is selected to support traffic, thereby becoming the active line.
The original active line then becomes the stand-by line. This status remains in effect even when
the fault clears. That is, there is no automatic switch back to the original status.
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Non-Synchronous
The essential characteristic of time-scales or signals such that their corresponding significant
instants do not necessarily occur at the same average rate.

NORM
Normal

NPI
Null Pointer Indication

NPPA (Non-Preemptible Protection Access)
Non-preemptible protection access increases the available span capacity for traffic which does
not require protection by a ring, but which cannot be preempted.

NRZ
Nonreturn to Zero

NSA
Non-Service Affecting

NSAP Address (Network Service Access Point Address)
Network Service Access Point Address (used in the OSI network layer 3). An automatically
assigned number that uniquely identifies a Network Element for the purposes of routing DCC
messages.

NUT (Non-preemptible Unprotected Traffic)
Traffic in 1:1 working and protecting timeslots

NVM (Non-Volatile Memory )
Memory that retains its stored data after power has been removed. An example of NVM would
be a hard disk.

....................................................................................................................................................................................................................................

O O&M
Operation and Maintenance

OA
Optical Amplifier

OAM&P
Operations, Administration, Maintenance, and Provisioning

OC, OC-n
Optical Carrier

OC-12
Optical Carrier, Level 12 Signal (622.08 Mbit/s)
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OC-192
Optical Carrier, Level 192 (9953.28 Mb/s) (10 Gbit/s)

OC-3
Optical Carrier, Level 3 Signal (155 Mbit/s)

OC-48
Optical Carrier, Level 48 (2488.32 Mb/s) (2.5 Gbit/s)

OI (Operations Interworking)
The capability to access, operate, provision, and administer remote systems through craft
interface access from any site in an SDH network or from a centralized operations system.

OLS
Optical Line System

OOF
Out-of-Frame

OOS (Out-of-Service)
The circuit pack is not providing its normal service function (removed from either the working
or protection state) either because of a system problem or because the pack has been removed
from service.

Open Ring Network
A network formed of a linear chain-shaped configuration of network elements. Each network
element connects to two others, one on each side, except for two network elements at the ends
which are connected on only one side. A closed ring can be formed by adding a connection
between the two end nodes.

Operations Interface
Any interface providing you with information on the system behavior or control. These include
the equipment LEDs, user panel, WaveStar CIT, office alarms, and all telemetry interfaces.

Operator
A user of the system with operator-level user privileges.

Optical Channel
A STM-N wavelength within an optical line signal. Multiple channels, differing by 1.5 µm in
wavelength, are multiplexed into one signal.

Optical Line Signal
A multiplexed optical signal containing multiple wavelengths or channels.

Original Value Provisioning
Preprogramming of a system’s original values at the factory. These values can be overridden
using local or remote provisioning.

OS (Operations System)
A central computer-based system used to provide operations, administration, and maintenance
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functions.

OSF
Open Software Foundation Operations System Function

OSI (Open Systems Interconnection)
Referring to the OSI reference model, a logical structure for network operations standardized by
the International Standards Organization (ISO).

Outage
A disruption of service that lasts for more than 1 second.

OW (Orderwire)
A dedicated voice-grade line for communications between maintenance and repair personnel.

....................................................................................................................................................................................................................................

P Parameter
A variable that is given a value for a specified application. A constant, variable, or expression
that is used to pass values between components.

Parity Check
Tests whether the number of ones (or zeros) in an array of binary bits is odd or even; used to
determine that the received signal is the same as the transmitted signal.

Pass-Through
Paths that are cross-connected directly across an intermediate node in a network.

Path
A logical connection between the point at which a standard frame format for the signal at the
given rate is assembled, and the point at which the standard frame format for the signal is
disassembled.

Path Terminating Equipment
Network elements in which the path overhead is terminated.

PCB
Printed Circuit Board

PCM
Pulse Code Modulation

PDH
Plesiochronous Digital Hierarchy

PI
Physical Interface

Platform
A family of equipment and software configurations designed to support a particular application.
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G L O S S A R Y
G L - 2 4

Lucent Technologies 365-371-524
Issue a, October 2001



Plesiochronous Network
A network that contains multiple subnetworks, each internally synchronous and all operating at
the same nominal frequency, but whose timing may be slightly different at any particular
instant.

PM (Performance Monitoring)
Measures the quality of service and identifies degrading or marginally operating systems (before
an alarm would be generated).

PMD (Polarization Mode Dispersion)
Output pulse broadening due to random coupling of the two polarization modes in an optical
fiber.

POH (Path Overhead)
Informational bytes assigned to, and transported with the payload until the payload is
demultiplexed. It provides for integrity of communication between the point of assembly of a
virtual container and its point of disassembly.

Pointer
An indicator whose value defines the frame offset of a virtual container with respect to the
frame reference of the transport entity on which it is supported.

POP
Point of Presence

Port (also called Line)
The physical interface, consisting of both an input and output, where an electrical or optical
transmission interface is connected to the system and may be used to carry traffic between
network elements. The words “port” and “line” may often be used synonymously. “Port”
emphasizes the physical interface, and “line” emphasizes the interconnection. Either may be
used to identify the signal being carried.

Port State Provisioning
A feature that allows a user to suppress alarm reporting and performance monitoring during
provisioning by supporting multiple states (automatic, in-service, and not monitored) for
low-speed ports.

POTS
Plain Old Telephone Service

PP
Pointer Processing

PRC (Primary Reference Clock)
The main timing clock reference in SDH equipment.

Preprovisioning
The process by which the user specifies parameter values for an entity in advance of some of
the equipment being present. These parameters are maintained only in NVM. These
modifications are initiated locally or remotely by either a CIT or an OS. Preprovisioning
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provides for the decoupling of manual intervention tasks (for example, install circuit packs)
from those tasks associated with configuring the node to provide services (for example,
specifying the entities to be cross-connected).

PRI
Primary

Proactive Maintenance
Refers to the process of detecting degrading conditions not severe enough to initiate protection
switching or alarming, but indicative of an impending signal fail or signal degrade defect.

Protection Access
To provision traffic to be carried by protection tributaries when the port tributaries are not being
used to carry the protected working traffic.

Protection Group Configuration
The members of a group and their roles, for example, working protection, line number, etc.

Protection Path
One of two signals entering a path selector used for path protection switching or dual ring
interworking. The other is the working path. The designations working and protection are
provisioned by the user, whereas the terms active path and standby path indicate the current
protection state.

Protection State
When the working unit is currently considered active by the system and that it is carrying
traffic. The “active unit state” specifically refers to the receive direction of operation — since
protection switching is unidirectional.

PROTN (Protection)
Extra capacity (channels, circuit packs) in transmission equipment that is not intended to be
used for service, but rather to serve as backup against equipment failures.

PROV (Provisioned)
Indicating that a circuit pack is ready to perform its intended function. A provisioned circuit
pack can be active (ACT), in-service (IS), standby (STBY), provisioned out-of-service (POS), or
out-of-service (OOS).

PSDN
Public Switched Data Network

PSTN
Public Switched Telephone Network

PTE
Path Terminating Equipment

PWR
Power
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PWR ON
Power On

....................................................................................................................................................................................................................................

Q Q-LAN
Thin Ethernet LAN which connects the manager to Gateway Network Elements so that
management information between Network Elements and management systems can be
exchanged.

QL (Quality Level)
The quality of the timing signal(s) provided to clock a Network Element. The level is provided
by the Synchronization Status Marker which can accompany the timing signal. If the System
and Output Timing Quality Level mode is “Enabled”, and if the signal selected for the Station
Clock Output has a quality level below the Acceptance Quality Level, the Network Element
“squelches” the Station Clock Output Signal, which means that no signal is forwarded at all.

Possible levels are:

• PRC (Primary Reference Clock)

• SSU_T (Synchronization Supply Unit - Transit)

• SSU_L (Synchronization Supply Unit - Local)

• SEC (SDH Equipment Clock)

• DUS (Do not Use for Synchronization)

QOS
Quality of Service

....................................................................................................................................................................................................................................

R RAM
Random Access Memory

RDI (Remote Defect Indication)
An indication returned to a transmitting terminal that the receiving terminal has detected an
incoming section failure. [Previously called far-end-receive failure (FERF).]

Reactive Maintenance
Refers to detecting defects/failures and clearing them.

Receive-Direction
The direction towards the Network Element.

Regeneration
The process of reconstructing a digital signal to eliminate the effects of noise and distortion.

Regenerator Loop
Loop in a Network Element between the Station Clock Output(s) and one or both Station Clock
Inputs, which can be used to dejitterize the selected timing reference in network applications.
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Regenerator Section Termination (RST)
Function that generates the Regenerator Section Overhead (RSOH) in the transmit direction and
terminates the RSOH in the receive direction.

Reliability
The ability of a software system performing its required functions under stated conditions for a
stated period of time. The probability for an equipment to fulfill its function. Some of the ways
in which reliability is measured are: MTBF (Mean Time Between Failures) expressed in hours;
Availability = (MTBF)/(MTBF+MTTR)(%) [where MTTR = mean time to restore]; outage in
minutes per year; failures per hour; percentage of failures per 1,000 hours.

Remote Network Element
Any Network Element that is connected to the referenced Network Element through either an
electrical or optical link. It may be the adjacent node on a ring, or N nodes away from the
reference. It also may be at the same physical location but is usually at another (remote) site.

Restore Timer
Counts down the time (in minutes) during which the switch waits to let the worker line recover
before switching back to it. This option can be set to prevent the protection switch continually
switching if a line has a continual transient fault.

Revertive
A protection switching mode in which, after a protection switch occurs, the equipment returns to
the nominal configuration (that is, the working equipment is active, and the protection
equipment is standby) after any failure conditions that caused a protection switch to occur,
clear, or after any external switch commands are reset. (See “Non-Revertive”.)

Revertive Switching
In revertive switching, there is a working and protection high-speed line, circuit pack, etc.
When a protection switch occurs, the protection line, circuit pack, etc. is selected. When the
fault clears, service “reverts” to the working line.

Ring
A configuration of nodes comprised of network elements connected in a circular fashion. Under
normal conditions, each node is interconnected with its neighbor and includes capacity for
transmission in either direction between adjacent nodes. Path switched rings use a head-end
bridge and tail-end switch. Line switched rings actively reroute traffic over the protection
capacity.

Route
A series of contiguous digital sections.

Router
An interface between two networks. While routers are like bridges, they work differently.
Routers provide more functionality than bridges. For example, they can find the best route
between any two networks, even if there are several different networks in between. Routers also
provide network management capabilities such as load balancing, partitioning of the network,
and trouble-shooting.
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RSOH
Regenerator Section OverHead; part of SOH

RST
Regenerator Section Termination

RT
Remote Terminal

RTRV
Retrieve

RZ (Return to Zero)
A code form having two information states (termed zero and one) and having a third state or an
at-rest condition to which the signal returns during each period.

....................................................................................................................................................................................................................................

S SA
Service Affecting

SA
Section Adaptation

SD
Signal Degrade

SDH (Synchronous Digital Hierarchy)
A hierarchical set of digital transport structures, standardized for the transport of suitable
adapted payloads over transmission networks.

SDS
Standard Directory Service based on ANSI recommendation T1.245

SEC
Secondary

SEC
SDH Equipment Clock

Section
The portion of a transmission facility, including terminating points, between a terminal network
element and a line-terminating network element, or two line-terminating network elements.

Section Adaptation
Function that processes the AU-pointer to indicate the phase of the VC-3/4 POH relative to the
STM-N SOH and assembles/disassembles the complete STM-N frame.
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Self-Healing
A network’s ability to automatically recover from the failure of one or more of its components.

SEMF (Synchronous Equipment Management Function)
Function that converts performance data and implementation specific hardware alarms into
object-oriented messages for transmission over the DCC and/or Q-interface. It also converts
object-oriented messages related to other management functions for passing across the S
reference points.

Server
Computer in a computer network that performs dedicated main tasks which generally require
sufficient performance.

Service
The operational mode of a physical entity that indicates that the entity is providing service. This
designation will change with each switch action.

SES (Severely Errored Seconds)
This performance monitoring parameter is a second in which a signal failure occurs, or more
than a preset amount of coding violations (dependent on the type of signal) occurs.

SH
Short Haul

Single-Ended Operations
Provides operations support from a single location to remote Network Elements in the same
SDH subnetwork. With this capability you can perform operations, administration, maintenance,
and provisioning on a centralized basis. The remote Network Elements can be those that are
specified for the current release.

Site Address
The unique address for a Network Element.

Slot
A physical position in a shelf designed for holding a circuit pack and connecting it to the
backplane. This term is also used loosely to refer to the collection of ports or tributaries
connected to a physical circuit pack placed in a slot.

SM (Single-Mode Fiber)
A low-loss, long-span optical fiber typically operating at either 1310 nm, 1550 nm, or both.

SMN
SDH Management Network

SNC/I
SubNetwork Connection (protection) / Inherent monitoring
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SNC/N
SubNetwork Connection (protection) / Non-Intrusive Monitoring

SNR (Signal-to-Noise Ratio)
The relative strength of signal compared to noise.

Software Backup
The process of saving an image of the current network element’s databases, which are contained
in its NVM, to a remote location. The remote location could be the WaveStar CIT or an OS.

Software Download
The process of transferring a generic (full or partial) or provisioned database from a remote
entity to the target network element’s memory. The remote entity may be the WaveStar CIT or
an OS. The download procedure uses bulk transfer to move an uninterpreted binary file into the
network element.

Software ID
Number that provides the software version information for the system.

SOH (Section Overhead)
Capacity added to either an AU-4 or assembly of AU-3s to create an STM-1. Contains always
STM-1 framing and optionally maintenance and operational functions. SOH can be subdivided
in MSOH (multiplex section overhead) and RSOH (regenerator section overhead).

SONET (Synchronous Optical Network)
The North American standard for the rates and formats that defines optical signals and their
constituents.

Span
An uninterrupted bidirectional fiber section between two network elements.

Span Growth
A type of growth in which one wavelength is added to all lines before the next wavelength is
added.

SPE
Synchronous Payload Envelope

SPI
SDH Physical Interface

Squelch Map
This map contains information for each cross-connection in a ring and indicates the source and
destination nodes for the low-speed circuit that is part of the cross-connection. This information
is used to prevent traffic misconnection in rings with isolated nodes or segments.

SSM
Synchronization Status Marker
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SSU_L
Synchronization Supply Unit — Local

SSU_T
Synchronization Supply Unit — Transit

Standby Path
One of two signals entering a constituent path selector, the standby path is the path not
currently being selected.

State
The state of a circuit pack indicates whether it is defective or normal (ready for normal use).

Station Clock Input
An external clock may be connected to a Station Clock Input.

Status
The indication of a short-term change in the system.

STBY (Standby)
The circuit pack is in service but is not providing service functions. It is ready to be used to
replace a similar circuit pack either by protection or by duplex switching.

STM
Synchronous Transport Module (SDH)

STM-N (Synchronous Transport Module, Level N)
A building block information structure that supports SDH section layer connections, where N
represents a multiple of 155.52 Mbit/s. Normally N=1, 4, 16, or 64.

STS
Synchronous Transport Signal (SONET)

Subnetwork
A group of interconnected/interrelated Network Elements. The most common connotation is a
synchronous network in which the Network Elements have data communications channel (DCC)
connectivity.

Supervisor
A user of the application with supervisor user privileges.

Suppression
A process where service-affecting alarms that have been identified as an “effect” are not
displayed to a user.

SYNC
Synchronizer

....................................................................................................................................................................................................................................

G L O S S A R Y
G L - 3 2

Lucent Technologies 365-371-524
Issue a, October 2001



Synchronization Messaging
Synchronization messaging is used to communicate the quality of network timing, internal
timing status, and timing states throughout a subnetwork.

Synchronous
The essential characteristic of time scales or signals such that their corresponding significant
instances occur at precisely the same average rate, generally traceable to a single Stratum-1
source.

Synchronous Network
The synchronization of transmission systems with synchronous payloads to a master (network)
clock that can be traced to a reference clock.

Synchronous Payload
Payloads that can be derived from a network transmission signal by removing integral numbers
of bits from every frame. Therefore, no variable bit-stuffing rate adjustments are required to fit
the payload in the transmission signal.

SYSCTL
System Controller circuit pack

System Administrator
A user of the computer system on which the system’s OS software application can be installed.

....................................................................................................................................................................................................................................

T TARP
Target Identifiers Address Resolution Protocol

TBD
To Be Determined

TCA (Threshold-Crossing Alert)
A message type sent from a Network Element that indicates that a certain performance
monitoring parameter has exceeded a specified threshold.

TDM (Time Division Multiplexing)
A technique for transmitting a number of separate data, voice, and/or video signals
simultaneously over one communications medium by interleaving a portion of each signal one
after another.

Through (or Continue) Cross-Connection
A cross-connection within a ring, where the input and output tributaries have the same tributary
number but are in lines opposite each other.

Through Timing
Refers to a network element that derives its transmit timing in the east direction from a received
line signal in the east direction and its transmit timing in the west direction from a received line
signal in the west direction.
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365-371-524
Issue a, October 2001

Lucent Technologies G L O S S A R Y
G L - 3 3



THz
Terahertz (1012 Hz)

TID (Target Identifier)
A provisionable parameter that is used to identify a particular Network Element within a
network. It is a character string of up 20 characters where the characters are letters, digits, or
hyphens (-).

TL1 (Transaction Language One)
A subset of ITU’s human-machine language.

TMN
Telecommunications Management Network

TR
Technical Requirement

Transmit-Direction
The direction outwards from the Network Element.

Tributary
A signal of a specific rate (2 Mbit/s, 34 Mbit/s, 140 Mbit/s, VC12, VC3, VC4, STM-1 or
STM-4) that may be added to or dropped from a line signal.

Tributary
A path-level unit of bandwidth within a port, or the constituent signal(s) being carried in this
unit of bandwidth, for example, an STM-1 tributary within an STM-N port.

Tributary Unit Pointer
Indicates the phase alignment of the VC with respect to the TU in which it resides. The pointer
position is fixed with respect to the TU frame.

True Wave™ Optical Fiber
Lucent Technologies’ fiber generally called non-zero dispersion-shift fiber, with a controlled
amount of chromatic dispersion designed for amplified systems in the 1550/1310 nm range.

TSA (Time Slot Assignment)
A capability that allows any tributary in a ring to be cross-connected to any tributary in any
lower-rate, non-ring interface or to the same-numbered tributary in the opposite side of the ring.

TSI (Time Slot Interchange)
The ability of the user to assign cross-connections between any tributaries of any lines within a
Network Element. Three types of TSI can be defined: Hairpin TSI, Interring TSI (between
rings), and Intraring TSI (within rings).

TSO
Technical Support Organization
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TTP
Trail Termination Point

TU (Tributary Unit)
An information structure which provides adaptation between the lower order path layer and the
higher path layer. Consists of a VC-n plus a tributary unit pointer TU PTR.

TUG
Tributary Unit Group

Two-Way Point-to-Point Cross-Connection
A two-legged interconnection, that supports two-way transmission, between two and only two
tributaries.

Two-Way Roll
The operation which moves a two-way cross-connection between tributary i and tributary j to a
two-way cross-connection between the same tributary i and a new tributary k with a single user
command.

....................................................................................................................................................................................................................................

U UAS (Unavailable Seconds )
In performance monitoring, the count of seconds in which a signal is declared failed or in
which 10 consecutively severely errored seconds (SES) occurred, until the time when 10
consecutive non-SES occur.

UITS (Unacknowledged Information Transfer Service)
Unconfirmed mode of LAPD operation.

UNEQ
Path Unequipped

Upstream
At or towards the source of the considered transmission stream, for example, looking in the
opposite direction of transmission.

User Privilege
Permissions a user must perform on the computer system on which the system software runs.

UTC (Universal Coordinated Time)
A time-zone independent indication of an event. The local time can be calculated from the
Universal Coordinated Time.

....................................................................................................................................................................................................................................

V V
Volts

VAC
Volts Alternating Current
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Value
A number, text string, or other menu selection associated with a parameter.

Variable
An item of data named by an identifier. Each variable has a type, such as int or Object, and a
scope.

VC (Virtual Container)
Container with path overhead.

VDC
Volts Direct Current

VF
Voice frequency

Virtual
Refers to artificial objects created by a computer to help the system control shared resources.

Virtual Circuit
A logical connection through a data communication (for example, X.25) network.

Voice Frequency (VF) Circuit
A 64 kilobit per second digitized signal.

Volatile Memory
Type of memory that is lost if electrical power is interrupted.

....................................................................................................................................................................................................................................

W WAD
Wavelength Add/Drop

WAN (Wide Area Network )
A communication network that uses common-carrier provided lines and covers an extended
geographical area.

Wander
Long term variations of amplitude frequency components (below 10 Hz) of a digital signal from
their ideal position in time possibly resulting in buffer problems at a receiver.

Wavelength Interchange
The ability to change the wavelength associated with an STM-N signal into another wavelength.

WaveStar OLS 40G/80G/400G
WaveStar Optical Line System 40G/80G/400G
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WDCS
Wideband Digital Cross-Connect System

WDM (Wavelength Division Multiplexing)
A means of increasing the information-carrying capacity of an optical fiber by simultaneously
transmitting signals at different wavelengths.

Wideband Communications
Voice, data, and/or video communication at digital rates from 64 kbit/s to 2 Mbit/s.

Working
Label attached to a physical entity. In case of revertive switching the working line or unit is the
entity that is carrying service under normal operation. In case of nonrevertive switching the
label has no particular meaning.

Working State
The working unit is currently considered active by the system and that it is carrying traffic.

WRT (Wait to Restore Time)
Corresponds to the time to wait before switching back after a failure has cleared, in a revertive
protection scheme. This can be between 0 and 15 minutes, in increments of one minute.

WS
Work Station

WTR (Wait to Restore)
Applies to revertive switching operation. The protection group enters the WTR state when all
Equipment Fail (EF) conditions are cleared, but the system has not yet reverted back to its
working line. The protection group remains in the WTR state until the Wait-to-Restore timer
completes the WTR time interval.

....................................................................................................................................................................................................................................

X X.25
An ITU standard defining the connection between a terminal and a public packet-switched
network

X.25 Interface/Protocol
The ITU packet-switched interface standard for terminal access that specifies three protocol
layers: physical, link, and packet for connection to a packet-switched data network.

....................................................................................................................................................................................................................................

Z Zero Code Suppression
A technique used to reduce the number of consecutive zeros in a line-coded signal (B3ZS,
B8ZS).
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Protection Ring
(MS-SPRing)

2-fiber MS-SPRing,
11-26

........................................................

N NE configuration data,
13-2

NE name, 1-11, 8-3, 8-29

NE software, 13-2

Near-side facility loopback,
12-9

Network Entity Title
(NET), 1-30, 1-30, 8-17

Network Service Access
Point (NSAP), 8-15

Network Service Access
Point (NSAP); NSAP
address, 1-11, 8-3

Network_side mode, 8-22

Non-preemptible
Unprotected Traffic
(NUT), 5-27

Non-preemptible
Unprotetcted Traffic
(NUT), 11-30

Nonvolatile memory
(NVM), 13-2

NSAP address, 1-11, 1-13,
1-14, 8-15

NSAP address format,
8-15, 8-15

NSAP Network Service
Access Point, 8-15

NVM Nonvolatile memory,
13-2
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O Operations Network (ON),
8-24

Operator identifier, 8-16

optical

interfaces, 14-8

Organization identifier
(ORG), 8-16

OSI Neighbor Map, 8-5

OSI network protocol, 8-3

OSI protocol stack, 8-10,
8-19

OSI Routing Map, 8-5

OSI-DCN, 8-2
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P PCMCIA flash disk, 13-2

Port units, 9-14

Preconditions for disabling
a DCC, 1-23, 1-26

Preconditions for enabling
a DCC, 1-23, 1-26

product

family, 14-7

product family, 14-7

Protocol stacks, 8-11
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Q Q-LAN, 8-2
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R RD Routing Domain, 8-16

Regenerator Section Data
Communication Channel
(DCC-R), 8-19

Reserved portion of the
NSAP, 8-16

Revertive mode, 10-7

Routing Domain (RD),
8-16

Routing Information Base
(RIB), 8-5

Routing metric, 8-23

Routing tables, 8-5
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S SDH management network,
8-2

Section DCC, 8-19

Selector, 8-16

Self healing rings, 11-27

Shelf layout, 9-7, 9-13

Shortest path first
algorithm, 8-4, 8-6, 8-23

Slave timing generator,
10-2

Software download, 8-11,
13-3

Software installation, 13-5

start-up system, 14-8

STM-1(e)

port units, 14-8

switch

capacity, 14-8

Switch request, 10-13

Synchronization Status
Marker (SSM), 10-4

System controller, 13-2

System identifier, 8-16

system overview, 14-8

System timing, 4-2, 4-11,
10-11

System timing reference,
10-11, 10-13
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T Target identifier (TID),
1-11, 8-3, 8-26, 8-29

TARP Data Cache (TDC),
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TARP manual adjacencies;
Manual adjacencies, 1-30,
8-28

TARP originator
functionality, 1-29, 8-26

TARP PDU lifetime, 8-26

TARP PDU types, 8-26

TARP propagation
functionality, 1-27

TARP responder
functionality, 1-27, 8-26

TID Address Resolution
Protocol (TARP), 8-16,
8-26

Timing configuration, 4-2,
10-3

Timing generator, 4-10,
10-2

Timing marker, 10-4

Timing protection, 10-6

Timing provisioning, 10-1

Timing quality, 10-4

Timing reference, 4-2, 4-9,
4-14, 4-16, 4-17, 4-19,
10-10

Timing reference protection
switching, 10-6

Timing references, 4-9

transmission interfaces

types of, 14-8
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U Unacknowldeged
Information Transfer
Service (UITS), 8-22

Undivided DCN, 8-7

User-Network Side MSect
Failure, 1-21, 1-21, 1-24

User-Network Side RSect
Failure, 1-21, 1-21, 1-24

User_side mode, 8-22
........................................................

W Wait-to-restore time
(WTR), 10-7, 10-13

WaveStar product family,
14-7
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X XC loopbacks
See: Cross connection

loopback
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